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About This Book

This book, Inside Macintosh: Macintosh Toolbox Essentials, describes the essential
elements of a Macintosh application and the system software routines that you
can use to implement them.

If you are new to programming on the Macintosh computer, you should also
read Inside Macintosh: Overview for an introduction to general concepts of
Macintosh programming and Macintosh Human Interface Guidelines for a
complete discussion of user interface guidelines and principles that every
Macintosh application should follow.

This book describes events, windows, menus, controls, alert boxes, and dialog
boxes. It also discusses how your application interacts with the Finder.

Macintosh applications respond to user actions and to other hardware- and
software-related events. To design your application so that it can respond to
events (such as keyboard input, mouse input, changes in the appearance of
windows on the screen, and changes in your application’s processing status),
see the chapter “Event Manager” in this book.

To create menus and set up your application’s menu bar, see the chapter
“Menu Manager.” This chapter describes how to define the items in your
menus, how to enable and disable menus, how to allow the user to choose
a menu item, and how to respond once the user chooses a menu item.

To create windows in which the user can view or edit information, see the
chapter “Window Manager.” This chapter describes the basic types of
windows and discusses how your application can work together with the
Window Manager to support the standard user interface conventions
associated with manipulating a window, such as moving a window, zooming
a window, and resizing a window.

To create controls in your application’s windows—such as scroll bars—or to
create controls in dialog boxes—such as buttons or checkboxes—see the
chapter “Control Manager.”

To create dialog boxes or alert boxes—windows that your application uses to
communicate with or solicit information from the user—see the chapter
“Dialog Manager.”

To create icons for your applications and the documents it creates, see the
chapter “Finder Interface.” This chapter also introduces file types and
creators and describes the various kinds of resources (icons, file references,
and bundles) that the Finder needs to display your application and the
documents it creates.

After implementing the basic elements of a Macintosh application as described
in this book, you can add additional features, such as help balloons and
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support for copy and paste, as described in Inside Macintosh: More Macintosh
Toolbox. You can also find detailed information about the Resource Manager in
Inside Macintosh: More Macintosh Toolbox.

Once you understand how to create menus, windows, and dialog boxes, you
can save information that the user enters in a window by writing the data to a
file. You can also open a previously saved file and read the information from
the file into a window. You use the File Manager to open, read, write, and close
files. See the chapter “Introduction to File Management” in Inside Macintosh:
Files for information on how to read and write files.

For information about drawing into a window or other graphics port, see
Inside Macintosh: Imaging.

For information on handling text in your application, see Inside
Macintosh: Text.

For information on communicating with other applications, see Inside
Macintosh: Interapplication Communication.

Format of a Typical Chapter

Almost all chapters in this book follow a standard structure. For example, the
Event Manager chapter contains these sections:

m “Introduction to Events.” This section presents a general introduction to the
types of events that your application can receive.

m “About the Event Manager.” This section provides an overview of the
features provided by the Event Manager.

m “Using the Event Manager.” This section describes the tasks you can
accomplish using the Event Manager. It describes how to use the most
common routines, gives related user interface information, provides code
samples, and supplies additional information.

m “Event Manager Reference.” This section provides a complete reference
to the Event Manager by describing the data structures, routines, and
resources it uses. Each routine description also follows a standard format,
which presents the routine declaration followed by a description of every
parameter of the routine. Some routine descriptions also give additional
descriptive information, such as assembly-language information or
result codes.

m “Summary of the Event Manager.” This section provides the Pascal and
C interfaces for the constants, data structures, routines, and result codes
associated with the Event Manager. It also includes relevant assembly-
language interface information.

Conventions Used in This Book

Inside Macintosh uses various conventions to present information. Words that
require special treatment appear in specific fonts or font styles. Certain
information, such as the contents of registers, use special formats so that you
can scan them quickly.
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Special Fonts

All code listings, reserved words, and names of actual data structures,
fields, constants, parameters, and routines are shown in Courier (this
is Courier).

Words that appear in boldface are key terms or concepts and are defined in
the Glossary.

Types of Notes

There are several types of notes used in this book.

Note

A note like this contains information that is interesting but possibly not
essential to an understanding of the main text. (An example appears on
page2-7.) &

IMPORTANT
A note like this contains information that is essential for an
understanding of the main text. (An example appears on page 5-27.) A

WARNING

Warnings like this indicate potential problems that you should be aware
of as you design your application. Failure to heed these warnings could
result in system crashes or loss of data. (An example appears on page
page 2-105.) A

Empty Strings

This book occasionally instructs you to provide an empty string in routine
parameters and resources. How you specify an empty string depends on what
language and development environment you are using. In Rez input files and
in C code, for example, you specify an empty string by using two double
quotation marks (""), and in Pascal you specify an empty string by using two
single quotation marks (').

Assembly-Language Information

Inside Macintosh provides information about the registers for specific routines
like this:

Registers on entry

A0 Contents of register A0 on entry

Registers on exit

DO Contents of register DO on exit
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In the “Assembly-Language Summary” section at the end of each chapter,
Inside Macintosh presents information about the fields of data structures in
this format:

0 what word event code
2 message long event message
6 when long ticks since startup

The left column indicates the byte offset of the field from the beginning of the
data structure. The second column shows the field name as defined in the
MPW Pascal interface files; the third column indicates the size of that field.
The fourth column provides a brief description of the use of the field. For a
complete description of each field, see the discussion of the data structure in
the reference section of the chapter.

The Development Environment

The system software routines described in this book are available using Pascal,
C, or assembly-language interfaces. How you access these routines depends
on the development environment you are using. When showing system
software routines, this book uses the Pascal interface available with the
Macintosh Programmer’s Workshop (MPW).

All code listings in this book are shown in Pascal (except for listings that
describe resources, which are shown in Rez-input format). They show
methods of using various routines and illustrate techniques for accomplishing
particular tasks. All code listings have been compiled and, in many cases,
tested. However, Apple Computer, Inc., does not intend for you to use these
code samples in your application. You can find the location of code listings in
the list of figures, tables, and listings. If you know the name of a particular
routine (such as DoEvent or MyAdjustMenus) shown in a code listing, you
can find the page on which the routine occurs by looking under the entry
“sample routines” in the index of this book.

In order to make the code listings in this book more readable, they show only
limited error handling. You need to develop your own techniques for handling
errors.

This book occasionally illustrates concepts by reference to a sample
application called SurfWriter; this is not an actual product of Apple
Computer, Inc.
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CHAPTER 1

Introduction to the Macintosh Toolbox

This chapter presents an introduction to the features provided by the Macintosh Toolbox.
The Macintosh Toolbox is a collection of system software routines that your application
can use to present a consistent and standard interface to the user; these routines also
allow you to simplify other tasks your application might need to perform.

A typical Macintosh application presents a friendly, intuitive, easy-to-use, visual inter-
face to the user. The careful design of a Macintosh application gives users the freedom

to perform actions and accomplish tasks according to their needs. The idea behind this
careful design is to put the user in control. In general, the user of a Macintosh application
should always be free to choose the next action he or she will perform. (This is the basic
tenet of the event loop and is explained in more detail in the chapter “Event Manager” in
this book.)

Figure 1-1 shows the screen as it might appear when a user is interacting with a typical
Macintosh application, such as SurfWriter. The SurfWriter application is an application
that lets a user do simple text editing. Like most Macintosh applications, the SurfWriter
application uses

m menus to let the user choose commands
m windows to allow the user to enter and edit information

m scroll bars to allow the user to view more information in a window

Figure 1-1 The SurfWriter application with multiple windows on the desktop
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m other controls (such as the Change button) to let the user control various settings
or options

m dialog boxes to solicit information from the user

You can create an application that incorporates these user-interface elements and that
helps users accomplish specific tasks by taking advantage of the routines provided by the
Macintosh Toolbox.

Overview of the Macintosh Toolbox

Macintosh system software contains a powerful set of routines that your application can
use to create windows, manage menus, paint objects, display text, open files, share data
between programs, and print files, as well as perform many other helpful tasks.

The Macintosh Toolbox encompasses a number of system software routines, most (but
not all) of which help present your application’s interface to the user. Some of these
routines include those provided by the Event Manager, Menu Manager, Window
Manager, Control Manager, Dialog Manager, Help Manager, Resource Manager, and
Scrap Manager.

You can directly call these routines from within your application. By using system
software routines, you can take advantage of the many tasks they can perform for
you, and you can concentrate on the parts of your application that are specific to
your particular product.

Using the Macintosh Toolbox, you can

m respond to user actions, such as mouse actions or keyboard input

m create and display menus

m create and display windows, alert boxes, and dialog boxes

m create and display controls in windows, alert boxes, and dialog boxes

m create icons for your application and its documents

This book, Macintosh Toolbox Essentials, describes these fundamental elements of a
Macintosh application. Inside Macintosh: More Macintosh Toolbox describes additional
features of a Macintosh application, including how you can

m create help balloons for your application’s menus, windows, and dialog boxes
m support copy and paste

m specify characteristics of your application’s menus, windows, controls, dialog boxes,
and help balloons in resources so that you can more easily localize your application

Overview of the Macintosh Toolbox
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The best Macintosh applications are designed according to the guidelines in Macintosh
Human Interface Guidelines. You should always design your application so that it meets
the needs of its users and responds in consistent and expected ways. Macintosh Human
Interface Guidelines describes

m the philosophy and the design principles behind the Macintosh interface
m the parts of the Macintosh interface including the interface elements and behaviors

m ways to do human interface design for Macintosh products

You can often get valuable feedback on the design of your application by performing user
testing. Do usability testing of your application early and often in the development phase
of your product.

Events

At the core of every Macintosh application is the application’s event loop. The event loop
is that piece of code in an application that processes and responds to user actions and
other events. You can use the Event Manager to retrieve information about these actions.
For example, you can get information that tells your application whether the user pressed
a key or the mouse button, whether one of your application’s windows needs updating
as a result of the user moving windows, or whether some other hardware or software
action requires a response from your application.

You should structure your application so that it can respond to events and so that the
user is able to perform tasks in any order. For example, a user should be able to type text
in a window, select a graphic and copy it, open a new document, paste in the graphic,
open another document, and then go back to the first window to select text and change
its typeface, size, or style.

Your application should respond to events in a way that lets the user switch between
your application and others whenever the user chooses to do so (for example, by clicking
in a window belonging to another application). Your application should also yield time to
other applications when it isn’t busy. System software provides a cooperative
multitasking environment that allows users to switch between many open applications
and that allows applications to receive available processing time when other applications
aren’t using the processor. System software coordinates the scheduling of processing time
between your application and other applications.

You can also let your application communicate with other applications in order to request
services or information from another application or to provide services to other
applications. You can use the Event Manager or Apple Event Manager to do this.

The chapter “Event Manager” in this book describes how to structure your event loop
and event-handling code to receive notification of user actions and changes in the
processing status of your application, how to communicate with other applications, and
how to respond to these events.

Overview of the Macintosh Toolbox 1-5
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Menus

Menus are an important part of the design of a Macintosh application. Menus let users
view or choose an item from a list of choices or commands that your application
provides. You design your menus according to the tasks or actions your application
performs. All applications should support the Apple, File, Edit, Help, Keyboard, and
Application menus. Figure 1-1 on page 1-3 shows the File menu of the SurfWriter
application.

System software makes it easy for you to create pull-down, hierarchical, and pop-up
menus. The chapter “Menu Manager” in this book describes how to create your
application’s menus, set up your menu bar, display menus, and respond to the user’s
choice of an item from a menu.

Windows

Most applications interact with the user through windows. Figure 1-2 shows a common
window and its elements. The chapter “Window Manager” in this book describes the
types of windows your application can create and how to respond to user actions
involving windows.

Figure 1-2 A typical window

1-6

Close box Title bar Zoom box

-

\
[I=—————— untitied grﬂ%'
=1

— Scroll bar

]

Scroll bar Content area Size box

The user typically has one or more windows on the desktop, often from a number of
different applications. Although the user can have multiple windows on the desktop,
only one window is the active window. The active window is the window that appears
frontmost on the desktop and is identified by racing stripes in its title bar. Figure 1-2
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shows an active window; in Figure 1-1 on page 1-3, the window titled SalesReport is an
inactive window.

All keyboard activity is directed toward the active window. You should make sure that
your application follows the human interface guidelines regarding active and inactive
windows. For example, you should show the scroll bars and highlight any selection in an
active window belonging to your application; you should hide the scroll bars and remove
highlighting from any selection in an inactive window belonging to your application. The
menu bar of your application also should always reflect the state of your application’s
active window—that is, your application should enable only those menu commands that
pertain to the active window.

You can use system software routines to assist you when your application needs to
create, move, size, zoom, or update the contents of your window. The chapter “Window
Manager” in this book describes how you can accomplish these tasks.

Controls

Most windows and dialog boxes contain controls. Controls are onscreen objects that the
user can manipulate with the mouse to cause an immediate action from your application
or to change settings in order to modify a future action.

Buttons, checkboxes, radio buttons, pop-up menus, and scroll bars are examples of
common controls used by most applications. Checkboxes, radio buttons, and pop-up
menus are most often used in dialog boxes; buttons are most often used in alert boxes or
dialog boxes; scroll bars are most often used in windows. Figure 1-3 illustrates these
types of controls.

Figure 1-3 Common controls
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A button appears as a rounded rectangle with a title centered inside. Use a button to
perform an instantaneous action when the user clicks the button, such as completing
operations defined by a dialog box or acknowledging an error message in an alert box.

A checkbox appears as a small square with a title beside it; the box contains an X when
the setting associated with the box is on and is empty when the setting is off. Use a
checkbox to indicate an option that must be either off or on.

A radio button appears as a circle with a title beside it; the circle contains a small black
dot when the setting associated with the radio button is on and is empty when the setting
is off. Radio buttons are similar to checkboxes in that they retain and display

an on-or-off setting; however, only one radio button in a group of radio buttons should
be on at any one time. You must decide how to group your radio buttons, and your
application must ensure that only one radio button in a group is on.

A pop-up menu is a menu that appears in a dialog box or window. You can use pop-up
menus as an alternative to radio buttons, to allow the user to select from a list of choices
or settings.

A scroll bar appears as a light gray rectangle that has scroll arrows at each end of the
rectangle. A window can have a horizontal scroll bar, a vertical scroll bar, or both. You
can use scroll bars to let the user change the portion of a document that the user can view
within a window.

You can track and respond to user actions in controls, redraw controls, and manipulate
controls using Control Manager routines. You usually use the Dialog Manager to handle
most controls in dialog boxes or alert boxes for you. The chapter “Control Manager” in
this book describes how to create controls (with special emphasis on creating and using
scroll bars in windows), and the chapter “Dialog Manager” in this book provides
additional information about how to create controls in dialog boxes and alert boxes.

Alert Boxes and Dialog Boxes

In addition to standard windows, your application typically also uses alert boxes and
dialog boxes. An alert box is a window that your application displays on the screen to
warn the user or to report an error to the user. An alert box typically consists of text
describing the situation and buttons for the user to acknowledge or rectify the problem.
Figure 1-4 shows an alert box that the SurfWriter application displays when the user
attempts to close a window without saving the document. The alert box gives the user a
chance to save the document before the SurfWriter application closes the window; this
prevents the user from accidentally losing data.

Figure 1-4 An alert box
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A dialog box is a window that you can use for the specific purpose of soliciting
additional information from the user. The Dialog Manager provides routines to help you
display dialog boxes and provides standard and consistent methods of interacting with
the user. Dialog boxes can contain editable text items, informative or instructional text,
and controls such as buttons and checkboxes. You can create modal, movable modal, or
modeless dialog boxes. Figure 1-5 shows an example of each type of dialog box.

A modal dialog box is a dialog box that puts the user in the state or “mode” of being able
to work only inside the dialog box. A modal dialog box is similar in appearance to an
alert box, except that a modal dialog box can contain editable text items and additional

Figure 1-5 Modal, movable modal, and modeless dialog boxes
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controls, such as radio buttons and pop-up menus. The user cannot move a modal dialog
box, and the user can dismiss a modal dialog box only by clicking its buttons. You should
use a modal dialog box only when it’s essential for the user to complete an operation
before performing any other work.

A movable modal dialog box is a modal dialog box with a title bar (but no close box) that
allows the user to move the dialog box. The user can dismiss the dialog box only by
clicking its buttons; however, when you use movable modal dialog boxes, you should
allow the user to switch to another application if the user clicks in the window of another
application or chooses another application from the Apple or Application menu. Use a
movable modal dialog box when the user might need to move the dialog box to view
other areas of the screen or when the user can switch to another application without
affecting the state of your application.

A modeless dialog box is a dialog box that looks like a document window without a size
box or scroll bars. A modeless dialog box does not require the user to respond before
doing anything else. The user can move a modeless dialog box, move between a
modeless dialog box and other windows, and close a modeless dialog box just like a
document window. Whenever possible, use a modeless dialog box instead of a movable
modal or modal dialog box. Use a modeless dialog box when the user can perform other
operations—such as working in document windows—without dismissing the modeless
dialog box.

The chapter “Dialog Manager” in this book describes in detail how you can create alert
boxes and dialog boxes for your application.

Icons and Other Interactions With the Finder

Once you've designed your application, you need to create icons to represent the
application and the documents it creates. The Finder displays these icons to the
user. If your application appears as an item in the Apple or Application menu, the
Menu Manager displays your application’s icon next to its name, and the Menu
Manager displays your application’s icon as the title of the Application menu when
your application is the active application.

The chapter “Finder Interface” in this book describes how to define and create the icons
for your application and its documents. The chapter also describes how your application
interacts with the Finder.

When a user opens your application or opens or prints one of its documents, the Finder
uses the Process Manager to schedule your application for execution and then sets up the
information your application needs to determine which, if any, files to open or print. In
System 7, your application can choose to receive this information through Apple events.
By supporting these and other Apple events, your application can efficiently respond to
requests from the user as well as requests from other applications. See

Inside Macintosh: Interapplication Communication for information about supporting

Apple events.

Overview of the Macintosh Toolbox



CHAPTER 1

Introduction to the Macintosh Toolbox

Resources

Resources are basic elements of every Macintosh application. By defining descriptions of
menus, windows, controls, dialog boxes, sounds, fonts, and icons in resources, you can
make these and other elements easier to create and manage. Using resources also eases
translation of user interface elements into other languages.

A resource is any data stored according to a defined structure in the resource fork of

a file; the data in a resource is interpreted according to its resource type. You usually
create resources using a resource compiler or resource editor. This book shows resources
in Rez format; Rez is a resource compiler provided with the Macintosh Programmer’s
Workshop (available from APDA). You can also use other resource tools, such as ResEdit
(also available from APDA), to create the resources for your application.

Most of the managers described in this book use the Resource Manager to read resources
for you. For example, you can use the Menu Manager, Window Manager, Dialog
Manager, and Control Manager to read descriptions of your application’s menus,
windows, dialog boxes, and controls from resources. These managers all interpret a
resource’s data accordingly once it is read into memory. While you'll typically use these
managers to access resources for you, you can also directly use the Resource Manager

to read and write resources.

The chapter “Resource Manager” in Inside Macintosh: More Macintosh Toolbox describes the
Resource Manager in detail. However, to help you understand how the Menu Manager,
Window Manager, Dialog Manager, and Control Manager use resources, this section
gives a brief overview of resources and provides a general introduction to the Resource
Manager.

Macintosh system software treats a file as a named, ordered sequence of bytes stored
on a Macintosh volume and divided into two forks, the data fork and the resource fork.
The data fork contains data that usually corresponds to data created by the user; the
application creating the file can store and interpret the data in the data fork in whatever
manner is appropriate. The resource fork of a file consists of a resource map and the
resources themselves.

When you write data to a file, you write to either the file’s resource fork or its data fork.
You typically read from and write to a file’s data fork using File Manager routines and
read from and write to a file’s resource fork using Resource Manager routines.

You typically store as resources data that has a defined structure—such as icons and
sounds—and descriptions of menus, controls, dialog boxes, and windows. When you
create a resource, you assign it a resource type and resource ID. A resource type is a
sequence of four characters that uniquely identifies a specific type of resource, and a
resource ID identifies by number a specific resource within that type. (You can also

use a resource name in place of a resource ID to identify a particular resource within a
resource type.) For example, to create a description of a menu in a resource, you create
a resource of type 'MENU' and give it a resource ID or resource name that is unique from
any other 'MENU' resources that you have defined. Some resources have restrictions on
the numbers you can use for resource IDs; in general, numbers 128 through 32767 are
available for your use.

Overview of the Macintosh Toolbox 1-11
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System software defines a number of standard resource types, such as 'ALRT', 'CNTL',
'"CODE', 'DITL', 'DLOG', 'FONT', 'ICN#', 'ICON', 'MBAR', 'MENU', 'STR ',
'STR#',and 'WIND'. You can use these resource types to define their corresponding
elements (for example, use a 'WIND' resource to define a window). You can also create
your own resource types if your application needs resources other than the standard
resource types defined by the system software.

The Resource Manager does not interpret the format of an individual resource type.
When you request a resource of a particular type with a given resource ID, the Resource
Manager looks for the specified resource and, if it finds it, reads the resource into
memory and returns a handle to it. Your application or other system software routines
can use the Resource Manager to read resources into memory. For example, when you
use the Window Manager to read a description of a window from a 'WIND' resource, the
Window Manager uses the Resource Manager to read the resource into memory. Once the
resource is in memory, the Window Manager interprets the resource’s data and creates a
window with the characteristics described by the resource.

System software stores certain resources used by the system software in the System
file. Although many of these resources are used only by the system software, your
application can access some of these resources if needed. For example, the standard
images for the I-beam and wristwatch cursors are stored as resources of type ' CURS'
in the System file. You can use these resources to change the appearance of the cursor
used by your application.

Occasionally you may need to write resources to the resource fork of a file. For example,
if your application saves the last position and size of a window (as determined by

the user), you can store this information in the resource fork of the document in a
resource defined by your application. The next time the user opens the document, your
application can read the location saved in this resource and position the document
accordingly.

You typically store the resources specific to your application, such as descriptions of its
menus, windows, controls, and dialog boxes, in the resource fork of your application.
You can store resources specific to a document created by your application in the resource
fork of the document file.

The resource map in the resource fork of a file contains entries that provide the location
of each resource in the resource fork. When the Resource Manager opens the resource
fork of a file, it reads the resource map into memory. As the Resource Manager reads
resources into memory, it replaces their entries in the resource map with handles to their
data in memory. The Resource Manager always searches the resource map in memory,
not the resource map of the resource fork on disk, when it searches for a resource. If a
requested resource is in memory, the Resource Manager uses the resource in memory;
otherwise it reads the resource from the resource fork on disk into memory.

Once the Resource Manager has opened a resource fork and read its resource map into
memory, it keeps the map in memory until the file is closed. You can specify that a
resource be read into memory immediately when the Resource Manager opens a file’s
resource fork, or you can specify that the Resource Manager read it into memory only
when needed. The Resource Manager stores resources from resource forks opened by
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your application in relocatable blocks in your application’s heap. You can also specify
whether the Resource Manager should purge a resource from memory in order to make
room in memory for other data. If you specify that a resource is purgeable, you need to
use the Resource Manager to make sure the resource is in memory before accessing it
through its resource handle.

When a user opens your application, system software opens your application’s resource
fork. When your application opens a file, your application typically opens both the

file’s data fork and the file’s resource fork. When your application requests a resource
from the Resource Manager, the Resource Manager follows a specific search order.

(If necessary, your application can change the search order using Resource Manager
routines.) The Resource Manager normally looks first for the resource in the resource fork
of the last file that your application opened. So, if your application has a single file open,
the Resource Manager looks first in that file’s resource fork. If the Resource Manager
doesn’t find the resource there, it continues to search each resource fork open to your
application in the reverse order that the files were opened. After looking in the resource
forks of files your application has opened, the Resource Manager searches your
application’s resource fork. If it doesn’t find the resource there, it searches the resource
fork of the System file.

This search path allows your application to use resources defined in the System file, to
override resources defined in the System file, to share resources between files by using
resources stored in your application’s resource fork, and to override your application-
defined resources and use resources specific to a document.

A Macintosh file always contains both a resource fork and a data fork, although one

or both of those forks can be empty. Document files typically contain the document’s data
in the data fork and any document-specific resources—such as preference settings,
window location, and the document icon—in the resource fork. The resource fork

of an application typically includes resources that describe the application’s menus,
windows, controls, dialog boxes, and icons, as well as the code itself, which is also stored
as a resource.

Whether you store data in the data fork or the resource fork of a document file depends
largely on whether you can structure that data in a useful manner as a resource.

For example, it’s often convenient to store document-specific settings, such as the
document’s previous window size and location, as a resource in the document’s resource
fork. Data that is likely to be edited by the user is usually stored in the data fork of

a document.

A resource fork can contain at most 2700 resources. The Resource Manager uses a linear
search when searching a resource fork’s resource types and resource IDs. In general, you
should not create more than 500 resources of the same type in any one resource fork.

Inside Macintosh: More Macintosh Toolbox describes resources and the use of the Resource
Manager in more detail. For information on writing data to a file’s data fork, see Inside
Macintosh: Files.
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Help Balloons

Your application can provide help balloons for elements such as menus, dialog boxes, or
the content area of a window. The chapter “Help Manager” in Inside Macintosh: More
Macintosh Toolbox describes how your application can provide help balloons. You can also
create help balloons for some elements of your application’s interface—such as its
menus—using the application BalloonWriter, which is available from APDA.

Copy and Paste

All Macintosh applications should support the copying of data from and pasting of data
to the Clipboard. The chapter “Scrap Manager” in Inside Macintosh: More Macintosh
Toolbox describes how to copy data from the Clipboard and paste data to the Clipboard
by using the Scrap Manager.

Related System Software Features

1-14

In addition to the managers provided by the Macintosh Toolbox, you can also use other
managers and system software routines. For example, you can use QuickDraw routines
to draw the content of your application’s windows, TextEdit (in conjunction with the
Dialog Manager) to handle editable text items in dialog boxes, the File Manager to read
and write files, the Process Manager and Memory Manager to control various aspects of
your application’s execution, and the Edition Manager and Apple Event Manager to
support interapplication communication. The rest of this chapter describes some of these
managers and where you can find more information about them.

Drawing on the Screen

System software routines, such as the routines provided by QuickDraw, perform all
drawing on the screen. For example, your application tells QuickDraw what and where
to draw, and QuickDraw does the actual drawing to the screen. The graphics routines
provided by system software support quick drawing of objects such as circles, ovals,
rectangles, lines, text, and pictures. See Inside Macintosh: Imaging for specific graphics-
related information.

Handling Text

You can use the system software routines provided by TextEdit to greatly simplify basic
text editing and formatting that your application would otherwise have to implement.
For example, most applications use editable text items in dialog boxes; your application
can use the Dialog Manager (which calls TextEdit) to automatically handle user
interaction in editable text items. The Dialog Manager and your application can use

Related System Software Features
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TextEdit to insert new text, delete characters that the user backspaces over, scroll text
within a window, cut text, copy text, paste text, select text, and handle word wrapping.
Most applications use TextEdit only for simple text editing in a dialog box and use their
own techniques for handling editable text in document windows.

You should design your application so that it can handle text in more than one language
or script. System software provides many routines to help you accomplish this. For
example, if your application automatically displays the date in the footer of your
document, you can use Text Utility routines to automatically display the date in the
format common to the current script. Similarly, if your application provides a Find
command, it can use Text Utility routines to search according to the word-break tables
and according to the current script.

See Inside Macintosh: Text for information on how you can provide support for text editing
in documents created by your application and for information on designing your
application so that it can support text editing in more than one language or script.

Managing Files

When the user chooses the Save or Save As menu command, you usually write to a file
the data that the user has entered in the active window. When the user selects a file using
the Open command, you read information from a file. You can use the File Manager to
read and write files. You can use the system software routines provided by the Standard
File Package to present a standard and consistent interface to the user when saving and
opening files. See the chapters “Introduction to File Management” and “Standard File
Package” in Inside Macintosh: Files for information about these topics.

Allocating Memory and Launching Processes

For information about how the Process Manager launches your application, see

the chapter “Process Manager” in Inside Macintosh: Processes. See the chapter
“Introduction to Memory Management” in Inside Macintosh: Memory for informa-

tion about how system software manages memory; how you can manage the memory

in your application’s partition effectively; and how your application can allocate, release,
or manipulate memory.

Creating Publishers and Subscribers

Your application should support Edition Manager features so that users can share and
automatically update data between documents. See the chapter “Edition Manager” in
Inside Macintosh: Interapplication Communication for information about supporting publish
and subscribe features.
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Communicating With Other Applications

System software provides various means of communication between applications. You
can use Event Manager routines to communicate, in the form of high-level events, with
other applications. High-level events are not required to adhere to any specific protocol,
so their interpretation is defined by each application that sends or receives them. Apple
events are high-level events that follow a standard defined protocol (the Apple Event
Interprocess Messaging Protocol). In most cases, you should use Apple events for
communication between applications. Because Apple has defined a standard set of Apple
events, all applications can interpret specific Apple events in the same way and respond
in an expected manner.

Both the Event Manager and Apple Event Manager rely on the services of the
Program-to-Program Communications (PPC) Toolbox to actually send and receive events
between applications. Your application can also directly access the PPC Toolbox if you
need to get additional control or services not provided by the Event Manager or Apple
Event Manager.

If your application supports publish and subscribe features, the Edition Manager sends
your application Apple events to notify it when new data is available for a subscriber or
to request that it create a new publisher.

For information on Apple events, publish and subscribe features, or direct access to the
PPC Toolbox, see Inside Macintosh: Interapplication Communication.

Designing Your Application
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As previously described, you'll need to make extensive use of this book and Macintosh
Human Interface Guidelines as you begin to design your application. Once you implement
the basic elements of a Macintosh application, you can begin to add features unique to
your application. Once again, you'll find Macintosh Human Interface Guidelines and other
books in the Inside Macintosh library valuable tools as you create applications.

Designing Your Application
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This chapter describes how your application can use the Toolbox Event Manager to
receive information about actions performed by the user, to receive notice of changes in
the processing status of your application, and to communicate with other applications.

For example, you can retrieve information from the Toolbox Event Manager that gives
your application details about whether the user has pressed a key or the mouse button,
whether one of your application’s windows needs updating, or whether some other
hardware-related or software-related action requires a response from your application.

Your application also uses the Event Manager to support the cooperative, multitasking
environment available on Macintosh computers. This environment allows users to switch
between many open applications and allows other applications to receive background
processing time. By using Event Manager routines, you allow the system software to
coordinate the scheduling of processing time between your application and other
applications.

The Event Manager and Process Manager maintain the cooperative, multitasking
environment. The Process Manager coordinates the scheduling of applications, and the
Event Manager communicates information about changes in your application’s
processing status to your application.

See the chapter “Process Manager” in Inside Macintosh: Processes for complete information
on how the Process Manager schedules applications for execution.

You can use the Event Manager to communicate with other applications. Your application
can also communicate with other applications using the services of the Apple Event
Manager.

The Event Manager and Apple Event Manager routines that let your application
communicate with other applications depend on the services of the Program-to-Program
Communications (PPC) Toolbox. The services performed by the Event Manager and
Apple Event Manager meet the needs of most applications for interapplication
communication. However, to get additional control or capabilities not provided by the
Event Manager or Apple Event Manager, you can choose to access the PPC Toolbox
directly. The chapter “Program-to-Program Communications Toolbox” in Inside
Macintosh: Interapplication Communication describes the PPC Toolbox routines that are
available to your application.

For a comparison of the services provided by the Event Manager, Apple Event Manager,
and PPC Toolbox, see Inside Macintosh: Interapplication Communication. For additional
information about Apple events, including descriptions of how to process the required
Apple events, see Inside Macintosh: Interapplication Communication.

This chapter describes both the Toolbox Event Manager and the Operating System Event
Manager. The Operating System Event Manager maintains a queue in which it stores
hardware-related occurrences that you may want your application to respond to. The
Toolbox Event Manager communicates the information maintained by the Operating
System Event Manager to your application. In most cases, your application needs to
interact only with the Toolbox Event Manager. In this chapter, the name Event Manager
refers to the Toolbox Event Manager.
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This chapter provides a general introduction to events and then explains how you can
use the Event Manager to

receive keypresses and mouse clicks as input for your application
m receive indication that your application’s windows need to be activated or updated

m allow other applications to use the available system resources when your application
isn’t using them

m communicate with other applications

Introduction to Events

Most Macintosh applications receive information about hardware and software
occurrences that require a response from the application, through events. An event is the
means by which the Event Manager communicates information about user actions,
changes in the processing status of the application, and other occurrences that require a
response from the application.

The Event Manager communicates information about events that occur through the event
record. The EventRecord data type defines the event record. The event record contains
information about what type of event occurred (a mouse click or keypress, for example)
and contains additional information associated with the event (for example, for a
keypress the Event Manager also reports which key was pressed).

Most Macintosh applications are event-driven—that is, they respond to various changes
or occurrences and take action based on the nature of the event. Typically, a Macintosh
application repeatedly checks to see if an event has occurred and, if so, responds to the
event. If no events are pending, the application can choose to relinquish the processor for
a specified amount of time or can perform other tasks before checking again to see
whether an event has occurred.

Your application typically retrieves events from the Event Manager and also relinquishes
processor time by using the WaitNextEvent function. If any events are pending for
your application, the WaitNextEvent function returns the event to your application. If
no events are pending for your application, the WaitNextEvent function may allocate
processing time to other applications.

When multiple applications are open, the user chooses one to interact with at any given
time. The active application (or foreground process) is the one currently interacting with
the user. The foreground process displays its menu bar, and its windows are in front of
the windows of all other applications. (The term process refers to an open application or,
in some cases, an open desk accessory.)

There can be only one foreground process at any one time; however, multiple processes
can exist in the background. A background process is a process that is not currently
interacting with the user. The foreground process has first priority for accessing the
CPU. Other processes can access the CPU only when the foreground process yields time
to them.

Introduction to Events
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By using WaitNextEvent to retrieve events, you allow other applications to make use of
processing time that your application would otherwise not use. When your application is
in the background, it in turn can receive processing time when other applications
relinquish the CPU. Using WaitNextEvent also allows users to switch between
multiple open applications.

An application that is in the background can get CPU time but can’t interact with the user
while it is in the background. (However, the user can choose to bring the application to
the foreground—for example, by clicking in one of the application’s windows.) An
application can also post a notification request using the Notification Manager if the
application is in the background and requires the user’s attention. Any application that
has the canBackground flag set in its size (' SIZE ') resource is eligible to obtain access
to the CPU when it is in the background.

At any given time a process is either in the foreground or the background; a process can
switch between the two states at well-defined times.

The Event Manager ensures that switching between applications occurs in a smooth
fashion—by sending your application an event when it is about to be suspended and
sending it an event when it has processing time again and can resume executing. The
Event Manager and Process Manager coordinate this switching and scheduling of
processor time among many applications.

Your application can receive various types of events: low-level events, operating-system
events, and high-level events.

The Event Manager returns low-level events to your application for occurrences such as
the user pressing the mouse button, releasing the mouse button, pressing a key on the
keyboard, or inserting a disk. The Event Manager also returns low-level events to your
application if your application needs to activate (make changes to a window based on
whether it is in front or not) or update (redraw the contents of) one of its windows. When
your application requests an event and there are no other events to report, the Event
Manager returns a null event.

The Event Manager returns operating-system events to your application when the
processing status of your application is about to change or has changed. For example, if
a user brings your application to the foreground, the Process Manager sends an event
through the Event Manager to your application. Some of the work of reactivating your
application is done automatically, both by the Process Manager and by the Window
Manager; your application must take care of any further processing needed as a result of
your application being reactivated.

The Event Manager returns high-level events to your application as a result of
communication directed to your application from another application or process.

Low-level events, except for update events and null events, are always directed to the
foreground process. Operating-system events are also always directed to the foreground
process. High-level events, update events, and null events can be directed to the
foreground process or background processes.
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You can specify which types of events you want your application to receive. You do this
by specifying an event mask as a parameter to various Event Manager routines. An event
mask allows you to mask out the events you are not interested in receiving. For example,
you can accept all events except high-level events.

Events can originate from a number of different sources: the Operating System Event
Manager, Window Manager, Process Manager, and PPC Toolbox. Figure 2-1 shows the
relationships between the Toolbox Event Manager, other parts of the system software,
and your application.

2-6

Figure 2-1 Sources of events sent to your application
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The Operating System Event Manager creates and maintains a queue referred to as the
Operating System event queue. The Operating System Event Manager detects and
reports low-level hardware-related events such as mouse clicks, keypresses, and disk
insertions. The Operating System Event Manager places these events in the Operating
System event queue. The Toolbox Event Manager retrieves events from this event queue
and returns events, one at a time at your application’s request, to your application.
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A maximum of 20 events can be pending in the Operating System event queue. If the
Operating System event queue becomes full, the Operating System Event Manager
begins to discard old events to make room for new ones as events are posted. The
Operating System Event Manager always discards the oldest event in the queue when
it must discard an event. However, this is not a common occurrence; your application
typically processes events much faster than the user can generate them. The actual
capacity of the event queue is determined by system startup information stored on

the startup volume; see the chapter “File Manager” in Inside Macintosh: Files for system
startup information.

The Event Manager can also report events from the Window Manager and Process
Manager. If a window needs to be updated, activated, or deactivated, the

Window Manager directs an event to the Toolbox Event Manager. Similarly, the
Process Manager directs an event to the Toolbox Event Manager if the processing
status of your application changes. The Toolbox Event Manager reports these events
to your application.

Note

On computers running System 6, MultiFinder provides some of
the capabilities supplied by the Process Manager in System 7. On
computers running System 6 without MultiFinder, only a single-
application environment is supported.

Your application can use the Event Manager to send and receive high-level events. To
transmit high-level events between applications, the Event Manager uses the PPC
Toolbox on behalf of your application. For each open application capable of receiving
high-level events, the Event Manager maintains a separate queue, referred to as the
application’s high-level event queue, to store high-level events. The size of an
application’s high-level event queue is limited only by the amount of available memory.

Your application’s event stream consists of those events that are available to your
application for retrieval when it makes a request for an event. For example, when your
application is in the background, its event stream can contain only update events, null
events, and high-level events.

When your application asks the Event Manager for the next event, the Event Manager
returns the next available event according to its priority. In general, the Event Manager
returns events in this order of priority:

1. low-level events
2. operating-system events
3. high-level events

The next sections describe low-level events, operating-system events, and high-level
events in greater detail.
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Low-Level Events

The Event Manager uses low-level events to report very low-level hardware and
software occurrences. Low-level events report

m actions by the user (such as pressing the mouse button, typing on the keyboard, or
inserting a disk)

m changes in windows on the screen
m that the Event Manager has no other events to report

Low-level events that report actions by the user include mouse-down, mouse-up,
key-down, key-up, auto-key, and disk-inserted events. The Event Manager reports any of
these events when the user performs the action associated with each event.

Mouse-down and mouse-up events report that the user pressed or released the mouse
button. For these events the Event Manager returns the location of the cursor at the time
the mouse button was pressed or released. Key-down and key-up events report that the
user pressed or released a key. Auto-key events report that the user has held a key down
for a certain amount of time. For keyboard-related events, the Event Manager reports
which key was pressed. For mouse-related and keyboard-related events, the Event
Manager also reports the state of the modifier keys (the Option, Command, Caps Lock,
Control, and Shift keys) at the time of the event.

When the user inserts a disk, the Operating System attempts to mount the volume on the
disk by calling the File Manager function PBMountVol. The Operating System Event
Manager then generates a disk-inserted event. If the user is interacting with a standard
file dialog box, the Standard File Package intercepts the disk-inserted event and handles
it. Otherwise, the event is left in the event queue for your application to retrieve. In most
cases your application can handle unexpected disk-inserted events by simply checking to
see if the volume was successfully mounted.

Update events and activate events are two types of low-level events that the Event
Manager can report as a result of changes in the appearance of windows on the screen.
For example, if a user is working with several open documents belonging to your
application, you can allow the user to switch from one document to another when the
user clicks in the appropriate window. You can determine whether the user clicked in
another window by using the Window Manager function FindWindow; if the user
clicked in another window, you can then use the Window Manager procedure
SelectWindow to generate the necessary activate events. Before the Event Manager
sends your application any activate events relating to this occurrence, the Window
Manager does some work for you, such as unhighlighting the deactivated window and
highlighting the newly activated window. At your application’s next request for an event,
the Event Manager returns an activate event.

An activate event indicates the window involved and whether the window is becoming
activated or deactivated. Your application should perform any other necessary actions to
complete the transformation of the window from active to inactive or vice versa. For
example, when a window becomes active, your application should show any scroll bars
and restore any selections.
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Your application typically receives an activate event for the window being deactivated,
followed by an activate event for the window becoming active at your application’s next
request for an event.

Note

If the user switches between your application and another application
(by clicking in the window of another application, for example), your
application is responsible for activating or deactivating any windows

as appropriate. Your application is notified of this occurrence

through operating-system events. If your application has the
acceptSuspendResumeEvents and doesActivateOnFGSwitch
flags set in its ' SIZE' resource, your application is notified of the switch
through an operating-system event and does not receive a separate
activate event when the user switches between applications.

The Window Manager generates update events to control the appearance of windows on
the screen. The Window Manager keeps track of the front-to-back ordering of windows
and allows windows to overlap other windows. The Window Manager coordinates the
display of windows. When one window covers another window and then the user moves
the first window, the Window Manager generates an update event so that the contents of
the newly exposed area can be updated. The Event Manager reports update events as
needed to the applications whose windows need updating. Unlike other low-level
events, update events can be directed to the foreground process or background processes.

Activate and update events generated by the Window Manager are not placed into the
Operating System event queue but are sent directly to the Event Manager.

The Event Manager reports a null event when your application requests an event and
your application’s event stream does not contain any of the requested event types. By
using the WaitNextEvent function, you can yield time to other processes when null
events are the only pending events for your application.

When your application receives a null event, your application can do idle processing
(such as blinking the caret) if it is in the foreground or do other tasks if it is in the
background. If you want your application to receive null events when it is in the
background, you must set the canBackground flag in your application’s ' SIZE'
resource. If your application does not perform any processing in response to null events
when it is in the background, then set the cannotBackground flag. If you set the
cannotBackground flag, the Event Manager does not report null events to your
application when it is in the background. However, the Event Manager still reports
update events (and high-level events if the isHighLevelEventAware flag is set in the
'SIZE' resource) to your application when it is in the background regardless of how the
background flag is set.

Figure 2-2 shows the various kinds of low-level events your application can receive. See
“Handling Low-Level Events” beginning on page 2-32 for complete details of how your
application should respond to low-level events.
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Figure 2-2 Low-level events
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Operating-System Events

The cooperative, multitasking environment allows the user to interact with your
application and with other applications. The Process Manager coordinates the scheduling
of applications, and the Event Manager communicates information about changes in the
operating status of applications to the applications involved.

For example, when your application is about to be switched into the background, the
Event Manager sends it a suspend event. Then, when your application is switched back
into the foreground, it receives a resume event. These types of events, as well as a special
type of mouse event, the mouse-moved event, are known as operating-system events.

Figure 2-3 illustrates how the Event Manager helps provide this cooperative,
multitasking environment. The Process Manager generates suspend, resume, and
mouse-moved events, and the Event Manager reports these events to applications.
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Figure 2-3 Operating-system events
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Note

If your application sets the accept SuspendResumeEvents and
doesActivateOnFGSwitch flags inits ' SIZE' resource, your
application is also responsible for activating or deactivating any
windows as appropriate in response to operating-system events. For
maximum compatibility, your application should set these flags and
handle suspend and resume events. See “The Size Resource” beginning
on page 2-115 for more information on these and other flags in the
'SIZE' resource. ¢

When your application receives a suspend event, it does not actually switch to the
background until it makes its next request to receive events from the Event Manager. At
the time that it receives the suspend event, your application should convert any private
scrap into the global scrap if necessary. Your application should hide scroll bars, remove
the highlighting from any selections, and hide any floating windows. If your application
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shows a window that displays the Clipboard contents, you should hide this window also.
Then you should call WaitNextEvent to relinquish the CPU and allow the Operating
System to schedule other processes for execution. It is important to minimize the
processing you do in response to a suspend event so that the computer appears
responsive to the user.

When control returns to your application, the first event it receives is a resume event.
Your application should convert the global scrap back to its private scrap, if necessary.
Your application should also restore any windows to the state the user left them in at the
time of the previous suspend event. For example, your application should show any
scroll bars, highlight any selections, and show any floating windows. See “Responding to
Suspend and Resume Events” beginning on page 2-60 for complete details of how your
application should respond to these events.

The events that your application can receive in the background are update, null, and
high-level events. When your application is in the background, it should not perform any
processing that would make the foreground process appear unresponsive to the user.
When receiving events in the background, your application should perform any needed
action in response to an event and then quickly return.

Your application should never interact with the user when it is in the background. If you
need to notify the user of some special occurrence while your application is executing

in the background, you should use the Notification Manager to queue a notification
request. You should not attempt to display an alert box while your application is in the
background. Instead, your application can specify that the Notification Manager play

a sound, display an alert box, cause a small icon representing your application to

blink in alternation with the Application menu icon, display a diamond next to your
application’s name in the Application menu, or put a combination of these actions

into effect.

These actions are designed to alert the user that another application needs the user’s
attention. By using the Notification Manager you help maintain the user interface
principle of giving the user control, as the user can choose to bring the application
requesting attention to the foreground at the user’s convenience. See the chapter
“Notification Manager” in Inside Macintosh: Processes for examples of how to post
notification requests.

Another kind of operating-system event is the mouse-moved event. You can request that
the Event Manager send your application a mouse-moved event whenever the cursor

is outside of a region that you specify to the WaitNextEvent function. For example, you
can use mouse-moved events as a convenient way for your application to change the
appearance of the cursor as the user moves the cursor from the text area of a document to
the scroll bar. See “Responding to Mouse-Moved Events” beginning on page 2-62 for
detailed examples.
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High-Level Events

The Event Manager provides routines that let applications communicate with each other
by exchanging high-level events. A high-level event is an event that your application can
send to another application to give it some information, to receive some information from
it, or to have it perform some action.

For example, your application can send a high-level event to another application
instructing that application to perform a specific action, such as adding a row to a
spreadsheet or changing the font size of a paragraph. Your application can also send a
high-level event to another application requesting information from that application—for
example, requesting a dictionary application to return the definition of a particular word.
When you send a high-level event to another application, you can also include additional
information or commands in an optional data buffer. For example, your application can
use a high-level event to send a list of new words and definitions to a dictionary
application.

Note
High-level events are available only in system software
version 7.0 or later. &

Figure 2-4 on the next page shows three different applications communicating with each
other by sending and receiving high-level events. The Event Manager uses the PPC
Toolbox to transmit high-level events. The Event Manager maintains a high-level event
queue for each application that has identified itself as capable of receiving high-level
events. The high-level event queues are limited in size only by available memory.

For effective communication between applications, your application must define the set
of high-level events it responds to and let other applications know the events it accepts.
By implementing the capabilities to send events to and receive events from other
applications, you allow other applications to interact with your application and provide
enhanced capabilities to your users.

Generally, there is no restriction on the type of processing that one application can
request from another by sending it a high-level event. For a high-level event sent by one
application to be understood by another application, however, the sender and receiver
must agree on a protocol, that is, on the way the event is to be interpreted. Apple events
are high-level events whose structure and interpretation are determined by the Apple
Event Interprocess Messaging Protocol (AEIMP).

Your application should support the required Apple events, as described in Inside
Macintosh: Interapplication Communication. The Finder uses the required Apple events to
provide your application with information when it is opened and to give it the names of
documents to open or print when the user opens or prints documents from the Finder.
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Figure 2-4 High-level events
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In addition, you may want your application to support other common Apple events.
For example, the Edition Manager uses Apple events to communicate information
about document sections among the various applications that may publish sections

or subscribe to them. The Edition Manager sends the appropriate Apple events

to applications that want to maintain up-to-date subscriber sections within their
documents. If a user alters a section of a document that has previously been published
and updates the edition, the Edition Manager might post an Apple event to the
application indicating that a new edition is available. The application receiving the Apple
event can then update the subscriber or ignore the information, as the user dictates. For
complete information on responding to Apple events sent by the Edition Manager, see
the chapter “Edition Manager” in Inside Macintosh: Interapplication Communication.
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To ensure compatibility and smooth interaction with other Macintosh applications,
you should use the Apple event protocol for high-level events whenever possible.
You should define new protocols only if your application must communicate with
applications on other computers that use different protocols or if your application
has other special needs. For complete information about Apple events and about
implementing the required set of Apple events, see Inside Macintosh: Interapplication
Communication.

Note

All Macintosh system software that sends or receives high-level events
uses the Apple events protocol. ¢

Priority of Events

Each type of event has a certain priority. The Event Manager returns events in this order
of priority:
1. activate events

2. mouse-down, mouse-up, key-down, key-up, and disk-inserted events in FIFO (first-in,
first-out) order

3. auto-key events

4. update events (in front-to-back order of windows)

5. operating-system events (suspend, resume, mouse-moved)
6. high-level events

7. null events

Several of the Event Manager routines can be restricted to operate on one or more specific
types of events. You do this by disabling (or “masking out”) the events you are not
interested in receiving. See “Setting the Event Mask” beginning on page 2-26 for details
about specifying the types of events you wish to receive.

Switching Contexts

Processes running in the background receive processing time when the foreground
process makes an event call (that is, calls WaitNextEvent or EventAvail) and there
are no events pending for that foreground process. A process running in the background
should relinquish the CPU regularly to ensure a timely return to the foreground process
when necessary.

In System 7 (or with MultiFinder in earlier versions), the available processing time is
distributed among multiple processes through a procedure known as context switching (or
just switching). All switching occurs at a well-defined time, namely, when an application
calls WaitNextEvent. When a context switch occurs, the Process Manager allocates
processing time to a process other than the one that had been receiving processing time.
Two types of context switching may occur: major and minor.
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A major switch is a complete context switch: an application’s windows are moved from
the back to the front, or vice versa. In a major switch, two applications are involved, the
one being switched to the foreground and the one being switched to the background. The
Process Manager switches the A5 worlds of both applications, as well as the relevant
low-memory environments. If those applications receive suspend and resume events,
they are so notified at the time that a major switch occurs.

A minor switch occurs when the Process Manager gives time to a background process
without bringing the background process to the front. The two processes involved in a
minor switch can be two background processes or a foreground process and a
background process. As in a major switch, the Process Manager switches the A5 worlds
and the low-memory environments of the two processes. However, the order of windows
is not switched, and neither process receives either suspend or resume events.

When the frontmost window is an alert box or a modal dialog box, major switching does
not occur, although minor switching can. To determine whether major switching can
occur, the Operating System checks (among other things) to see if the window definition
procedure of the frontmost window is dBoxProc, because the type dBoxProc is
specifically reserved for alert boxes and modal dialog boxes. (If the frontmost window is
a movable modal dialog box, major switching can still occur.)

Note

Your application can also get switched out if it calls a system software
routine that makes an event call. For example, when your application
calls ModalDialog, a minor switch can occur. ¢

Your application can receive processing time and perform tasks in the background,
but your application should not interact with the user or perform tasks that would slow
down the responsiveness of the foreground process.

Your application indicates scheduling options to the Operating System, such as whether
the application can use null-event processing time when in the background, whether it
can accept suspend and resume events, and so forth, by setting flags in its size (' SIZE")
resource. Every application executing in System 7, as well as every application executing
in System 6 with MultiFinder, should contain a ' SIZE' resource. See “Creating a Size
Resource” beginning on page 2-30 for details on how to specify this information.

About the Event Manager
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The Toolbox Event Manager provides routines that communicate information about
actions performed by the user and give notice of changes in the processing status of your
application. The Event Manager also provides routines that your application can use to
communicate with other applications. You can control the scheduling of your application
for execution by using the Event Manager.
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The rest of this chapter explains
m how to structure your main event loop to receive and process events

m how tocreate a ' SIZE' resource to specify your application’s memory requirements
and scheduling options

m how to respond to most types of events
m how to receive and process high-level events

m how to send high-level events to other applications

Using the Event Manager

You can use the Event Manager to receive information about hardware-related events,
about changes in the appearance of your application’s windows, or about changes in
the operating status of your application. You can also use the Event Manager to
communicate directly with other applications. This communication can include sending
events to other applications, receiving events from other applications, and searching for
specific events from other applications.

Your application can both send and receive high-level events, but it generally only
receives low-level events and should not send them. Your application receives low-level
events, operating-system events, and high-level events in the same way, which is by
asking the Event Manager for the next available event. If the event your application
receives is a high-level event, your application might need to use another Event Manager
or Apple Event Manager routine to retrieve an optional data buffer and additional
information accompanying that event.

Before using the Event Manager, you can use the Gestalt function to determine if
certain features of the Event Manager are available. See the chapter “Gestalt Manager” in
Inside Macintosh: Operating System Ultilities for information on the Gestalt function.

If your application sends or receives high-level events, you should use the Gestalt
function with the gestaltPPCToolboxAttr selector to determine whether the PPC
Toolbox is present. Use the Gestalt function with the gestaltOSAttr selector to see if
the Process Manager is available. If the PPC Toolbox and the Process Manager are
present, then the system software provides support for high-level events.

If your application sends or receives Apple events, use the Gestalt function with the
gestaltAppleEventsAttr selector to determine whether the Apple Event Manager
is available.

Your application needs to initialize QuickDraw, the Font Manager, and the Window
Manager before using the Event Manager. Your application can accomplish this
initialization by using the InitGraf, InitFonts, and InitWindows procedures.
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When your application starts, you can call the FlushEvents procedure to empty

the Operating System event queue of any low-level events left unprocessed by
another application. For example, you might want to remove any mouse-down

events or keyboard events that the user might have entered while the Finder launched
your application.

This section shows how to retrieve events from the Event Manager, how to mask out
unwanted events, how to specify memory and scheduling options for your application,
and how to handle each type of event received from the Event Manager.

Obtaining Information About Events

You get information about events through the event record. The EventRecord data type
defines the event record and has this structure:

TYPE EventRecord =

RECORD
what : Integer; {event code}
message: LongInt; {event message}
when: LongInt; {ticks since startup}
where: Point; {mouse location}
modifiers: Integer; {modifier flags}

END;

Field descriptions
what The what field indicates the type of event received. The type of
event can be identified by these constants:

CONST
nullEvent = 0; {no other pending events}
mouseDown = 1; {mouse button pressed}
mouseUp = 2; {mouse button released}
keyDown = 3; {key pressed}
keyUp = 4; {key released}
autoKey = 5; {key repeatedly held down}
updateEvt = 6; {window needs updating}
diskEvt = 7; {disk inserted}
activateEvt = 8; {activate/deactivate window}
osEvt = 15; {operating-system event-- |}
{ resume, suspend, or }
{ mouse-moved}
kHighLevelEvent = 23;{high-level event}
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message

when

where

The message field contains additional information associated with
the event. The interpretation of this information depends on the
event type. The contents of the message field for each event type
are summarized here:

Event type Event message

null, mouse-up, Undefined.

mouse-down

key-up, key-down, Character code and virtual key code in
auto-key low-order word. For Apple Desktop Bus

(ADB) keyboards, the low byte of the
high-order word contains the ADB address
of the keyboard where the keyboard event
occurred. The high byte of the high-order
word is reserved.

update, activate Pointer to the window to update, activate, or
deactivate.
disk-inserted Drive number in low-order word, File

Manager result code in high-order word.

resume The suspendResumeMessage constant in
bits 24-31 and a 1 in bit 0 to indicate the
event is a resume event. Bit 1 contains either
a1 or a0 to indicate if Clipboard conversion
is required, and bits 2-23 are reserved.

suspend The suspendResumeMessage constant in
bits 24-31 and a 0 in bit 0 to indicate the
event is a suspend event. Bit 1 is undefined,
and bits 2-23 are reserved.

mouse-moved The mouseMovedMessage constant in bits
24-31. Bits 2-23 are reserved, and bit 0 and
bit 1 are undefined.

high-level Class of events to which the high-level event
belongs. The message and where fields of
a high-level event define the specific type of
high-level event received.

The when field indicates the time when the event was posted (in
ticks since system startup). When needed, you can use the when
field to compare how much time has elapsed between successive
mouse events.

For low-level events and operating-system events, the where field
contains the location of the cursor at the time the event was posted
(in global coordinates).

For high-level events, the where field contains a second event
specifier, the event ID. The event ID defines the particular type of
event within the class of events defined by the message field of the
high-level event. For high-level events, you should interpret the
where field as having the data type OSType, not Point.
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modifiers The modifiers field contains information about the state of the
modifier keys and the mouse button at the time the event was
posted. For activate events, this field also indicates whether the
window should be activated or deactivated. In System 7 it also
indicates whether a mouse-down event caused your application to
switch to the foreground.

Each of the modifier keys is represented by a specific bit in the modifiers field of the
event record. Figure 2-5 shows how to interpret the modifiers field. You can examine
the modifiers field of the event record to determine which, if any, of the modifier keys
were pressed at the time of the event. The modifier keys include the Option, Command,
Caps Lock, Control, and Shift keys. If your application attaches special meaning to any of
these keys in combination with other keys or when the mouse button is down, you can
test the state of the modifiers field to determine the action your application should
take. For example, you can use this information to determine whether the user pressed
the Command key and another key at the same time to make a menu selection.

Figure 2-5 The modifiers field of the event record

- a4 a4 a4 a4 a4 a a4

* Reserved for future use

if right Control key down, 0O if not J

if right Option key down, 0 if not
if right Shift key down, 0 if not
if Control key down, 0 if not
if Option key down, 0 if not
if Caps Lock key down, O if not
if Shift key down, 0 if not
if Command key down, 0 if not
if mouse button up, 0 if not

if window being deactivated or if mouse-down event caused a foreground switch, 0 if deactivated

Bits 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
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Bit 0 in the modifiers field gives additional information that is valid only if the event is
an activate event or a mouse-down event.

For activate events, the value of bit 0 is 1 if the window pointed to by the event message
should be activated, and the value is 0 if the window should be deactivated.

For mouse-down events in System 7, bit 0 indicates whether a mouse-down event caused
your application to switch to the foreground. If so, bit 0 contains 1; otherwise,
it contains 0.
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You can also use these constants as masks to test the setting of various bits in the
modifiers field:

CONST activeFlag 1; {set if window being activated or if }

{ mouse-down event caused fgnd switch}

btnState = 128; {set if mouse button up}
cmdKey = 256; {set if Command key down}
shiftKey = 512; {set if Shift key down}
alphalock = 1024; {set if Caps Lock key down}
optionKey = 2048; {set if Option key down}
controlKey = 4096; {set if Control key down}

Note that the bit giving information about the mouse button is set if the mouse button is
up. The bits for the modifier keys are set if the corresponding key is down.

Some keyboards do not distinguish between the right or left Control, Shift, and Option
keys; for example, the virtual key code for the right Shift key and left Shift key might be
the same. For these keyboards, if the user presses the Control, Shift, or Option key, the
Event Manager sets only the bits corresponding to the shiftKey, optionKey, and
controlKey constants. For keyboards that do distinguish between these keys, the Event
Manager sets the bits in the modifiers field to indicate whether the right or left Control,
Shift, or Option keys were pressed. For example, the Event Manager sets bit 13 in the
modifiers field if the user presses the right Shift key and sets bit 9 if the user presses
the left Shift key. In most cases your application should not need to distinguish between
the left and right Control, Shift, and Option keys.

Processing Events

Applications receive events one at a time by asking the Event Manager for the next
available event. You use Event Manager routines to receive (or in the case of
EventAvail, simply to look at) the next available event that is pending for your
application. You supply an event record as a parameter to the Event Manager routines
that retrieve events. The Event Manager fills out the event record with the relevant
information about that event and returns it to your application.

Your application can use the WaitNextEvent function to retrieve events from the Event
Manager. If no events are pending for your application, the WaitNextEvent function
may allocate processing time to other applications. If an event is pending for your
application, the WaitNextEvent function returns the next available event of a specified
type and removes the returned event from your application’s event stream.

The EventAvail function gets the next available event of a specified type and returns it
to your application, but does not remove the event from your application’s event stream.
EventAvail thus allows your application to look at an event in the event stream
without actually processing the event.
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Note

You can also use the GetNextEvent function to retrieve and remove an
event; however, you should use WaitNextEvent to provide greater
support for multitasking. &

Using the WaitNextEvent Function

Your application typically calls WaitNextEvent repeatedly. The next section, “Writing
an Event Loop,” shows how to use WaitNextEvent with other routines to process
events. This discussion focuses on the WaitNextEvent function itself.

The WaitNextEvent function requires four parameters:
m an event mask (eventMask)

m an event record (theEvent)

m asleep value (sleep)

m a mouse region (mouseRgn)

When WaitNextEvent returns, the event record contains information about the
retrieved event, if any.

The eventMask parameter specifies the events you are interested in receiving.
WaitNextEvent returns events one at a time, in order of priority and at your
application’s request, according to the value you specify in the eventMask parameter. If
your application specifies that it doesn’t want to receive particular types of events, those
events are not returned to your application when it makes a request for an event.
However, those events are not removed from the event stream. (To remove events from
the Operating System event queue, you can use the FlushEvents procedure with a
mask specifying only those events you wish to remove from the queue.) See “Setting the
Event Mask” beginning on page 2-26 for examples of how to use constants to set the
value of the eventMask parameter.

The sleep parameter specifies the amount of time (in ticks) for which your application
agrees to relinquish the processor if no events are pending for it. When that time expires
or when an event becomes available for your application, the Process Manager schedules
your application for execution. In general, you should specify a value greater than 0 in
the sleep parameter so that other applications can receive processing time if they need
it. If the user is editing text and your application needs to blink the caret at periodic
intervals or uses TextEdit to blink the caret, your application should not specify a value
greater than the value returned by the Get CaretTime function.

In the mouseRgn parameter you specify a screen region inside of which the Event
Manager does not generate mouse-moved events. You should specify the region in
global coordinates. If the user moves the cursor outside of this region and your
application is the foreground process, the Event Manager reports mouse-moved events.
Your application should recalculate the mouseRgn parameter when it receives a
mouse-moved event; otherwise it will continue to receive mouse-moved events as long as
the cursor is outside of the original region. If you pass an empty region or a NIL region
handle, the Event Manager does not return mouse-moved events. You can use the
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mouseRgn parameter as a convenient way to change the shape of the cursor—for
example, when the user moves the cursor from the content area of a window to the scroll
bar. See “Responding to Mouse-Moved Events” beginning on page 2-62 for information
on how to set and change the mouseRgn parameter.

Listing 2-1 shows an example of using the WaitNextEvent function.

Listing 2-1 Using the WaitNextEvent function
VAR
eventMask: Integer;
event: EventRecord;
cursorRgn: RgnHandle;
mySleep: LongInt;
gotEvent: Boolean;
eventMask := everyEvent; {accept all events}
mySleep := MyGetSleep; {set an appropriate sleep value}
cursorRgn := MyGetRgn; {set the region as appropriate}
gotEvent := WaitNextEvent (eventMask, event,mySleep, cursorRgn) ;

The code in Listing 2-1 specifies that WaitNextEvent should return the next pending
event of any kind, give up the processor if no events are pending, and return a
mouse-moved event if the user moves the cursor out of the specified region.

The WaitNextEvent function returns after retrieving an event or after the time specified
in the sleep parameter has expired. If there are no events of the types specified by the
eventMask parameter (other than null events) pending for your application, and the
time specified in the sleep parameter has not expired, WaitNextEvent may allocate
processing time to background processes. Once an

event for your application occurs or the time specified in the s1leep parameter

expires, your application receives processing time again.

WaitNextEvent returns a function result of TRUE if it has retrieved any event other than
a null event. If there are no events of the types specified by the eventMask parameter
(other than null events) pending for the application, WaitNextEvent

returns FALSE.

Before returning an event to your application, WaitNextEvent performs other
processing and may intercept the event. The WaitNextEvent function:

m Calls the Operating System Event Manager function SystemEvent to determine
whether the event should be handled by your application or the Operating System.
For example, if the event is a Command-Shift-number key sequence, the Event
Manager intercepts the event and calls the corresponding 'FKEY' resource to perform
the associated action.

m Makes the alarm go off if the alarm is set and the current time is the alarm time. The
user sets the alarm using the Alarm Clock desk accessory.
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m Calls the SystemTask procedure, which gives time to each open desk accessory or
device driver to perform any periodic action defined for it. A desk accessory or device
driver specifies how often the periodic action should occur, and SystemTask gives
time to the desk accessory or device driver at the appropriate interval.

In System 7, the WaitNextEvent function reports a suspend event to your
application when

m your application is in the foreground and the user opens a desk accessory or other
item from the Apple menu,

m the user clicks in the window belonging to a desk accessory or another application, or
m the user chooses another process from the Application menu.

After your application is switched out, the Event Manager directs events (other than
events your application can receive in the background) to the newly activated process
until the user switches back to your application or another application.

Writing an Event Loop

In applications that are event-driven (that is, applications that decide what to do at any
time by receiving and responding to events), you can obtain information about pending
events by calling Event Manager routines. Since you call these routines repeatedly, the
section of code in which you request events from the Event Manager usually takes the
form of a loop; this section of code is called the event loop.

Listing 2-2 shows a simple event loop (an application-defined procedure called
MyEventLoop) for an application running in System 7.

Listing 2-2 An event loop

PROCEDURE MyEventLoop;

VAR
cursorRgn: RgnHandle;
gotEvent: Boolean;
event: EventRecord;
BEGIN
cursorRgn := NewRgn; {pass an empty region the first time thru}
REPEAT
gotEvent := WaitNextEvent (everyEvent, event, MyGetSleep,
cursorRgn) ;
IF (event.what <> kHighLevelEvent) AND (NOT gInBackground)
THEN MyAdjustCursor (event.where, cursorRgn) ;
IF gotEvent THEN {the event isn’t a null event, }
DoEvent (event) { so handle it}
ELSE {no event (other than null) to handle }
DoIdle (event); { right now, so do idle processing}
UNTIL gDone; {loop until user quits}
END;
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The MyEventLoop procedure repeatedly uses WaitNextEvent to retrieve events. The
WaitNextEvent function returns a Boolean value of FALSE if there are no events of the
specified types other than null events pending for the application. WaitNextEvent
returns TRUE if it has retrieved any event other than a null event.

After WaitNextEvent returns, the MyEventLoop procedure first calls an application-
defined routine, MyAdjustCursor, to adjust the cursor as necessary. You usually adjust
the cursor in response to mouse-moved events, and often in response to other events as
well. This code adjusts the cursor once every time through the event loop, when the
application receives any event other than a high-level event. The code does not adjust the
cursor if the event is a high-level event, because the where field of a high-level event
contains the event ID, not the location of the cursor. The code also does not adjust the
cursor if this application is in the background, as the foreground process is responsible
for setting the appearance of the cursor.

If waitNextEvent retrieved any event other than a null event, the event loop calls
DoEvent, an application-defined procedure, to process the event. Otherwise, the
procedure calls an application-defined idling procedure, DoIdle.

Note

If your application uses modeless dialog boxes, you need to
appropriately handle events in them. You can choose to handle events for
modeless dialog boxes using the same routines that you use to handle
events in other windows; this is the approach used throughout this
chapter. Alternatively, you can choose to call the IsDialogEvent
function in your event loop. See “Handling Events in a Dialog Box” on
page 2-29 for information on handling events in alert boxes, modal
dialog boxes, movable modal dialog boxes, and modeless dialog boxes.
For additional information on dialog boxes, see the chapter “Dialog
Manager” in this book. &

If you intend to design your application to run in either a single-application environ-
ment (such as System 6 without MultiFinder) or a multiple-application environment,
the very beginning of your event loop should test to make sure the WaitNextEvent
function is available. If WaitNextEvent is not available, your code should use
GetNextEvent to retrieve events. If your code uses GetNextEvent, it should also
call SystemTask to allow desk accessories to perform periodic actions. However,
your code should always use WaitNextEvent if it is available, rather than
GetNextEvent. If your application calls WaitNextEvent, it should not call the
SystemTask procedure.

The event loop shown in Listing 2-2 calls an application-defined procedure, DoEvent, to
determine what kind of event the call to WaitNextEvent retrieved. Listing 2-3 defines a
simple DoEvent procedure. The DoEvent procedure examines the value of the what
field of the event record to determine the type of event received and then calls an
appropriate application-defined routine to further process the event.
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Listing 2-3 Processing events

2-26

PROCEDURE DoEvent (event: EventRecord) ;

VAR
window: WindowPtr;
activate: Boolean;
BEGIN
CASE event.what OF

mouseDown :

DoMouseDown (event) ;
mouseUp:

DoMouseUp (event) ;
keyDown, autoKey:

DoKeyDown (event) ;

activateEvt:
BEGIN
window := WindowPtr (event.message) ;
activate := BAnd(event.modifiers, activeFlag) <> 0;

DoActivate (window, activate, event) ;

END;

updateEvt:
DoUpdate (WindowPtr (event .message) ) ;

diskEvt:
DoDiskEvent (event) ;

osEvt:
DoOSEvent (event) ;

kHighLevelEvent:
DoHighLevelEvent (event) ;

END; {of case}
END;

The next sections describe how to set the event mask, handle events in dialog boxes,
and create your application’s ' SIZE' resource. Following sections show code that can
handle each kind of event.

Setting the Event Mask

Several of the Event Manager routines can be restricted to operate on a specific event
type or group of types. You do this by specifying the event types you want your
application to receive, thereby disabling (or “masking out”) the events you are not
interested in receiving. To specify which event types an Event Manager routine governs,
you supply a parameter known as an event mask.

The event mask is an integer with one bit position for each event type. If the bit
representing a particular event type is set, then the Event Manager returns events of
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that type. If the bit is set to 0, the Event Manager does not return events of that type. To
accept all types of events, set every bit of the event mask to 1. You can do this using the
constant everyEvent.

CONST everyEvent = -1; {every event}

Figure 2-6 shows the bits corresponding to each event type in the event mask.

Figure 2-6 The event mask

Bits 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
* * * * * *

Operating system event

High-level event

Activate event

Disk-inserted event

Update event

Auto-key event

Key-up event

Key-down event

Mouse-up event

Mouse-down event

* Reserved for future use

You can use these constants when referring to the bits in the event mask that correspond
to each individual event type:

CONST mDownMask = 2; {mouse-down event (bit 1)}
mUpMask = 4; {mouse-up event (bit 2)}
keyDownMask = 8; {key-down event (bit 3)}
keyUpMask = 1s6; {key-up event (bit 4)}
autoKeyMask = 32; {auto-key event (bit 5)}
updateMask = 64; {update event (bit 6)}
diskMask = 128; {disk-inserted event (bit 7)}
activMask = 256; {activate event (bit 8)}
highlLevelEventMask = 1024; {high-level event (bit 10)}
osMask = -32768; {operating-system event (bit 15)}
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You can select any subset of events by adding or subtracting these constants. For
example, you can use this code to accept only high-level events and mouse-down events
and mask out all other events:

myErr := WaitNextEvent (highLevelEventMask + mDownMask, myEvent,
mySleep, myMRgnHnd) ;

The everyEvent constant indicates that you wish to receive every type of event. To
accept all events except mouse-up events, you can use the code:

myErr := WaitNextEvent (everyEvent - mUpMask, myEvent, mySleep,
myMRgnHnd) ;

Masking out specific types of events does not remove those events from the event stream.
If a type of event is masked out, the Event Manager simply ignores it when reporting
events from the event stream. Note that you cannot mask out null events by setting the
event mask. The Event Manager always returns a null event if no other events are
pending. However, if you do not want the Event Manager to report null events to your
application when it is in the background, you can set the cannotBackground flag in
your application’s ' SIZE' resource.

In most cases you should always use everyEvent as your event mask. The user expects
most applications to respond to keyboard, mouse, update, and other events.

The types of events returned to your application are also affected by the system event
mask. The Event Manager maintains a system event mask for each application. The
system event mask controls which low-level event types get posted in the Operating
System event queue. The Event Manager uses the system event mask of the current
process (the process that is currently executing and the process associated with the
CurrentAS global variable) when determining which low-level events to post in the
Operating System event queue. The system event mask is an integer with 1 bit for

each corresponding low-level event type. These constants refer to the bits that represent
the corresponding low-level event types in the system event mask:

CONST mDownMask = 2; {mouse-down (bit 1)}
mUpMask = 4; {mouse-up (bit 2)}
keyDownMask = 8; {key-down (bit 3)}
keyUpMask = 16; {key-up (bit 4)}
autoKeyMask = 32; {auto-key (bit 5)}
diskMask = 128; {disk-inserted (bit 7)}

When a low-level event (other than an update or activate event) occurs, the Operating
System Event Manager posts the low-level event in the Operating System event queue
only if the bit corresponding to the low-level event type is set in the system event mask of
the current process. When your application starts, the Operating System initializes the
system event mask of your application to post mouse-up, mouse-down, key-down,
auto-key, and disk-inserted events in the Operating System event queue. Thus, the
system event mask has this initial setting:

systemEventMask := everyEvent - keyUpMask;
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Your application should not change the system event mask except to enable key-up
events if your application needs to respond to key-up events. (Most applications ignore
key-up events.) If your application needs to receive key-up events, you can change the
system event mask using the Operating System Event Manager procedure
SetEventMask. Note that your application cannot rely on receiving key-up events when
it is not the current process. For example, if your application is the foreground (and
current) process and a minor switch occurs, the Event Manager uses the system event
mask of the background process (now the current process) when posting low-level event
types. When your application becomes the current process again, the Event Manager uses
the system event mask of your application when posting low-level events.

Handling Events in a Dialog Box

If your application uses alert boxes, modal dialog boxes, movable modal dialog boxes,
or modeless dialog boxes, you need to make sure your application handles events for
them appropriately.

To display and handle events in alert boxes, you use the Dialog Manager functions
Alert,NoteAlert, CautionAlert, and StopAlert. The Dialog Manager handles all
of the events generated by the user until the user clicks a button (typically the OK or
Cancel button). When the user clicks the OK or Cancel button, the alert box functions
highlight the button that was clicked, close the alert box, and report the user’s selection
to your application. Your application is responsible for performing the appropriate action
associated with that button.

For modal dialog boxes, you can use the Dialog Manager procedure ModalDialog. The
Dialog Manager handles most of the user interaction until the user selects an item. The
ModalDialog procedure then reports that the user selected an enabled item, and your
application is responsible for performing the action associated with that item. Your
application typically calls ModalDialog repeatedly, responding to clicks on enabled
items as reported by ModalDialog, until the user selects OK or Cancel.

For alert boxes and modal dialog boxes, you should also supply an event filter function
as one of the parameters to the alert box functions or ModalDialog procedure. As the
user interacts with the alert or modal dialog box, these functions pass events to your
event filter function before handling each event. Your event filter function can handle any
events not handled by the Dialog Manager or, if necessary, can choose to handle events
normally handled by the Dialog Manager. For more information on filter functions for
alert and dialog boxes, see the chapter “Dialog Manager” in this book.

To handle events in movable modal dialog boxes, you can use the Dialog Manager
functions IsDialogEvent and DialogSelect or you can use other Toolbox routines to
handle events without using the Dialog Manager.

For modeless dialog boxes, you can choose to handle events in them using an approach
similar to the one you use to handle events in other windows; that is, when you receive
an event, you first determine the type of event that occurred and then take the
appropriate action based on the type of window that is in front. If a modeless dialog box
is in front, you can provide code that takes any actions specific to that modeless dialog
box and call the DialogSelect function to handle any events that your code doesn’t
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handle. This is the approach used throughout this chapter. Alternatively, you can choose
to call the IsDialogEvent function in your event loop. If you do this, you can use the
IsDialogEvent function to determine whether the event involves a modeless dialog
box that belongs to your application. If the event involves a modeless dialog box
(including null events) and a modeless dialog box is active, IsDialogEvent returns
TRUE. Otherwise, IsDialogEvent returns FALSE.

If IsDialogEvent returns TRUE, your application can check to see what type of event
occurred and, depending on the type of event, it can choose to handle the event itself.

Regardless of the approach you use, if your application chooses not to handle the event,
it should call DialogSelect. The DialogSelect function handles events for modeless
dialog boxes (including null events). It also blinks the caret in editable text items when
necessary.

For more information on the DialogSelect function and events in dialog boxes, see the
chapter “Dialog Manager” in this book.

Creating a Size Resource

Your application should include a size (' SIZE') resource. You use a ' SIZE' resource to
inform the Operating System about the memory size requirements for your application
so that the Operating System can set up a partition of the appropriate size for your
application. You also use the ' SIZE' resource to indicate certain scheduling options to
the Operating System, such as whether your application can accept suspend and
resume events.

You can also specify additional information in the ' SIZE' resource in System 7,
indicating whether your application is 32-bit clean, whether your application supports
stationery documents, whether your application uses TextEdit’s inline input services,
whether your application wishes to receive notification of the termination of any applica-
tions it has launched, and whether your application wishes to receive high-level events.

A 'SIZE' resource consists of a 16-bit flags field, followed by two 32-bit size fields. The
flags field specifies operating characteristics of your application, and the size fields
indicate the minimum and preferred partition sizes for your application. The minimum
partition size is the actual limit below which your application will not run. The preferred
partition size is the memory size at which your application can run most effectively and
that the Operating System attempts to secure upon launch of your application. If that
amount of memory is unavailable, your application is placed into

the largest contiguous block available, provided that it is larger than the specified
minimum size.

Note

If the amount of available memory is between the minimum and the
preferred sizes, the Finder displays a dialog box asking if the user wants
to run the application using the amount of memory available. If your
application does not have a ' SIZE' resource, it is assigned a default
partition size of 512 KB and the Process Manager uses a default value

of FALSE for all specifications normally defined by constants in the
flags field.
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When you define a ' SIZE' resource, you should give it a resource ID of 1. A user can
modify the preferred size in the Finder’s information window for your application. If the
user does alter the partition size, the Operating System creates a new 'SIZE' resource
having a resource ID of 0. At application launch time, the Process Manager looks for a
'SIZE' resource with ID 0; if this resource is not found, it uses your original ' SIZE"
resource with ID —1. This new 'SIZE' resource is also created when the user modifies

any of the other settings in the resource.

When creating a ' SIZE' resource, you first need to determine the various operating
characteristics of your application. For example, if your application has nothing useful to
do when it is in the background, then you should not set the canBackground flag.
Similarly, if you have not tested your application in an environment that uses all 32 bits
of a handle or pointer for memory addresses, then you should not set the
is32BitCompatible flag.

Listing 2-4 shows the Rez input for a sample 'SIZE' resource. (Rez is a resource
compiler available with the MPW environment.)

Listing 2-4
resource 'SIZE' (-1) {
reserved,

acceptSuspendResumeEvents,

reserved,
canBackground,

doesActivateOnFGSwitch,

backgroundAndForeground,

dontGetFrontClicks,

ignoreAppDiedEvents,
ig32BitCompatible,
isHighLevelEventAware,
localAndRemoteHLEvents,
isStationeryAware,
dontUseTextEditServices,

reserved,
reserved,
reserved,
kPrefSize * 1024,
kMinSize * 1024

Using the Event Manager

The Rez input for a sample ' SIZE' resource

/*reserved*/

/*accepts suspend&resume events*/
/*reserved*/

/*can use background null */

/* events*/

/*activates own windows in */

/* response to 0S events*/
/*application has a user */

/* interfacex/

/*don't return mouse events */

/* in front window on resume*/
/*doesn't want app-died events*/
/*works with 24- or 32-bit addr*/
/*supports high-level events*/
/*also remote high-level events*/
/*can use stationery documents*/
/*can't use inline input */

/* services*/

/*reserved*/

/*reserved*/

/*reserved*/

/*preferred memory size*/

/*minimum memory sizex/
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The 'SIZE' resource specification in Listing 2-4 indicates, among other things, that the
application accepts suspend and resume events, does processing in the background using
null events, activates or deactivates any windows as necessary in response to
operating-system events, can execute in both the foreground and background, and
doesn’t want to receive any mouse event associated with a resume event that was caused
by the user clicking in the application’s front window. It also indicates that the
application doesn’t want to receive Application Died events, can work in 24-bit or 32-bit
addressing mode, does accept high-level events, including both local and network
high-level events, does handle stationery documents, and doesn’t use TextEdit’s inline
input services. In this example, the Rez-input file must define values for the constants
kPrefSize and kMinSize; for example, if kPrefSize is set to 50, the preferred
partition size is 50 KB.

The numbers you specify as your application’s preferred and minimum memory sizes
depend on the particular memory requirements of your application. Your application’s
memory requirements depend on the size of your application’s static heap, dynamic
heap, A5 world, and stack. (See “Introduction to Memory Management” in Inside
Macintosh: Memory for complete details about these areas of your application’s partition.)

The static heap size includes objects that are always present during the execution of your
application—for example, code segments, Toolbox data structures for window records,
and so on.

Dynamic heap requirements come from various objects created on a per-document basis
(which may vary in size proportionally with the document itself) and objects that are
required for specific commands or functions.

The size of the A5 world depends on the amount of global data and the number of
intersegment jumps your application contains.

The stack contains variables, return addresses, and temporary information. The size of
the application stack varies among computers, so you should base your values for the
stack size according to the stack size required on a Macintosh Plus computer (8 KB).
The Process Manager automatically adjusts your requested amount of memory to
compensate for the different stack sizes on different machines. For example, if you
request 512 KB, more stack space (approximately 16 KB) will be allocated on machines
with larger default stack sizes.

Unfortunately, it is difficult to forecast all of these conditions with any great degree of
reliability. You should be able to determine reasonably accurate estimates for the stack
size, static heap size, A5 world, and jump table. In addition, you can use tools such as
MacsBug's heap-exploring commands to help you empirically determine your
application’s dynamic memory requirements.

See “The Size Resource” beginning on page 2-115 for additional information on the
meaning of each of the fields and flags of a ' SIZE' resource.

Handling Low-Level Events

Low-level events include hardware-related occurrences stored in the Operating System
event queue and activate and update events generated by the Window Manager. When
your application receives a low-level event, your application needs to determine the type
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of event and respond appropriately. The following sections discuss how to respond to
mouse events, keyboard events (including certain specific keyboard events, such as when
the user presses the Command key and period key at the same time), update events,
activate events, disk-inserted events, and null events.

Responding to Mouse Events

Whenever the user presses or releases the mouse button, the Operating System Event
Manager records the action in the Operating System event queue. These actions are
stored in the event queue as mouse-down and mouse-up events. Your application can
retrieve these events using the WaitNextEvent function.

Events related to movements of the mouse are not stored in the event queue. The mouse
driver automatically tracks the mouse and displays the cursor as the user moves the
mouse. Therefore, the Operating System Event Manager does not report an event if the
user simply moves the mouse.

However, you can request that the Event Manager report mouse-moved events if the user
moves the cursor out of a region that you specify to the WaitNextEvent function. For
example, your application can use mouse-moved events in this way to change the shape
of the cursor from an I-beam to an arrow when the user moves the cursor from a text area
to the scroll bar of a window.

The rest of this section describes how your application responds to mouse-down or
mouse-up events. See “Responding to Mouse-Moved Events” beginning on page 2-62
for specific details on mouse-moved events.

The user expects that pressing the mouse button correlates to particular actions in an
application. Your application is responsible for providing feedback or performing any
actions in response to the user. For example, if the user presses the mouse button while
the cursor is in the menu bar, your application should use the Menu Manager function
MenuSelect to allow the user to choose a menu command.

Your application can receive and respond to mouse-down and mouse-up events. Most
applications respond to mouse-down events and use the routines of various managers
(such as MenuSelect, DragWindow, TEClick, TrackBox, TrackGoAway, and
TrackControl) to handle the corresponding mouse-up events. You can also provide
code to respond to mouse-up events if it's appropriate for your application. For example,
if your application implements its own text-editing capabilities, you might let the user
select lines of text by dragging the mouse and use mouse-up events to signal the end of
the selection.

In System 7, your application receives mouse-down events only when it is the foreground
process and the user clicks in the menu bar, in a window belonging to your application,
or in a window belonging to a desk accessory that was launched in your application’s
partition. If the user clicks in a window belonging to another application, the Event
Manager sends your application a suspend event and performs a major switch to the
other application.

When your application receives a mouse-down event, you need to first determine the
location of the cursor at the time the mouse button was pressed (the mouse location) and
respond appropriately. You can use the Window Manager function FindWindow to find
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which of your application’s windows, if any, the mouse button was pressed in and, if
applicable, to find which part of the window it was pressed in. The FindWindow
function also reports whether the given mouse location is in the menu bar or, in some
cases, in a window belonging to a desk accessory (if the desk accessory was launched in
your application’s partition).

The what field of the event record for a mouse event contains the mouseDown or
mouseUp constant to report that the mouse button was pressed or released. The
message field is undefined. The when field contains the number of ticks since the system
last started up. You can use the when field to compare how much time has elapsed
between successive mouse events; for example, you might use this information to help
detect mouse double clicks.

The where field of the event record contains the location of the cursor at the time the
mouse button was pressed or released. You can pass this location to the FindWindow
function; the FindWindow function maps the given mouse location to particular areas
of the screen.

The modifiers field contains information about the state of the modifier keys at the
time the mouse button was pressed or released. Your application can perform different
actions based on the state of the modifier keys. For example, your application might let
the user extend a selection or select multiple objects at a time if the Shift key was down at
the time of the mouse-down event.

Listing 2-5 shows code that handles mouse-down events. The DoMouseDown procedure
is an application-defined procedure that is called from the DoEvent procedure.
(Listing 2-3 on page 2-26 shows the DoEvent procedure.)

Listing 2-5 Handling mouse-down events

PROCEDURE DoMouseDown (event: EventRecord) ;

VAR
part: Integer;
thisWindow: WindowPtr;
BEGIN

{map location of the cursor (at the time of mouse-down event) }
{ to general areas of the screen}
part := FindWindow(event.where, thisWindow) ;

CASE part OF {take action based on the mouse location}

inMenuBar: {mouse down in menu bar, respond appropriately}
BEGIN
{first adjust marks and enabled state of menu items}
MyAdjustMenus;
{let user choose a menu command}
DoMenuCommand (MenuSelect (event .where)) ;
END;

inSysWindow: {cursor in a window belonging to a desk accessory}
SystemClick (event, thisWindow) ;
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inContent: {mouse down occurred in the content area of }
{ one of your application's windows}
IF thisWindow <> FrontWindow THEN
BEGIN {mouse down occurred in a window other than the front }
{ window—-make the window clicked in the front window, }
{ unless the front window is movable modal}
IF MyIsMovableModal (FrontWindow) THEN
SysBeep (30)
ELSE
SelectWindow (thisWindow) ;
END
ELSE {mouse down was in the content area of front window}
DoContentClick (thisWindow, event) ;

inDrag: {handle mouse down in drag area}
IF (thisWindow <> FrontWindow) AND
(MyIsMovableModal (FrontWindow) )

THEN
SysBeep (30)
ELSE
DragWindow (thisWindow, event.where, GetGrayRgn””.rgnBBox) ;
inGrow: {handle mouse down in grow region}
DoGrowWindow (thisWindow, event) ;
inGoAway: {handle mouse down in go-away region}
IF TrackGoAway (thisWindow, event.where) THEN
DoCloseCmd;

inZoomIn, inZoomOut: {handle mouse down in zoom box region}
IF TrackBox(thisWindow, event.where, part) THEN
DoZoomWindow (thisWindow, part) ;
END; {end of CASE}
END; {of DoMouseDown }

When your application retrieves a mouse-down event, call the Window Manager
function FindWindow to map the location of the cursor to particular areas of the screen.
Given a mouse location, the FindWindow function returns as its function result a value
that indicates whether the mouse location is in the menu bar, in one of your application’s
windows, or, in some cases, in a desk accessory window. If the mouse location is in an
application window, the function result indicates which part of the window the mouse
location is in. You can test the function result of FindWindow against these constants to
determine the mouse location at the time of the mouse-down event:

CONST inDesk = 0;{none of the following}
inMenuBar = 1;{in the menu bar}
inSysWindow = 2;{in a desk accessory window}
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inContent = 3;{anywhere in content region except the }
{ grow region if the window is active, }
{ anywhere in content region including the }
{ grow region if the window is inactive}

inDrag = 4;{in drag (title bar) region}

inGrow = 5;{in grow region (active window only) }
inGoAway = 6;{in go-away region (active window only) }
inZoomIn = 7;{in zoom-in region (active window only) }
inZoomOut = 8;{in zoom-out region (active window only) }

The FindwWwindow function reports the inDesk constant if the mouse location is not in
the menu bar, desk accessory window, or any window of your application. For example,
the FindWindow function may report this constant if the location of the cursor is inside a
window frame but not in the drag region or go-away region of the window; your
application seldom receives the inDesk constant.

If FindWindow returns the inMenuBar constant, the mouse location is in the menu bar.
In this case your application should first adjust its menus. The application-defined
MyAdjustMenus procedure adjusts its menus—enabling and disabling items and setting
marks—based on the context of the active window. For example, if the active window is a
document window that contains a selection, your application should enable the Cut and
Copy commands in the Edit menu, add marks to the appropriate items in the Font, Size,
and Style menus, and adjust any other menu items accordingly. After adjusting your
application’s menus, call the Menu Manager function MenuSelect, passing it the
location of the mouse, to allow the user to choose a menu command. The MenuSelect
function handles all user interaction until the user releases the mouse button. The
MenuSelect function returns as its function result a long integer indicating the menu
selection made by the user. As shown in Listing 2-5 on page 2-34, the DoMouseDown
routine calls an application-defined routine, DoMenuCommand, to perform the menu
command selected by the user. See the chapter “Menu Manager” in this book for a listing
that gives the code for the MyAdjustMenus and DoMenuCommand routines and for more
information about responding to specific menu commands.

In System 7, the FindWindow function seldom returns the inSysWindow constant. The
FindWindow function returns this constant only when a mouse-down event occurred
in a desk accessory that was launched in the application’s partition. Normally, if the
user clicks in a desk accessory’s window, the Event Manager sends your application a
suspend event and brings the desk accessory to the foreground. From that point on,
mouse-down events and other events are handled by the desk accessory until the user
again clicks in one of your application’s windows.

If Findwindow does return the inSysWindow constant, the mouse location is in a
window belonging to a desk accessory that was launched in your application’s
partition. In this case, your application should call the SystemClick procedure. The
SystemClick procedure routes the event to the desk accessory as appropriate. If the
mouse button was pressed while the cursor was in the content region of the desk
accessory’s window and the window is inactive, SystemC1lick makes it the active
window. It does this by sending your application an activate event to deactivate its front
window and directing an event to the desk accessory to activate its window.
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FindWindow can return any of the constants inContent, inDrag, inGrow, inGoAway,
inZoomIn, or inZoomOut if the given mouse location is in your application’s active
window. If the cursor is in the content area, your application should perform any actions
appropriate to your application. Note that scroll bars are part of the content region. In
most cases, if the cursor is in the content area, your application first needs to determine
whether the mouse location is in the scroll bar or any other controls and then respond
appropriately. The DoMouseDown procedure calls the application-defined procedure
DoContentClick to handle mouse-down events in the content area of the active
window. If your application needs to determine whether the mouse-down event caused a
foreground switch (and you set the get FrontClicks flag in your application’s ' SIZE'
resource), your DoContentClick procedure can test bit 0 in the modifiers field of the
event record (normally your application does not test for this condition).

See the chapter “Control Manager” in this book for an example DoContentClick
procedure and for detailed information on implementing controls in your

application’s windows.

If the mouse location is in any of the other specified regions of an active application
window, your application should perform the action corresponding to that region.
For example, if the cursor is in the drag region, your application should call the
Window Manager procedure DragWindow to allow the user to drag the window to
a new location.

If the mouse location is in an inactive application window, FindWindow can return the
inContent or inDrag constant, but does not distinguish between any other areas of the
window. In this case, if FindWindow reports the inContent constant, your application
should bring the inactive window to the front using the SelectWindow procedure
(unless the active window is a movable modal dialog box). If the active window is a
movable modal dialog box, then your application should use the SysBeep procedure to
play the system alert sound rather than activating the selected window. Also, if your
application interprets the first mouse click in an inactive window as a request to activate
the window and perform an action, you can process the event again. However, note that
most users expect the first click in an inactive window to activate

the window without performing any additional action. If FindWindow reports inDrag
for an inactive application window, your application should call the DragWindow
procedure to allow the user to drag the window to a new location (unless the active
window is a movable modal dialog box, in which case your application should simply
play the system alert sound).

If you're using TextEdit to handle text editing and call TEC1ick, TEClick automatically
interprets mouse double clicks appropriately, including allowing the user to select a word
by double-clicking it. Your application must provide the means to allow double- clicking
in this manner in all other contexts.

You can detect mouse double clicks by comparing the time and location of a mouse-up
event with that of the immediately following mouse-down event. The GetDb1Time
function returns the recommended difference in ticks that should exist between the
occurrence of a mouse-up and mouse-down event for those two mouse events to be
considered a double click.
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You should interpret mouse events as a double click if both of these conditions are true:

m The times of the mouse-up event and mouse-down event differ by a number of ticks
less than or equal to the value returned by the GetDb1Time function.

m The locations of the two mouse-down events separated by the mouse-up event are
sufficiently close to each other. How you determine this value depends on your
application and the context in which the mouse-down events occurred. For example,
in a word-processing application, you might consider two mouse-down events a
double click if the mouse locations both mapped to the same character, whereas in a
graphics application you might consider it a double click if the sum of the horizontal
and vertical difference between the two mouse locations is no more than five pixels.

The Event Manager also provides other routines that give information about the mouse.
You can find the current mouse location using the GetMouse procedure. You can
determine the current state of the mouse button using the Button, StillDown, and
WaitMouseUp functions. See “Reading the Mouse” beginning on page 2-108 for detailed
information on these routines.

Responding to Keyboard Events

Your application can receive keyboard events to notify you when the user has pressed
or released a key or continued to hold down a key. When the user presses a key, the
Operating System Event Manager stores a key-down event in the Operating System
event queue. Your application can retrieve the event from the queue; determine which
key was pressed; determine which modifier keys, if any, were pressed at the time of the
event; and respond appropriately. Typically, your application provides feedback by
echoing (displaying) the glyph representing the character generated by the pressed key
on the screen.

When the user holds down a key for a certain amount of time, the Event Manager
generates auto-key events. The Event Manager generates an auto-key event after a certain
initial delay (the auto-key threshold) has elapsed since the original key-down event. The
Event Manager generates subsequent auto-key events whenever a certain repeat interval
(the auto-key rate) has elapsed since the last auto-key event and while

the original key is still held down. The user can set the initial delay and rate of repetition
using the Keyboard control panel. The default value for the auto-key threshold is

16 ticks, and the default value for the auto-key rate is 4 ticks. Current values of the auto-
key threshold and auto-key rate are stored in the system global variables KeyThresh
and KeyRepThresh.

In addition to getting keyboard events when the user presses or releases a key, you can
directly read the keyboard (and keypad) using the GetKeys procedure.

When the user presses a key or a combination of keys, your application should respond
appropriately. Your application should follow the guidelines in Macintosh Human Interface
Guidelines for consistent use of and response to keyboard events. For example, your
application should allow the user to choose a frequently used menu command by using a
keyboard equivalent for that menu command—usually a combination of the Command
key and another key. Your application should also respond to the user pressing the arrow
keys, Shift key, or other keys according to the guidelines provided

in Macintosh Human Interface Guidelines.
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Also note that certain keyboards have different physical layouts or contain additional
keys, such as function keys. If your application supports function keys or other special
keys, you should follow the guidelines in Macintosh Human Interface Guidelines when
determining what action to take when the user presses one of these keys.

Certain keystroke combinations are handled by the Event Manager and not returned to
your application. If the user holds down the Command and Shift keys while pressing a
numeric key to produce a special effect, that special effect occurs. Apple provides three
standard Command-Shift-number key sequences. The standard Command-Shift-
number key sequences are 1 for ejecting the disk in the internal drive, 2 for ejecting the
disk in a second internal drive or for ejecting the disk in an external drive if the computer
has only one internal drive, and 3 for taking a snapshot of the screen and storing it as a
TeachText document on the startup volume.

The action corresponding to a Command-Shift-number key sequence is implemented
as a routine that takes no parameters and is stored in an 'FKEY' resource with a resource
ID that corresponds to the number that activates it. Apple reserves 'FKEY' resources
with resource IDs 1 through 4 for its own use; if you provide an 'FKEY' resource, use a
resource ID between 5 and 9.

You can disable the Event Manager’s processing of Command-Shift-number key
sequences for numbers 3 through 9 by setting the system global variable ScrDmpEnb
(a byte) to 0. However, in most cases you should not disable the Event Manager’s
processing of these events.

The what field of the event record for a keyboard-related event contains either the
keyDown or keyUp constant to indicate that the key was pressed or released, or the
autokey constant to indicate that the key is being held down.

The Event Manager sets the system event mask of your application to accept all events
except key-up events. Most applications ignore key-up events. If your application needs
to receive key-up events, you can change the system event mask of your application
using the Operating System Event Manager procedure SetEventMask.

In the low-order word the message field contains the character code and virtual key
code that corresponds to the key pressed by the user.

The virtual key code represents the key pressed or released by the user; this value is
always the same for a specific physical key on a particular keyboard. For example, on
the Apple Keyboard II, ISO layout, the virtual key code for the fifth key to the right
of the Tab key (the key labeled “T”) is always $11, regardless of which modifier keys
are also pressed.

To determine the virtual key code that corresponds to a specific physical key, system
software uses a hardware-specific key-map (' KMAP ') resource that specifies the virtual
key codes for a particular keyboard. After determining the virtual key code of the key
pressed by the user, system software uses a script-specific keyboard-layout (' KCHR ')
resource to map a virtual key code to a specific character code. Any given script system
has one or more 'KCHR' resources. For example, a particular computer might contain the
French 'KCHR' resource in addition to the standard U.S. ' KCHR' resource. In this
situation, the current ' KCHR ' resource determines whether virtual key codes are mapped
to the French or U.S. character set.
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The character code represents a particular character. The character code that is generated
depends on the virtual key code, the state of the modifier keys, and the current ' KCHR'
resource. For example, the U.S. 'KCHR' resource specifies that for the virtual key code
$2D (the fifth key to the left of the Shift key and labeled “N” on an Apple Keyboard II,
Domestic layout), the character code is $6E when no modifier keys are pressed; the
character code is $4E when this key is pressed in combination with the Shift key.
Character codes for the Roman script system are specified in the extended version of
ASCII (the American Standard Code for Information Interchange).

The message field contains additional information for ADB keyboards. The low-order
byte of the high-order word contains the ADB address of the keyboard where the
keyboard event occurred. Figure 2-7 shows the structure of the message field of the
event record for keyboard events.

2-40

Figure 2-7 The message field of the event record for keyboard events
31 2423 16 15 8 7 0
Reserved ADB address Virtual key code Character code

Usually your application uses the character code, rather than the virtual key code, when
responding to keyboard events. You can use these two constants to access the virtual key
code and character code in the message field:

CONST charCodeMask $000000FF; {mask for character code}
keyCodeMask = $0000FF00; {mask for virtual key code}

The when field contains the number of ticks since the system last started up. You can
use the when field to compare how much time has expired between successive
keyboard events.

The where field of the event record contains the location of the cursor at the time the key
was pressed or released. You typically disregard the mouse location when processing
keyboard events.

The modifiers field contains information about the state of the modifier keys at the
time the key was pressed or released. Your application can perform different actions
based on the state of the modifier keys. For example, your application might perform an
action associated with a corresponding menu command if the Command key was down
at the time of the key-down event.

System software can support a number of different types of keyboards, for example, the
Apple Keyboard II, the Apple Extended keyboards, or other keyboards. The system
software uses various keyboard resources and international resources to manage different
types of keyboards. Figure 2-8 illustrates how system software maps keys to character
codes.
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Figure 2-8 Keyboard translation
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When a user presses or releases a key on the keyboard, the keyboard generates a raw

key code. The system software uses a 'KMAP' resource to map the raw key code to a
hardware-independent virtual key code and to set bits indicating the state of the modifier
keys. A 'KMAP' resource specifies the physical arrangement of a particular keyboard and
indicates the virtual key codes that correspond to each physical key.

If the optional key-remap ('it1k') resource is present, the system software remaps the
virtual key codes and modifier state for some key combinations on certain keyboards
before using the 'KCHR' resource. The 'it1k' resource can reintroduce hardware
dependence because certain scripts, languages, and regions need subtle differences in
layout for specific keyboards. If present, the '1t 1k' resource affects only a few keys.

After mapping the virtual key code and the state of the modifier keys through an
optional 'it 1k’ resource, the system software uses a 'KCHR' resource to produce the
character code representing the key that was pressed or released. The 'KCHR' resource
specifies how to map the setting of the modifier keys and a virtual key code to a character
code.
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After mapping the key, the Event Manager returns the virtual key code and the character
code in the message field of the event record.

Figure 2-9 shows the virtual key codes as specified by the 'KMAP ' resource for the Apple
Keyboard II, ISO layout. The labels for the keys on the keyboard are shown using the U.S.
keyboard layout. The virtual key codes are shown in hexadecimal.

Figure 2-9 Virtual key codes for the Apple Keyboard Il, ISO layout
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Figure 2-10 shows the virtual key codes as specified by the ' KMAP' resource for the
Apple Extended Keyboard II, one that uses the Domestic (ANSI) layout, and one that
uses the ISO layout. The labels for the keys on the ISO keyboard are shown using the
French keyboard layout. The virtual key codes are shown in hexadecimal.

If a user of an Apple Extended Keyboard II (using the U.S. ' KCHR' resource) presses the
key labeled “C” and no modifier keys, the system software maps this through the 'KMAP'
and 'KCHR' resources to produce a virtual key code of $08 and the character code $63 (the
character “c”) in the message field of the event record. If the user presses the key labeled
“C” and the Option key, then the system software maps this to virtual key code $08 and
the character code $8D (the character “¢”) in the message field.

As another example, if a user of an Apple Extended Keyboard II, Domestic layout, is
using the U.S. 'KCHR' resource and presses the key labeled “M” the system software
maps this through the 'KMAP' and ' KCHR' resources to produce a virtual key code of $2E
and the character code $6D (the character “m”) in the message field of the event record.

If a user of an Apple Extended Keyboard II, ISO layout, is using the French ' KCHR'
resource and presses the key labeled “M” the system software maps this through the
'"KMAP' and 'KCHR' resources to produce a virtual key code of $29 and the character
code $6D (the character “m”) in the message field of the event record.

See Inside Macintosh: Text for additional information about the keyboard resources and
how the Script Manager manages various scripts.
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Figure 2-10 Virtual key codes for the Apple Extended Keyboard Il
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Listing 2-6 shows code that handles key-down and auto-key events. The DoKeyDown
procedure is an application-defined procedure that is called from the DoEvent
procedure. (Listing 2-3 on page 2-26 shows the DoEvent procedure.)

Listing 2-6 Handling key-down and auto-key events

PROCEDURE DoKeyDown (event: EventRecord) ;
VAR
key: Char;
BEGIN
key := CHR(BAnd (event.mesgssage, charCodeMask)) ;
IF BAnd(event.modifiers, cmdKey) <> 0 THEN
BEGIN {Command key down}
IF event.what = keyDown THEN
BEGIN {first enable/disable/check menu items as needed-- }
{ the MyAdjustMenus procedure adjusts the menus }
{ as appropriate for the current window}
MyAdjustMenus;
DoMenuCommand (MenuKey (key) ) ; {handle the menu command}
END;
END
ELSE
MyHandleKeyDown (event) ;
END;

The DoKeyDown procedure in Listing 2-6 first extracts the character code of the key
pressed from the message field of the event record. It then checks the modifiers field
of the event record to determine if the Command key was pressed at the time of the
event. If so, and if the event is a key-down event, the code calls the application-defined
procedure MyAdjustMenus, and then calls another application-defined routine,
DoMenuCommand, to perform the menu command associated with that key. (The
MyAdjustMenus procedure adjusts the menus appropriately, and according to whether
the current window is a document window or modeless dialog box. See the chapter
“Menu Manager” in this book for code that defines the MyAdjustMenus procedure.)
Otherwise, the code calls the application-defined procedure MyHandleKeyDown to
handle the event.

Listing 2-7 shows the application-defined routine MyHandleKeyDown.

Listing 2-7 Handling key-down events
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PROCEDURE MyHandleKeyDown (event: EventRecord) ;
VAR

key: Char;

window: WindowPtr;
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myData: MyDocRecHnd;

te: TEHandle;

windowType: Integer;
BEGIN

window := FrontWindow;

{determine the type of window--document, modeless, etc.}

windowType := MyGetWindowType (window) ;

IF windowType = kMyDocWindow THEN

BEGIN
key := CHR(BAnd(event.message, charCodeMask)) ;
IF window <> NIL THEN
BEGIN

IF key = char(kTab) THEN {handle special characters}
MyDoTab (event)

ELSE
BEGIN
myData := MyDocRecHnd (GetWRefCon (window) ) ;
te := myData™”".editRec;
IF
(te®” .teLength - (te”*.selEnd - te™".selStart) + 1
< kMaxTELength) THEN
BEGIN
TEKey (key, te); {insert character in document}
MyAdjustScrollBars (window, FALSE) ;
MyAdjustTE (window) ;
myData™”.windowDirty := TRUE;
END;
END;
END;
END
ELSE

MyHandleKeyDownInModeless (event, windowType) ;
END;

The MyHandleKeyDown procedure in Listing 2-7 handles key-down events in any
window of the application. For document windows, the code inserts the character
represented by the key pressed by the user into the active document. It first finds the
active document using the FrontWindow function, then handles the event as
appropriate for the document window. For example, it treats the Tab key as a special
character and calls an application-defined routine, MyDoTab, to handle this character
appropriately for the document. For all other keys directed to the document window, the
code gets the edit record associated with the document, and then it simply inserts the
character into the document, using the TextEdit TEKey procedure. It also calls two other
application-defined routines, MyAdjustScrollBars and MyAdjustTE, to update the
document and edit record.
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The MyHandleKeyDown procedure calls an application-defined routine,
MyHandleKeyDownInModeless, to handle key-down events in modeless dialog boxes.
See the chapter “Dialog Manager” in this book for more information on handling events
in dialog boxes.

Scanning for a Cancel Event

Your application should allow the user to cancel a lengthy operation by using the
Command-period combination. Your application can implement this cancel operation by
periodically examining the state of the keyboard using the GetKeys procedure, or your
application can scan the event queue for a keyboard event.

Listing 2-8 shows an application-defined function that scans the event queue for any
occurrence of a Command-period event.

The UserbDidCancel function in Listing 2-8 first checks to see if the user changed the
script. The application maintains a global variable, gCurrentKeyScript, that keeps
track of this information. The application also uses a global variable, gPeriodKeyCode,
to hold the key code that maps to the period key according to the current script. If the
current script has changed, the UserDidCancel function calls an application-defined
routine, MySet PeriodKeyCode, to change the value of the gPeriodKeyCode global
variable as necessary.

The UserDidCancel function then determines whether A /UX is running. You must

use a different method to scan the event queue if A/UX is running. This code uses

an application-defined function called MyCheckAUXEventQueue to search for a
Command-period event if A/UX is running. Otherwise, the code checks the what field
for a key-down event. If it finds a key-down event, it then checks the message field

to determine whether the user pressed the period key and checks the modifiers

field to determine whether the user also pressed the Command key. If it finds the
Command-period combination, it sets the foundEvent variable to TRUE and returns this
value. Otherwise, it looks at the next entry in the queue and continues to search the
queue until it either finds a Command-period event or reaches the end of the queue.

Listing 2-8 Scanning for a Command-period event

FUNCTION UserDidCancel: Boolean;

VAR
foundEvent: Boolean;
eventQPtr: EVQE1Ptr;
eventQHdr : QHdArPtr;
keyCode: LongInt;
isCmdKey: LongInt;
BEGIN
foundEvent := FALSE; {assume the event is not there}

{Check to see if the script has changed}

IF (gCurrentKeyScript <> GetEnvirons (smKeyScript)) THEN

MySetPeriodKeyCode; {set gPeriodKeyCode to match new script}
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IF (GetAUXVersion > 0) THEN {if A/UX is running use this method}
foundEvent := MyCheckAUXEventQueue (gPeriodKeyCode, cmdKey)
ELSE
BEGIN {scan event queue}
eventQHdr := GetEvQHdr; {get the event queue header}
eventQPtr := EVQElPtr (eventQHdr”.gHead); {get first entry}
WHILE (eventQPtr <> NIL) AND (NOT(foundEvent)) DO
BEGIN {look for key-down event}
IF (eventQPtr”.evtQWhat = keyDown) THEN {found key-down event, |}
BEGIN { look for Command-period}
keyCode := BAND (eventQPtr”.evtQMessage, keyCodeMask) ;
keyCode := BSR(keyCode, 8);
isCmdKey := BAND (eventQPtr”.evtQModifiers, cmdKey) ;
IF isCmdKey <> 0 THEN {Command key was pressed}
IF keyCode = gPeriodKeyCode THEN
foundEvent := TRUE; {key pressed was '.'}
END; {of found key-down}
IF (NOT foundEvent) THEN {go to next entry}
eventQPtr := EVQE1Ptr (eventQPtr”.qgLink) ;
END; {of while}
END; {of scan event queue}
UserDidCancel := foundEvent; {return result of search}

END;

Responding to Update Events

The Event Manager reports update events to your application whenever one of your
application’s windows needs updating. Upon receiving an update event, your applica-
tion should update the contents of the specified window. Your application can call the
Window Manager procedure BeginUpdate, draw the window’s contents, and then call
EndUpdate when your application has finished updating the window’s contents.

Your application can also let the Window Manager automatically update the contents of a
window by supplying in the window record a handle to a picture that contains the
contents of the window. This technique is generally useful only for windows that contain
static information that doesn’t change or can’t be edited. For example, if your application
provides a window that always displays a picture of the earth, you can supply the handle
to the picture, and the Window Manager automatically updates the window as needed,
without sending your application an update event. In most cases, your application needs
to perform the update itself.

The Window Manager maintains an update region for each window. The Window
Manager keeps track of all areas in a window’s content region that need to be redrawn
and accumulates them in the window’s update region. When an application calls
WaitNextEvent or EventAvail (or GetNextEvent), the Event Manager checks to see
if any windows have an update region that is not empty. If so, the Event Manager reports
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update events to the appropriate applications; any applications with windows that
require updating receive the necessary update events according to the normal processing
of events.

If more than one window needs updating, the Event Manager issues update events for
the frontmost window first. This means that updating of windows occurs in front-to-back
order, which is what the user expects.

When one of your application’s windows needs to be updated, the Window Manager
calls the window definition function of that window, requesting that it draw the window
frame. The Window Manager then generates an update event for that window. The Event
Manager reports any update events for your application’s windows to your application,
and your application should update the window contents as necessary.

In response to an update event, your application should first call the BeginUpdate
procedure. The BeginUpdate procedure temporarily replaces the visible region of the
window’s graphics port (that part of the window that is visible on the screen) with the
intersection of the visible region and update region of the window. The BeginUpdate
procedure then clears the update region of the window—preventing the update event for
this occurrence from being reported again.

After calling BeginUpdate, your application should draw the window’s contents, either
entirely or in part. You can draw either the entire content region or only the area in the
visible region. In either case, the Window Manager allows only what falls within the
visible region to be drawn on the screen. (Because the BeginUpdate procedure
intersects the visible region with the update region, the visible region at this point
corresponds to any visible parts of the old update region.)

The EndUpdate procedure restores the normal visible region of the window’s
graphics port.

Figure 2-11 shows how an application updates its windows. In this example, Window 1
partially covers Window 2. When the user moves Window 1 so that more of Window 2 is
exposed, the Window Manager requests the window definition function of the window
to update the window frame, and accumulates the area requiring updating in the update
region of the window.

When the application receives an update event for this window, the message field of the
event record contains a pointer to the window that needs updating. Your application can
call BeginUpdate, draw the window’s contents, and then call EndUpdate. This
completes the handling of the update event.

Your application can receive update events when it is in the foreground or in the
background. In the example shown in Figure 2-11, Window 1 and Window 2 could
belong to the same application or different applications. In either case, the Event
Manager reports an update event to the application whose window contents

need updating.
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Figure 2-11 Responding to an update event for a window
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Your application should respond to update events or at least call the BeginUpdate
procedure in response to an update event. If you do not call the BeginUpdate
procedure, your application continues to receive update events for the window (until
the update region is empty). You should always make sure that you match a call to
BeginUpdate with a call to EndUpdate. By calling the BeginUpdate and EndUpdate
procedures, you indicate to the Window Manager that you have updated the window
and handled the update event.
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Listing 2-9 shows an example of an application-defined routine that responds to
update events.

Listing 2-9 Responding to update events

2-50

PROCEDURE DoUpdate (window: WindowPtr) ;
VAR
windowType: Integer;
BEGIN
{determine the type of window--document, modeless, etc.}
windowType := MyGetWindowType (window) ;
CASE windowType OF
kMyDocWindow:
BEGIN
BeginUpdate (window) ;
MyDrawWindow (window) ;
EndUpdate (window) ;
END;
OTHERWISE
DoUpdateMyDialog (window) ;
END; {of CASE}
END;

The DoUpdate procedure in Listing 2-9 first determines if the window is a document
window or a modeless dialog box. The MyGetWindowType function is an
application-defined routine that returns the kMyDocWindow constant if the window is a
document window and returns other application-defined constants if the window is a
modeless dialog box.

If the window is a document window, the procedure does all its drawing of the window
within calls to the BeginUpdate and EndUpdate procedures. The application-defined
routine MyDrawWindow performs the actual updating of the document window contents.
See the chapter “Window Manager” in this book for code that shows the
MyGetWindowType and MyDrawWindow routines.

If the window is a modeless dialog box, the code calls the application-defined
DoUpdateMyDialog procedure to update the contents of the dialog box. See the chapter
“Dialog Manager” in this book for details on handling update events in dialog boxes.

Responding to Activate Events

When several windows belonging to your application are open, you should allow the
user to switch from one window to another by clicking in the appropriate window. To
implement this, whenever your application receives a mouse-down event, you should
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first determine whether the user clicked in another window by using the Window
Manager function FindWindow; if so, you can use the Window Manager procedure
SelectWindow to generate the necessary activate events.

Before returning to your application and before your application receives any events
relating to this occurrence, the SelectWindow procedure does some work for you, such
as removing the highlighting from the window to be deactivated and highlighting the
newly activated window. At your application’s next request for an event, the Event
Manager returns an activate event.

An activate event indicates the window involved and whether the window is being
activated or deactivated. Your application should perform any other actions needed to
complete the action of the window becoming active or inactive. For example, when a
window becomes active, your application should show any scroll bars and restore
selections as necessary.

Your application typically receives an activate event (with a flag that indicates the
window should be deactivated) for the window being deactivated, followed by an
activate event for the window becoming active.

Activate events are not placed into the Operating System event queue but are sent
directly to the Event Manager.

Figure 2-12 on the next page shows two documents belonging to the same application,
with Window 1 the active window. When the user clicks in Window 2, your application
receives a mouse-down event and can use the FindWindow function to determine
whether the mouse location is in an inactive window. If so, your application should call
the SelectWindow procedure. The SelectWindow procedure removes highlighting
of Window 1, highlights Window 2, and generates activate events for both of these
occurrences. The Event Manager reports the activate events one at a time to your
application; in this example, the first activate event indicates that Window 1 should be
deactivated. Your application should hide the scroll bars and remove the highlighting
from any selections as necessary.

The next activate event indicates that Window 2 should be activated. Your application
should show the scroll bars and restore any selections as necessary. If the window needs
updating as a result of being activated, the Event Manager sends your application an
update event so that your application can update the window contents.

Your application also needs to activate or deactivate windows in response to suspend
and resume events. If you set the accept SuspendResumeEvents flag and the
doesActivateOnFGSwitch flag in your application’s 'SIZE' resource, your
application is responsible for activating or deactivating your application’s

windows in response to handling suspend and resume events. If you set the
acceptSuspendResumeEvents flag and do not set the doesActivateOnFGSwitch
flag, your application receives an activate event immediately following a suspend or
resume event. In most cases, you should set both the accept SuspendResumeEvents
and doesActivateOnFGSwitch flags in your application’s ' SIZE' resource.
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Figure 2-12

Responding to activate events for a window
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The what field of an event record for an activate event contains the activateEvt
constant. The message field contains a pointer to the window being activated or
deactivated. The modifiers field contains additional information about the activate
event, along with information about the state of the modifier keys at the time the event
was posted. Your application can examine bit 0 of the modifiers field of the event
record to determine if the window should be activated or deactivated. Bit 0 of the
modifiers field is 1 if the window should be activated and 0 if the window should be
deactivated. You can use the activeFlag constant to test the state of this bit in the
modifiers field.

The when field of the event record contains the number of ticks since the system last
started up. The where field of the event record contains the location of the cursor at the
time the activate event occurred.

Upon receiving an activate event that indicates the window is being deactivated, your
application should hide any scroll bars and remove the highlighting from any selections
as necessary.

Upon receiving an activate event that indicates the window is becoming active, your
application should show any scroll bars, highlight any selections, and otherwise restore
the window to the state it was in when it was last active. For example, your application
should restore the insertion point to its previous position, and the document should be
scrolled to the position in which the user last left it. Your application should also adjust
its menus appropriately for the newly active window—adjusting the marks and enabled
state of menu items based on the state of the active window.

Listing 2-10 shows an application-defined procedure that responds to activate events.

Listing 2-10 Responding to activate events

PROCEDURE DoActivate (window: windowPtr; activate: Boolean;
event: EventRecord) ;
VAR
growRect : Rect; {window's grow rectangle}
myData: MyDocRecHnd ; {window's document record}
windowType: Integer;
BEGIN
{determine the type of window--document, modeless, etc.}
windowType := MyGetWindowType (window) ;
CASE windowType OF
kMyDocWindow:
BEGIN
myData := MyDocRecHnd (GetWRefCon (window) ) ;
HLock (Handle (myData) ) ;
WITH myData”” DO
IF activate THEN {window is being activated}
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BEGIN

{restore any selections or display caret}
MyRestoreSelection (window) ;
{adjust menus as appropriate for this document window}

MyAdjustMenus;

{activate any scroll bars}
vScrollBar”™”.contrlvVis := kControlVisible;
hScrollBar”™”®.contrlvVis := kControlVisible;

{invalidate area of scroll bars to force update}
InvalRect (vScrollBar™”.contrlRect) ;

InvalRect (hScrollBar™
{invalidate area of size box, if any}

A

.contrlRect) ;

growRect := window”.portRect;

WITH growRect DO

BEGIN
top := bottom - kScrollbarAdjust;
left := right - kScrollbarAdjust;

END; {end of WITH growRect statement}
InvalRect (growRect) ;

END

BEGIN

ELSE {window is being deactivated}
{unhighlight selection (if any) or hide the caret}
MyHideSelection;

HideControl (vScrollBar) ; {hide any scroll bars}
HideControl (hScrollBar) ;
DrawGrowIcon (window) ; {change size box immediately}

END;
HUnLock (Handle (myData)) ;

END; {end of kMyDocWindow}

kMyGlobalChangesID: {this window is a modeless dialog box }

{ for this app's Global Changes command}

MyDoActivateGlobalChangesDialog (window, event) ;

{handle other modeless dialog boxes as appropriate}
END; {of CASE}

END;

Listing 2-10 uses the application-defined function MyGetWindowType to determine what
type of window is involved with the activate event. If the window is a document
window, the DoAct ivate procedure uses the GetWRefCon function to get a handle

to the window’s document record. (The DoActivate procedure, and other application-
defined routines, maintain information about the document associated with a window

in a document record; the application stores a handle to the document record as the
window’s reference constant value when it creates a new window. See the chapter
“Window Manager” in this book for information on defining a document record.)
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If the document window should be activated, the code calls an application-defined
routine, MyRestoreSelection. Your application should restore any selection or display
the caret as appropriate. For example, if your application uses TextEdit to display text in
the content area of windows, you can call the TextEdit procedure TEAct ivate to restore
any selection or display a caret at the insertion point. The DoActivate procedure then
calls another application-defined procedure, MyAdjustMenus, to adjust the menus as
appropriate for the document window. (See

the chapter “Menu Manager” for a listing of the MyAdjustMenus procedure.) After
restoring any selections and adjusting its menus, the code shows the scroll bars and size
box of the window being activated. It does this by invalidating the area of the scroll bars
and size box, accumulating these areas into the update region. This causes an update
event to be generated. The application redraws its controls as appropriate in response to
update events.

If the document window should be deactivated, the code in Listing 2-10 unhighlights
the selection and hides the caret by calling the application-defined procedure
MyHideSelection. The code then hides the scroll bars and size box of the
deactivated window.

If the window associated with the activate event is a modeless dialog box, for example, a
Global Changes modeless dialog box, the DoAct ivate procedure calls an
application-defined procedure to activate or deactivate the dialog box as needed. See the
“Dialog Manager” chapter in this book for information on handling activate events in
modeless dialog boxes.

Responding to Disk-Inserted Events

When your application uses the Standard File Package to allow the user to choose a file to
open or choose a location for storing a file, the Standard File Package responds to
disk-inserted events for your application while interacting with the user. In most cases, if
your application receives an unexpected disk-inserted event, it can simply check to see if
the disk was successfully mounted and use the Disk Initialization Manager function
DIBadMount to notify the user if the disk was not successfully mounted.

When the user inserts a disk, the Operating System attempts to mount the volume on the
disk by calling the File Manager function PBMountVol. If the volume is successfully
mounted, an icon representing the disk appears on the desktop. The Operating System
Event Manager then generates a disk-inserted event. If the user is interacting with a
standard file dialog box, the Standard File Package intercepts the disk-inserted event and
handles it. Otherwise, the event is left in the event queue for your application to retrieve.
The Desk Manager also intercepts and handles disk-inserted events if a desk accessory is
in front.

Usually your application should handle and not mask out disk-inserted events. The user
might insert a disk at any time and expects to be warned if the disk is uninitialized or
damaged. If your application receives a disk-inserted event and the volume was
successfully mounted, your application usually does not need to take any further action.
However, if the volume was not successfully mounted, then your application should give
the user a chance to initialize or eject the uninitialized or damaged disk.
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If you do mask out disk-inserted events, the event stays in the Operating System event
queue until your application calls the Standard File Package or until an application that
does handle disk-inserted events becomes the foreground process. This situation can be
confusing to the user, so your application should handle disk-inserted events at the time
that they occur.

If the volume was successfully mounted and your application either does not use the
Standard File Package or prompts the user to insert a disk, then you can choose to
respond to disk-inserted events in whatever way is appropriate for your application.

The Dialog Manager procedure ModalDialog masks out disk-inserted events. (The
Standard File Package changes the mask in order to receive disk-inserted events.) If one
of your application’s modal dialog boxes needs to respond to disk-inserted events, then
you can change the event mask from within the event filter function that you supply as
one of the parameters to ModalDialog. Otherwise, your application can respond to the
disk-inserted event after the user dismisses the modal dialog box.

The what field of the event record contains the diskEvt constant to indicate a
disk-inserted event. The message field contains the drive number in the low-order word
and the result code from the PBMountVol function in the high-order word. Your
application can examine the high-order word to determine if the attempt to mount the
volume was successful. If the volume was not successfully mounted, your application
can notify the user using the Disk Initialization Manager function DIBadMount. If the
volume was successfully mounted, your application can use the drive number returned
in the low-order word for accessing the disk.

Listing 2-11 shows a procedure that handles disk-inserted events. If the disk was not
successfully mounted, the procedure notifies the user using the DIBadMount function.
Otherwise, it does not take any action. See the chapter “Disk Initialization Manager”
in Inside Macintosh: Files for information on the routines provided by the Disk
Initialization Manager.

Listing 2-11 Responding to disk-inserted events

PROCEDURE DoDiskEvent (event: EventRecord) ;

VAR
thisPoint: Point;
myErr: OSErr;
BEGIN
IF HiWord (event.message) <> noErr THEN
BEGIN {attempt to mount was unsuccessful}
DILoad; {load Disk Initialization Manager}

SetPt (thisPoint, 120, 120);
{notify the user}
myErr := DIBadMount (thisPoint, event.message) ;
DIUnload; {unload Disk Initialization Manager}
END
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ELSE {attempt to mount was successful}
; {record the drive number or do other processing}
END;

Responding to Null Events

When the Event Manager has no other events to report, it returns a null event. The
WaitNextEvent function reports a null event by returning a function result of FALSE
and setting the what field of the returned event record to nul1Evt. (The EventAvail
and GetNextEvent functions also return null events in this manner.)

When your application receives a null event, it can perform idle processing. Your
application should do minimum processing in response to a null event, so that other
processes can use the CPU and so that the foreground process (or your application, if
it is in the foreground) can respond promptly to the user.

For example, if your application receives a null event and it is in the foreground, it can
make the caret blink in the active window.

If your application receives a null event in the background, it can perform tasks or do
other processing while in the background. However, your application should not
perform any tasks that would slow down the responsiveness of the foreground process.
Your application also should not interact with the user if it is in the background.

If you don’t want your application to receive null events when it is in the background, set
the cannotBackground flag in your application’s ' SIZE' resource.

Listing 2-12 shows a procedure that performs idle processing in response to a null event.
If the application is not in the background and the active window is a document window,
this code calls the TextEdit procedure TEIdle. The TEIdle procedure makes a blinking
caret appear at the insertion point in the text referred to by the edit record. (This
application uses TextEdit to display text in its document windows; if you don’t use
TextEdit for your document windows, provide your own routine to blink the caret.) If the
active window is a modeless dialog box, the DoIdle procedure calls the Dialog Manager
function DialogSelect to blink the caret in any editable text item of the dialog box.

Listing 2-12 Handling null events

PROCEDURE DolIdle (event: EventRecord) ;

VAR
window: WindowPtr;
myData: MyDocRecHnd;
windowType: Integer;
itemHit: Integer;
result: Boolean;
BEGIN
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window := FrontWindow;
{determine the type of window--document, modeless, etc.}

windowType := MyGetWindowType (window) ;
CASE windowType OF
kMyDocWindow:
IF (NOT gInBackground) THEN
BEGIN
myData := MyDocRecHnd (GetWRefCon (window) ) ;
TEIdle (myData”".editRec) ;
END;
kMyGlobalChangesID:
result := DialogSelect (event, window, itemHit) ;
END; {of CASE}
END;

Handling Operating-System Events

Operating-system events include suspend, resume, and mouse-moved events. Your
application receives suspend and resume events as a result of changes in its processing
status. Your application can request that the Event Manager return mouse-moved events
whenever the cursor is outside a specified region by specifying a nonempty region in
the mouseRgn parameter to WaitNextEvent. If you specify an empty region or a NIL
region handle in the mouseRgn parameter, the Event Manager does not report mouse-
moved events.

Your application examines the event record to determine which event it received and to
obtain additional information associated with the event.

The what field in the event record of an operating-system event contains the
osEvt constant.

The message field in the event record of an operating-system event contains information
indicating whether the event is a suspend, resume, or mouse-moved event. The message
field also indicates whether Clipboard conversion is required when the application
resumes execution. The bits in the message field give this information:

Bit Contents
0 0 if a suspend event
1if a resume event
1 0 if Clipboard conversion not required
1 if Clipboard conversion required
2-23 Reserved

24-31 suspendResumeMessage if a suspend or resume event
mouseMovedMessage if a mouse-moved event
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Note that you need to examine bits 24-31 of the message field to determine what kind of
operating-system event you have received. Bits 24-31 in the message field contain one of
these two constants:

CONST suspendResumeMessage $01; {suspend or resume event}

mouseMovedMessage = S$FA; {mouse-moved event}

If the event is a suspend or resume event, you need to examine bit 0 to determine
whether that event is a suspend or resume event. Bits 0 and 1 are meaningful only if bits
24-31 indicate that the event is a suspend or resume event. You can use the resumeFlag
constant to determine whether the event is a suspend or resume event. If the event is a
resume event, you can use the convertClipboardFlag constant to determine whether
Clipboard conversion from the Clipboard to your application’s scrap is required:

CONST resumeFlag
convertClipboardFlag = 2; {Clipboard conversion required}

1; {resume event}

Whenever the user performs a copy or cut operation, your application should copy the
selected data either to its private scrap or, if your application doesn’t have a private
scrap, to the Clipboard. If your application uses a private scrap, you need to convert the
data from your private scrap to the Clipboard whenever your application receives a
suspend event. Likewise, you need to convert any data from the Clipboard (if it has
changed) when your application receives a resume event. For resume events, the value of
bit 1 of the message field is 1 if your application needs to read in the new contents of the
Clipboard.

Listing 2-13 shows a procedure that responds to operating-system events.

Listing 2-13 Responding to operating-system events

PROCEDURE DoOSEvent (event: EventRecord) ;
BEGIN
CASE BAnd (BRotL (event.message, 8), $FF) OF {get high byte}
mouseMovedMessage :
DoIdle (event); {mouse-moved same as idle for this app}
suspendResumeMessage:
DoSuspendResumeEvent(event);{handle supend/resume event}
END;
END;

The DoOSEvent procedure in Listing 2-13 is called from the DoEvent procedure (shown
in Listing 2-3 on page 2-26) whenever the application receives an operating-system event.
The DoOSEvent procedure examines the high byte of the message field to determine
whether the event is a mouse-moved, suspend, or resume event, and it then calls an
application-defined procedure to handle the event. Note that most applications either
adjust the cursor in response to mouse-moved events or adjust the cursor in their event
loop whenever any type of event is received. The code in this chapter uses the latter
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approach, and thus the DoOSEvent procedure simply calls its DoIdle procedure in
response to mouse-moved events. The next two sections show the code that handles
suspend, resume, and mouse-moved events.

Responding to Suspend and Resume Events

The WaitNextEvent function returns a suspend event when your application is about
to be switched to the background. WaitNextEvent returns a resume event when your
application becomes the foreground process again.

Upon receiving a suspend event, your application should deactivate the front window,
remove the highlighting from any selections, and hide any floating windows. Your
application should also convert any private scrap into the global scrap, if necessary.

If your application shows a window that displays the Clipboard contents, you should
hide this window also, as the user might change the contents of the Clipboard before
returning to your application. Your application can also do anything else necessary to
get ready for a major switch. Then your application should call WaitNextEvent to
relinquish the processor and allow the Operating System to schedule other processes
for execution.

Upon receiving a resume event, your application should activate the front window and
restore any windows to the state the user left them in at the time of the previous suspend
event. For example, your application should show scroll bars, restore any selections that
were previously in effect, and show any floating windows. Your application should copy
the contents of the Clipboard and convert the data back to its private scrap, if necessary.
If your application shows a window that displays the Clipboard contents, you can update
the contents of the window after reading in the scrap. Your application can then resume
interacting with the user.

Responding to a suspend or resume event usually involves activating or deactivating
windows. If you set the accept SuspendResumeEvents flag and the
doesActivateOnFGSwitch flag in your application’s ' SIZE' resource, your
application is responsible for activating or deactivating your application’s windows
in response to handling suspend and resume events.

Note

If you set the accept SuspendResumeEvents flag and do not set the
doesActivateOnFGSwitch flag in your application’s ' SIZE"
resource, your application receives an activate event immediately
following a suspend or resume event. In most cases, you should set both
the acceptSuspendResumeEvents and doesActivateOnFGSwitch
flags in your application’s ' SIZE' resource.

Your application can use the Scrap Manager functions InfoScrap, ZeroScrap,
PutScrap, and GetScrap to read data from and write data to the Clipboard.
See the chapter “Scrap Manager” in Inside Macintosh: More Macintosh Toolbox for
additional details.
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Note

If your application does not handle suspend and resume events (as
indicated by a flag in its ' SIZE' resource), then the Operating System
has to trick your application into performing scrap coercion to ensure
that the contents of the Clipboard can be transferred from one applica-
tion to another. This process adds to the time it takes to move the
foreground application to the background and vice versa. ¢

Listing 2-14 shows a procedure that responds to suspend and resume events. The
DoSuspendResumeEvent procedure first gets a pointer to the front window using
the Window Manager function FrontWindow. It then examines bit 0 of the message
field of the event record to determine whether the event is a suspend or resume event.
If the event is a resume event, the code examines bit 1 of the message field of the
event record to determine whether it needs to read in the contents of the scrap. If so,
the code calls an application-defined routine, MyConvertScrap, that reads in the
scrap and converts the contents to its private scrap. It then sets a private global flag,
gInBackground, to FALSE, to indicate that the application is not in the background. It
then calls another application-defined routine, DoAct ivate (shown in Listing 2-10), to
activate the application’s front window.

For suspend events, the DoSuspendResumeEvent procedure calls the
application-defined MyConvertScrap procedure to copy the contents of its private
scrap to the global scrap. It then sets a private global flag, gInBackground, to TRUE, to
indicate that the application is in the background. Finally, it calls another
application-defined routine to deactivate the application’s front window.

Listing 2-14 Responding to suspend and resume events

PROCEDURE DoSuspendResumeEvent (event: EventRecord) ;
VAR
currentFrontWindow: WindowPtr;
BEGIN {handle suspend/resume event}
currentFrontWindow := FrontWindow;
IF (BAnd(event.message, resumeFlag) <> 0) THEN
BEGIN {it's a resume event}
IF (BAnd(event.message, convertClipboardFlag) <> 0) THEN
MyConvertScrap (kClipboardToPrivate) ;
gInBackground := FALSE;
{activate front window}
DoActivate (currentFrontWindow, NOT gInBackground, event) ;
MyShowClipboardWindow; {show Clipboard window if it was }
{ showing at last suspend event}
MyShowFloatingWindows; {show any floating windows}
END
ELSE
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BEGIN {it's a suspend event}
MyConvertScrap (kPrivateToClipboard) ;
gInBackground := TRUE;

{deactivate front window}

DoActivate (currentFrontWindow, NOT gInBackground, event) ;
MyHideClipboardWindow; {hide Clipboard window if showing}
MyHideFloatingWindows; {hide any floating windows}

END;

END;

Your application can receive processing time while in the background and perform tasks
in the background, but your application should not interact with the user or perform
tasks that would slow down the responsiveness of the foreground process.

If you need to notify the user of some special occurrence while your application is
executing in the background, you should use the Notification Manager to queue a
notification request. See the chapter “Notification Manager” in Inside Macintosh:
Processes for examples of how to post notification requests.

Responding to Mouse-Moved Events

Whenever the user moves the mouse, the mouse driver, the Event Manager, and your
application are responsible for providing feedback to the user. The mouse driver
performs low-level functions, such as continually polling the mouse for its location and
status and maintaining the current location of the mouse in a global variable.

As the user moves the mouse, the user expects the cursor to move to a corresponding
relative location on the screen. The low-level interrupt routines of the mouse driver map
the movement of the mouse to relative locations on the screen. Whenever the user moves
the mouse, a low-level interrupt routine of the mouse driver moves the cursor displayed
on the screen and aligns the hot spot of the cursor with the new mouse location. A hot
spot is a point that the mouse driver uses to align the cursor with the mouse location.

Your application is responsible for setting the initial appearance of the cursor, for
restoring the cursor after WaitNextEvent returns, and for changing the appearance of
the cursor as appropriate for your application. For example, most applications set the
cursor to the I-beam when the cursor is inside a text-editing area of a document, and
change the cursor to an arrow when the cursor is inside the scroll bar of a document.
Your application can achieve this effect by requesting that the Event Manager report
mouse-moved events if the user moves the cursor out of a region you specify in the
mouseRgn parameter to the WaitNextEvent function.

The mouse driver and your application control the shape and appearance of the cursor. A
cursor can be any 256-bit image, defined by a 16-by-16 bit square. The mouse driver
displays the current cursor, which your application can change by using various cursor-
handling routines (for example, the Set Cursor procedure).

Figure 2-13 shows the standard arrow cursor. You can initialize the cursor to the standard
arrow cursor using the InitCursor procedure. In Figure 2-13, the hot spot
for the arrow cursor is at location (1,1). See Inside Macintosh: Imaging for information on
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the cursor-handling routines and for specific details of how your application can define

its own cursors.

Figure 2-13 The standard arrow cursor

Hot spot
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Figure 2-14 shows four other common cursors that are available to your application: the

I-beam, crosshairs, plus sign, and wristwatch cursors.

Figure 2-14 The I-beam, crosshairs, plus sign, and wristwatch cursors

I + & @

I-beam Crosshairs Plus sign Wristwatch

The I-beam, crosshairs, plus sign, and wristwatch cursors are defined as resources,
and your application can get a handle to any of these cursors by specifying their
corresponding resource IDs to the Get Cursor function. These constants specify the
resource IDs for the I-beam, crosshairs, plus sign, and wristwatch cursors:

CONST iBeamCursor = 1;{used in text editing}
crossCursor 2;{often used for manipulating graphics}
plusCursor = 3;{often used for selecting fields in }
{ an array}
watchCursor = 4;{used to mean a lengthy operation }
{ 1s in progress}
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You can change the appearance of the cursor using the SetCursor procedure or other
cursor-handling routines. You can also define your own cursors, store them in resources,
and use them as needed in your application.

Your application usually needs to change the shape of the cursor as the user moves the
cursor to different areas within a document. Your application can use mouse-moved
events to accomplish this. Your application also needs to adjust the cursor in response to
resume events. Most applications adjust the cursor once through the event loop in
response to almost all events.

You can request that the Event Manager report mouse-moved events whenever

the cursor is outside of a specified region that you pass as a parameter to the
WaitNextEvent function. If you specify an empty region or a NIL handle to

the WaitNextEvent function, WaitNextEvent does not report mouse-moved events.

If you specify a nonempty region in the mouseRgn parameter to the WaitNextEvent
function, WaitNextEvent returns a mouse-moved event whenever the cursor is out of
this region. For example, Figure 2-15 shows a document window. An application might
define two regions: a region that encloses the text area of a window (the I-beam region),
and a region that defines the scroll bars and all other areas outside the text area (the arrow
region). By specifying the I-beam region to WaitNextEvent, the mouse driver continues
to display the I-beam cursor until the user moves the cursor out of this region.

Figure 2-15 The arrow region and the I-beam region
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When the user moves the cursor out of the I-beam region, WaitNextEvent reports a
mouse-moved event. Your application can then change the I-beam cursor to the arrow
cursor and change the mouseRgn parameter to the area defined by the scroll bars and
all other areas outside of the I-beam region. The cursor now remains an arrow until the
user moves the cursor out of this region, at which point your application receives a
mouse-moved event.

Figure 2-16 shows how an application might change the cursor from the I-beam cursor to
the arrow cursor after receiving a mouse-moved event.
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Figure 2-16 Changing the cursor from the I-beam cursor to the arrow cursor
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Note that your application should recalculate the mouseRgn parameter when it receives
a mouse-moved event; otherwise, it will continue to receive mouse-moved events as long
as the cursor position is outside the original region.

After receiving any event other than a high-level event, the MyEvent Loop procedure
(shown in Listing 2-2 on page 2-24) calls the application-defined procedure
MyAdjustCursor to adjust the cursor. After adjusting the cursor, if the event is an
operating-system event, the DoEvent procedure calls the DoOSEvent procedure. The
DoOSEvent procedure calls the DoIdle procedure for mouse-moved events. The
DoIdle procedure simply calls TEId1e to blink the caret in the text-editing window.

Listing 2-15 shows the application-defined routine MyAdjustCursor.

Listing 2-15 Changing the cursor

PROCEDURE MyAdjustCursor (mouse: Point; VAR region: RgnHandle) ;
VAR

window: WindowPtr;
arrowRgn: RgnHandle;
iBeamRgn: RgnHandle;
iBeamRect: Rect;
myData: MyDocRecHnd;
windowType: Integer;

BEGIN

window := FrontWindow;

{determine the type of window--document, modeless, etc.}
windowType := MyGetWindowType (window) ;
CASE windowType OF

kMyDocWindow:
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BEGIN
{initialize regions for arrow and I-beam}
arrowRgn := NewRgn;
ibeamRgn := NewRgn;

{set arrow region to large region at first}
SetRectRgn (arrowRgn, -32768, -32768, 32766, 32766) ;

{calculate I-beam region}
{first get the document's TextEdit view rectangle}
myData := MyDocRecHnd (GetWRefCon (window) ) ;

AA

iBeamRect := myData””.editRec™”.viewRect;
SetPort (window) ;
WITH iBeamRect DO
BEGIN
LocalToGlobal (topLeft) ;
LocalToGlobal (botRight) ;
END;
RectRgn (iBeamRgn, iBeamRect) ;
WITH window”.portBits.bounds DO
SetOrigin(-left, -top);
{intersect I-beam region with window's visible region}
SectRgn (iBeamRgn, window”.visRgn, iBeamRgn) ;
SetOrigin(0,0) ;

{calculate arrow region by subtracting I-beam region}
DiffRgn (arrowRgn, iBeamRgn, arrowRgn) ;

{change the cursor and region parameter as necessary}
IF PtInRgn(mouse, iBeamRgn) THEN {cursor is in I-beam rgn}

BEGIN
SetCursor (GetCursor (iBeamCursor) **) ; {set to I-beam}
CopyRgn (iBeamRgn, region) ; {update the region param}
END;

{update cursor if in arrow region}
IF PtInRgn(mouse, arrowRgn) THEN {cursor is in arrow rgn}

BEGIN
SetCursor (arrow) ; {set cursor to the arrow}
CopyRgn (arrowRgn, region) ; {update the region param}
END;

DisposeRgn (iBeamRgn) ;
DisposeRgn (arrowRgn) ;
END; {of kMyDocWindow}
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kMyGlobalChangesID:
MyCalcCursorRgnForModelessDialogBox (window, region) ;

kNil:
BEGIN
MySetRegionNoWindows (kNil, region) ;
SetCursor (arrow) ;
END;
END; {of CASE}
END;

The MyAdjustCursor procedure sets the cursor appropriately, according to whether a
document window or modeless dialog box is active.

For a document window, the code in Listing 2-15 defines two regions, specified by

the arrowRgn and iBeamRgn variables. If the cursor is inside the region described

by the arrowRgn variable, the code sets the cursor to the arrow cursor and returns the
region described by arrowRgn. Similarly, if the cursor is inside the region described
by the iBeamRgn variable, the code sets the cursor to the I-beam cursor and returns
the region described by iBeamRgn.

The MyAdjustCursor procedure calculates the two regions by first setting the arrow
region to the largest possible region. It then sets the I-beam region to the region described
by the document’s TextEdit view rectangle. This region typically corresponds to the
content area of the window minus the scroll bars. (If your application doesn’t

use TextEdit for its document window, then set this region as appropriate to your
application.) The code then adjusts the I-beam region so that it includes only the part of
the content area that is in the window’s visible region (for example, to take into account
any floating windows that might be over the window). The code then sets the arrow
region to include the entire screen except for the region occupied by the I-beam region.

The procedure then determines which region the cursor is in and sets the cursor and
region parameter appropriately.

For modeless dialog boxes (for example, the Global Changes modeless dialog box), the
MyAdjustCursor procedure calls an application-defined routine to appropriately adjust
the cursor for the modeless dialog box. The MyAdjustCursor procedure also
appropriately adjusts the cursor if no windows are currently open.

Handling High-Level Events

High-level events provide a means of communication between applications. Apple
events are high-level events that follow the Apple Event Interprocess Messaging Protocol
(AEIMP). In most cases, you should use Apple events rather than define your own
high-level events if you wish to communicate with other applications. If you plan to use
Apple events, see Inside Macintosh: Interapplication Communication for specific information
on Apple events, and refer to this section for specific details about how the Event
Manager reports high-level events.
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To receive high-level events, you must set the appropriate flags in your application’s
"SIZE' resource. You must set the isHighLevelEventAware flag if your application
is to receive any high-level events. You must set the localAndRemoteHLEvents

flag for your application to receive high-level events sent from another computer on

the network. In addition, to receive high-level events from another computer, your
application must be shared and Program Linking must be enabled. The user shares your
application by selecting your application in the Finder and choosing Sharing from the
File menu and enables Program Linking from the Sharing Setup control panel.

If you set the isHighLevelEventAware flag in your application’s ' SIZE' resource,
your application receives the Finder information in the form of Apple events. The Finder
information is the information your application can use to determine which files to open
or print. Your application must respond to the required Apple events (Open Application,
Open Documents, Print Documents, and Quit Application) that are sent by the Finder if
your application sends or receives high-level events.

The what field in the event record of a high-level event contains the kHighLevelEvent
constant.

To determine the type of high-level event received, your application needs to examine the
message and where fields of the event record. For high-level events, these two fields of
the event record have special meanings.

The message field and the where field of the event record together define the specific
type of high-level event received. Your application should interpret these fields as having
the data type 0OSType, not LongInt or Point.

The message field contains the event class of the high-level event. For example, Apple
events sent by the Edition Manager have the event class 'sect’. You can define your own
group of events that are specific to your application. If you have registered your
application signature with Apple Computer, Inc., then you can use your signature to
define the class of events that belong to your application. Note, however, that Apple
reserves the use of all event classes whose names contain only lowercase letters and
nonalphabetic characters.

For high-level events, the where field in the event record contains a second message
specifier, called the event ID. The event ID defines the particular type of event (or
message) within the class of events defined by the event class. For example, the Section
Read event sent by the Edition Manager has event class 'sect'and event ID 'read'. The
Open Documents event sent by the Finder has event class 'aevt' and event ID 'odoc'.
You can define your own set of event IDs corresponding to your own event class. For
example, if the message field contains 'biff' and the where field contains 'cmd1’, then
the high-level event indicates the type of event defined by 'cmd1’ within the class of
events defined by the application with the signature biff'

Note

If your application supports Apple events, you can call the
AEProcessAppleEvent function to determine the type of Apple event
received, rather than examining the message and where fields.
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Note that because the where field of an event record for a high-level event is used to
select a specific kind of event (within the class determined by the message field),
high-level event records do not contain the mouse location at the time of the event. You
should not interpret the where field before interpreting the what field because different
event classes can contain overlapping sets of event IDs.

Unlike low-level events and operating-system events, high-level events may not be
completely determined by the event record returned to your application when it calls
WaitNextEvent. For example, you might still need to know which other application
sent you the high-level event or what additional data that application wants to send you.
Your application can obtain this further information about the high-level event by calling
the AcceptHighLevelEvent function. The additional information associated with a
high-level event includes

m the identity of the sender of the event

m a unique number that identifies the request associated with the event or associates the
particular event with a request from a previous event

m the address and length of a data buffer that can contain optional data

To obtain this additional information, your application must call
AcceptHighLevelEvent before calling WaitNextEvent again. By convention,
calling AcceptHighLevelEvent indicates that your application intends to process
the high-level event.

To accept an Apple event, call the AEProcessAppleEvent function instead of

the AcceptHighLevelEvent function. The Apple Event Manager also extracts

any additional information associated with the Apple event at your application’s request.
This chapter discusses how to accept high-level events using the
AcceptHighLevelEvent function; for information on the AEProcessAppleEvent
function, see Inside Macintosh: Interapplication Communication.

Responding to Events From Other Applications

You can identify high-level events by the value in the what field of the event record. The
message and where fields further classify the type of high-level event. Your application
can choose to recognize as many events as are appropriate. Some high-level events may
be fully specified by their event record only, while others may include additional
information in an optional buffer. To get that additional information or to find the sender
of the event, use the AcceptHighLevelEvent function.

Note
To respond to an Apple event, use the Apple Event Manager, as
described in Inside Macintosh: Interapplication Communication. ¢

Listing 2-16 on the next page illustrates how to respond to a high-level event.

The DoHighLevelEvent procedure in Listing 2-16 first determines the type of high-
level event received by checking the message and where fields of the event record. It
then uses AcceptHighLevelEvent to get any additional data associated with the
event. This particular application recognizes only one type of high-level event. If the
event is not of this type, the code assumes that the event is an Apple event and calls
AEProcessAppleEvent to handle the event.
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In general, you cannot know in advance how big the optional data buffer is, so you can
allocate a zero-length buffer and then resize it if the call to AcceptHighLevelEvent
returns the buf ferIsSmall result code.

Listing 2-16 Accepting a high-level event

2-70

PROCEDURE DoHighLevelEvent (event: EventRecord) ;

VAR
myTarg: TargetID; {target ID record}
myRefCon: LongInt;
myBuff: Ptr;
myLen: LongInt;
myErr: OSErr;
BEGIN
IF (event.message = LongInt (kMySpecialHLEventClass)) AND
(LongInt (event.where) = LongInt (kMySpecialHLEventID)) THEN
BEGIN
{it's a high-level event that doesn't use AEIMP}
myLen := 0; {start with a 0-byte buffer}
myBuff := NIL;

myErr:=AcceptHighLevelEvent (myTarg, myRefCon, myBuff, myLen) ;
IF myErr = bufferIsSmall THEN

BEGIN
myBuff := NewPtr (myLen) ;{allocate needed storage}
myErr := AcceptHighLevelEvent (myTarg, myRefCon, myBuff,

myLen) ;
IF myErr = noErr THEN
; {perform any action requested by the event}
END;
IF myErr <> noErr THEN
DoError (myErr) ; {perform the necessary error handling}
END
ELSE
BEGIN {otherwise, assume that the event is an Apple event}
myErr := AEProcessAppleEvent (event) ;
IF myErr <> noErr THEN
DoError (myErr) ; {perform the necessary error handling}
END;
END;

The AcceptHighLevelEvent function returns additional information and data
associated with the event. The ID of the sender of the event is returned in the first
parameter, which is a target ID record. You can inspect the fields of that record to
determine which application sent the event. The target ID record contains the session
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reference number that identifies the connection with the other application as well as the
port name and location name of the sender. If the high-level event requires that you
return information, you can use the information returned in the target ID record to
send an event back to the requesting application. See “Determining the Sender of a
High-Level Event” on page 2-72 and “Sending High-Level Events” on page 2-73 for
specific information on the target ID record.

The second parameter to AcceptHighLevelEvent, the reference constant parameter, is
a unique number that identifies the request associated with the event or identifies that
the particular event is related to a request from a previous event. If you send a response
to this event, you should use the same value for the reference constant so that the sender
of the event can associate the reply with the original request.

The third parameter points to any additional data associated with the event. Any data

in this additional buffer is defined by the particular high-level event. On input, the fourth
parameter to AcceptHighLevelEvent, the length parameter, contains the

size of the buffer. If no error occurs, on output the length parameter contains the size

of the message accepted. If the AcceptHighLevelEvent function returns the result
code bufferIsSmall, the length parameter contains the size of the message yet to

be received.

Searching for a Specific High-Level Event

Sometimes you do not want to accept the next available high-level event pending for
your application. Instead, you might want to select one event from among all the
high-level events in your application’s high-level event queue. For example, you might
want to look for a return receipt for a high-level event you previously posted before
processing other high-level events.

You can select a specific high-level event by calling the Get SpecificHighLevelEvent
function. One of the parameters you pass to this function is a filter function that you
provide. Your filter function should examine an event in your application’s high-level
event queue and determine whether it is the kind of event you wish to receive. If it is,
your filter function returns TRUE. This indicates that your filter function does not want to
inspect any more events. If the filter function finds an event of the desired type, it should
call AcceptHighLevelEvent to retrieve the event. When your function returns TRUE,
the GetSpecificHighLevelEvent function itself returns TRUE.

If your filter function returns FALSE for an event in the high-level event queue, then
GetSpecificHighLevelEvent looks at the next event in the high-level event queue
and executes your filter function. If the filter function returns FALSE for all the high-
level events in the queue, then GetSpecificHighLevelEvent itself returns FALSE to
your application.

Here’s how you declare the filter function whose address you pass to the

GetSpecificHighLevelEvent function:

FUNCTION MyFilter (yourDataPtr: Ptr;
msgBuff: HighLevelEventMsgPtr;
sender: TargetID): Boolean;
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When your application calls Get SpecificHighLevelEvent, you pass it a parameter
that indicates the criteria your filter function should use to search for a specific event. The
GetSpecificHighLevelEvent function passes this information to your filter function
in the yourDataPtr parameter. The Get SpecificHighLevelEvent function also
provides your filter function with information about the event record of the high-level
event in the msgBuf f parameter as well as information about the sender of the high-level
event in the sender parameter.

The msgBuf £ parameter contains a pointer to a high-level event message record that has
this structure:

TYPE HighLevelEventMsg =

RECORD
HighLevelEventMsgHeaderLength: Integer;
version: Integer;
reservedl: LongInt;
theMsgEvent: EventRecord;
userRefCon: LongInt;
postingOptions: LongInt;
msgLength: LongInt;

END;

HighLevelEventMsgPtr= “HighLevelEventMsg;

When you call Get SpecificHighLevelEvent and it executes your filter function for a
high-level event waiting in the high-level event queue, the fields of the high-level event
message record are filled in by the Event Manager. You can then compare the fields of this
record to the information in the yourDataPtr parameter to determine whether that
event suits your needs. For example, the yourDataPtr parameter might contain the
signature of a return receipt. You can test its value against the event class of the event
record contained in the theMsgEvent field of the high-level event message record.

Determining the Sender of a High-Level Event

When you receive a high-level event, part of the information returned by
AcceptHighLevelEvent is the identity of the sender of the event. You can use that
information to respond selectively to requests made by other applications or to find
which application to send any replies to. The information about the sender is provided in
the form of a target ID record, defined as follows:

TYPE TargetID =

RECORD
sessionID: LongInt; {session reference number}
name : PPCPortRec; {sender's port name}
location: LocationNameRec; {sender's location name}
recvrName: PPCPortRec; {reserved}

END;
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The sessionID field corresponds to the session reference number created by the PPC
Toolbox. This is a 32-bit number that uniquely identifies a PPC Toolbox session (or
connection) with another application. The name and location fields contain the
sender’s port name and location name. If the sending application is on the same
computer as the receiving application, you can determine the sending application’s
process serial number by calling the Get ProcessSerialNumberFromPortName
function.

Sending High-Level Events

You use the PostHighLevelEvent function to send a high-level event to another
application. When doing so, you need to provide six pieces of information:

m an event record with the event class and event ID assigned appropriately

the identity of the recipient of the event

m a unique number that identifies the communication associated with this
particular event

m a data buffer that can contain optional data
m the length of the data buffer

m options determining how the event is posted

Note

To send an Apple event, use the Apple Event Manager function
AESend. The Apple Event Manager uses the Event Manager to post
Apple events. For information on posting Apple events, see Inside
Macintosh: Interapplication Communication. &

When you post a high-level event to an application on the same computer, you can
specify its recipient in one of four ways:

m by port name and location name (specified in a target ID record)

m by a session reference number

by the application’s creator signature
m by a process serial number

To specify the recipient of a high-level event sent across a network, you can use only

the receiving application’s port name and location name or its session reference number.
You can use any of the four ways when sending high-level events to applications on the
local computer.

You specify the recipient of a high-level event in the receiverID parameter when you
use the PostHighLevelEvent function. To specify a port name and location name,
provide the address of a target ID record in the receiverID parameter. To specify a
process serial number, provide its address in the receiverID parameter. To specify a
session reference number, or signature, provide the data in the receiverID parameter.

When you are replying to a high-level event, it is easy to identify the recipient because
you can use the target ID record that you receive from AcceptHighLevelEvent, the
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session reference number contained in that target ID record, or the process serial number
(if the receiving process is local). Note that replying by session reference number is
always the fastest way to respond to a high-level event.

When you are not replying to a previous event, you need to determine the identity of

the target application yourself. You can use one of several methods to do this. If the target
application is on the local computer, you can search for that application’s creator
signature or its process serial number by calling the Get ProcessInformation
function. See the chapter “Process Manager” in Inside Macintosh: Processes for a detailed
explanation of the Get ProcessInformation function and for examples of how to use
it to generate a list of process serial numbers of all open processes on the local computer.

If the application to which you want to send a high-level event is located on a remote
computer, you need to identify it either by its session reference number or by its port
name and location name. You can call the PPCBrowser function to let the user browse
for a specific port. You can call the IPCListPorts function to obtain a list of all ports
registered with the target PPC Toolbox. See the chapter “Program-to-Program
Communications Toolbox” in Inside Macintosh: Interapplication Communication for an
explanation of both of these functions.

As just described, you can identify the recipient of the high-level event in one of four
ways. Listing 2-17 illustrates how to send a high-level event to an application on the local
computer using the application’s creator signature. In this example, an application is
sending a high-level event to the application with the creator signature of 'boff'. The
specific high-level event being sent is identified by the event class 'bof£f' and the event
ID 'emd1.

Listing 2-17 Posting a high-level event by application signature

PROCEDURE MyPostTest;

VAR
myEvent : EventRecord; {an event record}
myRecvID: OSType; {receiver ID}
myOpts: LongInt; {posting options}
myErr: OSErr;
BEGIN
myEvent .what := kHighLevelEvent;
myEvent .message := LongInt ('boff'); {event class}
myEvent .where := Point (LongInt('cmdl')); {event ID}

{the receiver is identified by its signature and }
{ a return receipt is requested}

myOpts := receiverIDisSignature + nReturnReceipt;

myRecvID := 'boff'; {receiver's signature}

myErr := PostHighLevelEvent (myEvent, Ptr (myRecvID), 0, NIL, O,
myOpts) ;

IF myErr <> noErr THEN
DoError (myErr) ;
END;
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In this example of using the PostHighLevelEvent function, there is no additional data
to transmit, so the sending application provides NIL as the pointer to the data buffer and
sets the buffer length to 0. The myOpt s variable specifies posting options.

Posting options are of two types: delivery options and options associated with the
receiverID parameter. You can specify one or more delivery options to indicate if you
want the other application to receive the event at the next opportunity and to indicate if
you want acknowledgment that the other application received the event. You use the
options associated with the receiverID parameter to indicate how you are specifying
the recipient of the event. To set the various posting options, use these constants:

CONST nAttnMsg = $00000001; {give this message priority}
nReturnReceipt = $00000200; {return receipt requested}
receiverIDisTargetID

$00005000;{ID is port name and location name}
$00006000; {ID is PPC session ref number}
receiverIDisSignature = $00007000;{ID is creator signature}
receiverIDisPSN = $00008000; {ID is process serial number}

receiverIDisSessionID

When you specify the receiving application in the receiverID parameter, you can use
these constants to specify the receiver of the event by port name and location name,
session reference number, process serial number, or signature. Any of these specifications
allows you to send an event to another application on the local computer. For example, in
Listing 2-17 the myOpt s variable indicates that the receiver is identified by its creator
signature, and the myRecvID variable contains the receiver’s creator signature. To send
events to an application on a remote computer, you can specify the recipient only by the
session reference number or by the port name and location name.

When you specify the receiver of the event by port name and location name, use the
receiverIDisTargetID constant in the posting options parameter and specify the
address of a target ID record in the receiverID parameter.

TYPE TargetID =
RECORD

sessionID: LongInt; {unused for posting}

name: PPCPortRec; {recipient's port name}

location: LocationNameRec; {recipient's port loc}

recvrName: PPCPortRec; {unused for posting}
END;

When you pass a target ID record, you need to specify only the name and location
fields. You can use the IPCListPorts function to list all of the existing port names
along with information on whether the port will accept authenticated service on the
computer specified by the location name. For information on how to use the
IPCListPorts function, see the chapter “Program-to-Program Communications
Toolbox” in Inside Macintosh: Interapplication Communication.

You can also use the PPCBrowser function to fill in a target ID record. Listing 2-18 on the
next page illustrates how to use the PPCBrowser function to post a high-level event. In
this example, the sending application wants to locate a dictionary application and have
the dictionary return the definition of a word to it.
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Listing 2-18 Using the PPCBrowser function to post a high-level event

FUN
VAR

BEG

CTION MyPostWithPPCBrowser (aTextPtr: Ptr; textlength: LongInt): OSErr;
myHLEvent : EventRecord;

myErr: OSErr;

myNumTries: Integer;

myPortInfo: PortInfoRec;

myTarget: TargetID;

IN

{use PPCBrowser to get the target}
myErr := PPCBrowser ('Select an Application', 'Application', FALSE,
myTarget.location, myPortInfo, NIL, '');
IF myErr = NoErr THEN
BEGIN
{copy port name into myTarget.name}

myTarget .name := myPortInfo.name;
myHLEvent .what := kHighLevelEvent;
myHLEvent .message := LongInt ('Dict');
myHLEvent .where := Point (LongInt ('Defn')) ;

{if a connection is broken, then sessClosedErr is returned to }
{ pPostHighLevelEvent; to reestablish the connection, just post }

{ the event one more time}

myNumTries := 0;
REPEAT
myErr := PostHighLevelEvent (myHLEvent, @myTarget, 0, aTextPtr,
textlength, receiverIDisTargetID) ;
myNumTries := myNumTries + 1;

UNTIL (myErr <> sessClosedErr) OR (myNumTries > 1);

END;

MyPostWithPPCBrowser := myErr; {return any error}

END;
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The application-defined function in Listing 2-18 uses the PPCBrowser function to
display a dialog box asking the user to select a dictionary. (For additional information

on the PPCBrowser function, see Inside Macintosh: Interapplication Communication.) If

the user selects a dictionary, this code posts a high-level event to that dictionary
application asking for the definition of the selected text. Note that the sending application
and the receiving application must both agree that definition queries are to be of event
class 'Dict'and event ID 'Defn'. It is necessary to define a private protocol only in cases
in which no suitable Apple event exists.
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Note

You should avoid passing handles to the receiving application in an
attempt to share a block of data. It is better to put the relevant data into a
buffer (as illustrated in Listing 2-18) and pass the address of the buffer. If
you absolutely must share data by passing a handle, make sure that the
block of data is located in the system heap. ¢

If a high-level event is posted successfully, PostHighLevelEvent returns the result
code noErr, which indicates only that the event was successfully passed to the PPC
Toolbox. Your application needs to call another Event Manager routine (EventAvail,
GetNextEvent, or WaitNextEvent) to give the other application an opportunity to
receive the event.

The event you send might require the other application to return some information to
your application by sending a high-level event back to your application. You can scan for
the response by using GetSpecificHighLevelEvent. If your application must wait
for this event, you might want to display a wristwatch cursor or take other action as
appropriate to your application. You also might want to implement a timeout mechanism
in case your application never receives a response to the event.

Requesting Return Receipts

When you post a high-level event, you can request a return receipt by including the
nReturnReceipt constant as one of the posting options. This requests that the Event
Manager send your application a high-level event that tells you whether the other
application accepted your event. Note that this does not necessarily mean that the other
application performed any action you might have requested from: it.

A return receipt is a high-level event having an event class and an event ID indicated by
these two constants:

CONST HighLevelEventMsgClass = 'jaym';
rtrnReceiptMsgID = 'rtrn';

Return receipts are posted by the Event Manager on the computer of the receiving
application (and not by the receiving application itself). No data buffer is associated with
a return receipt. However, the posting Event Manager sets the modifiers field of the
high-level event record to one of the following values:

CONST msgWasNotAccepted 0;
msgWasFullyAccepted 1;

msgWasPartiallyAccepted 2;

The msgWasNotAccepted constant indicates that your event was not accepted by

the receiving application. This means that the receiving application was notified

of the arrival of your event (through WaitNextEvent) but did not call
AcceptHighLevelEvent to accept the event. The msgWasFullyAccepted constant
indicates that the receiving application did call AcceptHighLevelEvent and retrieved
all the data in the optional data buffer. The msgWasPartiallyAccepted constant
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indicates that the receiving application called AcceptHighLevelEvent, but the
application’s data buffer was too small to hold the data sent with your application, and
the receiving application called WaitNextEvent before retrieving the rest of the buffer.

Note that a return receipt does not indicate the identity of the receiving application. To
determine on whose behalf the Event Manager has sent you a particular return receipt,
you need to call AcceptHighLevelEvent. When AcceptHighLevelEvent returns
successfully, the sender parameter contains a target ID record with the fields filled in for
the receiving application. With return receipts, the msgLen parameter is 0, the msgBuf £
parameter is NIL, and the msgRefCon parameter contains the unique number of the
refCon parameter of the original high-level event sender (that is, your application).

Handling Apple Events

If your application uses high-level events, your application must respond to the
required Apple events sent by the Finder. The four required Apple events are Open
Application, Open Documents, Print Documents, and Quit Application. See Inside
Macintosh: Interapplication Communication for information on how to handle the required
Apple events.

When your application receives a high-level event (as indicated by the
kHighLevelEvent constant in the what field of the event record), and if your
application supports Apple events, call the AEProcessAppleEvent function. The
AEProcessAppleEvent function provides an easy way for your application to identify
the event class and event ID of the Apple event and to direct the Apple Event Manager to
call the code in your program that handles the Apple event.

To send Apple events to other applications, use the AESend function.

To ensure compatibility and smooth interaction with other Macintosh applications, you
should use the Apple event protocol for high-level events whenever possible. By
implementing the capabilities to send Apple events to and receive Apple events from
other applications, you allow other applications to interact with your application and
provide enhanced capabilities to your users.

See Inside Macintosh: Interapplication Communication for complete information on how to
send and receive Apple events.

Event Manager Reference

This section describes the data structures and routines for the Event Manager and
Operating System Event Manager. It also describes the ' SIZE' resource.

Data Structures

This section describes the event record, target ID record, high-level event message record,
and structure of the Operating System event queue. The Event Manager
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uses event records to return information about events. You can use a target ID record

to specify or identify the address of another application or process with which your
application is communicating. If your application supplies a filter function as a parameter
to the GetSpecificHighLevelEvent function, your filter function

receives information about high-level events in a high-level event message record.

The Event Record

When your application uses an Event Manager routine to retrieve an event, the Event
Manager returns information about the retrieved event in an event record. The
EventRecord data type defines the event record.

TYPE EventRecord =

RECORD
what : Integer; {event code}
message: LonglInt; {event message}
when: LonglInt; {ticks since startup}
where: Point; {mouse location}
modifiers: Integer; {modifier flags}

END;

Field descriptions

what The what field indicates the type of event received. The type of
event can be identified by these constants:

CONST

nullEvent = 0; {no other pending events}
mouseDown = 1; {mouse button pressed}
mouseUp = 2; {mouse button released}
keyDown = 3; {key pressed}

0
1
2
3
keyUp = 4; {key released}
autoKey = 5; {key repeatedly held down}
6; {window needs updating}
7; {disk inserted}
8; {activate/deactivate window}
15; {operating-system event-- }
{ resume, suspend, or }
{ mouse-moved}
kHighLevelEvent = 23;{high-level event}

updateEvt =
diskEvt =
activateEvt =
OosEvt =

Note that in System 7, event types with the values 9 through 14 are
undefined and reserved for future use by Apple. All other values for
the what field are also reserved for use by Apple.
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message

when

where

modifiers

Additional information associated with the event. The interpreta-
tion of this information depends on the event type. The contents of
the message field for each event type are summarized here:

Event type Event message

null, mouse-up, Undefined.

mouse-down

key-up, key-down, Character code and virtual key code in
auto-key low-order word. For Apple Desktop Bus

(ADB) keyboards, the low byte of the
high-order word contains the ADB address
of the keyboard where the keyboard event
occurred. The high byte of the high-order
word is reserved.

update, activate Pointer to the window to update, activate, or
deactivate.
disk-inserted Drive number in low-order word, File

Manager result code in high-order word.

resume The suspendResumeMessage constant in
bits 24-31 and a 1 in bit 0 to indicate the
event is a resume event. Bit 1 contains either
a1 or a0 to indicate if Clipboard conversion
is required, and bits 2-23 are reserved.

suspend The suspendResumeMessage constant in
bits 24-31 and a 0 in bit 0 to indicate the
event is a suspend event. Bit 1 is undefined,
and bits 2-23 are reserved.

mouse-moved The mouseMovedMessage constant in bits
24-31. Bits 2-23 are reserved, and bit 0 and
bit 1 are undefined.

high-level Class of events to which the high-level event
belongs. The message and where fields of
a high-level event define the specific type of
high-level event received.

The when field indicates the time when the event was posted (in
ticks since system startup).

For low-level events and operating-system events, the where field
contains the location of the cursor at the time the event was posted
(in global coordinates).

For high-level events, the where field contains a second event
specifier, the event ID. The event ID defines the particular type of
event within the class of events defined by the message field of the
high-level event. For high-level events, you should interpret the
where field as having the data type OSType, not Point.

The modifiers field contains information about the state of the
modifier keys and the mouse button at the time the event was
posted. For activate events, this field also indicates whether the
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The Target ID Record

window should be activated or deactivated. In System 7 it also
indicates whether the mouse-down event caused your application to
switch to the foreground.

Each of the modifier keys is represented by a specific bit in the
modifiers field of the event record. Figure 2-5, on page 2-20,
shows how to interpret the modifiers field. The modifier keys
include the Option, Command, Caps Lock, Control, and Shift keys.
If your application attaches special meaning to any of these keys in
combination with other keys or when the mouse button is down,
you can test the state of the modifiers field to determine the action
your application should take. For example, you can use this
information to determine whether the user pressed the Command
key and another key to make a menu choice.

When you send a high-level event to another application, you can use the target ID
record to specify the recipient of the event. When you receive a high-level event, the
AcceptHighLevelEvent function uses a target ID record to return information about
the sender of the event.

The TargetID data type defines the target ID record.

TYPE TargetID

RECORD
sessionID: LonglInt; {session reference number}
name: PPCPortRec; {port name}
location: LocationNameRec; {location name}
recvrName: PPCPortRec; {reserved}
END;

Field descriptions
segsgsionID

name

For high-level events that your application receives, this field
contains the session reference number created by the PPC Toolbox.
This is a 32-bit number that uniquely identifies a PPC Toolbox
session (or connection) with another application. This field is not
used by your application when sending a high-level event to
another process. (To send a high-level event that specifies the
recipient by session reference number, provide a pointer to a session
reference number in the receiverID parameter and use the
receiverIDisSessionID constant in the postingOptions
parameter to PostHighLevelEvent.)

For high-level events that your application receives, this field
contains a PPC port record that specifies the port name of the
process from which the high-level event originated. When sending a
high-level event to a process on a local or remote computer, you can
specify the port name of the recipient process in a PPC port record
that you provide in this field.
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If the sending application is on the same computer as the
receiving application, you can determine the sending
application’s process serial number by calling the
GetProcessSerialNumberFromPortName function.

location For high-level events that your application receives, this field
contains a location name record that identifies the location name
of the process from which the high-level event originated. When
sending a high-level event to a process on a local or remote
computer, you can specify the location name of the recipient process
in a location name record that you provide in this field.

recvrName This field is reserved.

The High-Level Event Message Record

You can search your application’s high-level event queue for a specific high-level event

by using the Get SpecificHighLevelEvent function and providing a filter function.

Your filter function receives a pointer to a high-level event message record that contains
information about a high-level event. (See “Filter Function for Searching the High-Level
Event Queue” on page 2-114 for information on how to define a filter function.)

The HighLevelEventMsg data type defines the structure of a high-level event
message record.

TYPE HighLevelEventMsg =

RECORD
HighLevelEventMsgHeaderLength: Integer;
version: Integer;
reservedl: LongInt;
theMsgEvent: EventRecord;
userRefCon: LongInt;
postingOptions: LongInt;
msgLength: LongInt;

END;

Field descriptions

HighLevelEventMsgHeaderLength
Reserved for use by the Event Manager.

version Reserved for use by the Event Manager.
reservedl Reserved for use by the Event Manager.
theMsgEvent The event record of a high-level event. Your filter function can

compare the fields of this event record to determine whether the
high-level event is the desired event. If your filter function finds the
desired event, it should call AcceptHighLevelEvent to accept the
event and remove the event from the high-level event queue, and
return TRUE as its function result.
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userRefCon A unique number that identifies the communication associated with
this event.

postingOptions Reserved for use by the Event Manager.
msgLength Reserved for use by the Event Manager.

The Event Queue

The event queue is a standard Macintosh Operating System queue that the Operating
System Event Manager maintains. Only mouse-up, mouse-down, key-up, key-down,
auto-key, and disk-inserted events are stored in the Operating System event queue. In
most cases, your application should not access the event queue directly. Instead you
usually use the WaitNextEvent function, which can retrieve events from this queue as
well as from other sources.

The event queue consists of a header followed by the actual entries in the queue. The
event queue has the same header as all standard Macintosh Operating System queues.
The Qhdr data type defines the queue header.

TYPE QHdr =
RECORD
gFlags: Integer; {queue flags}
gHead: QElemPtr; {first queue entry}
gTail: QElemPtr; {last queue entry}
END;

The EvQE1 data type defines an entry in the Operating System event queue.

TYPE EvVQEl =

RECORD
gLink: QElemPtr; {next queue entry}
gType: Integer; {queue type (ORD (evType)) }
evtQWhat : Integer; {event code}
evtQMessage: LonglInt; {event message}
evtQWhen: LonglInt; {ticks since startup}
evtQWhere: Point; {mouse location}
evtQModifiers: Integer; {modifier flags}

END;

Each entry in the event queue begins with 4 bytes of flags followed by a pointer to the
next queue entry. The flags are maintained by and internal to the Operating System Event
Manager. The queue entries are linked by pointers, and the first field of the EvQE1 data
type, which represents the structure of a queue entry, begins with a pointer to the next
queue entry. Thus you cannot directly access the flags using the EvQEL data type.
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Event Manager Routines

The Event Manager includes routines for receiving events, receiving and sending
high-level events, and searching for specific high-level events. The Event Manager also
provides routines for converting between process serial numbers and port names, getting
information about the state of the mouse button, reading the keyboard, and getting
timing information.

Receiving Events

2-84

You can use the WaitNextEvent or GetNextEvent function to retrieve an event from
the Event Manager and remove the event from the event stream. To provide greater
support for multitasking, however, you should use the WaitNextEvent function instead
of GetNextEvent whenever possible. You can use the EventAvail function

to look at an event without removing it from the event stream. You can use the
AcceptHighLevelEvent function to get additional information associated with a
high-level event and GetSpecificHighLevelEvent to search for a specific high-

level event.

The FlushEvents procedure removes all low-level events from the Operating System
event queue. In general, your application should not empty the event queue.

You can use the SystemClick procedure to route events to desk accessories when
necessary. The SystemTask and SystemEvent routines are used by the Event Manager,
and your application usually does not need to call these two routines.

You usually use the functions provided by the Toolbox Event Manager to retrieve events
from the event stream. Even if you are interested only in the events stored in the
Operating System event queue, you can retrieve these events using the Toolbox Event
Manager by setting the event mask to mask out all events except keyboard, mouse, and
disk-inserted events. However, you can choose to use Operating System Event Manager
routines to perform this task.

The Operating System Event Manager provides two functions, GetOSEvent and
OSEventAvail, to retrieve events from the Operating System event queue. In most
cases, your application will not need to use these two functions.

If your application needs to receive key-up events, you can change the system event
mask of your application using the SetEventMask procedure. The Get EvQHdAr function
returns a pointer to the header of the Operating System event queue.
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WaitNextEvent

You can use the WaitNextEvent function to retrieve events one at a time from the Event
Manager.

FUNCTION WaitNextEvent (eventMask: Integer;
VAR theEvent: EventRecord; sleep: LonglInt;
mouseRgn: RgnHandle) : Boolean;

eventMask A value that indicates which kinds of events are to be returned; this
parameter is interpreted as a sum of event mask constants. You can use
these constants to specify the event mask:

CONST
mDownMask = 2; {mouse-down event (bit 1)}
mUpMask = 4; {mouse-up event (bit 2)}
keyDownMask = 8; {key-down event (bit 3)}
keyUpMask = 16; {key-up event (bit 4)}
autoKeyMask = 32; {auto-key event (bit 5)}
updateMask = 64; {update event (bit 6)}
diskMask = 128; {disk-inserted event (bit 7)}
activMask = 256; {activate event (bit 8)}
highLevelEventMask

= 1024; {high-level event (bit 10)}
osMask = -32768; {operating-system (bit 15)}

To accept all events, you can specify the everyEvent constant as the
event mask:

CONST
everyEvent = -1; {every event}

If no event of any of the designated types is available, WaitNextEvent
returns a null event. WaitNextEvent determines the next available event
to return based on the eventMask parameter and the priority of the
event.

Events not designated by the event mask remain in the event stream until
retrieved by an application. Low-level events in the Operating System
event queue are kept in the queue until they are retrieved by your
application or another application or until the queue becomes full. Once
the queue becomes full, the Operating System Event Manager begins
discarding the oldest events in the queue.

theEvent  The next available event of the specified type or types. The
WaitNextEvent function removes the returned event from the event
stream and returns the information about the event in an event record.
The event record includes the type of event received and other
information. See “The Event Record,” beginning on page 2-79, for a
description of the fields in the event record.

Event Manager Reference 2-85



DESCRIPTION

2-86

CHAPTER 2

Event Manager

In addition to the event record, high-level events can contain additional
data; you use the AcceptHighLevelEvent or AEProcessAppleEvent
functions to get additional data associated with these events.

sleep The number of ticks (a tick is approximately !/60 of a second) indicating
the amount of time your application is willing to relinquish the processor
if no events (other than null events) are pending for your application. If
you specify a value greater than O for the sleep parameter, your
application relinquishes the processor for the specified time or until an
event occurs.

You should usually specify a value greater than 0 for the sleep parameter
to allow background processes to receive processing time. You should not
set the sleep parameter to a value greater than the number of ticks
returned by GetCaretTime if your application provides text-editing
capabilities. When the specified time expires, and if there are no pending
events for your application, WaitNextEvent returns a null event in the
parameter theEvent.

mouseRgn  Ahandle to a region that specifies a region inside of which mouse

movement does not cause mouse-moved events. In other words, your
application receives mouse-moved events only when the cursor is outside
the specified region. You should specify the region in global coordinates. If
you pass an empty region or a NIL region handle, the Event Manager does
not report mouse-moved events to your application. Note that your
application should recalculate the mouseRgn parameter when it receives a
mouse-moved event, or it will continue to receive mouse-moved events as
long as the cursor position is outside the original mouseRgn.

The WaitNextEvent function returns FALSE as its function result if the event being
returned is a null event or if WaitNextEvent has intercepted the event; otherwise,
WaitNextEvent returns TRUE. The WaitNextEvent function calls the Operating
System Event Manager function SystemEvent to determine whether the event should
be handled by the application or the Operating System.

If no events are pending for your application, WaitNextEvent waits for a specified
amount of time for an event. (During this time, processing time may be allocated to
background processes.) If an event occurs, it is returned as the value of the parameter

theEvent, and WaitNextEvent returns a function result of TRUE. If the specified

time expires and there are no pending events for your application, WaitNextEvent
returns a null event in theEvent and a function result of FALSE.

Before returning an event to your application, WaitNextEvent performs other
processing and may intercept the event.

The WaitNextEvent function intercepts Command-Shift-number key sequences and
calls the corresponding 'FKEY' resource to perform the associated action. The Event
Manager’s processing of Command-Shift-number key sequences with numbers 3
through 9 can be disabled by setting the ScrDmpEnable global variable (a byte) to 0.

The WaitNextEvent function also makes the alarm go off if the alarm is set and
the current time is the alarm time. The user sets the alarm using the Alarm Clock
desk accessory.
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The WaitNextEvent function also calls the SystemTask procedure, which gives time
to each open desk accessory or device driver to perform any periodic action defined
for it. A desk accessory or device driver specifies how often the periodic action should
occur, and SystemTask gives time to the desk accessory or device driver at the
appropriate interval.

Some high-level events may be fully specified by their event records only, while others
may include additional information in an optional buffer. To get any additional
information and to find the sender of the event, use the AcceptHighLevelEvent
function.

If the returned event is a high-level event and your application supports Apple events,
use the Apple Event Manager function AEProcessAppleEvent to respond to the Apple
event and to get additional information associated with the Apple event.

SPECIAL CONSIDERATIONS

In System 7, if your application is in the foreground and the user opens a desk accessory
or other item from the Apple menu, clicks in the window belonging to another
application or desk accessory, or chooses another process from the Application menu, the
next event reported to your application by the WaitNextEvent function is a suspend
event. After your application is switched out, the Event Manager directs events (other
than events your application can receive in the background) to the newly activated
process until the user switches back to your application or another application.

Note

In a single-application environment in System 6, and in a multiple-
application environment in which the desk accessory is launched in

the application’s partition (for example, a desk accessory opened by the
user from the Apple menu while holding down the Option key), the
Event Manager handles events for desk accessories in a slightly
different manner.

In these environments, when mouse-up, activate, update, and keyboard
events (including keyboard equivalents of menu commands) occur, the
Event Manager checks to see whether the active window belongs to a
desk accessory and whether the desk accessory can handle the event. If
so, it sends the event to the desk accessory and WaitNextEvent returns
FALSE to your application. Also note that in these environments, the
Event Manager returns TRUE for mouse-down events, regardless of
whether the mouse-down event is for a desk accessory or not. For
mouse-down events in these situations, if the mouse button was

pressed while the cursor was in a desk accessory window (as indicated
by the inSystem constant returned by the FindWindow function),

your application should call the SystemClick procedure. The
SystemClick procedure handles mouse-down events as appropriate
for desk accessories, including sending your application an activate
event to deactivate its front window if the desk accessory window needs
to be activated. &
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SEE ALSO
For examples that use the WaitNextEvent function, see Listing 2-1 on page 2-23 and
Listing 2-2 on page 2-24.
To get information about the sender of a high-level event and to retrieve any
additional data associated with the high-level event, see the description of the
AcceptHighLevelEvent function on page 2-90. For details on how to process
an Apple event, see the description of the AEProcessAppleEvent function in
Inside Macintosh: Interapplication Communication.
For information on how to retrieve an event without removing it from the event stream,
see the description of the EventAvail function, immediately following.
EventAvail
You can use the EventAvail function to retrieve the next available event from
the Event Manager without removing the returned event from your application’s
event stream.
FUNCTION EventAvail (eventMask: Integer;
VAR theEvent: EventRecord) : Boolean;
eventMask A value that indicates which kinds of events are to be returned; this
parameter is interpreted as a sum of event mask constants. You can use
these constants to specify the event mask:
CONST
mDownMask = 2; {mouse-down event (bit 1)}
mUpMask = 4; {mouse-up event (bit 2)}
keyDownMask = 8; {key-down event (bit 3)}
keyUpMask = 16; {key-up event (bit 4)}
autoKeyMask = 32; {auto-key event (bit 5)}
updateMask = 64; {update event (bit 6)}
diskMask = 128; {disk-inserted event (bit 7)}
activMask = 256; {activate event (bit 8)}
highLevelEventMask
= 1024; {high-level event (bit 10)}
osMask = -32768; {operating-system (bit 15)}
To accept all events, you can specify the everyEvent constant as the
event mask:
CONST
everyEvent = -1; {every event}
If no event of any of the designated types is available, EventAvail
returns a null event.
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theEvent  The next available event of the specified type or types. The EventAvail
function does not remove the returned event from the event stream, but
does return the information about the event in an event record. The event
record includes the type of event received and other information.

DESCRIPTION

EventAvail returns FALSE as its function result if the event being returned is a null
event; otherwise, EventAvail returns TRUE.

Like WaitNextEvent, the EventAvail function calls the SystemTask procedure to
give time to each open desk accessory or device driver to perform any periodic action
defined for it. The EventAvail function also makes the alarm go off if the alarm is set
and the current time is the alarm time. The user sets the alarm using the Alarm Clock
desk accessory.

SPECIAL CONSIDERATIONS

If EventAvail returns a low-level event from the Operating System event queue, the
event will not be accessible later if, in the meantime, the event queue becomes full and
the event is discarded from it; however, this is not a common occurrence.

SEE ALSO
See “The Event Record,” beginning on page 2-79, for a description of the fields in the
event record.

GetNextEvent

Although you should normally use WaitNextEvent, you can also use the
GetNextEvent function to retrieve events one at a time from the Event Manager.

FUNCTION GetNextEvent (eventMask: Integer;
VAR theEvent: EventRecord) : Boolean;

eventMask A value that indicates which kinds of events are to be returned; this
parameter is interpreted as a sum of event mask constants (listed in
“Setting the Event Mask” beginning on page 2-26). If no event of any of
the designated types is available, GetNextEvent returns a null event.

theEvent  The next available event of the specified type or types. The
GetNextEvent function removes the returned event from the
event stream and returns the information about the event in an
event record. The event record includes the type of event received
and other information.
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GetNextEvent returns FALSE as its function result if the event being returned is a null
event or if GetNextEvent has intercepted the event; otherwise, GetNext Event returns
TRUE. The GetNextEvent function calls the Operating System Manager function
SystemEvent to determine whether the event should be handled by the application or
the Operating System.

Like WaitNextEvent, the GetNextEvent function calls the SystemTask procedure to
give time to each open desk accessory or device driver to perform any periodic action
defined for it. The GetNextEvent function also makes the alarm go off if the alarm is set
and the current time is the alarm time. (The user sets the alarm using the Alarm Clock
desk accessory.)

The GetNextEvent function also intercepts Command-Shift-number key sequences
and calls the corresponding 'FKEY' resource to perform the associated action. The Event
Manager’s processing of Command-Shift-number key sequences with numbers

3 through 9 can be disabled by setting the ScrDmpEnable global variable (a byte) to 0.

SPECIAL CONSIDERATIONS

SEE ALSO

For greater support of the multitasking environment, your application should use
WaitNextEvent instead of GetNext Event whenever possible. If your application does
call GetNextEvent, it should also call the SystemTask procedure.

See “The Event Record,” beginning on page 2-79, for a description of the fields in the
event record. For information on the SystemTask procedure, see page 2-95.

AcceptHighLevelEvent

2-90

After receiving a high-level event (other than an Apple event), use the
AcceptHighLevelEvent function to get any additional information associated
with the event.

FUNCTION AcceptHighLevelEvent (VAR sender: TargetID;
VAR msgRefcon: LongInt;
msgBuff: Ptr;
VAR msgLen: LongInt): OSErr;

sender Identifies the sender of the event; this information is returned in a target
ID record. The sender parameter contains the session reference number
that identifies the connection with the other application and the port name
and location name of the sender.
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msgRefcon Uniquely identifies the communication associated with this event. If you
send a response to this event, you should specify the same value for the
msgRefcon parameter so that the sender of the event can associate the
reply with the original request.

msgBuff Specifies where the AcceptHighLevelEvent function should return any
additional data associated with the event. Your application is responsible
for allocating the memory for the additional data pointed
to by the msgBuf f parameter and for setting the msgLen parameter to the
number of bytes that you have allocated for the data.

If the msgBuf f parameter points to an area in memory that is

not large enough to hold all the data associated with the event,
AcceptHighLevelEvent returns as much data as the specified
memory area can hold, returns the amount of data remaining in the
msgLen parameter, and returns the result code bufferIsSmall.

msgLen Contains the size of the data (in bytes) pointed to by the msgBuf £
parameter. If AcceptHighLevelEvent returns the result code
bufferIsSmall, the msgLen parameter contains the number of bytes
remaining. You can call AcceptHighLevelEvent again to receive the
rest of the data.

DESCRIPTION

When your application receives a high-level event, you can use the
AcceptHighLevelEvent function to get additional data associated with the
event. The AcceptHighLevelEvent function returns information that identifies
the sender of the event and the unique message reference constant of the event.

Your application should allocate memory for any additional data associated with the
event, then supply a pointer to the data area and also provide the length in bytes of the
data area.

SPECIAL CONSIDERATIONS

The AcceptHighLevelEvent function may move or purge memory. You should not
call this function from within an interrupt, such as in a completion routine or VBL task.

ASSEMBLY-LANGUAGE INFORMATION
The trap macro and routine selector for the AcceptHighLevelEvent function are

Trap macro Selector
_OSDispatch $0033

RESULT CODES
noErr 0 No error
bufferIsSmall -607 Buffer is too small
noOutstandingHLE -608 No outstanding high-level event
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For details on how to process an Apple event using the AEProcessAppleEvent
function, see Inside Macintosh: Interapplication Communication.

GetSpecificHighLevelEvent

DESCRIPTION

2-92

You can use the GetSpecificHighLevelEvent function to select and optionally
retrieve a specific high-level event from your application’s high-level event queue.

FUNCTION GetSpecificHighLevelEvent
(aFilter: GetSpecificFilterProcPtr;
yourDataPtr: UNIV Ptr; VAR err: OSErr): Boolean;

aFilter Specifies the filter function that GetSpecificHighLevelEvent should
use to search for a specific event. Get SpecificHighLevelEvent calls
your filter function once for each event in your application’s high-level
event queue until your filter function returns TRUE or the end of the queue
is reached.

yourDataPtr
Specifies the criteria your filter function should use to select a specific
event. For example, in the yourDataPtr parameter you can specify a
reference constant to search for a particular event, a pointer to a target ID
record to search for a specific sender of an event, or an event class to
search for a specific class of event.

err GetSpecificHighLevelEvent returns in this parameter a value
indicating if any errors occurred. The err parameter contains the noErr
constant if no errors occurred or noOut standingHLE if no high-level
events are pending in your application’s high-level event queue.

You can use the GetSpecificHighLevelEvent function to search for a specific
high-level event in your application’s high-level event queue. You provide a pointer to a
filter function as one of the parameters to Get SpecificHighLevelEvent. The
GetSpecificHighLevelEvent function calls your filter function once for every event
in your application’s high-level event queue, until your filter function returns TRUE or
the end of the queue is reached.

The GetSpecificHighLevelEvent function passes the value you specify in the
yourDataPtr parameter to your filter function. Your filter function also receives as
parameters the event record associated with the high-level event and the target ID record
that identifies the sender of the event. Your filter function can compare the contents of the
yourDataPtr parameter with any of the other information it receives.

If your filter function finds a match, it can call AcceptHighLevelEvent if necessary,
and then return TRUE. If your filter function does not find a match, then it should
return FALSE.
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If your filter function returns TRUE, the GetSpecificHighLevelEvent function
returns TRUE. If your filter function returns FALSE for all high-level events in your
application’s event queue, or if there are no high-level events in the queue,
GetSpecificHighLevelEvent returns FALSE.

SPECIAL CONSIDERATIONS

The GetSpecificHighLevelEvent function may move or purge memory. You
should not call this function from within an interrupt, such as in a completion routine
or VBL task.

ASSEMBLY-LANGUAGE INFORMATION

The trap macro and routine selector for the Get SpecificHighLevelEvent
function are

Trap macro Selector
_OSDispatch $0045

SEE ALSO
See “Filter Function for Searching the High-Level Event Queue” on page 2-114 for more
information about how to define a filter function and the parameters that
GetSpecificHighLevelEvent passes to your filter function.

FlushEvents

The FlushEvents procedure removes low-level events from the Operating System
event queue. Note that FlushEvents does not remove any types of events not stored
in the Operating System event queue.

You can choose to use the FlushEvents procedure when your application first starts to
empty the Operating System event queue of any keystrokes or mouse events generated
by the user while the Finder loaded your application. In general, however, your
application should not empty the queue at any other time as this loses user actions and
makes your application and the computer appear unresponsive to the user.

PROCEDURE FlushEvents (whichMask: Integer; stopMask: Integer) ;
whichMask A value that indicates which kinds of low-level events are to be removed
from the Operating System event queue; this parameter is interpreted

as a sum of event mask constants. The whichMask and stopMask
parameters together specify which events to remove.
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stopMask A value that limits which low-level events are to be removed from the
Operating System event queue; this parameter is interpreted as a sum
of event mask constants. FlushEvents does not remove any low-
level events that are specified by the stopMask parameter. To remove
all events specified by the whichMask parameter, specify 0 as the
stopMask parameter.

DESCRIPTION
FlushEvents removes only low-level events stored in the Operating System event

queue; it does not remove activate, update, operating-system, or high-level events.

You specify which low-level events to remove using the whichMask and stopMask
parameters. FlushEvents removes the low-level events specified by the whichMask
parameter, up to but not including the first event of any type specified by the
stopMask parameter.

If the event queue doesn’t contain any of the events specified by the whichMask
parameter, FlushEvents does not remove any events from the queue.

ASSEMBLY-LANGUAGE INFORMATION

You must set up register DO with the event mask (whichMask) and stop mask before
calling FlushEvents. When FlushEvents returns, register DO contains 0 if all events
were removed from the queue or, if all events were not removed from the queue, an
event code that specifies the type of event that caused the removal process to stop.
Registers on entry

DO Event mask (low-order word)

Stop mask (high-order word)

Registers on exit

DO 0 if all events were removed from the queue, or the event code
of the event that stopped the search (low-order word)

SEE ALSO
See “Setting the Event Mask” beginning on page 2-26 for information on how to specify
an event mask.

SystemClick

After receiving a mouse-down event, your application should call the Window
Manager function FindWindow to determine where the cursor was when the mouse
button was pressed. If FindWindow returns the inSysWindow constant, call the
SystemClick procedure to handle the event.

PROCEDURE SystemClick (theEvent: EventRecord;
theWindow: WindowPtr) ;
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theEvent The event record for the event.

theWindow The window in which the mouse-down event occurred. Pass the window
pointer returned by FindWindow in this parameter.

If a mouse-down event occurred in a desk accessory’s window, the SystemClick
procedure determines which part of the desk accessory’s window the cursor was in when
the mouse button was pressed and routes the event to the appropriate desk accessory as
necessary.

If the mouse button was pressed while the cursor was in the content region of the desk
accessory’s window and the window is active, SystemClick sends the mouse-down
event to the desk accessory to process. If the mouse-down event occurred in the content
region of the window and the window is inactive, SystemC1lick makes it the active
window. It does this by sending your application an activate event to deactivate its
front window and directing an event to the desk accessory to activate its window.

If the mouse button was pressed while the cursor was in the drag region or go-away
region, SystemClick calls the Window Manager routine DragWindow or
TrackGoAway, as appropriate. If TrackGoAway reports that the user closed the desk
accessory, SystemClick sends a close message to the desk accessory.

See “The Event Record,” beginning on page 2-79, for a description of the fields in the
event record.

DESCRIPTION

In a multiple-application environment, the WaitNextEvent function is responsible for
giving time to each open desk accessory or driver to perform any periodic action. You
should not call SystemTask if your application calls WaitNextEvent.

If your application calls GetNextEvent, your application should call the SystemTask
procedure.

PROCEDURE SystemTask;

The SystemTask procedure gives time to each open desk accessory or driver to
perform the periodic action defined for it. A desk accessory or device driver specifies
how often the periodic action should occur, and SystemTask gives time to the desk
accessory or device driver at the appropriate interval.

If your application calls GetNextEvent, your application should call SystemTask at
least every sixtieth of a second. This usually corresponds to calling SystemTask once

Event Manager Reference 2-95



CHAPTER 2

Event Manager

each time through your event loop. If your application does a large amount of
processing, you may need to call SystemTask more than once in your event loop.

SEE ALSO
For a description of the WaitNextEvent function and the GetNextEvent function, see
page 2-85 and page 2-89, respectively.

SystemEvent
The WaitNextEvent and GetNextEvent functions call the SystemEvent function. In
most cases your application should not call the SystemEvent function.
The SystemEvent function determines if a specific event should be handled by the
application or the Operating System.
FUNCTION SystemEvent (theEvent: EventRecord): Boolean;
theEvent  The event record for the event.

DESCRIPTION

SystemEvent returns FALSE as its function result if the event should be handled by the
application; otherwise, SystemEvent takes any appropriate actions and returns TRUE.

For activate, update, mouse-up, and keyboard events (including keyboard equivalents of
commands), SystemEvent checks to see whether the active window belongs to a desk
accessory and whether that desk accessory can handle that type of event. If so,
SystemEvent sends the event to the desk accessory and returns TRUE. Otherwise,
SystemEvent returns FALSE.

For mouse-down events and null events, SystemEvent returns FALSE.

For disk-inserted events, SystemEvent attempts to mount the disk using the
PBMountVol function but returns FALSE so that the application can perform further
processing if necessary.

ASSEMBLY-LANGUAGE INFORMATION

SEE ALSO

2-96

If the SEvtEnb global variable (a byte) contains 0, SystemEvent always returns FALSE.

See “The Event Record,” beginning on page 2-79, for a description of the fields in the
event record. For a description of the PBMountVol function, see the chapter “File
Manager” in Inside Macintosh: Files.
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GetOSEvent

DESCRIPTION

The Toolbox Event Manager calls the GetOSEvent function to retrieve low-level events
stored in the Operating System event queue. In most cases your application should not
use this function.

FUNCTION GetOSEvent (mask: Integer;
VAR theEvent: EventRecord): Boolean;

mask A value that indicates which kinds of events are to be returned; this
parameter is interpreted as a sum of event mask constants. GetOSEvent
returns only low-level events stored in the Operating System event queue;
it does not return activate, update, operating-system, or high-level events.
If no low-level event of any of the designated types is available,
GetOSEvent returns a null event.

theEvent  The next available low-level event of the specified type or types in the
Operating System event queue. The GetOSEvent function removes the
returned event from the Operating System event queue and returns the
information about the event in an event record. The event record includes
the type of event received and other information.

The GetOSEvent function retrieves and removes an event from the Operating System
event queue. GetOSEvent returns FALSE as its function result if the event being
returned is a null event; otherwise, Get OSEvent returns TRUE. GetOSEvent does not
intercept or respond to the event in any way. It also does not process Command-Shift—
number key combinations or process any alarms set by the user through the Alarm Clock
desk accessory.

ASSEMBLY-LANGUAGE INFORMATION

You must set up register AO with the address of an event record and register DO with the
event mask before invoking GetOSEvent. When Get OSEvent returns, register DO
indicates whether the returned event is a null event or an event other than a null event
and the returned event is accessible through register AQ.

Registers on entry
A0 Addpress of event record

DO Event mask (low-order word)

Registers on exit
A0 Address of event record

DO 0 if GetOSEvent returns any event other than a null event, or
-1 if it returns a null event (low-order byte)
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SEE ALSO
See “The Event Record,” beginning on page 2-79, for a description of the fields in the
event record. See “Setting the Event Mask,” beginning on page 2-26, for information on
how to specify an event mask.
OSEventAvail
The Toolbox Event Manager uses the OSEventAvail function to retrieve an event from
the Operating System event queue without removing it. In most cases your application
does not need to use this function.
FUNCTION OSEventAvail (mask: Integer;
VAR theEvent: EventRecord): Boolean;
mask A value that indicates which kinds of events are to be returned; this
parameter is interpreted as a sum of event mask constants.
OSEventAvail returns only low-level events stored in the Operating
System event queue; it does not return activate, update, operating-system,
or high-level events. If no low-level event of any of the designated types is
available, OSEventAvail returns a null event.
theEvent  The next available event of the specified type or types. The
OSEventAvail function does not remove the returned event from the
Operating System event queue but does return information about the
event in an event record. The event record includes the type of event
received and other information.
DESCRIPTION

The 0OSEventAvail function retrieves an event from the Operating System event queue
without removing it from the queue. The OSEventAvail function returns FALSE as its
function result if the event being returned is a null event; otherwise, 0SEventAvail
returns TRUE.

OSEventAvail does not intercept or respond to the event in any way:. It also does not
process Command-Shift-number key combinations or process any alarms set by the user
through the Alarm Clock desk accessory.

SPECIAL CONSIDERATIONS

2-98

If the OSEventAvail function returns a low-level event from the Operating System
event queue, the event will not be accessible later if, in the meantime, the event
queue becomes full and the event is discarded from it; however, this is not a common
occurrence.
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ASSEMBLY-LANGUAGE INFORMATION

SEE ALSO

You must set up register A0 with the address of an event record and register DO with the
event mask before invoking OSEventAvail. When OSEventAvail returns, register DO
indicates whether the returned event is a null event or some other event, and the
returned event is accessible through register A0.

Registers on entry

A0 Address of event record

Do Event mask (low-order word)

Registers on exit
A0 Address of event record

DO 0 if OSEventAvail returns any event other than a null event,
or —1 if it returns a null event (low-order byte)

See “The Event Record,” beginning on page 2-79, for a description of the fields in the
event record. See “Setting the Event Mask,” beginning on page 2-26, for information on
how to specify an event mask

SetEventMask

DESCRIPTION

The SetEventMask procedure sets the system event mask of your application to the
specified mask. Your application should not call the SetEventMask procedure to disable
any event types from being posted. Use SetEventMask only to enable key-up events if
your application needs to respond to key-up events.

PROCEDURE SetEventMask (theMask: Integer) ;

theMask An event mask that specifies which events should be posted in the
Operating System event queue.

The SetEventMask procedure sets the system event mask of your application according
to the parameter theMask. The Operating System Event Manager posts only low-level
events (other than update or activate events) corresponding to bits in the system event
mask of the current process when posting events in the Operating System event queue.
The system event mask of an application is initially set to post mouse-up, mouse-down,
key-down, auto-key, and disk-inserted events into the Operating System event queue.
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ASSEMBLY-LANGUAGE INFORMATION

The system event mask of the current application is available in the SysEvtMask system
global variable.

SEE ALSO
For additional information on event masks, see “Setting the Event Mask” beginning on
page 2-26.

GetEvQHdr
The Event Manager uses the Get EvQHdr function to get a pointer to the header of the
Operating System event queue. In most cases your application should not call the
GetEvQHdAr function.
FUNCTION GetEvQHdr: QHArPtr;

DESCRIPTION

The Get EvQHdr function returns a pointer to the header of the Operating System
event queue.

ASSEMBLY-LANGUAGE NOTE

SEE ALSO

The EventQueue system global variable contains the header of the event queue.

See “The Event Queue” on page 2-83 for information on the structure of the Operating
System event queue.

Sending Events

2-100

You can send events to other applications or processes using the PostHighLevelEvent
function. To send Apple events to other applications, use the Apple Event Manager
function AESend. The Operating System Event Manager also provides the PPostEvent
and PostEvent functions for posting low-level events to the Operating System event
queue. The PostEvent function is used by the Toolbox Event Manager. In most cases
your application should not use the PostEvent function.
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PostHighLevelEvent

You can use the PostHighLevelEvent function to send a high-level event to
another application.

FUNCTION PostHighLevelEvent (theEvent: EventRecord;
receiverID: Ptr; msgRefcon: LongInt;
msgBuff: Ptr; msglLen: LongInt;
postingOptions: LongInt): OSErr;

theEvent  The event to send. Your application should fill out the what, message,
and where fields of the event record. Specify the kHighLevelEvent
constant in the what field, the event class of the high-level event in the
message field, and the event ID in the where field. You do not need to fill
out the when or modifiers fields; the Event Manager automatically
assigns the appropriate values to these fields when you send the message.

receiverID
The recipient of the high-level event. When sending an event to another
application on the local computer, you can specify the recipient of the
event by session reference number, process serial number, signature, or
port name and location name. When sending an event to an application on
a remote computer, you can specify the recipient only by the session
reference number or by the port name and location name.

To specify a port name and location name, provide the address of a target
ID record in the receiverID parameter. To specify a process serial
number, provide its address in the receiverID parameter. To specify a
session reference number, or signature, provide the data (cast to the Ptr
data type) in the receiverID parameter.

msgRefcon A unique number that identifies the communication associated with this
event. Your application can set this field to any value it chooses. If you are
replying to a high-level event, you should use the same value in the
msgRefcon parameter as specified in the high-level event that originated
the request.

msgBuff A pointer to a data buffer that contains any additional data for the event.

msgLen The size (in bytes) of the data buffer pointed to by the msgBuf £
parameter.

postingOptions

Options associated with the receiverID parameter and delivery options
associated with the event. You can specify one or more delivery options to
indicate whether you want the other application to receive the event at the
next opportunity and to indicate whether you want acknowledgment that
the event was received by the other application. You use the options
associated with the receiverID parameter to indicate how you are
specifying the recipient of the event—whether by port name and location
name in a target ID record, by session reference number, by process serial
number, or by signature.
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You can use a combination of these constants in the post ingOptions
parameter:

CONST
nAttnMsg

= $00000001; {give this message priority}
nReturnReceipt

= $00000200; {return receipt requested}
receiverIDisTargetID

= $00005000; {ID is port name and location name}
receiverIDisSessionID

= $00006000; {ID is PPC session reference number}
receiverIDisSignature

= $00007000; {ID is creator signature}
receiverIDisPSN

= $00008000; {ID is process serial number}

The PostHighLevelEvent function posts the high-level event to the specified process.

If the application to which you are sending a high-level event terminates, you receive

the result code sessionClosedErr the next time your application calls
PostHighLevelEvent to send another high-level event to the terminated application. If
you do not care about any state information about that session, you can just resend your
event. Otherwise, you must restart another session and resend your event.

If your application is running in the background and posts a high-level event that
requires the network authentication dialog box to be displayed, PostHighLevelEvent
returns the noUserInteractionAllowed result code, does not display the network
authentication dialog box, and does not send the event. If your application receives the
noUserInteractionAllowed result code, you can use the Notification Manager to
inform the user that your application needs attention. When the user brings your
application to the foreground, you can repost the event. If the reposting is successful,
your application can continue to post high-level events without further user interaction.
Note that PostHighLevelEvent can return noUserInteractionAllowed only on
the first posting of a high-level event to a remote target.

SPECIAL CONSIDERATIONS

The PostHighLevelEvent function may move or purge memory. You should not call
this function from within an interrupt, such as in a completion routine or VBL task.

ASSEMBLY-LANGUAGE INFORMATION
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The trap macro and routine selector for the PostHighLevelEvent function are

Trap macro Selector
_OSDhispatch $0034
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SEE ALSO
For details on how to send Apple events to other applications using the AESend function,
see Inside Macintosh: Interapplication Communication.
RESULT CODES
noErr 0 No error
connectionInvalid -609 Connection is invalid
noUserInteractionAllowed  -610 Cannot interact directly with user
sessionClosedErr 917  Session closed
PPostEvent
In most cases your application does not need to post events in the Operating System
event queue; however, if you must do so, you can use the PPostEvent function.
FUNCTION PPostEvent (eventCode: Integer; eventMsg: LonglInt;
VAR gEl: EvQElPtr): OSErr;
eventCode A value that indicates the type of event to post into the Operating System
event queue. The types of events that can be posted in this queue are
represented by these constants: mouseDown, mouseUp, keyDown, keyUp,
autoKey, and diskEvt. Do not attempt to post any other type of event in
the Operating System event queue.
eventMsg  Along integer that contains the contents of the message field for the
event that PPostEvent should post in the queue.
gEl PPostEvent returns a pointer to the event queue entry of the posted
event in this parameter.
DESCRIPTION

In the eventCode and eventMsg parameters, you specify the value for the what and
message fields of the event’s event record. The PPostEvent function fills out the when,
where, and modifiers fields of the event record with the current time, current mouse
location, and current state of the modifier keys and mouse button.

The PPostEvent function returns a pointer to the event queue entry of the posted event
in the gE1 parameter. You can change any fields of the posted event by changing the
fields of its event queue entry. For example, you can change the posted event’s modifier
keys by changing the value of the evtQModifiers field of the event queue entry.

The PPostEvent function posts only events that are enabled by the system event mask.
If the event queue is full, PPostEvent removes the oldest event in the queue and posts
the new event.
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WARNING

Do not post any events other than mouse-down, mouse-up, key-down,
key-up, auto-key, and disk-inserted events in the Operating System
event queue. Attempting to post other events into the Operating
System event queue interferes with the internal operation of the

Event Manager. A

ASSEMBLY-LANGUAGE INFORMATION

RESULT CODES

You must set up register A0 and register DO before invoking PPostEvent. The
PPostEvent function returns values in registers A0 and DO.

Registers on entry
A0 Event number (low-order word)

DO Event message (long)

Registers on exit
A0 Pointer to an event queue entry (long)

DO Result code (low-order word)

evtNotEnb 1 Event type not valid—event not posted
noErr 0 No error

SEE ALSO
For a description of the entries in the event queue, see “The Event Queue” on page 2-83.
PostEvent
The Toolbox Event Manager uses the PostEvent function to post events into the
Operating System event queue. In most cases your application should not call the
PostEvent function.
FUNCTION PostEvent (eventNum: Integer; eventMsg: LonglInt): OSErr;
eventNum A value that indicates the type of event to post into the Operating System
event queue. The types of events that can be posted in this queue are
represented by these constants: mouseDown, mouseUp, keyDown, keyUp,
autoKey, and diskEvt. Do not attempt to post any other type of event in
the Operating System event queue.
eventMsg  Along integer that contains the contents of the message field for the
event that PostEvent should post in the queue.
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In the eventNum and eventMsg parameters, you specify the value for the what and
message fields of the event’s event record. The PostEvent function fills out the when,
where, and modifiers fields of the event record with the current time, current mouse
location, and current state of the modifier keys and mouse button.

The PostEvent function posts only events that are enabled by the system event mask. If
the event queue is full, Post Event removes the oldest event in the queue and posts the
new event.

Note that if you use PostEvent to repost an event, the Post Event function fills out the
when, where, and modifier fields of the event record, giving these fields of the
reposted event different values from the values contained in the original event.

WARNING

Do not post any events other than mouse-down, mouse-up, key-down,
key-up, auto-key, and disk-inserted events in the Operating System
event queue. Attempting to post other events into the Operating
System event queue interferes with the internal operation of the

Event Manager. A

ASSEMBLY-LANGUAGE INFORMATION

RESULT CODES

You must set up register A0 with the event code and register DO with the event
message before invoking PostEvent. When PostEvent returns, register DO
contains the result code.

Registers on entry
A0 Event number (low-order word)

DO Event message (long)

Registers on exit
Do Result code (low-order word)

evtNotEnb 1 Event type not valid—event not posted
noErr 0 No error

Converting Process Serial Numbers and Port Names

The Event Manager provides two functions to convert between process serial

numbers and port names (GetProcessSerialNumberFromPortName and
GetPortNameFromProcessSerialNumber). Both functions are intended to map serial
numbers to port names (or vice versa) for applications open on the local computer. They
do not return useful results for applications open on remote computers.
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GetProcessSerialNumberFromPortName

Use GetProcessSerialNumberFromPortName to get the process serial number of a
process.

FUNCTION GetProcessSerialNumberFromPortName
(portName: PPCPortRec;
VAR PSN: ProcessSerialNumber): OSErr;

portName The port name registered to a process whose serial number you want.

PSN Returns the process serial number of the process designated by the
portName parameter. You can use the returned process serial number to
send a high-level event to that process. Do not interpret the value of the
process serial number.

DESCRIPTION

The GetProcessSerialNumberFromPortName function returns the process serial
number of the process registered at a specific port.

SPECIAL CONSIDERATIONS

The GetProcessSerialNumberFromPortName function does not move or purge
memory but for other reasons should not be called from within an interrupt, such as
in a completion routine or VBL task.

ASSEMBLY-LANGUAGE INFORMATION

The trap macro and routine selector for the Get ProcessSerialNumberFromPortName
function are

Trap macro Selector
_OSDhispatch $0035

RESULT CODES

noErr 0 No error
noPortErr -903 Invalid port name

SEE ALSO

For a description of the PPCPortRec data type, see the chapter “Program-to-Program
Communications Toolbox” in Inside Macintosh: Interapplication Communication.
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GetPortNameFromProcessSerialNumber

Use GetPortNameFromProcessSerialNumber to get the port name of a process.

FUNCTION GetPortNameFromProcessSerialNumber
(VAR portName: PPCPortRec;
PSN: ProcessSerialNumber): OSErr;

portName  Returns the port name of the process designated by the PSN parameter.
You can use the returned port name to send a high-level event to
that process.

PSN The process serial number of the process whose port name you want.

DESCRIPTION

The Get PortNameFromProcessSerialNumber function returns the port name
registered to a process having a specific process serial number.

SPECIAL CONSIDERATIONS

The Get PortNameFromProcessSerialNumber function does not move or purge
memory but for other reasons should not be called from within an interrupt, such as
in a completion routine or VBL task.

ASSEMBLY-LANGUAGE INFORMATION

The trap macro and routine selector for the Get PortNameFromProcessSerialNumber
function are

Trap macro Selector
_OSbhispatch $0046

RESULT CODES
noErr 0 No error
procNotFound -600 No eligible process with specified process
serial number
SEE ALSO

For a description of the PPCPortRec data type, see the chapter “Program-to-Program
Communications Toolbox” in Inside Macintosh: Interapplication Communication.
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Reading the Mouse

GetMouse

The Event Manager provides routines you can use to get information about the mouse.
You can get the current mouse location using the GetMouse procedure. You can use
the But ton function to determine whether the user pressed the mouse button. After
receiving a mouse-down event, you can use the St i11Down function to determine
whether the mouse button is still down, and you can use WaitMouseUp to determine if
the user subsequently released the mouse.

Button

You can use the GetMouse procedure to obtain the current mouse location.
PROCEDURE GetMouse (VAR mouselLoc: Point) ;

mouselLoc Returns the current mouse location in local coordinates of the current
graphics port (for example, the active window). Note that this value
differs from the value of the where field of the event record, which
specifies the mouse location in global coordinates.

DESCRIPTION

SEE ALSO
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You can use the But ton function to determine whether the user pressed the
mouse button.

FUNCTION Button: Boolean;

The But ton function looks in the Operating System event queue for a mouse-down
event. If it finds one, the But ton function returns TRUE; otherwise, it returns FALSE. To
determine whether the mouse button is still down after a mouse-down event, use the
StillDown function.

See “The Event Queue” on page 2-83 for information about the Operating System
event queue.
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StillDown

After receiving a mouse-down event, you can use the Sti1l1Down function to determine
if the mouse button is still down.

FUNCTION StillDown: Boolean;

DESCRIPTION

The stillDown function looks in the Operating System event queue for a mouse
event. If it finds one, the St i11Down function returns FALSE. If it does not find any
mouse events pending in the Operating System event queue, the St 111Down function
returns TRUE.

SEE ALSO

See “The Event Queue” on page 2-83 for information about the Operating System
event queue.

WaitMouseUp

After receiving a mouse-down event, you can use the WaitMouseUp function to
determine if the user subsequently released the mouse.

FUNCTION WaitMouseUp: Boolean;

DESCRIPTION

The WaitMouseUp function looks in the Operating System event queue for a mouse-up
event. If it finds one, the WaitMouseUp function removes the mouse-up event from the
queue and returns TRUE. If it does not find any mouse events pending in the Operating
System event queue, the WaitMouseUp function returns FALSE.

SEE ALSO

See “The Event Queue” on page 2-83 for information about the Operating System
event queue.
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Reading the Keyboard

The Event Manager reports keyboard events one at a time at your application’s request
when you use the WaitNextEvent, EventAvail, or GetNextEvent function. In
addition to getting keyboard events when the user presses or releases a key, you can
directly read the keyboard (and keypad) at any time using the GetKeys procedure.

You can also use the KeyTranslate function to convert virtual key codes to character
code values using a specified 'KCHR' resource.

GetKeys
You can use the GetKeys procedure to obtain the current state of the keyboard.
PROCEDURE GetKeys (VAR theKeys: KeyMap) ;
theKeys Returns the current state of the keyboard, including the keypad, if any.
The GetKeys procedure returns this information using the KeyMap data
type.
TYPE KeyMap = PACKED ARRAY[0..127] OF Boolean;
Each key on the keyboard or keypad corresponds to an element in the
KeyMap array. The index for a particular key is the same as the key’s
virtual key code minus 1. For example, the key with virtual key code 38
(the “J” key on the Apple Keyboard II) can be accessed as KeyMap [37] in
the returned array. A KeyMap element is TRUE if the corresponding key is
down and FALSE if it isn’t. The maximum number of keys that can be
down simultaneously is two character keys plus any combination of the
five modifier keys.
DESCRIPTION
You can use the GetKeys procedure to determine the current state of the keyboard at any
time. For example, you can determine whether one of the modifier keys is down by itself
or in combination with another key using the GetKeys procedure.
KeyTranslate
You can use the KeyTranslate function to convert a virtual key code to a character
code based on a 'KCHR' resource. The KeyTranslate function is also available as the
KeyTrans function.
FUNCTION KeyTranslate (transData: Ptr; keycode: Integer;
VAR state: LongInt): LongInt;
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transData A pointer to the 'KCHR' resource that you want the KeyTranslate
function to use when converting the key code to a character code.

keycode A 16-bit value that your application should set so that bits 0-6 contain the
virtual key code and bit 7 contains either 1 to indicate an up stroke or 0 to
indicate a down stroke of the key. Bits 8—15 have the same interpretation
as the high byte of the modifiers field of the event record and should be
set according to the needs of your application.

state A value that your application should set to 0 the first time it calls
KeyTranslate or any time your application calls KeyTranslate with a
different ' KCHR' resource. Thereafter, your application should pass the
same value for the state parameter as KeyTranslate returned in the
previous call.

The KeyTranslate function returns a 32-bit value that gives the character code for the
virtual key code specified by the keycode parameter. Figure 2-17 shows the structure of
the 32-bit number that KeyTranslate returns.

Figure 2-17 Structure of the KeyTranslate function result

SEE ALSO

31 2423 16 15 8 7 0

Reserved 1 Character code 1 Reserved 2 Character code 2

The KeyTranslate function returns the values that correspond to one or possibly two
characters that are generated by the specified virtual key code. For example, a given
virtual key code might correspond to an alphabetic character with a separate accent
character. For example, when the user presses Option-E followed by N, you can map this
through the KeyTranslate function using the U.S. 'KCHR ' resource to produce n,
which KeyTranslate returns as two characters in the bytes labeled Character code 1
and Character code 2. If KeyTranslate returns only one character code, it is always in
the byte labeled Character code 2. However, your application should always check both
bytes labeled Character code 1 and Character code 2 in Figure 2-17 for possible values
that map to the virtual key code.

For additional information on the ' KCHR' resource and the KeyTranslate function, see
Inside Macintosh: Text.
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Getting Timing Information

TickCount

You can get the current number of ticks since the system last started up using the
TickCount function. You can use this function to compare the number of ticks that have
expired since a given event or other action occurred.

By using the GetDb1Time function, you can get the suggested maximum difference in
ticks that should exist to consider two mouse events a double click. The user can adjust
this value using the Mouse control panel. Using the Get CaretTime function you can get
the suggested maximum difference in ticks that should exist between blinks of the caret
in editable text. The user can adjust this value using the General Controls panel.

DESCRIPTION

You can use the TickCount function to get the current number of ticks (a tick is
approximately /60 of a second) since the system last started up.

FUNCTION TickCount: LongInt;

The TickCount function returns a long integer that indicates the current number of ticks
since the system last started up. You can use this value to compare the number of ticks
that have elapsed since a given event or other action occurred. For example, you could
compare the current value returned by TickCount with the value of the when field of an
event record.

The tick count is incremented during the vertical retrace interrupt, but this interrupt can
be disabled. Your application should not rely on the tick count to increment with absolute
precision. Your application also should not assume that the tick count always increments
by 1; an interrupt task might keep control for more than one tick. If your application
keeps track of the previous tick count and then compares this value with the current tick
count, your application should compare the two values by checking for a “greater than or
equal” condition rather than “equal to previous tick count plus 1.”

WARNING
Don’t rely on the tick count being exact; it’s usually accurate to within
one tick, but this level of accuracy is not guaranteed. A

ASSEMBLY-LANGUAGE NOTE
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The value returned by TickCount is also accessible in the global variable Ticks.
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GetDblTime

DESCRIPTION

To determine whether a sequence of mouse events constitutes a double click, your
application measures the elapsed time (in ticks) between a mouse-up event and a
mouse-down event. If the time between the two mouse events is less than the value
returned by GetDb1Time, your application should interpret the two mouse events
as a double click.

FUNCTION GetDblTime: LongInt;

The GetDb1Time function returns the suggested maximum elapsed time, in ticks,
between a mouse-up event and a mouse-down event. The user can adjust this value
using the Mouse control panel.

If your application distinguishes a double click of the mouse from a single click, your
application should use the value returned by GetDb1Time to make this distinction. If
your application uses TextEdit, the TextEdit procedures automatically recognize and
handle double clicks of text within a TextEdit edit record by appropriately highlighting or
unhighlighting the selection.

ASSEMBLY-LANGUAGE NOTE

The value returned by GetDb1Time is also accessible in the system global variable
DoubleTime.

GetCaretTime

DESCRIPTION

You can use the GetCaretTime function to get the suggested difference in ticks that
should exist between blinks of the caret (usually a vertical bar marking the insertion
point) in editable text. The user can adjust this value using the General Controls panel.

FUNCTION GetCaretTime: LongInt;

If your application supports editable text, your application should use the value returned
by GetCaretTime to determine how often to blink the caret. If your application uses
only TextEdit, you can use TextEdit procedures to automatically blink the caret at the
time interval that the user specifies in the General Controls panel.

ASSEMBLY-LANGUAGE NOTE

The value returned by GetCaretTime is also accessible in the system global
variable CaretTime.

Event Manager Reference 2-113



CHAPTER 2

Event Manager

Application-Defined Routine

When you use GetSpecificHighLevelEvent, you supply a filter function so
that your application can search for a specific event in the high-level event queue
of your application.

Filter Function for Searching the High-Level Event Queue

MyFilter

This section describes the filter function that you can provide to
GetSpecificHighLevelEvent. For example, you might use a filter
function to search for a high-level event sent from a specific application.

DESCRIPTION

2-114

When you use GetSpecificHighLevelEvent to search the high-level event queue
of your application for a specific event, you supply a pointer to a filter function.
GetSpecificHighLevelEvent calls your filter function once for each event in the
high-level event queue until your filter function returns TRUE or the end of the queue
is reached. Your filter function can examine each event and determine whether that
event is the desired event. If so, your filter function should return TRUE.

Here’s how you declare the filter function MyFilter:

FUNCTION MyFilter (yourDataPtr: Ptr;
msgBuff: HighLevelEventMsgPtr;
sender: TargetID): Boolean;

yourDataPtr
Specifies the criteria your filter function should use to select a specific
event. For example, you can specify the yourDataPtr parameter as a
reference constant to search for a particular event, as a pointer to a target
ID record to search for a specific sender of an event, or as an event class to
search for a specific class of event.

msgBuff Contains a pointer to a record of data type HighLevelEventMsg, which
provides: the event record for the high-level event and the reference
constant of the event. The HighLevelEventMsg data type is described in
“The High-Level Event Message Record” on page 2-82.

sender Contains the target ID record of the application that sent the event. The
TargetID data type is described in “The Target ID Record” on page 2-81.

Your filter function can compare the contents of the yourDataPtr parameter with the
contents of the msgBuf f and sender parameters. If your filter function finds a match, it
can call AcceptHighLevelEvent, if necessary, and your filter function should return
TRUE. If your filter function does not find a match, it should return FALSE.
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For information about how to specify your filter function to the
GetSpecificHighLevelEvent function, see page 2-92.

This section explains the structure of a ' SIZE' resource and the meaning of each of its
fields. You are responsible for creating the information in this resource.

The Size Resource

Every application executing in System 7, as well as every application executing under
MultiFinder, should contain a size (' SIZE ') resource. One of the principal functions
of the 'SIZE' resource is to inform the Operating System about the memory size
requirements for the application so that the Operating System can set up an
appropriately sized partition for the application. The 'SIZE' resource is also used to
indicate certain scheduling options to the Operating System, such as whether the
application can accept suspend and resume events. The ' SIZE' resource in System 7
contains additional information indicating whether the application is 32-bit clean,
whether it supports stationery documents, whether it uses TextEdit’s inline input
services, whether the application wishes to receive notification of the termination of
any applications it has launched, and whether the application wishes to receive high-
level events.

A 'SIZE' resource consists of a 16-bit flags field followed by two 32-bit size fields. The
flags field specifies operating characteristics of the application, and the size fields indicate
the minimum and preferred partition sizes for the application. The minimum partition
size is the actual limit below which your application will not run. The preferred partition
size is the memory size at which your application can run most effectively and which the
Operating System attempts to secure upon launching the application. If that amount of
memory is unavailable, the application is placed into the largest contiguous block
available, provided that it is larger than the specified minimum size.

Note

If the amount of available memory is between the minimum and the
preferred sizes, the Finder displays a dialog box asking if the user wants
to run the application using the amount of memory available. If your
application does not have a ' SIZE ' resource, it is assigned a default
partition size of 512 KB and the Process Manager uses a default value

of FALSE for all specifications normally defined by constants in the
flags field.

When you define a ' SIZE' resource, you should give it a resource ID of —1. A user can
modify the preferred size in the Finder’s information window for your application. If the
user does alter the preferred partition size, the Operating System creates a new 'SIZE'
resource having resource ID 0. The Process Manager also creates a new 'SIZE' resource
when the user modifies any of the other settings in the resource.
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In system software version 7.1 the user can also modify the minimum size in the Finder’s
information window for your application. In version 7.1, if the user alters either the
minimum or the preferred partition size, the Operating System creates two new ' SIZE'
resources, one with resource ID 0 and one with resource ID 1.

At application launch time, the Process Manager looks for a ' SIZE' resource with ID 0
for the preferred partition size; if this resource is not found, it uses your original ' SIZE'

resource with ID —1. In version 7.1, the Process Manager looks for a ' SIZE' resource
with ID 0 for the preferred size and looks for a ' SIZE' resource with ID 1 for the
minimum size; if these resources are not found, it uses your original ' SIZE' resource

with ID -1.

Listing 2-19 shows the structure of the ' SIZE' resource in Rez format. See Listing 2-4 in
“Creating a Size Resource,” beginning on page 2-30 for a sample ' SIZE' resource for

an application.

Listing 2-19

type 'SIZE'
boolean
boolean

boolean
boolean

boolean

boolean

boolean

boolean

boolean

boolean

boolean

boolean

boolean
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{

reserved;

ignoreSuspendResumeEvents,
acceptSuspendResumeEvents;

reserved;
cannotBackground,
canBackground;

needsActivateOnFGSwitch,

doesActivateOnFGSwitch;

backgroundAndForeground,

onlyBackground;
dontGetFrontClicks,

getFrontClicks;

ignoreAppDiedEvents,
acceptAppDiedEvents;
not32BitCompatible,
is32BitCompatible;
notHighLevelEventAware,
isHighLevelEventAware;
onlyLocalHLEvents,
localAndRemoteHLEvents;
notStationeryAware,
isStationeryAware;

dontUseTextEditServices,

useTextEditServices;

Event Manager Reference

A Rez template fora ' SIZE' resource

/*reserved*/

/*ignores suspend-resume events*/
/*accepts suspend-resume events*/
/*reserved*/

/*can't use background null events*/
/*can use background null events*/
/*needs activate event following */
/* major switch*/

/*activates own windows in */

/* response to OS events*/

/*app has a user interface*/

/*app has no user interface*/
/*don’'t return mouse events */

/* in front window on resume*/
/*do return mouse events */

/* in front window on resume*/
/*applications use this*/

/*app launchers use this*/

/*works with 24-bit addr*/

/*works with 24- or 32-bit addr*/
/*can't use high-level events*/
/*can use high-level events*/
/*only local high-level events*/
/*also remote high-level events*/
/*can't use stationery documents*/
/*can use stationery documents*/
/*can't use inline services*/
/*can use inline services*/



boolean
boolean
boolean

unsigned
unsigned
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reserved;
reserved;
reserved;

longint;
longint;

/*reserved*/

/*reserved*/

/*reserved*/

/*memory sizes are in bytes*/
/*preferred memory size*/
/*minimum memory sizex/

The nonreserved bits in the flags field have the following meanings:

Flag descriptions

acceptSuspendResumeEvents

canBackground

When set, indicates that your application can process suspend and
resume events (which the Operating System sends to your
application before sending it into the background or when bringing
it into the foreground).

Note

If you set the accept SuspendResumeEvents flag, you should
also set the doesActivateOnFGSwitch flag. ¢

When set, indicates that your application wants to receive null event
processing time while in the background. If your application has
nothing to do in the background, you should not set this flag.

doesActivateOnFGSwitch

onlyBackground

getFrontClicks

When set, indicates that your application takes responsibility for
activating and deactivating any windows in response to a suspend
or resume event. If the accept SuspendResumeEvents flag is set,
if the doesActivateOnFGSwitch flag is not set, and if your
application is suspended, then your application receives an activate
event following the suspend event. However, if you set the
doesActivateOnFGSwitch flag, then your application won't
receive activate events associated with operating-system events, and
you must take care of activation and deactivation when it receives
the corresponding suspend or resume event. This means that if a
window of your application is frontmost, you should treat

a suspend event as though a deactivate event were received as

well (assuming that both the doesActivateOnFGSwitch and
acceptSuspendResumeEvents flags are set). For example, you
should hide scroll bars, hide any caret, and unhighlight any selected
text if your application moves to the background. If you do not set
this flag, the Process Manager creates an offscreen window to force
the activate and deactivate events to occur.

When set, indicates that your application runs only in the back-
ground. Usually this is because it does not have a user interface
and cannot run in the foreground.

When set, indicates that your application is to receive the
mouse-down and mouse-up events that are used to bring your
application into the foreground when the user clicks in your
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application’s frontmost window. Typically, the user simply wants to
bring your application into the foreground, so it is usually not
desirable to receive the mouse events (which would probably move
the insertion point or start drawing immediately, depending on the
application). The Finder is one application, however, that has the
getFrontClicks flag set.

When the user clicks in the front window of your application and
causes a foreground switch, your application receives a resume
event. Your application should activate its front window in response
to the resume event. In this case if your application’s
getFrontClicks flag is not set, your application does not receive
the associated mouse event that caused the foreground switch. If
your application’s get FrontClicks flag is set, your application
does receive the associated mouse event.

Your application always receives the associated mouse event when
the user clicks in one of your application’s windows other than the
front window and causes a foreground switch.

When your application receives a mouse-down event in System 7,
your application can examine bit 0 of the modifiers field of the
event record to determine if the mouse-down event caused a
foreground switch. This information can be especially useful if your
application sets its get Front Clicks flag. For example, your
application can examine bit 0 to determine whether to process the
mouse-down event (probably depending on whether the clicked
item was visible before the foreground switch).

acceptAppDiedEvents
When set, indicates that your application is to be notified whenever
an application launched by your application terminates or crashes.
If the Process Manager is available, your application receives this
information as an Apple event, the Application Died event. See the
chapter “Process Manager” chapter in Inside Macintosh: Processes for
more information about launching applications and receiving
Application Died events.

Note

Some early versions of MultiFinder do not send application-died
events, and your application should not depend on receiving them if
it is running in System 6. These events are provided primarily for
use by debuggers.

ig32BitCompatible
When set, indicates that your application can be run with the 32-bit
Memory Manager. You should not set this flag unless you have
thoroughly tested your application on a 32-bit system (such as
a Macintosh Ilci computer running System 7 in 32-bit mode or under
A/UX).

isHighLevelEventAware
When set, indicates that your application can send and receive
high-level events. If this flag is not set, the Event Manager does
not give your application high-level events when you call
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WaitNextEvent. There is no way to mask out specific types of
high-level events; if this flag is set, your application receives all
types of high-level events sent to your application.
Your application must support the four required Apple events if you
set the isHighLevelEventAware flag. See Inside Macintosh:
Interapplication Communication for information that describes how
to respond to the four required Apple events.

localAndRemoteHLEvents
When set, indicates that your application is to be visible to
applications running on other computers on a network (in addition
to applications running on the local computer). If this flag is not
set, your application does not receive high-level events across
a network.

isStationeryAware
When set, indicates that your application can recognize stationery
documents. If this flag is not set and the user opens a stationery
document, the Finder duplicates the document and prompts the
user for a name for the duplicate document. For information about
how your application can use stationery documents, see the chapter
“Finder Interface” in this book.

useTextEditServices
When set, indicates that your application can use the inline text
services provided by TextEdit. See Inside Macintosh: Text for
information about the inline input capabilities of TextEdit.

The numbers you specify as your application’s preferred and minimum memory sizes
depend on the particular memory requirements of your application. Your application’s
memory requirements depend on the size of your application’s static heap, dynamic
heap, A5 world, and stack. (See “Introduction to Memory Management” in Inside
Macintosh: Memory for complete details about these areas of your application’s partition.)

The static heap size includes objects that are always present during the execution of the
application—for example, code segments, Toolbox data structures for window records,
and so on.

Dynamic heap requirements depend on how many objects are created on a per-
document basis (which may vary in size proportionally with the document itself)
and the number of objects that are required for specific commands or functions.

The size of the A5 world depends on the amount of global data and the number of
intersegment jumps the application contains.

Finally, the stack contains variables, return addresses, and temporary information. The
application stack size varies among computers, so you should base your values for the
stack size according to the stack size required on a Macintosh Plus (8 KB). The Process
Manager automatically adjusts your requested amount of memory to compensate for the
different stack sizes on different machines. For example, if you request 512 KB, more
stack space (approximately 16 KB) will be allocated on machines with larger default stack
sizes.
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Summary of the Event Manager

Pascal Summary

Constants

CONST {event codes}

nullEvent = 0;
mouseDown = 1;
mouseUp = 2;
keyDown = 3;
keyUp = 4;
autoKey = 5;
updateEvt = 6;
diskEvt = 7;
activateEvt = 8;
osEvt = 15;
kHighLevelEvent = 23;
{event masks}

everyEvent = -1;
mDownMask = 2;
mUpMask = 4;
keyDownMask = 8;
keyUpMask = 16;
autoKeyMask = 32;
updateMask = 64;
diskMask = 128;
activMask = 256;
highLevelEventMask = 1024;
osMask = -32768;

{no other pending events}
{mouse button pressed}
{mouse button released}

{key pressed}

{key released}

{key repeatedly held down}
{window needs updating}
{disk inserted}
{activate/deactivate window}
{operating-system events }

{ (suspend, resume, mouse-moved) }
{high-level events }

{ (includes Apple events) }

{every event}

{mouse-down event (bit 1)}
{mouse-up event (bit 2)}
{key-down event (bit 3)}
{key-up event (bit 4)}
{auto-key event (bit 5)}
{update event (bit 6)}
{disk-inserted event (bit 7)}
{activate event (bit 8)}
{high-level event (bit 10)}
{operating-system event (bit 15)}

{message codes for operating-system events}

suspendResumeMessage
mouseMovedMessage =
osEvtMessageMask =
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{flags for suspend and resume events}

resumeFlag = 1; {resume event}

convertClipboardFlag = 2; {clipboard conversion }
{ required}

{event message masks for keyboard events}

charCodeMask= $000000FF; {use to get character code}
keyCodeMask = $0000FF00; {use to get key code}
adbAddrMask = $00FF0000; {ADB address for ADB keyboard}

{constants corresponding to bits in the modifiers field of event}

activeFlag = 1; {bit 0 of low byte--valid only for }

{ activate and mouse-moved events}
btnState = 128; {bit 7 of low byte is mouse button state}
cmdKey = 256; {bit 0 of high byte}
shiftKey = 512; {bit 1 of high byte}
alphalock = 1024; {bit 2 of high byte}
optionKey = 2048; {bit 3 of high byte}
controlKey = 4096; {bit 4 of high byte}

{high-level event posting options}

nAttnMsg = $00000001; {give this message priority}
priorityMask = $000000FF; {mask for priority options}
nReturnReceipt = 300000200; {return receipt requested}
systemOptionsMask = $S00000F00;

receiverIDisTargetID = $00005000; {ID is port name & location}
receiverIDisSessionID = $00006000; {ID is PPC session ref number}
receiverIDisSignature = $00007000; {ID is creator signature}
receiverIDisPSN = $00008000; {ID is process serial number}
receiverIDMask = $0000F000;

{class and ID values for return receipt}
HighLevelEventMsgClass = 'jaym'; {event class of return receipt}
rtrnReceiptMsgID

'rtrn'; {event ID of return receipt}

{modifiers values in return receipt}
msgWasNotAccepted = 0; {recipient did not accept }
{ the message}
msgWasFullyAccepted = 1; {recipient accepted the}
{ entire message}
msgWasPartiallyAccepted

]
N

{recipient did not accept }
{ the entire message}
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Data Types
TYPE

EventRecord =

RECORD
what : Integer; {event code}
message: LonglInt; {event message}
when: LonglInt; {ticks since startup}
where: Point; {mouse location}
modifiers: Integer; {modifier flags}

END;

KeyMap = PACKED ARRAY[0..127] OF Boolean; {records state of keyboard}

TargetID =

RECORD
sessionID: LongInt; {session reference number (not }

{ used if posting an event) }

name: PPCPortRec; {port name}
location: LocationNameRec; {location name}
recvrName : PPCPortRec; {reserved}

END;

TargetIDPtr = “TargetID; {pointer to a target ID record}

Target IDHA1 = “TargetIDPtr; {handle to a target ID record}

HighLevelEventMsg =

RECORD
HighLevelEventMsgHeaderLength: Integer; {reserved}
version: Integer; {reserved}
reservedl: LongInt; {reserved}
theMsgEvent : EventRecord; {event record}
userRefCon: LonglInt; {reference constant}
postingOptions: LongInt; {reserved}
msgLength: LonglInt; {reserved}

END;

HighLevelEventMsgPtr = “HighLevelEventMsg;

HighLevelEventMsgHdl

GetSpecificFilterProcPtr ProcPtr;
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EVQEl =

RECORD
gLink: QElemPtr;
gType: Integer;
evtQWhat: Integer;
evtQMessage: LongInt;
evtQWhen: LongInt;
evtQWhere: Point;

evtQModifiers: Integer;
END;

EVvQElPtr = “EVQEL;

Event Manager Routines

{event queue entry}

{next queue entry}

{queue type (ORD (evType)) }
{event code}

{event message}

{ticks since startup}
{mouse location}

{modifier flags}

Receiving Events

FUNCTION WaitNextEvent (eventMask: Integer; VAR theEvent: EventRecord;

sleep: LonglInt; mouseRgn: RgnHandle): Boolean;

FUNCTION EventAvail (eventMask: Integer; VAR theEvent: EventRecord)
Boolean;

FUNCTION GetNextEvent (eventMask: Integer; VAR theEvent: EventRecord)
Boolean;

FUNCTION AcceptHighLevelEvent

(VAR sender: TargetID; VAR msgRefcon: LonglInt;
msgBuff: Ptr; VAR msglLen: LongInt): OSErr;

FUNCTION GetSpecificHighLevelEvent
(aFilter: GetSpecificFilterProcPtr; yourDataPtr:
UNIV Ptr; VAR err: OSErr)

Boolean;

PROCEDURE FlushEvents (whichMask: Integer; stopMask: Integer) ;

PROCEDURE SystemClick (theEvent: EventRecord; theWindow: WindowPtr) ;

PROCEDURE SystemTask;

FUNCTION SystemEvent (theEvent: EventRecord): Boolean;

FUNCTION GetOSEvent (mask: Integer; VAR theEvent: EventRecord)
Boolean;

FUNCTION OSEventAvail (mask: Integer; VAR theEvent: EventRecord)
Boolean;

PROCEDURE SetEventMask (theMask: Integer) ;

FUNCTION GetEvQHdr : QHdrPtr;

Summary of the Event Manager
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Sending Events

FUNCTION PostHighLevelEvent (theEvent: EventRecord; receiverID: Ptr;
msgRefcon: LongInt; msgBuff: Ptr;
msglLen: LongInt; postingOptions: LongInt)
OSErr;
FUNCTION PPostEvent (eventCode: Integer; eventMsg: Longlnt;
VAR gEl: EvQElPtr): OSErr;

FUNCTION PostEvent (eventNum: Integer; eventMsg: LongInt) : OSErr;

Converting Process Serial Numbers and Port Names

FUNCTION GetProcessSerialNumberFromPortName
(portName: PPCPortRec;
VAR PSN: ProcessSerialNumber) : OSErr;

FUNCTION GetPortNameFromProcessSerialNumber
(VAR portName: PPCPortRec;
PSN: ProcessSerialNumber): OSErr;

Reading the Mouse

PROCEDURE GetMouse (VAR mouseLoc: Point) ;
FUNCTION Button : Boolean;

FUNCTION StillDown : Boolean;

FUNCTION WaitMouseUp : Boolean;

Reading the Keyboard

PROCEDURE GetKeys (VAR theKeys: KeyMap) ;

{the KeyTranslate function is also available as the KeyTrans function}

FUNCTION KeyTranslate (transData: Ptr; keycode: Integer;
VAR state: LongInt): LongInt;

Getting Timing Information

FUNCTION TickCount : LongInt;
FUNCTION GetDblTime : LongInt;
FUNCTION GetCaretTime : LongInt;

Application-Defined Routine

Filter Function for Searching the High-Level Event Queue

FUNCTION MyFilter (yourDataPtr: Ptr;
msgBuff: HighLevelEventMsgPtr;
sender: TargetID): Boolean;
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C Summary

Constants

enum {

}i

enum {

/*event codes*/
nullEvent
mouseDown
mouseUp
keyDown
keyUp
autoKey
updateEvt
diskEvt
activateEvt
osEvt

/*event masks*/
mDownMask
mUpMask
keyDownMask
keyUpMask
autoKeyMask
updateMask
diskMask
activMask
highLevelEventMask
osMask

everyEvent

= 0, /*no other pending events*/
= 1, /*mouse button pressed*/
= 2, /*mouse button released*/
= 3, /*key pressed*/
= 4, /*key released*/
= 5, /*key repeatedly held down*/
= 6, /*window needs updating*/
= 7, /*disk inserted*/
= 8, /*activate/deactivate window*/
= 15, /*operating-system events */
/* (suspend, resume, mouse-moved)*/

= 2, /*mouse-down (bit 1)=*/
= 4, /*mouse-up (bit 2)*/
= 8, /*key-down (bit 3)*/
= 16, /*key-up (bit 4)*/
= 32, /*auto-key (bit 5)*/
= 64, /*update (bit 6)*/
= 128, /*disk-inserted (bit 7)*/
= 256, /*activate (bit 8)*/
= 1024, /*high-level (bit 10)*/
= -32768 /*operating-system (bit 15)*/

= -1, /*every event*/

/*event message masks for keyboard events*/

charCodeMask
keyCodeMask
adbAddrMask
osEvtMessageMask

0x000000FF
0x0000Q0FFO00
0x0O0FFO0000
0xFFO000000

Summary of the Event Manager
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/*message codes for operating-system events*/

mouseMovedMessage = OxFA, /*mouse-moved event*/
suspendResumeMessage = 0x01, /*suspend or resume event*/
/*flags for suspend and resume eventsx*/

resumeFlag =1, /*resume event*/
convertClipboardFlag = 2, /*Clipboard conversion */

/* required*/

/*constants corresponding to bits in the modifiers field of event*/

activeFlag = 1, /*bit 0 of low byte--valid only for */

/* activate and mouse-moved events*/
btnState = 128, /*bit 7 of low byte is mouse button state*/
cmdKey = 256, /*bit 0 of high byte*/
shiftKey = 512, /*bit 1 of high byte*/
alphalock = 1024, /*bit 2 of high byte*/
optionKey = 2048, /*bit 3 of high bytex*/
controlKey = 4096 /*bit 4 of high bytex*/
kHighLevelEvent = 23, /*event code for high-level events */

/* (includes Apple events)*/
/*high-level event posting options*/

receiverIDMask = 0x0000F000, /*mask for receiver ID bits*/
receiverIDisPSN = 0x00008000, /*ID is proc serial number*/
receiverIDisSignature = 0x00007000, /*ID is creator signature*/
receiverIDisSessionID = 0x00006000, /*ID is session ref number*/
receiverIDisTargetID = 0x00005000, /*ID is port name & location*/
systemOptionsMask = 0x00000F00,

nReturnReceipt = 0x00000200, /*return receipt requested*/
priorityMask = 0x000000FF, /*mask for priority options*/
nAttnMsg = 0x00000001, /*give this message priority*/

/*class and ID values for return receipt*/
#define HighLevelEventMsgClass 'jaym'
#define rtrnReceiptMsgID 'rtrn'

/*modifiers values in return receipt*/

msgWasPartiallyAccepted = 2,
msgWasFullyAccepted =1,
msgWasNotAccepted =0
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Data Types

struct EventRecord ({

short what;

long message;
long when;
Point where;
short modifiers;

}i

code*/

message*/

/*event
/*event
/*ticks
/*mouse location*/
/*modifier flags*/

since startup*/

typedef struct EventRecord EventRecord;

typedef long KeyMap[4];

struct TargetID ({
long

PPCPortRec
LocationNameRec
PPCPortRec

}i

typedef struct TargetID TargetID;

typedef TargetID *TargetIDPtr,

/*records state of keyboard*/

sessionID; /*session reference number (not */
/* used i1f posting an event)*/
name; /*port name*/
location; /*location name*/
recvrName; /*reserved*/
**TargetIDHA];

struct HighLevelEventMsg {

unsigned short
unsigned short
unsigned long
EventRecord

unsigned long
unsigned long
unsigned long

}i

HighLevelEventMsgHeaderLength; /*reserved*/
version; /*reserved*/
reservedl; /*reserved*/
theMsgEvent ; /*event recordx*/
userRefCon; /*ref constant*/
postingOptions; /*reserved*/
msgLength; /*reserved*/

typedef struct HighlLevelEventMsg HighLevelEventMsg;

typedef HighLevelEventMsg *HighLevelEventMsgPtr,

struct EvQEl {

/*event queue entry*/

**HighLevelEventMsgHdl ;

QElemPtr gLink; /*next queue entry*/
short qgType; /*queue type (evType)*/
short evtQWhat ; /*event codex/

long evtQMessage; /*event message*/

long evtQWhen; /*ticks since startup*/

Summary of the Event Manager
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evtQWhere;
evtQModifiers;

/*mouse location*/
/*modifier flags*/

Point

short
}i
typedef struct EVQEl EvVQEL;
typedef EvQEl *EvVQElPtr;

typedef pascal Boolean (*GetSpecificFilterProcPtr)
(void *yourDataPtr,
HighLevelEventMsgPtr msgBuff,

const TargetID *sender) ;

Event Manager Routines

Receiving Events

pascal Boolean WaitNextEvent (short eventMask, EventRecord *theEvent,
unsigned long sleep, RgnHandle mouseRgn) ;

pascal Boolean EventAvail (short eventMask, EventRecord *theEvent) ;
pascal Boolean GetNextEvent (short eventMask, EventRecord *theEvent) ;
pascal OSErr AcceptHighLevelEvent

(TargetID *sender,
msgBuff,

unsigned long *msgRefcon,
unsigned long *msglen) ;

pascal Boolean GetSpecificHighLevelEvent
(GetSpecificFilterProcPtr aFilter,

void *yourDataPtr, OSErr *err);

pascal void FlushEvents (short whichMask, short stopMask) ;

(const EventRecord *theEvent,
WindowPtr theWindow) ;

pascal void SystemClick

pascal void SystemTask (void) ;

pascal Boolean SystemEvent (const EventRecord *theEvent) ;
pascal Boolean GetOSEvent (short mask, EventRecord *theEvent) ;
pascal Boolean OSEventAvail (short mask, EventRecord *theEvent) ;
pascal void SetEventMask (short theMask) ;

#define GetEvVQHdr () ( (QHdrPtr) 0x014A)

Sending Events

pascal OSErr PostHighLevelEvent
(const EventRecord *theEvent,

unsigned long
unsigned long
unsigned long
unsigned long
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pascal OSErr PPostEvent (short eventCode, long eventMsg, EVQElPtr *gEl)

pascal OSErr PostEvent (short eventNum, long eventMsg) ;

Converting Process Serial Numbers and Port Names

pascal OSErr GetPortNameFromProcessSerialNumber
(PPCPortPtr portName,
const ProcessSerialNumberPtr pPSN) ;
pascal OSErr GetProcessSerialNumberFromPortName
(const PPCPortPtr portName,
ProcessSerialNumberPtr pPSN) ;

Reading the Mouse

pascal void GetMouse (Point *mouseLoc) ;
pascal Boolean Button (void) ;

pascal Boolean StillDown (void) ;

pascal Boolean WaitMouseUp (void) ;

Reading the Keyboard

pascal void GetKeys (KeyMap theKeys) ;

{the KeyTranslate function is also available as the KeyTrans function}

pascal long KeyTranslate (const void *transData, short keycode,
long *state) ;

Getting Timing Information

pascal unsigned long TickCount

(void) ;
#define GetDblTime () (* (unsigned long*) 0x02FO0)
#define GetCaretTime () (* (unsigned long*) 0x02F4)

Application-Defined Routine

Filter Function for Searching the High-Level Event Queue

pascal Boolean MyFilter (void *yourDataPtr,
HighLevelEventMsgPtr msgBuff,
const TargetID *sender) ;

Summary of the Event Manager 2-129



CHAPTER 2

Event Manager

Assembly-Language Summary

Data Structures

Event Data Structure

0 what
2 message
6 when
10 where
14 modifiers

Target ID Data Structure

0 sessionID
4 name
72 location
106 recvrName

word
long
long
long
word

long

68 bytes
34 bytes
68 bytes

event code

event message
ticks since startup
mouse location
modifier flags

session reference number (not used if posting event)
port name (specified in a PPCPortRec data structure)
location name (specified in a Locat ionNameRec)
reserved

High-Level Event Message Data Structure

0 HighLevelEventMsgHeaderLength

2 version

4 reservedl

8 theMsgEvent
22 userRefCon

26 postingOptions
30 msgLength

Event Queue Header Data Structure

0 gqLink

4 qType

6 evtQWhat

8 evtQMessage
12 evtQWhen

16 evtQWhere

20 evtQModifiers

Trap Macros

word
word
long

16 bytes
long
long
long

long
word
word
long
long
long
word

reserved

reserved

reserved

event record
reference constant
reserved

reserved

next queue entry
queue type

event code

event message
ticks since startup
mouse location
modifier flags

Trap Macros Requiring Routine Selectors

_OSDispatch

Selector Routine

$0033 AcceptHighLevelEvent
$0034 PostHighLevelEvent
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Selector Routine

$0035 GetProcessSerialNumberFromPortName
$0045 GetSpecificHighLevelEvent

$0046 GetPortNameFromProcessSerialNumber

Trap Macros Requiring Register Setup

Trap macro name
_FlushEvents

_GetOSEvent

_OSEventAvail

__PostEvent

Global Variables

Registers on entry Registers on exit
DO0: event mask (low-order word) DO: 0 if all events were removed from the
stop mask (high-order word) queue, or the event code of the event
that stopped the search (low-order
word)

AO0: address of event record

DO0: event mask (low-order word) DO0: 0 if GetOSEvent returns any event
other than a null event, or -1 if it
returns a null event (low-order byte)

AO0: address of event record

DO0: event mask (low-order word) DO0: 0if OSEventAvail returns any event
other than a null event, or -1 if it
returns a null event (low-order byte)

AO0: event code (low-order word)
DO: event message (long word) DO: result code (low-order word)

CaretTime
DoubleTime
EventQueue
KeyRepThresh
KeyThresh
ScrDmpEnable
SEvtEnb

SysEvtMask
Ticks

The suggested difference in ticks that should exist between blinks of the caret
in editable text.

The suggested maximum difference in ticks that should exist between the
time of a mouse-up event and a mouse-down event for your application to
consider those two mouse events a double click.

The header of the event queue.

The value of the auto-key rate (the amount of time, in ticks, that must elapse
before the Event Manager generates a subsequent auto-key event).

The value of the auto-key threshold (the amount of time, in ticks, that must
elapse before the Event Manager generates an auto-key event).

A byte that, if set to 0, disables the Event Manager’s processing of
Command-Shift-number key combinations with numbers 3 through 9.

A byte that, if set to 0, causes the SystemEvent function to always return
FALSE.

The system event mask of the current application.

Along integer that indicates the current number of ticks since the system last
started up.
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Result Codes

noErr

procNotFound
bufferIsSmall
noOutstandingHLE
connectionInvalid
noUserInteractionAllowed
noPortErr
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No error

No eligible process with specified process serial number
Buffer is too small

No outstanding high-level event
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Menu Manager

You can use the Menu Manager to create and manage the menus in your application.
Menus allow the user to view or choose from a list of choices and commands that your
application provides.

All Macintosh applications should provide these standard menus: the Apple menu, the
File menu, and the Edit menu. If you include an Apple menu as a menu of your
application, the Menu Manager automatically adds the Help and Application menus to
your application’s menu bar; it adds the Keyboard menu if more than one keyboard
layout or input method is installed.

Menus are typically stored as resources. This chapter describes the menu-related
resources. See the chapter “Introduction to the Macintosh Toolbox” in this book for
general information on resources and see the chapter “Resource Manager” in Inside
Macintosh: More Macintosh Toolbox for information on Resource Manager routines.
See Macintosh Human Interface Guidelines for additional examples of menus that
incorporate many principles of user interface design. Inside Macintosh: Text contains
further information on localizing your application for worldwide markets.

You can choose to provide help balloons for your application’s menus. See the chapter
“Help Manager” in Inside Macintosh: More Macintosh Toolbox for additional details on
providing help balloons for your application’s menus.

You often present a dialog box to the user as a result of the user’s choice of a menu
command that requires additional information before you can perform the command. See
the chapter “Dialog Manager” later in this book for information on creating dialog boxes
in your application.

For additional information on processing events, see the chapter “Event Manager” earlier
in this book.

This chapter provides an introduction to menus and the menu bar, and it then describes
m various types of menus your application can use

m standard menus

m how to store menus as resources

m how to create menus

m how to create a menu bar

m how to change characteristics of menu items

m how to add items to a menu

Introduction to Menus

A menu is a user interface element you can use in your application to allow the user to
view or choose an item from a list of choices and commands that your application
provides. Menus can appear in several different forms: pull-down menus, hierarchical
menus, and pop-up menus.
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A pull-down menu is identified by a menu title (a word or an icon) in the menu bar. Your
application can use pull-down menus in the menu bar to allow users to choose a
command or perform an action on a selected object. A pop-up menu is a menu that does
not appear in the menu bar, but appears elsewhere on the screen when the user presses
the mouse button while the cursor is in a particular place. Pop-up menus are most often
accessed from a dialog box. Your application can use pop-up menus to let the user select
one choice from a list of many or to set a specific value. A submenu refers to a menu that
is attached to another menu. A menu to which a submenu is attached is referred to as a
hierarchical menu.

Figure 3-1 shows examples of a pull-down menu, a submenu, and a pop-up menu.

Figure 3-1 A pull-down menu, a submenu, and a pop-up menu
Undo Typing *®Z Undo Typing 32
Cut £ Cut ¥H
Copy #C Copy ¥C
Pazia i Pavia i
Clear Clear
Select All #A Select All #A
Speed: 1200 bps .
Create Publisher... Publishing |d Create Publisher... 2400 bps
subscribe To... subscribe To... 9600 bps
Publisher Options... Show Clipboard | Publisher Options... 19200 bps
Show Clipboard

Pull-down menu Submenu Pop-up

3-6

The standard menu bar extends across the top of the startup screen and contains the title
of each available pull-down menu. Your application’s menu bar should always provide at
least the Apple menu, the File menu, and the Edit menu. When you insert the Apple
menu in your application’s menu bar, the Menu Manager automatically adds the Help
and Application menus to your application’s menu bar. It also adds the Keyboard menu
if multiple script systems are installed or if a certain bit is set in the 'it1lc' resource.
Your application can include as many other menus as fit on the smallest screen on which
your application runs, and you should create only as many items as are essential to your
application.

If your application uses a menu bar, you should make it always visible and available for
use. If you do not always wish to display the menu bar (for example, if your application
allows the user to view a screen presentation), you can give the user the option of
viewing the presentation on the entire screen without the menu bar showing. However,
you must provide a way, such as a keyboard equivalent for a command, for the user to
access the menu bar or to make the menu bar reappear.

Using menus in your application allows the user to explore many possible choices and
options without having to choose any particular one. By providing help balloons for
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your menus, you further allow users to learn about the possible actions or consequences
of a particular menu choice without having to choose the menu command to find out
what happens.

Figure 3-2 shows the SurfWriter application’s menu bar with the Edit menu displayed.
This application supports the standard Apple, File, and Edit menus; the Help and
Application menus; and in addition supports two other application-specific menus.

Figure 3-2 The SurfWriter application’s menu bar with the Edit menu displayed

Menu titles Menu titles

— =

Tools Colors @ ﬁ ]* Menu

Toso B

Undo Typing %2 E untitled ————————— 1 bar
I

Cut *H ]

Copy *C

Paste U

Clear

S5elect Al #A

Create Publisher...
Subscribe To...
Publisher Options...

Show Clipboard

Each menu has a menu title and one or more menu items associated with it. You should
name each menu so that the title describes or relates to the actions the user can perform
from that menu. For example, the Edit menu of a typical application contains commands
that let the user edit the contents of a document.

Your application can disable any menu. The Menu Manager indicates that a menu is
disabled by dimming its menu title. (In Figure 3-2, the Colors menu is disabled.) The
Menu Manager dims all menu items of a disabled menu. The user can still pull down and
examine the items in a disabled menu, but cannot choose any of the items.

Your application can also disable individual menu items. The Menu Manager dims the
appearance of a disabled item and does not highlight it when the user rests the cursor on
that item. If the user releases the mouse button while the cursor is over a disabled menu
item, the Menu Manager reports that the user did not choose a menu command. (You can
determine if this happened, however, by using the MenuChoice function.)

In Figure 3-2, the Paste command is disabled; the SurfWriter application disables the Paste
command if the Clipboard is empty. SurfWriter also disables the Publisher Options
command when the current selection does not contain a publisher or a subscriber. As
explained in the chapter “Help Manager” in Inside Macintosh: More Macintosh Toolbox, your
application should provide help balloons for disabled items that describe what the item
normally does and explain why the item is not available at this time.
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Note

Although enabled and disabled are the constants you use in a
resource file to display or to dim menus and menu items, you shouldn’t
use these terms in your help balloons or user documentation. Instead use
the terms menus, menu commands, and menu items for those that are
enabled, and use the terms not available and dimmed to distinguish those
that have been disabled. &

The Menu Manager highlights an enabled menu item when the cursor is over it.
Enabled items do not have a dim appearance and can be chosen by the user.

Your application specifies whether menu items are enabled or disabled when it first
defines and creates a menu. You can also disable or enable menu items at any time after
creating a menu. You should enable a menu item whenever your application allows the
user to choose the action associated with that item, and you should disable an item
whenever the user cannot choose that item. For example, if the user selects text and then
presses the mouse button while the cursor is in the menu bar, you should enable the
Copy command in the Edit menu. You should disable the Copy command in the Edit
menu if the user has not selected anything to copy.

Your application can also specify other characteristics of menu items, such as whether the
item has a marking character next to its text (for example, a checkmark) or whether the
item has a keyboard equivalent (for example, Command-C for the Copy command).
“Menu Items” beginning on page 3-12 describes the characteristics of individual menu
items in more detail.

The user typically chooses commands by moving the cursor to the menu bar and
pressing the mouse button while the cursor is over a menu title. When the user presses
the mouse button while the cursor is in the menu bar, your application should call the
MenuSelect function. The MenuSelect function tracks the mouse, displays and
removes menus as the user drags the cursor through the menu bar, highlights menu titles
as the user drags the cursor over them, displays the menu items associated with a
selected menu, highlights enabled menu items as the user drags through a menu, and
handles all user activity until the user releases the mouse button.

The user chooses a menu item by releasing the mouse button while the cursor is over a
particular enabled menu item. When the user chooses a menu item, the Menu Manager
briefly blinks the chosen menu item (to confirm the choice) and then removes the menu
from the display. The Menu Manager leaves the title of the chosen menu highlighted to
provide feedback to the user.

The MenuSelect function returns information that allows your application to determine
which menu item was chosen. Your application then typically responds by performing
the desired command. When your application completes the requested action, your
application should unhighlight the menu title, indicating to the user that the action is
complete.

The user can move the cursor out of the menu (or menu bar) at any time; the Menu
Manager displays any currently visible menu as long as the mouse button is pressed. (If
the cursor is outside of the menu, the Menu Manager removes any highlighting of the
menu item.) If the user releases the mouse button outside of a menu, the MenuSelect
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function reports that the user did not choose a menu item, and the Menu Manager
removes any currently visible menu. Your application should not take any action if the
user does not choose a menu item.

Menu and Menu Bar Definition Routines

The menu definition procedure and menu bar definition function define the general
appearance and behavior of menus. The Menu Manager uses these routines to display
and perform basic operations on menus and the menu bar.

A menu definition procedure performs all the drawing of menu items within a menu.
When you define a menu, you specify its menu definition procedure. The Menu Manager
uses the specified menu definition procedure to draw the menu items in a menu,
determine which item the user chose from a menu, insert scrolling indicators as items in a
menu, and calculate the menu’s dimensions.

A menu bar definition function draws the menu bar and performs most of the drawing
activities related to the display of menus when the user moves the cursor between them.
Unless you specify otherwise, the Menu Manager uses the standard menu bar definition
function to manage your application’s menu bar. The Menu Manager uses the standard
menu bar definition function to draw the menu bar, clear the menu bar, determine
whether the cursor is in the menu bar or any currently displayed menu, calculate the left
edges of menu titles, highlight a menu title, invert the entire menu bar, erase the
background color of a menu and draw the menu’s structure (shadow), and save or
restore the bits behind a menu.

Apple provides a standard menu definition procedure and standard menu bar definition
function. These definition routines are stored as resources in the System file. The standard
menu definition procedure is the 'MDEF ' resource with resource ID 0. The standard
menu bar definition function is the 'MBDF' resource with resource ID 0.

When you define your menus and menu bar, you specify the definition routines that the
Menu Manager should use when managing them. You'll usually want to use the standard
definition routines for your application. However, if you need a feature not provided by
the standard menu definition procedure (for example, if you want to include more
graphics in your menus), you can choose to write your own menu definition procedure.
See “Writing Your Own Menu Definition Procedure” beginning on page 3-87 for more
information. While the Menu Manager does allow you to specify your own menu bar
definition function, Apple recommends that you use the standard menu bar definition
function.

The Menu Bar

Each application has its own menu bar. The menu bar of an application applies to only
that application. You usually define a menu bar for your application by providing a
menu bar (' MBAR ') resource that lists the order and resource ID of each menu that
appears in your menu bar. You define the menu title and the individual characteristics of
menu items that appear in a menu by providing a menu (' MENU') resource for each
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menu that appears in your menu bar. You use Menu Manager routines to create the
menus and menu bar based on these resource definitions.

Your application can change the enabled state of a menu, add menus to or remove menus
from its menu bar, or change the characteristics of any menu items. Whenever your
application changes the enabled state of a menu or the number of menus in its menu bar,
your application must call the DrawMenuBar procedure to update the menu bar’s
appearance.

The menu bar (as defined by the standard menu bar definition function) is white, with a
height that is tall enough to display menu titles in the height of the system font and
system font size, and with a black lower border that is one pixel tall. The menu bar is as
wide as the screen and always appears on the monitor designated by the user as the
startup screen. (The user selects a startup screen using the Monitors control panel.) The
menu bar appears at the top of the screen, and nothing except the cursor can appear in
front of it. Figure 3-3 shows the menu bar of the SurfWriter application.

Figure 3-3 The menu bar of the SurfWriter application

[ % File Edit Tools Colors (D @ |

The menu bar helps to indicate the active application. The active application is the one
whose menu bar is currently showing and whose icon appears as the menu title of the
Application menu.

The titles of menus appear in the menu bar. A menu title is a text string (except for the
Apple, Help, Keyboard, and Application menus, the titles of which contain a small icon).
Menu titles always appear in the system font and system font size (for Roman scripts, the
system font is Chicago and the system font size is 12).

You can insert any number of menu titles in the menu bar; however, less than 10 is
usually optimum. Keep in mind that not all users have the same size monitor. Design
your menu bar so that all titles can fit in the menu bar of the smallest screen on which
your application can run. You should also consider localization issues when designing
the number of menus that fit in your menu bar—not all menu titles might fit in the menu
bar once the menu titles are translated. For example, English text often grows 50 percent
larger when translated to other languages.

Figure 3-4 shows the SurfWriter application’s menu bar with menu titles that have been
localized for another script system.

Figure 3-4 The SurfWriter application’s menu bar localized for another script system
[ & 2710 BE V-0 N5- BEERE N
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Menus

A menu (as defined by the standard menu definition procedure) is a list of menu items
arranged vertically and contained in a rectangle. The rectangle is shaded and can extend
vertically for the length of the screen. If a menu has more items than will fit on the screen,
the standard menu definition procedure adds a downward-pointing triangular indicator
to the last item on the screen, and it automatically scrolls through the additional items
when the user moves the cursor past the last menu item currently showing on the screen.
When the user begins to scroll through the menu, the standard menu definition
procedure adds an upward-pointing triangular indicator to the top item on the screen to
indicate that the user can scroll the menu back to its original position.

Each menu can have color information associated with it. If you do not define the colors
for your menus in your application’s menu color information table, the Menu Manager
uses the default colors for your menus and menu bar. The default colors are black text on
a white background. In most cases the default colors should meet the needs of your
application. “The Menu Color Information Table Record” on page 3-98 and “The Menu
Color Information Table Resource” on page 3-155 give information on how you can
define colors for your application’s menus.

Your application’s menus can contain any number of menu items. “Menu Items”
(the next section) describes the visual variations that you can use when defining your
menu items.

You typically define the order and resource IDs of the menus in your application’s menu
bar in an 'MBAR' resource. You should define your 'MBAR' resource such that the Apple
menu is the first menu in the menu bar. You should define the next two menus as the File
and Edit menus, followed by any other menus that your application uses. You do not
need to define the Keyboard, Help, or Application menus in your 'MBAR' resource; the
Menu Manager automatically adds them to your application’s menu bar if your
application calls the GetNewMBar function and your menu bar includes an Apple menu
or if your application inserts the Apple menu into the current menu list using the
InsertMenu procedure.

You define the menu title and characteristics of each individual menu item in a ' MENU'
resource. “Creating a Menu Resource” on page 3-43 describes the 'MENU' resource in
more detail.

Pop-up menus do not appear in the menu bar but appear elsewhere on the screen. You
often use pop-up menus in a dialog box when you want the user to be able to make a
selection from a large list of choices. For example, rather than displaying the choices
as a number of radio buttons, you can use a pop-up menu to display the choices at the
user’s convenience.

A hierarchical menu refers to either a pull-down or pop-up menu that has a submenu
attached to it. (However, you should avoid attaching a submenu to a pop-up menu
whenever possible, as this can make the interface more complex and less intuitive to
the user.)
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“Creating a Pop-Up Menu” on page 3-56 gives additional information about pop-up
menus, and “Creating a Hierarchical Menu” on page 3-53 describes hierarchical menus in
more detail.

Menu ltems

A menu item can contain text or can be a line (a divider) separating groups of choices. A
divider is always dimmed, and it has no other characteristics associated with it.

Each menu item (other than dividers) can have a number of visual characteristics:

An icon to the left of the menu item’s text. If you define an icon for a menu item, use
an icon that gives a symbolic representation of the menu item’s meaning or effect. You
can specify an icon, a small icon, a reduced icon, or a color icon as the icon for a menu
item; however, items with small or reduced icons cannot have submenus and cannot
be drawn in a script other than the current system script.

A checkmark or other marking character to the left of the menu item’s text (and to the
left of the item’s icon, if any). Use such a mark if you need to denote the status of the
menu item or the mode it controls. A menu item can have a mark or a submenu, but
not both.

The symbol for the Command key (Ill) and another 1-byte character to the right of the
menu item’s text (referred to as the keyboard equivalent of a command). Use this if your
application allows the user to invoke the menu command from the keyboard by
pressing the Command key and one or more other keys in combination, just as if the
user had chosen the command from the menu. An item that has a keyboard equivalent
cannot have a submenu, a small icon, or a reduced icon and cannot be drawn in a
script other than the current system script.

A triangular indicator to the right of the menu item’s text to indicate that the item has
a submenu. A menu item that has a submenu cannot have a keyboard equivalent, a
marking character, a small icon, or a reduced icon and cannot be drawn in a script
other than the current system script.

A font style—either plain or one of various other styles—for the menu item’s text. You
can set the menu item’s style to bold, italic, underline, outline, shadow, or any
combination of these.

The text of the menu item. Choose words for menu items that declare the action that
occurs when the user chooses the command (usually verbs, such as Print or Save). You
can also use adjectives if the command changes the attribute of a selected object (for
example, Bold or Italic). Unless you specify otherwise, the text of menu items appears
in the script of the system font and system font size (for Roman scripts, the system font
is Chicago and the system font size is 12 points). If you want a menu item’s text to
appear in a script other than the current system script, you can specify a script code for
the text. The Menu Manager draws the item’s text in the script identified by the script
code if the script for the specified script system is installed. A menu item that is drawn
in another script cannot have a submenu, small icon, or reduced icon.

Three ellipsis points (...) as the last character in the text of the menu item. Use ellipses
in the text of menu items to indicate that your application displays a dialog box that
requests more information from the user before executing the command. Do not use
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ellipses in menu items that display informational dialog boxes that do not require
additional information from the user. In addition, you should not use ellipses if your
application displays a confirmation alert after the user chooses a menu command. For
example, if the user makes changes to a document, then chooses the Close command,
your application can display a confirmation alert box, asking the user whether the
document should be saved before closing. This type of command should not contain
ellipses in its text.

If your application displays a dialog box requesting more information in response to
the choice of a menu command, do include ellipses in the menu item’s text. For
example, the Open command includes ellipses in its text because the user must
provide additional information: the name of the file to open. When you request more
information from the user in a dialog box, you should provide an OK button or its
equivalent in the dialog box that the user can select to perform the command. The
dialog box should also include a Cancel button or its equivalent so that the user can
cancel the command. See the chapter “Dialog Manager” in this book for information
on creating dialog boxes.

m A dimmed appearance. When your application disables a menu item, the Menu
Manager dims the menu item to indicate that the user can’t choose it. Note that the
Menu Manager dims the entire menu item, including any mark or icon, the menu text,
and any keyboard equivalent symbol. Divider lines always have a dimmed
appearance, regardless of whether your application enables them or not. When your
application disables an entire menu, the Menu Manager dims the menu title and all
menu items in that menu.

Figure 3-5 shows two menus with menu items that illustrate many of the characteristics
that you can use when defining your menu items.

Figure 3-5 Two menus with various characteristics
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When the primary line direction is right to left (as is the case for non-Roman script
systems such as Arabic) the Menu Manager reverses the order of elements in menu items.
For example, any marking character appears to the far right and any keyboard equivalent
appears to the far left of the menu item’s text.
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On a monitor that is set to display only black and white, the Menu Manager displays
dividers as dotted lines. In all other cases, the Menu Manager displays dividers as
appropriate, based on the current color table. For example, on a monitor set to display
4-bit color or greater, the Menu Manager typically displays dividers as gray lines.

Your menu can contain as many menu items as you wish. However, only the first

31 menu items can be individually disabled (all menu items past 31 are always enabled
if the menu is enabled and always disabled if the menu is disabled). If your menu items
exceed the length of the screen, the user must scroll to view the additional items. Keep
in mind that the fewer the menu items in a menu, the simpler and clearer the menu is
for the user.

Groups of Menu Items

The menu items in a particular menu should be logically related to the title of the menu
and grouped to provide greater ease of use and understanding to the user. You should
separate groups with dividers.

A menu can contain both commands that perform actions and commands that set
attributes. You should use a verb or verb phrase to name commands that perform actions
(for example, Cut, Copy, Paste). You should use an adjective to name commands that set
attributes of a selected object (for example, Bold, Italic, Underline). You should group
menu items by their type: verbs (actions) or adjectives (attributes). Create groups within
each type according to the guidelines described here.

Group action commands that are logically related but independent; this makes your
menus easier to read. For example, the Cut, Copy, Paste, Clear, and Select All commands
in the Edit menu are grouped together; the Create Publisher, Subscribe To, and Publisher
Options commands are grouped together; and the Show Clipboard command is set

off by itself. (Figure 3-5 on page 3-13 shows these commands in the Edit menu of a typical
application.)

Group attribute commands that are interdependent. You typically group a set
of commands that set attributes into either a mutually exclusive group or an
accumulating group.

Group a set of attribute commands together if only one attribute in the group can be in
effect at any one time (a mutually exclusive group). Place a checkmark next to the item that
is currently in effect. If the user chooses a different attribute in the group, move the
checkmark to the newly chosen attribute. For example, Figure 3-6 shows a Colors menu
from the SurfWriter application. The colors listed in the Colors menu form a mutually
exclusive group because only one color can be in effect at any one time. In this example,
green is the color currently in effect. If the user chooses a different color, such as blue, the
SurfWriter application uses the Set ItemMark procedure to remove the checkmark from
the Green command and to place a checkmark next to the Blue command.
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Figure 3-6 Menu items in a mutually exclusive group

You can also group a set of attribute commands together if a number of the attributes in
the group can be in effect at any one time (an accumulating group). In an accumulating
group, use checkmarks to indicate that multiple attributes are in effect. In this type

of group, you also need to provide a command that cancels all the other attributes. For
example, a Style menu that lets the user choose any combination of font styles should
also include a Plain Text command that cancels all the other attributes. Figure 3-7 shows a
Style menu; in this example, the Bold and Outline attributes are both in effect.

Figure 3-7 Menu items in an accumulating group
Plain Text 2T
+ Bold #B
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Underline 3U
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You can also use a combination of checkmarks and dashes to help indicate the state of the
user’s content. For example, in a menu that reflects the state of a selection, place a
checkmark next to an item if the attribute applies to the entire selection; place a dash next
to an item if the attribute applies to only part of the selection. Figure 3-8 shows a Style
menu that indicates that the selection contains more than one style. In this figure, the
Bold attribute applies to the entire selection; the Underline attribute applies to only part
of the selection.

Figure 3-8 Use of a checkmark and dash in an accumulating group
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Your application should adjust its menus appropriately before displaying its menus.

For example, you should add checkmarks or dashes to items that are attributes as
necessary, based on the state of the user’s document and according to the type of window
that is in the front. See “Adjusting the Menus of an Application” on page 3-73 for more
information.

Another way to show the presence or absence of an attribute is to use a toggled
command. Use a toggled command if the attribute has two states and you want to allow
the user to move between the two states using a single menu command. For example,
your application could provide a Show Borders command when the borders surrounding
publishers and subscribers are not showing in a document. When the user chooses the
Show Borders command, your application should show the borders and change the
menu item to Hide Borders. When the user chooses the Hide Borders command, your
application should hide the borders surrounding any publishers or subscribers and
change the menu item to Show Borders. Use a toggled command only when the wording
of the two versions of the command is not confusing to the user. Choose a verb phrase as
the text of a toggled command; the text should clearly indicate the action your
application performs when the user chooses the item. See “Changing the Text of an Item”
on page 3-59 for further information on providing a toggled command.

Keyboard Equivalents for Menu Commands

A menu command can have a keyboard equivalent. The term keyboard equivalent refers
to a keyboard combination, such as Command-C (Ill-C) or any other combination of the
Command key, another key, and one or more modifier keys, that invokes a corresponding
menu command when pressed by the user. For example, if your application supports the
New command in the File menu, your application should perform the same action when
the user presses Command-N as when the user chooses New from the File menu.

The term Command-key equivalent refers specifically to a keyboard equivalent that the
user invokes by holding down the Command key and pressing another key (other than a
modifier key) at the same time. This generates a keyboard event that specifies a 1-byte
character that your application should pass as a parameter to the MenuKey function. The
MenuKey function maps the given 1-byte character to the menu item (if any) with that
Command-key equivalent.

The Menu Manager provides support for Command-key equivalents. If you define a
Command-key equivalent for a menu item, the standard menu definition procedure
draws the Command symbol and the specified 1-byte character to the right of the menu
item’s text (or to the left of the item’s text if the primary line direction is right to left).

You detect a Command-key equivalent of a command by examining the modifiers field
of the event record for a keyboard event. This allows you to determine whether

the Command key was pressed at the same time as the keyboard event. If so, your
application typically calls the MenuKey function, passing as a parameter the character
code that represents the key pressed by the user. The MenuKey function determines if the
1-byte character matches any of the keyboard equivalents defined for your menu items; if
so, MenuKey returns this information to your application. Your application can then

Introduction to Menus



CHAPTER 3

Menu Manager

perform the associated menu command, if any. See the chapter “Event Manager” in this
book for additional information about the modifiers field of the event record.

The keyboard layout (' KCHR ') resource of some keyboards masks or cancels the effect of
the Shift key when the Command key is also pressed. For example, with a U.S. keyboard
layout, when a user presses Command-S, the character code in the message field of the
event record is $73 (the character code for “s”); when a user presses Command-Shift-S,
the character code in the message field of the event record is also $73. However, not all
'"KCHR' resources mask the Shift key in this way.

Furthermore, when your application uses the MenuKey function to process Command-
key equivalents, MenuKey does not distinguish between uppercase and lowercase letters.
The MenuKey function takes the 1-byte character passed to it and calls the UpperText
procedure (which provides localizable uppercase conversion of the character). Thus,
MenuKey translates any lowercase character to uppercase when comparing a keyboard
event to keyboard equivalents. If your application must distinguish between lowercase
and uppercase characters for keyboard equivalents, you need to provide your own
method for handling such keyboard equivalents.

The key you specify for a Command-key equivalent must be a 1-byte character and is
usually a letter (although you can specify 1-byte characters other than letters). For
consistency and to provide greater support for localizing your application, you should
always specify any letters for keyboard equivalents in uppercase when you define your
application’s menu commands.

If you wish to provide other types of keyboard equivalents in addition to Command-key
equivalents, your application must take additional steps to support them. If your
application allows the user to hold down more than one modifier key to invoke a
keyboard equivalent, your application must provide in the menu item a visual indication
that represents this keyboard combination. In most cases your application must use its
own method (other than MenuKey) for mapping the keyboard equivalent to the
corresponding menu item.

If you specify a key other than a letter for a Command-key equivalent or use more than
one modifier key for a keyboard equivalent, you should choose keys and keyboard
combinations that can be easily localized for other regions.

If your application uses other keyboard equivalents, you can examine the state of the
modifier keys and use the KeyTranslate function, if necessary, to help map the
keyboard equivalent to a particular menu item. See the chapter “Event Manager” in this
book for information on the KeyTranslate function, and see the discussion of ' KCHR'
resources in Inside Macintosh: Text for information on how various keyboard combinations
map to specific character codes.

One command that isn’t listed in a menu but can be invoked from the keyboard is the
Command-period (Ill-.) or Cancel command. You detect a Command-period command
in a method similar to the method for detecting other keyboard equivalents—you
examine the modifiers field of a keyboard event to determine whether the Command
key was pressed. In this case, however, if the user pressed the period key in addition to
the Command key, rather than invoking a menu command your application should
cancel the current operation.
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You typically define the Command-key equivalents for your application’s menu
commands when you define the menu commands in a 'MENU"' resource. The Menu
Manager displays the Command-key equivalent for a menu command (if it has one)
to the right of the menu item’s text (or to the left of the item’s text for right-to-left
script systems).

Apple reserves several keyboard equivalents for common commands. You should use
these keyboard equivalents for commands in the File and Edit menus of your application.

Table 3-1 show the keyboard equivalents for standard commands.

Table 3-1 Reserved keyboard equivalents for all systems
Keys Command Menu
H-A Select All Edit
mC Copy Edit
H-N New File
-0 Open... File
B-r Print... File
| NO) Quit File
s Save File
v Paste Edit
m-w Close File
[ D Cut Edit
| 74 Undo Edit
Note

You should use the keyboard equivalents Z, X, C, and V for the editing
commands Undo, Cut, Copy, and Paste in order to provide support for
editing in desk accessories and dialog boxes. &

Apple also reserves several keyboard equivalents for use with worldwide versions of
system software, localized keyboards, and keyboard layouts. Table 3-2 shows these
keyboard equivalents. Your application should not use the keyboard equivalents listed in
Table 3-2 for its own menu commands.

See Inside Macintosh: Text for more discussion of handling keyboard equivalents in other
script systems.

The key combinations listed in Table 3-1 and Table 3-2 are reserved across all
applications. Even if your application doesn’t support one of these menu commands, it
shouldn’t use these keyboard equivalents for another command. This guideline is for the
user’s benefit. Reserving these key combinations provides guaranteed, predictable
behavior across all applications.
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Table 3-2 Reserved keyboard equivalents for worldwide systems

Keys Action

-Space bar Rotate through enabled script systems

B-Option-Space bar Rotate through keyboard layouts or input methods
within the active script system

B-modifier key—Space bar Reserved

B-Right arrow Change keyboard layout to the current keyboard

layout of the Roman script

B-Left arrow Change keyboard layout to the current keyboard
layout of the system script

Table 3-3 shows other common keyboard equivalents. These keyboard equivalents are
secondary to the standard keyboard equivalents listed in Table 3-1 and Table 3-2. If your
application doesn’t support one of the functions in Table 3-3, then you can use the
equivalent as you wish.

Table 3-3 Other common keyboard equivalents
Keys Command Menu

B Bold Style

B-F Find File

B-G Find Again File

-1 Italic Style

BT Plain Text Style

U Underline Style

You shouldn’t assign keyboard equivalents to infrequently used menu commands. Only
add keyboard equivalents for the commands that your users employ most frequently.

Menus Added Automatically by the Menu Manager

In System 7, the Menu Manager may add as many as three additional menus to your
application’s menu bar: the Help menu, the Keyboard menu, and the Application menu.
These menus provide access to system features such as Balloon Help, keyboard layouts,
and application switching. All three of these menus have icons as titles and are
positioned at the right side of the menu bar. (These menus are sometimes referred to as
the system-handled menus.)

The Menu Manager automatically inserts these additional menus in your application’s
current menu list when your application inserts an Apple menu into its menu bar. In this
case, the Menu Manager always displays the Application menu, displays the Help menu
if space is available, and displays the Keyboard menu if multiple script systems are
installed and space is available. The Menu Manager also displays the Keyboard menu if
the smfShowIcon bitis set in the flags byte of the "it1c' resource.
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The Help menu icon or both the Help menu icon and the Keyboard menu icon disappear
from the menu bar if your application inserts a menu whose title extends into the space
occupied by one or both of those icons. This allows your application to reclaim any space
in the menu bar that would have been occupied by one or both of those two menu icons,
if necessary. However, if your application inserts a menu whose title is long enough to
overlap space occupied by the Application menu icon, the overlapping portion of that
title disappears behind the Application menu icon. The Application menu icon is always
displayed in the menu bar.

Because the Menu Manager inserts the Help, Keyboard, and Application menus into your
application’s current menu bar, you should not make any assumptions about the last
menu (or menus) in your menu bar. Apple also reserves the right to add other
system-handled menus to your application’s menu bar; for compatibility you should
define your menu bar such that there is room for the Help, Keyboard, and Application
menus and at least one additional system-handled menu.

Your application does not need to take any action if the user chooses an item from the
Keyboard or Application menu; the Menu Manager performs any appropriate actions for
these two menus. If the user chooses an item that your application added to the Help
menu, your application should perform the corresponding action.

The following sections describe the Help, Keyboard, and Application menus in more
detail, and they also describe other menus in a typical application, including the Apple,
File, and Edit menus.

The Apple Menu

You should define the Apple menu as the first menu in your application. The title of the
Apple menu is the Apple icon. The Apple menu of an application typically provides an
About command as the first menu item, followed by a divider, which is followed by a list
of all desktop objects contained in the Apple Menu Items folder. (The phrase desktop
objects refers to applications, desk accessories, documents, folders, and any other item
that can reside in the Apple Menu Items folder.) The items following the divider in the
Apple menu are listed in alphabetical order. Each item below the divider lists a desktop
object and the small icon for that object.

Figure 3-9 shows the Apple menu for the SurfWriter application as it might appear on a
particular user’s system.

To create the items in your application’s Apple menu, define the Apple menu title, the
characteristics of your application’s About command, and the divider following it in a
'"MENU' resource.

To insert the items contained in the Apple Menu Items folder into your application’s
Apple menu, use the AppendResMenu or InsertResMenu procedure and specify
'"DRVR' as the resource type to add in the parameter theType. If you do this, these
procedures automatically add all items in the Apple Menu Items folder in alphabetical
order to the specified menu.
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Figure 3-9 The Apple menu for the SurfWriter application
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Note

The Apple Menu Items folder is available in System 7 and later. In System 6,
the AppendResMenu and InsertResMenu procedures add only the desk
accessories in the System file to the specified menu when you specify
'"DRVR' as the resource type to add in the parameter theType. &

The user can place any desktop object in the Apple Menu Items folder. When the user
places an item in this folder, the system software automatically adds it to the list of items
in the Apple menu of all open applications.

When the user chooses an item other than your application’s About command from

the Apple menu, your application should call the OpenDeskAcc function. The
OpenDeskAcc function prepares to open the desktop object chosen by the user; for
example, if the user chooses the Alarm Clock desk accessory, the OpenDeskAcc function
prepares to open the Alarm Clock. The OpenDeskAcc function schedules the Alarm
Clock desk accessory for execution and returns to your application. On your application’s
next call to WaitNextEvent, it receives a suspend event, and then

the Alarm Clock desk accessory becomes the foreground process.

If the user chooses a desktop object other than a desk accessory or an application, the
OpenDeskAcc function also takes the appropriate action. For example, as shown in
Figure 3-9, if the user chooses a document called MyTideReport created by the SurfWriter
application, the OpenDeskAcc function prepares to open the SurfWriter application (if it
isn’t already open) and schedules the SurfWriter application for execution. The
SurfWriter application is instructed to open the MyTideReport document when it
becomes the foreground process.

When the user chooses your application’s About command, your application can
display a dialog box or an alert box that contains your application’s name, version
number, copyright information, or other information as necessary. Your application
should provide an OK button in the dialog box; the user clicks the OK button to close
the dialog box.
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Figure 3-10 shows the alert box that the SurfWriter application displays when the user
chooses the About command from the application’s Apple menu.

Figure 3-10 Choosing the About command of the SurfWriter application
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If your application provides any application-specific Help commands, place these in the
Help menu, not the Apple menu.

The File Menu

The standard File menu contains commands related to managing documents. For
example, the user can open, close, save, or print documents from this menu. The user
should also be able to quit your application by choosing Quit from the File menu.

Your application should support the menu commands of the standard File menu. If you
add other commands to your application’s File menu, they should pertain to managing
a document.

Figure 3-11 shows the standard File menu for applications.

Figure 3-11 The standard File menu for an application
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Table 3-4 describes the standard commands in the File menu and the actions your
application should take when a user chooses them.

Table 3-4 Actions for standard File menu commands

Command Action

New Open a new, untitled document.

Open... Display the Open dialog box using the Standard File Package.
Close Close the active window (which may be a document window,

modeless dialog box, or other type of window). If the active window
is a document and the document has been changed since the last save,
display a dialog box asking the user if the document should be saved
before closing.

Save Save the active document to a disk, including any changes made to
that document since the last time it was saved. If the user chooses
Save for a new untitled document (one that the user hasn’t named
yet), display the Save dialog box using the Standard File Package.

Save As... Save a copy of the active document under a new name provided by
the user. Display the Save dialog box using the Standard File Package.
After your application saves the document, the document should
remain open and active.

Page Setup... Display the Page Setup dialog box to let the user specify printing
parameters such as the paper size and printing orientation. Your
application can provide other printing options as appropriate. Your
application should save the user’s Page Setup printing preferences for
the document when the user saves the document.

Print... Display the Print job dialog box to let the user specify various
parameters, such as print quality and number of copies. Print the
document if the user clicks the Print button. The options specified in
the Print dialog box apply to only the current printing operation, and
your application should not save these settings with the document or
restore the settings when the user chooses Print again.

Quit Quit your application after performing any necessary cleanup
operations. If any open documents have been changed since the user
last saved them, display the Save dialog box once for each open
document that requires saving. If any background or lengthy
operation is still in progress, notify the user, giving the user the option
to continue and not quit the application.

See Macintosh Human Interface Guidelines for additional commands that you can provide
in the File menu. See the chapter “Introduction to File Management” in Inside Macintosh:
Files for information on how to perform the actions associated with the commands in the
File menu. See the chapter “Standard File Package” in Inside Macintosh: Files for
information on the standard file dialog boxes. See the chapter “Printing Manager” in
Inside Macintosh: Imaging for information on displaying the Page Setup and Print job
dialog boxes.
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The New, Open, Close, Save, Print, and Quit commands have the keyboard equivalents
shown in Figure 3-11 on page 3-22. These keyboard equivalents are reserved for these
menu commands; do not assign these keyboard equivalents to any menu command other
than the ones shown in Figure 3-11.

The Edit Menu

The standard Edit menu provides commands that let users change or edit the contents of
their documents. It also provides commands that allow users to share data within and
between documents created by different applications using editions or the Clipboard. All
Macintosh applications should support the Undo, Cut, Copy, Paste, and Clear
commands. Use these commands to provide standard text-editing abilities in your
application.

Figure 3-12 shows the standard Edit menu supported by Macintosh applications.

Figure 3-12 The standard Edit menu for an application
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The standard editing commands (Undo, Cut, Copy, Paste, and Clear) in your
application’s Edit menu should appear in the order shown in Figure 3-12. Whenever
possible, you should add an additional word or phrase to clarify what action your
application will reverse when the user chooses the Undo command. For example,
Figure 3-12 shows an application’s Edit menu that uses the phrase Undo Typing when
typing was the last action performed by the user. If your application can’t undo the last
operation, you should change the text of the Undo command to Can’t Undo and disable
the menu item. See “Changing the Text of an Item” on page 3-59 for an example of how
to change the text of a menu item.

You can include other commands in your application’s Edit menu if they're related to
editing or changing the content of your application’s documents. If you add commands
to the Edit menu, add them after the standard menu commands. For example, if
appropriate, your application should support a Select All command. If your application
supports both the Clear and Select All commands, they should appear in the order shown
in Figure 3-12.
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Table 3-5 describes the standard commands in the Edit menu and the actions your
application should take when a user chooses them.

Table 3-5 Actions for standard Edit menu commands
Command Action
Undo Reverse the effect of the previous operation. You should add the

name of the last operation to the Undo command. For example,
change the item to read Undo Typing if the user just finished
entering some text in a document. If your application cannot
undo the previous operation, disable this menu item and change
the phrase to Can’t Undo.

Cut Remove the data in the current selection, if any. Store the cut
selection in the scrap (on the Clipboard). This replaces the
previous contents of the scrap.

Copy Copy the data in the current selection, if any. Copy the selection
to the scrap (the Clipboard). This replaces the previous contents
of the scrap.

Paste Paste the data from the scrap at the insertion point; this replaces
any current selection.

Clear Remove the data in the highlighted selection; do not copy the
data to the scrap (Clipboard).

Select All Highlight all data in the document.

Create Publisher... Display the Create Publisher dialog box (using the Edition

Manager). Create an edition based on the selected data if the
user clicks the Publish button.

Subscribe To... Display the Subscribe To dialog box (using the Edition
Manager). Allow the user to insert data from an edition if the
user clicks the Subscribe button.

Publisher Options... Display the Publisher Options dialog box (using the Edition
Manager) and allow the user to set or change options associated
with the publisher. Change this menu item to Subscriber
Options if the current selection includes a subscriber. When the
user chooses the Subscriber Options command, display the
Subscriber Options dialog box.

Show Clipboard Display the contents of the Clipboard in a window. Change
this item to Hide Clipboard when the Clipboard window is
showing. When the user chooses Hide Clipboard, hide the
window displaying the Clipboard contents and change the
menu item to Show Clipboard.

The Undo, Cut, Copy, Paste, and Select All commands have the keyboard equivalents
shown in Figure 3-12 on page 3-24. These keyboard equivalents are reserved for these
menu commands; do not assign these keyboard equivalents to any menu command other
than the ones shown in Figure 3-12. See the chapter “Scrap Manager” in Inside Macintosh:
More Macintosh Toolbox for information on copying data to and from the scrap. See the
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chapter “Edition Manager” in Inside Macintosh: Interapplication Communication for
information on supporting the Create Publisher, Subscribe To, and Publisher Options
commands in your application.

The Font Menu

You can provide a Font menu to allow the user to choose text fonts. A font is a complete
set of characters created in one typeface and font style. The characters in a font can
appear in many different point sizes, but all have the same design elements.

You should list the names of all currently available fonts in your application’s Font menu.
The currently available fonts are those fonts residing in the Fonts folder of the user’s
System Folder (or in earlier versions of system software, in the user’s System file).

You add fonts to the Font menu using the AppendResMenu or InsertResMenu
procedure. These two procedures add items to the specified menu in alphabetical order.

The user can install a large number of fonts and thereby create a very large Font menu.
Therefore, you should never include other items in the Font menu. Use separate menus to
accommodate lists of attributes such as style and size choices. You can also provide a
Size menu to allow the user to choose a specific point size of a font; the next section
describes the Size menu.

Figure 3-13 shows a typical Font menu. Your application should indicate which typeface
is in use by adding a checkmark to the left of the name of the current font. In Figure 3-13,
the application has placed a checkmark next to Palatino to indicate that Palatino® is the
current font. When the user starts entering text at the insertion point, your application
should display text in the current font.

Figure 3-13 A typical Font menu
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In the Font menu, you can use dashes to indicate that the selection contains more than
one font. (Place a checkmark next to an item if the entire selection contains only one font.)
If the current selection contains more than one font, place a dash next to the name of each
font that the selection contains. See “Changing the Mark of Menu Items” on page 3-61 for
information on adding dashes and checkmarks to a menu item.
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Figure 3-14 shows the use of dashes to indicate that a selection contains more than one
font. In this figure, part of the selection contains a Helvetica® font and part of the
selection contains a Palatino font.

Figure 3-14 A Font menu showing a selection containing more than one font

The AppendResMenu and InsertResMenu procedures can recognize when an added
font resource is associated with a script other than the current system script (non-Roman
fonts have font numbers greater than $4000). The Menu Manager displays a font name in
its corresponding script if the script system for that font is installed.

You can choose to provide a Size menu and a Style menu in addition to a Font menu.
If you do so, these three menus typically appear in the order Font, Size, Style in
most applications.

The Size Menu

Your application can provide a Size menu to allow the user to choose sizes for fonts. Font
sizes are measured in points. A point is a typographical unit of measure equivalent (on
Macintosh computers) to 1/72 of an inch.

Your application should indicate the current point size by adding a checkmark to the
menu item of the current size. You can use dashes if the selection contains more than one
point size.

System 7 supports both bitmapped and TrueType fonts. TrueType fonts can be displayed
in a wider range of point sizes, for example, 12 points, 51 points, 156 points, 578 points,
or greater. Your application should not provide an upper limit for font sizes.

In the Size menu, your application should outline font sizes to indicate which sizes are
directly provided by the current font. If the user chooses a TrueType font, outline all sizes
of that font in the Size menu. If the user chooses a bitmapped font, outline only those
sizes that appear in the Fonts folder. Use plain type for all other font sizes. See the
chapter “Font Manager” in Inside Macintosh: Text for additional information on
supporting fonts in your application.
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Figure 3-15 shows a typical Size menu of an application.

Figure 3-15 A typical Size menu

Your application should also provide a method that allows users to choose any point size.
You can add an Other command to the end of the Size menu for this purpose. When the
user chooses this command, display a dialog box that allows the user to choose any
available font size. You can include an editable text item in which the user can type the
desired font size. Figure 3-16 shows a dialog box an application might display when the
user chooses the Other command from the Size menu.

Figure 3-16 A dialog box to select a new point size for a font

3-28

Other Font Size

Font Size: pnints

Figure 3-17 shows the Other dialog box after the user has entered a new font size
of 31.
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Figure 3-17 Entering a new point size for a font
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If the user enters a font size not currently in the menu, your application should add a
checkmark to the Other menu command and include the font size as part of the text of
the Other command. You should show the font size in parentheses after the text Other,
as shown in Figure 3-18.

Figure 3-18 The Other command with a font size added to it
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If a selection contains more than one nonstandard size, you should include the text
Mixed in parentheses following the word Other. In this case leave the editable text field
of the Other dialog box blank when the user chooses the Other (Mixed) command.

See “Handling a Size Menu” on page 3-82 for more information on how to respond to the
user’s choice of a command from the Size menu. See the chapter “Dialog Manager” for
information on creating a dialog box.

The Help Menu

The Help menu is specific to each application, just as the Apple, File, and Edit menus are.
The Help menu items defined by the Help Manager are common to all applications and
give the user access to Balloon Help.

You can add menu items to your application’s Help menu to give your users access
to any online help that your application supplies in addition to help balloons. If you
currently provide your users with help information when they choose the About
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command from the Apple menu, you should instead append a command for your own
help to the Help menu. This gives users one consistent place to obtain help information.

When adding your own items to the Help menu, include the name of your application in
the command so that users can easily determine which application the help relates to.

Figure 3-19 shows the Help menu for the SurfWriter application. This application
appends one item to the end of the standard Help menu: SurfWriter Help. When the
user chooses this item, the application provides access to any application-specific
help information.

Figure 3-19 The Help menu of the SurfWriter application
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You add items to the Help menu by using the HMGetHelpMenuHandle function and the
AppendMenu procedure. Apple reserves the right to change the number of standard
items in the Help menu. You should always append any additional items to the end. See
“Adding Items to the Help Menu” on page 3-67 for specific examples.

The user turns Balloon Help on or off by choosing Show Balloons or Hide Balloons from
the Help menu. The Help Manager automatically enables or disables Balloon Help when
the user chooses Show Balloons or Hide Balloons from the Help menu. The setting of
help is global and affects all applications.

When the user turns on Balloon Help, the Help Manager displays small help balloons as
the user moves the cursor over areas such as scroll bars, buttons, menus, or rectangular
areas in windows or dialog boxes that have help information associated with them.
Help balloons are rounded-rectangle windows that contain explanatory information for
the user.

The Help Manager provides help balloons for the menu titles of the Apple, Help,
Application, and Keyboard menus. The Help Manager also provides help balloons for
menu items in the Application and Keyboard menus, for any item from the Apple Menu
Items folder in the Apple menu, and for the standard items in the Help menu. The Help
Manager provides these help balloons only if your application uses the standard menu
definition procedure.

Your application should provide the content of help balloons for all other menu items
and menus in your application.

Figure 3-20 shows the default help balloons for the Apple menu title and Application
menu title.
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Figure 3-20 Default help balloons for the Apple menu and Application menu
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Figure 3-21 shows help balloons for an application’s Cut command when it is enabled
and when it is disabled.

Figure 3-21 Help balloons for different states of the Cut command
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Your application can provide the content for help balloons for your menus and menu
items. You define the help balloons for your application using 'hmmu' resources.

For information on how to define the help balloons for your application’s menus
in 'hmmu' resources, see the chapter “Help Manager” in Inside Macintosh: More Macintosh
Toolbox.
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The Keyboard Menu

The Keyboard menu displays a list of all the keyboard layouts and input methods that
are available for each enabled script system. Each script system has at least one keyboard
layout or input method associated with it. If only the Roman script system and the U.S.
keyboard layout are available, the Menu Manager does not add the Keyboard menu
(unless the smfShowIcon bit is set in the flags byte of the 'it1c' resource). If the user’s
system includes an additional script system or includes additional keyboard layouts for
the Roman script system and the smfShowIcon bitissetinthe 'itlc' resource, the
Menu Manager adds the Keyboard menu to your application’s menu

bar as long as your application’s menu bar includes an Apple menu. The Menu

Manager adds the Keyboard menu to the right of the Help menu and to the left of the
Application menu.

Figure 3-22 shows a Keyboard menu as it might appear on a particular user’s system.
System software groups the items in the Keyboard menu by their script systems. For
example, in Figure 3-22 seven script systems are shown: Arabic, Roman, Cyrillic, Hebrew,
Thai, Japanese, and Korean. Two keyboard layouts are available in the user’s system for
the Arabic script system, two keyboard layouts for the Roman script system, one
keyboard layout for the Cyrillic script system, two keyboard layouts for the Hebrew
script system, three keyboard layouts for the Thai script system, two input methods for
the Japanese script system, and one input method for the Korean script system.

Figure 3-22 Accessing the Keyboard menu from an application
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When the user chooses an item from the Keyboard menu, the Menu Manager handles it
appropriately. For example, if the user chooses a different keyboard layout in a different
script, the Menu Manager changes the current keyboard layout and script system to the
item chosen by the user. See Inside Macintosh: Text for further information on supporting
text and handling text in multiple scripts in your application.

The Application Menu

The Application menu is the menu farthest to the right in the menu bar; the Application
menu contains the icon of the active application or desk accessory for its menu title.

The Menu Manager automatically appends the Application menu to your application’s
menu bar if your menu bar includes an Apple menu.

When the user chooses an item from the Application menu, the Menu Manager handles
the event as appropriate. For example, if the user chooses the Hide Others command, the
Menu Manager hides the windows of all other open applications. If the user chooses
another application from the Application menu, the Menu Manager sends your
application a suspend event. Your application receives the suspend event the next time it
calls WaitNextEvent, and your application is switched out after handling the suspend
event. (See the chapter “Event Manager” in this book for information about responding
to suspend and resume events.)

Figure 3-23 shows the Application menu for the SurfWriter application as it appears
when both SurfWriter and TeachText are open and the user is currently interacting with
SurfWriter. The checkmark next to the menu item showing SurfWriter’s icon indicates
that SurfWriter is the active application.

Figure 3-23 SurfWriter’s Application menu
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Pop-Up Menus

You can use pop-up menus to present the user with a list of choices in a dialog box or
window. Pop-up menus are especially useful in dialog boxes that require the user to
select one choice from a list of many or to set a specific value.

In System 7, the standard pop-up menu is implemented by a control definition function.
This section explains how the standard pop-up control definition function provides
support for pop-up menus. The chapter “Control Manager” in this book explains controls
in detail.
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A pop-up menu appears as a rectangle with a one-pixel border and a one-pixel drop
shadow. Pop-up menus are identified by a downward-pointing triangle that appears
in the pop-up box. The title of the pop-up menu appears next to the pop-up box.
Figure 3-24 shows a pop-up menu.

Figure 3-24 A pop-up menu
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To display a pop-up menu, the user presses the mouse button while the cursor is over the
pop-up title or pop-up box. If the pop-up menu is in a dialog box and your application
uses the Dialog Manager, the Dialog Manager uses the pop-up control definition function
to display the pop-up menu and to handle all user interaction in the pop-up menu. If the
pop-up menu is in one of your application’s windows, your application needs to
determine which control the cursor was in when the user pressed the mouse button. Your
application can then use the Control Manager routines to display the pop-up menu and
to handle user interaction in the control.

Just like MenuSelect, the pop-up control definition function highlights the pop-up
menu title and highlights menu items appropriately as the user drags the cursor through
the menu items. The pop-up control definition function also highlights the default
(current) menu item when the pop-up menu is first displayed and adds the checkmark to
the menu item. Once the user releases the mouse button, the pop-up control definition
function causes the chosen item (if any) to blink, unhighlights the menu title, changes the
text in the pop-up box, and stores the item number of the chosen item as the value of the
control. Your application can use the Control Manager function GetControlvValue to
get the menu item chosen by the user.

Figure 3-25 shows a pop-up menu in its closed state (as it appears initially to the user)
and its open state (as it appears when the user presses the mouse button while the cursor
is in the pop-up menu).

Figure 3-25 A pop-up menu in its closed and open states
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If you don’t provide a title for a pop-up menu, the current menu item serves as the title.
In most cases you should create pop-up menus that have titles. Choose a title that reflects
the contents of the menu or indicates the purpose of the menu.
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Figure 3-26 shows the process of a user making a selection from a pop-up menu.

Figure 3-26 Making a selection from a pop-up menu
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In step 1 in Figure 3-26, the user presses the mouse button while the cursor is over the
pop-up box. When this occurs, your application can use the Dialog Manager or Control
Manager to call the pop-up control definition function. In step 2, the pop-up control
definition function highlights the title of the pop-up menu, removes the downward-
pointing triangle from the pop-up box, adds a checkmark to the current item, highlights
the current item, and displays the contents of the pop-up menu. In step 3, the pop-up
control definition function handles all user interaction, highlighting and unhighlighting
menu items, until the user releases the mouse button. When the user releases the mouse
button, the pop-up control definition function closes the pop-up menu, unhighlights the
pop-up menu title, sets the text of the pop-up box to the item chosen by the user, and
stores the item number of the chosen item as the value of the control. Step 4 shows the
appearance of the closed pop-up menu after the pop-up control definition function
performs these actions.

If your application does not use the standard pop-up control definition function, you

can create your own control definition function and you can choose to use the
PopUpMenuSelect function to help your application handle pop-up menus. In this case,
when the user presses the mouse button when the cursor is in a pop-up menu,

your application should call the PopUpMenuSelect function. Your application must
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highlight the pop-up title before calling PopUpMenuSelect and unhighlight it
afterward. The PopUpMenusSelect function displays the pop-up menu and highlights
menu items appropriately as the user drags the cursor through the menu items. Once the
user releases the mouse button, PopUpMenuSelect flashes the chosen item, if any, and
returns information indicating which menu item was chosen to your application. Your
application is responsible for highlighting and unhighlighting the menu title, updating
the text in the pop-up box, and storing any changes to the settings of the menu items if
you use the PopUpMenuSelect function.

Pop-up menus work well when your application needs to present several choices to the
user. Note that pop-up menus hide these choices from the user until the user chooses to
display the pop-up menu. Use pop-up menus when the user doesn’t need to see all the
choices all the time. For example, Figure 3-27 shows a dialog box that uses a pop-up
menu to allow the user to choose one color from a list of many.

Figure 3-27 Choosing one attribute from a list of many
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If you need to show only a few choices, you may find that using checkboxes or radio
buttons is more appropriate for your application. For example, in Figure 3-27 the
selection of columns is implemented with radio buttons rather than a pop-up menu.
Whenever possible, you should show all available choices to the user. Note that in this
example the amount of space occupied by the radio buttons is about the same as the
amount of space required for a corresponding pop-up menu.

Use pop-up menus to allow the user to choose one option from a set of many choices.
Don’t use a pop-up menu for multiple-choice lists where the user can make more than
one selection. If you do, the text in the menu box will not fully describe the selections in
effect. For example, don’t use a pop-up menu for font style selections. In a dialog box,
font style selections are more appropriately implemented as checkboxes. Figure 3-28
shows a dialog box that uses checkboxes instead of a pop-up menu to allow the user to
select more than one font style. The Size and Font choices are implemented as pop-up
menus in this example, since the user can choose only one size and one font from a list
of many.
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Figure 3-28 A dialog box with checkboxes and pop-up menus
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Never use a pop-up menu as a way to provide more commands. Pop-up menus should
not contain actions (verbs) but can contain attributes (adjectives) or settings that allow
the user to choose one from many. For these reasons, you should not use Command-key
equivalents for pop-up menu items.

Your application can also use type-in pop-up menus when appropriate. Use a type-in
pop-up menu to give the user a list of choices and to allow the user to type in an
additional choice. The standard pop-up control definition function that implements
pop-up menus does not provide specific support for type-in menus. You can create your
own control definition function to handle type-in pop-up menus. If you do so, your
type-in pop-up menu should adhere to the guidelines described here. Figure 3-29 shows
a typical type-in pop-up menu in its closed and open states.

Figure 3-29 A type-in pop-up menu in its closed and open states

Your application is responsible for drawing and highlighting the type-in field of the
pop-up menu. Your application does not need to highlight the title of a type-in pop-up
menu; your application should highlight the type-in field instead.

If the user types in a value that is already in the menu, make that item the current item. If
the user types a value that does not match any of the items in the pop-up menu, add the
item to the top of the menu and add a divider below the item to separate it from the rest
of the standard items. Figure 3-30 on the next page shows a type-in pop-up menu with a
user’s choice added to it.

Introduction to Menus 3-37



CHAPTER 3

Menu Manager

Figure 3-30 A type-in pop-up menu with a user’s choice added
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A type-in pop-up menu should allow the user to type in a single additional choice. That
is, a standard type-in pop-up menu does not accumulate the user’s choices in the menu.
For example, if the user types in a value of 13, then types in a new choice, such as 43, the
menu should appear as shown in Figure 3-30, except that the type-in field and menu item
that previously contained 13 is replaced by 43.

A type-in pop-up menu should also allow the user to type in any of the standard values
in the menu or choose any of the standard items in the pop-up menu. If the user types in
or chooses any of the standard items, you should remove any user-specified item
previously added to the menu. For example, as shown in Figure 3-30, the user specified a
nonstandard size of 13. If the user then types in or selects 9, your application should
return the pop-up menu to its standard state, as shown in Figure 3-29 on page 3-37.

Hierarchical Menus

A hierarchical menu is a menu that has a submenu attached to it. Hierarchical menus can
be useful when your application needs to offer additional choices to the user without
taking up extra space in the menu bar. If you use a hierarchical menu in your application,
use it to give the user additional choices or to choose attributes, not to choose additional
commands.

In a hierarchical menu, a menu item serves as the title of a submenu; this menu item
contains a triangle to identify that the item has a submenu. The triangle appears in the
location of the keyboard equivalent. The title of a submenu should represent the choices
it contains. Figure 3-31 shows a menu with a submenu whose menu title is Label Style.

When a user drags the cursor through a hierarchical menu and rests the cursor on a menu
item that has a submenu, the Menu Manager displays the submenu after a brief delay.
The title of the submenu remains highlighted while the user browses through the
submenu; the Menu Manager unhighlights the menu title of the submenu when the user
releases the mouse button.

Hierarchical menus are useful for providing lists of related items, such as font sizes and
font styles. Never use more than one level of hierarchical menus (in other words, don’t
attach a submenu to another submenu). You can assign keyboard equivalents to the
menu items of a submenu; however, if you do so, you make it harder for the user to
quickly scan all menus for their keyboard equivalents.
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Figure 3-31 A hierarchical menu item and its submenu
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About the Menu Manager

The Menu Manager, together with the menu definition procedure and menu bar
definition function, provides your application with a convenient way to manage the
menus in your application. The Menu Manager uses two data structures, menu records
and menu lists, to manage menus. The next two sections describe how the Menu
Manager uses these two data structures. “Using the Menu Manager,” which begins on
page 3-41, shows how you can use the Menu Manager to

m define a menu using a 'MENU' resource

m define a menu bar using an 'MBAR' resource

m install your application’s menu bar

m change the appearance of menu items

m add menu items to a menu

m respond to the user when the user chooses a menu item

m handle the Apple and Help menus

m create a pop-up menu

m create a hierarchical menu

m handle access to menus when your application displays a dialog box

m write your own menu definition procedure
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How the Menu Manager Maintains Information About Menus

The Menu Manager maintains information about menus in menu records. Each menu
record includes certain information about a specific menu, including

m the menu ID of the menu
m the horizontal and vertical dimensions of the menu (in pixels)
m a handle to the menu definition procedure of the menu

m flags indicating whether each item (for the first 31 items) is enabled or disabled and
whether the menu title is enabled or disabled

m the contents of the menu, including the menu title and other data that defines the
menu items

You typically specify most of this information in a menu resource, that is, a resource of
type 'MENU'. When you create a menu, the Menu Manager stores this information in a
menu record. A menu record is a data structure of type MenuInfo. You usually never
need to access the information in the menu record directly; the Menu Manager
automatically updates the menu record when you make any changes to the menu, such
as adding a menu item. See “The Menu Record” beginning on page 3-95 if you need to
access the fields of the menu record directly.

The Menu Manager identifies every menu by a number referred to as a menu ID. You
must assign a menu ID to each menu in your application. Each menu in your application
must have a menu ID that is unique from that of any other menu in your application. You
can use any number greater than 0 for a menu ID of a pull-down or pop-up menu;
submenus of an application can use only menu IDs from 1 through 235; submenus of a
desk accessory must use menu IDs from 236 through 255.

When you create a menu, the Menu Manager creates a menu record for the menu and
returns a handle to that menu record. To refer to a menu, you usually use either the
menu’s menu ID or a handle to the menu’s menu record.

To refer to a menu item, use the menu item’s item number. Item numbers identify items
in menus; items are assigned item numbers starting with 1 for the first menu item in the
menu, 2 for the second menu item in the menu, and so on, up to the number of the last
menu item in the menu.

How the Menu Manager Maintains Information About an
Application’s Menu Bar

A menu list contains handles to the menu records of one or more menus (although a
menu list can be empty). The end of a menu list can contain handles to the menu

records of submenus and pop-up menus; the phrase submenu portion of the menu list refers
to this portion of the menu list, which contains information about submenus

and pop-up menus.

When your application initializes the Menu Manager, the Menu Manager allocates the
current menu list, which is initially empty. The contents of the current menu list change
as your application adds menus to or removes menus from it.
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The current menu list contains handles to the menu records of all menus in the current
menu bar and the menu records of any submenus or pop-up menus that you have
inserted into the current menu list. Your application typically creates a menu list using
GetNewMBar, and it then sets the current menu list to its newly created menu list using
SetMenuBar. You can insert other menus in the current menu list using the GetMenu
function and InsertMenu procedure.

The Menu Manager displays the menu bar and the titles of all pull-down menus that
are defined in the current menu list when your application calls the DrawMenuBar
procedure. The Menu Manager displays the menus in the menu bar in the same order
that they appear in the current menu list.

The Menu Manager provides routines for adding menus to and removing menus from
the current menu list; your application should never access a menu list directly. To refer
to a menu list, use the handle returned by GetNewMBar or GetMenuBar.

The Menu Manager inserts the Help menu, the Keyboard menu if necessary, and the
Application menu into your application’s menu list if your application calls the
GetNewMBar function and your menu bar includes an Apple menu; your application
then uses SetMenuBar to set the current menu list to the newly created menu list. The
Menu Manager also inserts these menus into your application’s current menu list if your
application inserts the Apple menu into the current menu list using the InsertMenu
procedure. Therefore, you should not make any assumptions about the last menu (or
menus) in your application’s current menu list.

When your application inserts a submenu into the current menu list, the Menu Manager
stores a handle to the menu record of the submenu in the submenu portion of the current
menu list. Similarly, when your application inserts a pop-up menu into the current menu
list, the Menu Manager stores a handle to the menu record of the pop-up menu in the
submenu portion of the current menu list.

Using the Menu Manager

You can define your application’s menus and menu bar as resources and use Menu
Manager routines to create and manage them. For example, whenever the user presses
the mouse button while the cursor is in the menu bar, your application should call the
MenuSelect function, allowing the user to choose a command from any menu. The
MenuSelect function handles all user activity until the user releases the mouse button.
The MenuSelect function displays and removes menus as the user drags the cursor
through the menu bar, and it highlights enabled menu items as the user drags through
a menu.

You should provide help balloons for each menu title and menu item of your applica-
tion. You store information and text for help balloons in resources. See the chapter
“Help Manager” in Inside Macintosh: More Macintosh Toolbox for complete and specific
information on how to provide help balloons for the menus of your application. The
BalloonWriter application, available from APDA, can also help you create help balloons
for the menus of your application.
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Your application needs to initialize QuickDraw, the Font Manager, and the Window
Manager before using the Menu Manager. Your application can accomplish this using the
InitGraf, InitFonts, and InitWindows procedures. To initialize the Menu Manager,
use the InitMenus procedure.

If your application uses pop-up menus, use the Gestalt function with the
gestaltPopUpAttr selector to determine if the control definition function for

pop-up menus is available. See Inside Macintosh: Operating System Ultilities for information
about the Gestalt function.

To create the pull-down menus in your application’s menu bar, you need to
m create descriptions of each pull-down menu in 'MENU' resources
m create an 'MBAR' resource that lists the order and resource ID of each menu

m use the GetNewMBar function and SetMenuBar procedure to set up your menu bar
and use the DrawMenuBar procedure to draw your menu bar

The next section, “Creating a Menu,” explains these steps in detail.

After creating your application’s menu bar, you can enable or disable your menu items,
add marks such as checkmarks or dashes to menu items, or add items to any of your
menus as needed. See “Enabling and Disabling Menu Items” on page 3-58, “Changing
the Mark of Menu Items” on page 3-61, and “Adding Items to a Menu” beginning on
page 3-64 for information on these topics.

“Handling User Choice of a Menu Command,” beginning on page 3-70, shows how to
handle mouse-down events in the menu bar, adjust the menus of your application, and
determine if the user chose a keyboard equivalent of a command.

“Responding When the User Chooses a Menu Item,” beginning on page 3-78, describes
how your application should respond once the user chooses an item and also shows how
to handle the user’s choice of a command from the Apple and Help menus.

If your application displays dialog boxes, see “Accessing Menus From a Dialog Box”
beginning on page 3-84.

Finally, if your application needs to create submenus or pop-up menus, see “Creating a
Hierarchical Menu” on page 3-53 and “Creating a Pop-Up Menu” on page 3-56.

Creating a Menu

You use various Menu Manager routines to set up the menus and the menu bar
for your application. You can use any of these methods to create pull-down menus for
your application:

m You can create descriptions of your application’s menus in 'MENU' resources and
describe your application’s menu bar in an 'MBAR' resource. You use the
GetNewMBar function to read in descriptions of your menu bar and menus and create
a new menu list, use the SetMenuBar procedure to set the current menu list to your
application’s menu list, and use the DrawMenuBar procedure to update the menu bar.

m You can create descriptions of your application’s menus in 'MENU' resources, read
them in using GetMenu, add them to the current menu list using InsertMenu, and
update the menu bar using DrawMenuBar.
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m You can use NewMenu to create new empty menus; use AppendMenu,
InsertMenultem, InsertResMenu, or AppendResMenu to fill the menus with
menu items; add the menus to the current menu list using InsertMenu; and update
the menu bar using DrawMenuBar.

Whenever possible you should define your menus in menu (' MENU') resources and your
menu bar in a menu bar (' MBAR ') resource to make your application easier
to localize.

To create a hierarchical menu, you need to create descriptions of the submenu and the
menu to which the submenu is attached. Usually you create the description of both
menus in 'MENU' resources. You typically read in the description of the hierarchical
menu using GetNewMBar (if you also provide an 'MBAR' resource). To read in the
description of the submenu and insert it in the current menu list, use the GetMenu
function and InsertMenu procedure.

To create a pop-up menu, create descriptions of the pop-up menu and its menu items,
create a control that uses the pop-up control definition function, and associate the control
with a window or dialog box. You can display and manage the pop-up menu using the
Dialog Manager or Control Manager routines.

Once the Menu Manager creates a menu for your application, if necessary you can add
additional menu items to the menu using AppendMenu, InsertMenultem,
InsertResMenu, or AppendResMenu. You can use various Menu Manager routines to
change the appearance of menu items.

The next sections describe how to create 'MENU' and 'MBAR' resources. “Creating a
Hierarchical Menu” on page 3-53 describes how to create a menu that has a submenu,
and “Creating a Pop-Up Menu” on page 3-56 describes how to create pop-up menus.

Creating a Menu Resource

Usually you should define your menus in menu (' MENU') resources so that you can
easily localize the menu titles and menu items for other languages, cultures, or regions. A
'"MENU' resource defines the menu title of a menu and the characteristics of menu items
in a menu. Listing 3-1 shows a sample 'MENU' resource in Rez format for an
application’s Apple menu. (Rez is a resource compiler available with MPW. You can also
define menus using a resource utility, such as ResEdit, available from APDA.)

Listing 3-1 Rez input for a 'MENU ' resource for the Apple menu

#define mApple 128

resource 'MENU' (mApple, preload) { /*resource ID, preload resourcex*/
mApple, /*menu ID*/
textMenuProc, /*uses standard menu definition */

/* procedure*/

0b1111111111111111111111111111101, /*enable About item, */

/* disable divider, */
/* enable all other items*/
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enabled, /*enable menu titlex/
apple, /*menu titlex/
{
/*first menu item*/
"About SurfWriter..", /*text of menu item */
/* (includes ellipsis)*/
/*item characteristics follow*/
noicon, /*icon number (if any) or */
/* script code (if any)*/
nokey, /*keyboard equivalent (if any) */
/* or submenu (if any) or */
/* small or reduced icon (if any)*/
nomark, /*marking character (if any) or */
/* menu ID of submenu (if any)*/
plain; /*style of menu item text*/
/*second menu item*/
non, /*item text (divider)*/

noicon, nokey, nomark, plain /*item characteristics*/

You should also define help balloons for each of your application’s menu items and each
menu title when you create your menus. (Figure 3-21 on page 3-31 shows help balloons
for an application’s Cut command.) You define the help balloons for your application’s
menus in 'hmmu' resources. See the chapter “Help Manager” in Inside Macintosh: More
Macintosh Toolbox for examples of how to create ' hmmu' resources.

Listing 3-1 defines the resource ID of the Apple menu as 128. You can use any number
equal to or greater than 128 as a resource ID for a menu. By convention, many
applications use 128 as the resource ID of the first menu in the application’s menu bar
(the Apple menu) and use sequential numbers for the resource IDs of following menus.

Listing 3-1 also defines the menu ID of the Apple menu as 128. Once your application
creates the menu, the Menu Manager uses the defined menu ID to refer to this menu. The
number you define for the menu ID of a menu does not have to match the resource ID of
the menu, but it is usually more convenient to use the same number. You can use any
number greater than 0 for the menu ID of a pull-down or pop-up menu; submenus of an
application can only use menu IDs from 1 through 235; submenus of a desk accessory
must use menu IDs from 236 through 255.

The listing specifies that this menu uses the standard menu definition procedure. If you
choose to create your own menu definition procedure, list its resource ID instead of the
textMenuProc constant.
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After the resource ID of the menu definition procedure is a 32-bit number (expressed as
a 31-bit field followed by a Boolean field), where bits 1-31 indicate if the correspond-
ing menu item is disabled or enabled, and bit 0 indicates whether the menu is enabled
or disabled.

The listing specifies in the 31-bit field that the first menu item should be enabled, that the
second menu item should be disabled, and that the following menu items (item numbers
3 through 31) should be enabled when the menu is first created. After creating a menu,
your application can enable or disable menu items using the EnableItem or
DisableItem procedure. If a menu contains more than 31 items, the Menu Manager
automatically enables all items following the 31st item when the menu is enabled. Your
application cannot disable any individual items following the 31st item. However, you
can disable all items, including items after the 31st item, by disabling the entire menu.

Listing 3-1 specifies that the menu title should be enabled when it is first created.

Your application can also disable or enable the menu title using the DisableItem or
EnableItem procedure. When you disable a menu using the DisableItem procedure,
the Menu Manager disables all menu items in the menu (including any items following
the 31st item) and dims the title of the menu.

The resource listing identifies the title of the menu using the constant apple. If you
specify the apple constant as the title, the Menu Manager uses a small Apple icon as the
title of the menu. The Menu Manager uses a color Apple icon if the monitor is set to
display colors. The listing then defines the characteristics of each menu item in the menu.
For each menu item, you need to define the text and any other characteristics of the menu
item. For example, Listing 3-1 defines the first item in the Apple menu as the About
command; note that the text of this menu item specifies three ellipsis points (...). Specify
three ellipsis points following the text of a menu command if your application displays a
dialog box requesting information from the user before performing the command. In
general, you should not use ellipses if your application displays a confirmation alert after
the user chooses a menu command; the About command is an exception to this guideline.

Listing 3-1 defines other characteristics of the About command—it doesn’t have an
icon to the left of the menu item text, it doesn’t have a keyboard equivalent, it doesn’t
have any mark to the left of the menu item text, and the font style of the menu item
text is plain.

By specifying various combinations of values in the icon field and keyboard equivalent
field, you can define an icon (normal, small, reduced, or color), a keyboard equivalent, a
submenu, or the script code of a menu item. Note that some characteristics are mutually
exclusive (for example, an item can have a keyboard equivalent or submenu, but not
both), as described in the following paragraphs. Table 3-6 on page 3-46 summarizes how
the Menu Manager interprets these item characteristics.
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Table 3-6 Specifying submenus, script codes, reduced icons, small icons, and color icons of a
menu item in a menu resource

Keyboard
equivalent
field

$1B

$1C

$1D

$1E

$00 or >$20

3-46

Marking
Icon field character field Description
Menu ID of Indicates the item has a submenu. The
submenu marking character field specifies the
menu ID of the submenu.
Script code of item Indicates the item text uses the script
text defined by the script code specified in the
icon field.
Icon number of Indicates the item has an icon defined by an
' ICON ' resource "ICON' resource and that it should be
reduced to fit in a 16-by-16 bit rectangle.
Icon number Indicates the item has an icon defined by an
of 'SICN' "SICN' resource.
resource
Icon number of Indicates the item has an icon defined
"ICON' or by an 'ICON' ora 'cicn'resource.
'cicn' resource (A value greater than $20 in the

keyboard equivalent field specifies the
item’s keyboard equivalent.)

To assign an icon to a menu item, specify an icon number in place of the noicon
constant. The icon number you specify should be a number from 1 through 255 (or from 1
through 254 for small icons and reduced icons); add 256 to your icon number and use the
result for the resource ID of the color icon (' cicn') resource, icon (' ICON') resource, or
small icon (' SICN') resource that describes the icons for the menu item. You must define
the icon for a menu itemina 'cicn',an 'ICON', or an 'SICN' resource; the Menu
Manager uses only these types of resources for icons you define for your menu items. The
Menu Manager first looks for a 'cicn' resource with the calculated resource ID and
uses that icon if it finds it. If it doesn’t find a ' cicn' resource (or if the computer doesn’t
have Color QuickDraw) and the keyboard equivalent field specifies $1E, the Menu
Manager looks for an 'SICN' resource with the calculated resource ID. Otherwise, the
Menu Manager looks for an ' ICON' resource and plots it in a 32-by-32 bit rectangle,
unless the keyboard equivalent field contains $1D. If the keyboard equivalent field
contains $1D, the Menu Manager reduces the icon to fit in a 16-by-16

bit rectangle.

If you provide an ' ICON' resource and specify the nokey constant or a value greater
than $20 as the keyboard equivalent, the Menu Manager enlarges the rectangle of the
entire menu item to fit the 32-by-32 bit ' ICON"' resource. If you specify a value of $1D as
the keyboard equivalent of the menu item, the Menu Manager reduces the ' ICON'
resource to fit in a 16-by-16 bit rectangle. If you provide an ' SICN' resource and specify
a value of $1E as the keyboard equivalent of a menu item, the Menu Manager plots the
small icon in a 16-by-16 bit rectangle. If you provide a 'cicn' resource, the Menu
Manager automatically enlarges the enclosing rectangle of the menu item according to
the rectangle specified in the 'cicn' resource. (For the Apple and Application menus,
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the Menu Manager automatically reduces the icon to fit within the enclosing rectangle of
a menu item or uses the appropriate icon from the application’s icon family, such as an
'ics8' resource, if one is available.) See the chapter “Finder Interface” in this book for
details on how to create icons for your application.

To assign a keyboard equivalent to a menu item, specify the 1-byte character that the user
types in addition to the Command key in place of the nokey constant in your resource
definition for the menu item. If your application attaches a submenu to a menu item, then
specify the hierarchicalMenu constant in place of the nokey constant. A menu item
can have either a keyboard equivalent or submenu defined for it, but not both. To
indicate that a menu item has an icon that is defined in an ' SICN' resource, specify $1E
in place of the nokey constant. To indicate that a menu item has an icon that is defined in
an 'ICON' resource and that the Menu Manager should reduce this icon to a 16-by-16 bit
rectangle, specify $1D in place of the nokey constant. Menu items that have small icons
or reduced icons cannot have keyboard equivalents.

To set the script code of a menu item’s text, specify $1C in place of the nokey constant
and define the desired script code in place of the noicon constant. If an item contains
$1C in its keyboard equivalent field and a script code in its icon field, the Menu Manager
draws the item’s text in the script identified by the script code value if the corresponding
script system is installed. If you do not specify a script code for a menu item, the Menu
Manager displays the menu item’s text in the system font of the current system script. For
Roman scripts, the system font is Chicago and the system font size is 12.

To assign a mark that appears to the left of the menu item text and to the left of any

icon, specify the marking character in place of the nomark constant in your resource
definition. If the menu item has a submenu, then specify the menu ID of the submenu in
place of the nomark constant. Submenus of an application must use menu IDs from

1 through 235; submenus of a desk accessory must use menu IDs from 236 through 255.
Note that defining the menu ID of a submenu in a 'MENU' resource does not attach the
submenu to its menu. You must use the GetMenu function and InsertMenu procedure
to do this. “Creating a Hierarchical Menu,” which begins on page 3-53, gives information
on attaching a submenu to its menu.

To assign a font style to a menu item, in your 'MENU' resource use the constants bold,
italic, plain, outline, and shadow to get their corresponding styles.

Listing 3-1 defines the second menu item as a divider. When you use a hyphen as the first
character in the string that defines the text of a menu item, the Menu Manager creates a
divider that extends across the entire width of the menu item. You cannot assign any
other characteristics to a divider.

The 'MENU' resource for the Apple menu does not list any other menu items. Use the
AppendResMenu procedure to add the desktop items to the Apple menu after your
application creates the menu. See “Adding Items to the Apple Menu” on page 3-68 for
more information.

Once you create a menu, you can append additional items to it using the AppendMenu,
InsertMenulItem, InsertResMenu, or AppendResMenu procedure. You can also
change the characteristics of individual menu items using Menu Manager routines. See
“Changing the Appearance of Items in a Menu” on page 3-57 for more information.
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Figure 3-12 on page 3-24 shows a typical Edit menu for an application. Listing 3-2 shows
a 'MENU' resource for this Edit menu.

Listing 3-2 Rez input for a 'MENU' resource for an Edit menu
#idefine mEdit 130
resource 'MENU' (mEdit, preload) ({ /*resource ID, preload resource*/
mEdit, /*menu ID*/
textMenuProc, /*uses standard menu definition */

3-48

/* procedure*/
0b0000000000000000001001000000000, /*enable/disable first 31 menu */
/* items as appropriate*/

enabled, /*enable titlex/

"Edit", /*text of menu titlex*/

{ /*menu items*/

"Undo", noicon, "Z", nomark, plain; /*keyboard equivalent Command-Z*/
non, noicon, nokey, nomark, plain;

"Cut", noicon, "X", nomark, plain; /*keyboard equivalent Command-X*/
"Copy", noicon, "C", nomark, plain; /*keyboard equivalent Command-C*/
"Paste", noicon, "V", nomark, plain; /*keyboard equivalent Command-V*/

"Clear", noicon, nokey, nomark, plain;
"Select All",

noicon, "A", nomark, plain; /*keyboard equivalent Command-A*/
nomn, noicon, nokey, nomark, plain;
"Create Publisher..",

noicon, nokey, nomark, plain;
"Subscribe To..",

noicon, nokey, nomark, plain;
"Publisher Options..",

noicon, nokey, nomark, plain;
non, noicon, nokey, nomark, plain;
"Show Clipboard",

noicon, nokey, nomark, plain

Listing 3-2 defines the resource ID of the Edit menu as 130, defines the menu ID of the
Edit menu as 130, and specifies that this menu uses the standard menu definition
procedure. The listing defines the initial enabled state of the first 31 menu items and
also specifies that the menu title should be enabled when it is first created.

The resource listing defines the title of the menu, Edit. It then defines the characteristics
of each menu item in the menu. For each menu item, you need to specify the text of the
menu item and any other characteristics of the menu item. For example, Listing 3-2
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defines the first item in the Edit menu as the Undo command with these characteristics:
there is no icon to the left of the menu item text, the menu item has a keyboard equivalent
of Command-Z, it does not have any mark to the left of the menu item text, and the style
of the menu item text is plain. The listing defines the second menu item as a divider line.
It defines the Cut, Copy, and Paste commands; specifies keyboard equivalents for each of
them; and defines the rest of the items in the menu.

Listing 3-3 shows another example of a resource description of a menu, the File menu of a
typical application.

Listing 3-3 Rez input for a 'MENU' resource for a File menu

resource 'MENU' (mFile, preload) {
mFile, textMenuProc,
0b0000000000000000000010000000000,

enabled,

ngpile" ,

{
"New", noicon, "N", nomark, plain;
"Open...", noicon, "O", nomark, plain;
now, noicon, nokey, nomark, plain;
"Close", noicon, "W", nomark, plain;
"Save", noicon, "S", nomark, plain;
"Save As..", noicon, nokey, nomark, plain;
momn, noicon, nokey, nomark, plain;
"Page Setup..", noicon, nokey, nomark, plain;
"Print..", noicon, "P", nomark, plain;
momn, noicon, nokey, nomark, plain;
"Quit", noicon, "Q", nomark, plain

!

¥

Creating a Menu Bar Resource

You typically define your application’s menu bar using a menu bar (' MBAR ') resource.
Listing 3-4 shows an 'MBAR' resource, in Rez format, for a sample application.

Listing 3-4 Rez input for an '"MBAR' resource
#define rMenuBar 128
#define mApple 128
#define mFile 129
#define mEdit 130
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resource 'MBAR' (rMenuBar, preload) {/*resource ID, preload*/
/*menus appear in the order listed here*/
{ mApple, mFile, mEdit }; /*resource IDs for menus in */
/* this menu bar*/

}i

Listing 3-4 defines the 'MBAR' resource with resource ID 128. This 'MBAR' resource
defines the order and resource IDs of the menus contained in it; it defines its first
three menus as the menus with resource IDs 128, 129, and 130. The Menu Manager
uses the assigned resource IDs to read in the menus when it creates a menu bar from
an 'MBAR' resource.

Setting Up Your Application’s Menu Bar

To create a menu list as defined in an 'MBAR' resource, use the GetNewMBar function.
For each menu defined by the 'MBAR' resource, the GetNewMBar function creates a
menu record for the menu, creates each menu according to its resource definition in its
corresponding 'MENU' resource, and inserts each menu into the new menu list. The
GetNewMBar function returns a handle to the created menu list. For example, this code
creates a menu list for the menu bar defined by the 'MBAR' resource with resource ID
128 (defined by the constant rMenuBar):

CONST
rMenuBar = 128;
VAR
menuBar: Handle;
menuBar := GetNewMBar (rMenuBar); {read menus and menu bar }

{ descriptions,create & return }
{ a handle to a new menu list}

Use the SetMenuBar procedure to set the current menu list to the menu list created
by your application and the DrawMenuBar procedure to update the menu bar’s
appearance. For example, Listing 3-5 uses these two routines to set up the application’s
menu bar.

Listing 3-5 Setting up an application’s menus and menu bar

PROCEDURE MyMakeMenus ;
VAR
menuBar: Handle;

BEGIN

{first use the GetNewMBar function to read menus in & create a |}
{ new menu list. If you define an Apple menu, the Menu Manager |}
{ inserts the Help and Application menus (and Keyboard menu if }
{ necessary) into the newly created menu list}
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menuBar := GetNewMBar (rMenuBar) ;
IF menuBar = NIL THEN
EXIT (MyMakeMenus) ;
SetMenuBar (menuBar) ; {insert menus into the current menu list}
DisposHandle (menuBar) ;
{add desktop items in Apple Menu Items }
{ folder to Apple menu}

AppendResMenu (GetMenuHandle (mApple), 'DRVR') ;
MyAdjustMenus; {adjust items and enabled state of menus}
DrawMenuBar; {draw the menu bar}

END;

The code in Listing 3-5 creates the application’s menu bar by reading in the definition
from the 'MBAR' resource with resource ID 128, and it uses SetMenuBar to set the
current menu list to the newly created menu list. The code then adds the desktop
items in the Apple Menu Items folder to the Apple menu using the AppendResMenu
procedure.

You can use the GetMenuHandle function to get a handle to the menu record of

any menu in the current menu list. You supply the menu ID of the desired menu as a
parameter to GetMenuHandle, and GetMenuHandle returns a handle to the menu’s
menu record. Most Menu Manager routines require either a menu ID or a handle to

a menu record as a parameter.

After creating the menu bar and adding any other menus or items as necessary, the code
calls the MyAdjustMenus procedure to adjust the application’s menus—for example,
this procedure sets the enabled and disabled states of menu items in accordance with the
current state of the application. (Listing 3-19 on page 3-74 shows the application-defined
MyAdjustMenus procedure used in Listing 3-5.) After adjusting the menus, the code in
Listing 3-5 uses DrawMenuBar to draw the menus in the menu bar according to their
current enabled state and as they are defined in the current menu list.

Usually you'll define the menus of your application and its menu bar using ' MENU'
resources and an 'MBAR' resource and using the GetNewMBar function to read the
resource definitions. However, you can choose to read in a 'MENU' resource using the
GetMenu function or to create a new empty menu using NewMenu. You can then insert
a menu into the current menu list using the InsertMenu procedure. See “Creating
Menus” on page 3-105 and “Adding Menus to and Removing Menus From the Current
Menu List” on page 3-108 for information on forming your menus using these routines.

If your application uses a submenu, you need to use the GetMenu function and
InsertMenu procedure to make these menus available to your application. See
“Creating a Hierarchical Menu” on page 3-53 for information on creating submenus.
If your application uses a pop-up menu, you can use the pop-up control definition
function and Dialog Manager or Control Manager routines to create and display

the pop-up menu. See “Creating a Pop-Up Menu” on page 3-56 for information on
creating pop-up menus.
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The Menu Manager creates and initializes your application’s menu color information
table when your application calls GetNewMBar. You can add entries to your application’s
menu color information table if you want to use colors other than the default colors in
your menus and menu bar. You can add entries to this table by providing menu color
information table (' mctb ') resources or by using the SetMCEntries procedure.
Usually you should use the default colors to help maintain

a consistent user interface.

If you add menu color entries to your application’s menu color information table and
your application uses more than one menu bar, you need to save a copy of your
application’s menu color information table before changing menu bars. Use the
GetMCInfo function before calling GetNewMBar and call SetMCInfo afterward to
restore the menu color information table. Listing 3-6 shows a routine that saves and
then restores the menu color information table when creating a new menu bar.

PRO
CON

VAR

BE

Listing 3-6 Saving and restoring menu color information
CEDURE MyChangeMenuBarAndSaveColorInfo;
ST
rMenuBar2 = 129;
menu: MenuHandle;
menuBar: Handle;
currentMCTable: MCTableHandle;
newMCTable: MCTableHandle;
GIN
currentMCTable := GetMCInfo; {save menu color info table}

IF currentMCTable = NIL THEN
EXIT (MyChangeMenuBarAndSaveColorInfo) ;
menuBar := GetNewMBar (rMenuBar2) ; {read menus in & create new menu list}
IF menuBar = NIL THEN
EXIT (MyChangeMenuBarAndSaveColorInfo) ;
newMCTable := GetMCInfo; {get new menu color info table}
IF newMCTable = NIL THEN
EXIT (MyChangeMenuBarAndSaveColorInfo) ;

SetMCInfo (currentMCTable) ; {restore previous menu color info table}
SetMenuBar (menuBar) ; {insert menus into the current menu list}
DisposHandle (menuBar) ;
AppendResMenu (GetMenuHandle (m2Apple), 'DRVR'); {add desktop items from }

{ hpple Menu Items folder to Apple menu}
MyAdjustMenus ; {adjust menu items}
DrawMenuBar ; {draw the menu bar}

END;

3-52 Using the Menu Manager



CHAPTER 3

Menu Manager

Creating a Hierarchical Menu

A hierarchical menu is a menu that has a submenu attached to one or more of its menu
items. Submenus can be useful when your application needs to offer additional choices to
the user without taking up extra space in the menu bar. If you use a submenu in your
application, use it to give the user additional choices or to choose attributes, not
additional commands.

A menu item of a pull-down menu is the title of the attached submenu. A menu item that
has a triangle facing right in the location of the keyboard equivalent identifies

that a submenu is attached to the menu item. The title of a submenu should represent
the choices it contains. Figure 3-32 shows a menu with a submenu whose menu title is
Label Style.

Figure 3-32 A menu item with a submenu
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When a user drags the cursor through a menu and rests it on a menu item with a
submenu attached to it, the Menu Manager displays the submenu after a brief delay.
The title of the submenu remains highlighted while the user browses through the
submenu; the Menu Manager unhighlights the menu title of the submenu when the
user releases the mouse button.

Your application is responsible for placing any marks next to the current choice or
attribute of the submenu. For example, in Figure 3-32 the application placed the
checkmark next to the Numeric menu item to indicate the current choice. If the user
makes a new choice from the menu, your application should update the menu items
accordingly.

You can specify that a particular menu item has a submenu by identifying this
characteristic (using the hierarchicalMenu constant) when you define the menu item
inits 'MENU' resource. You cannot assign keyboard equivalents to a menu item that has
a submenu. (You can define keyboard equivalents for the menu items in the submenu,
but this is not recommended.) You identify the menu ID of the submenu in place of the
marking character in the menu item’s resource description. Thus, a menu item that has a
submenu cannot have a marking character and cannot have a keyboard equivalent.
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To insert a submenu into the current menu list, you must use the InsertMenu
procedure. The GetNewMBar function does not read in the resource descriptions of

any submenus.

Listing 3-7 shows the 'MENU' resource for an application-defined menu called Outline.
The Outline menu contains a number of menu items, including the Label Style menu
item. The description of this menu item contains the constant hierarchicalMenu,
which indicates that the item has a submenu. This menu item description also contains
the menu ID of the submenu (defined by the mSubMenu constant). The menu ID of a
submenu of an application must be from 1 through 235; the menu ID of a submenu of a
desk accessory must be from 236 through 255.

The submenu is defined by the menu with the menu ID specified by the Label Style menu
item. You define the menu items of a submenu in the same way as you would a
pull-down menu (except you shouldn’t define keyboard equivalents for items in a
submenu, and you shouldn’t attach a submenu to another submenu).

Listing 3-7 Rez input for a description of a hierarchical menu with a submenu

#define mOutline 135
#define mSubMenu 181

resource
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'MENU' (mOutline, preload) {

mOutline , /*menu ID*/

textMenuProc,

0b0000000000000000000000000010000,

enabled,

"Outline", /*menu titlex/

{ /*menu items*/
"Expand", noicon, "E", nomark, plain;
"Expand To..", noicon, nokey, nomark, plain;
"Expand All", noicon, nokey, nomark, plain;
"Collapse", noicon, nokey, nomark, plain;
non, noicon, nokey, nomark, plain;

/*the Label Style
"Label Style",

"Move Left",
"Move Right",
"Move Up",

"Move Down'",

item has a
noicon,
noicon,
noicon,
noicon,
noicon,

noicon,
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resource 'MENU' (mSubMenu ,
mSubMenu ,
textMenuProc,

preload)

{

/*menu ID*/

0b0000000000000000000000001111111,

enabled,
"Label Style",

"Alphabetic",
"Bullet™",
"Chicago",
"Harvard",
"Legal",
"Numeric",

"Roman",

noicon,
noicon,
noicon,
noicon,
noicon,
noicon,

noicon,

/*menu title (ignored--defined */

/* by parent menu item text)*/

/*menu items*/

nokey,
nokey,
nokey,
nokey,
nokey,
nokey,
nokey,

nomark,
nomark,
nomark,
nomark,
nomark,
nomark,
nomark,

plain;
plain;
plain;
plain;
plain;
plain;
plain

When you use GetNewMBar to read in menu descriptions and create a new menu list,
GetNewMBar records the menu ID of any submenu in the menu record but does not read
in the description of the submenu. To read a description of a submenu, use the GetMenu
function. To actually insert a submenu into the current menu list, you must use the
InsertMenu procedure.

When needed, your application can use the GetMenu function to read a description of
the characteristics of a menu from a 'MENU' resource. The GetMenu function creates a
menu record for the menu, allocating space for the menu record in your application’s
heap. The GetMenu function creates the menu and menu items (and fills in the menu
record) according to its 'MENU' resource. The GetMenu function does not insert the
menu into a menu list. When you're ready to add it to the current menu list, use the
InsertMenu procedure.

Listing 3-8 uses the GetMenu function to read the description of a submenu and uses the
InsertMenu procedure to insert the menu into the current menu list.

Listing 3-8 Creating a hierarchical menu

PROCEDURE MyMakeSubMenu

VAR

subMenu: MenuHandle;

BEGIN

(subMenuResID:

subMenu := GetMenu (subMenuResID) ;

InsertMenu (subMenu,

END;
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To insert a submenu into the current menu list using the InsertMenu procedure, specify
-1 in the second parameter to insert the menu into the submenu portion of the menu list.
As the user traverses menu items, if a menu item has a submenu the MenuSelect
function looks in the submenu portion of the menu list for the submenu; it searches for a
menu with a defined menu ID that matches the menu ID specified by the hierarchical
menu item. If it finds a menu with a matching menu ID, it attaches the submenu to the
menu item and allows the user to browse through the submenu.

Creating a Pop-Up Menu

In System 7, pop-up menus are implemented as controls. You define the menu items of a
pop-up menu in the same way as in other menus (using a 'MENU' resource), and you
define specific features of the pop-up menu itself (such as the location of the pop-up
menu) in a control that uses the standard pop-up control definition function. Pop-up
menus provide the user with a simple way to select from among a list of choices without
having to move up to the menu bar. They are particularly useful in a dialog box that
requires the user to specify a number of settings or values. Figure 3-33 shows an example
of a pop-up menu in a dialog box.

Figure 3-33 A pop-up menu in a dialog box
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To create a pop-up menu, create a control that uses the pop-up control definition
function, define the pop-up menu and its menu items, and associate the control with a
window or dialog box. You can use Dialog Manager or Control Manager routines to
display pop-up menus.

For example, if you define a modal dialog box that contains a pop-up control and use the
Dialog Manager to display and help handle events in the dialog box, the Dialog Manager
automatically uses the pop-up control definition function to draw the control and also to
handle user interaction when the user presses the mouse button while the cursor is over a
pop-up control.

If your application defines a control in one of your application’s windows, you can use
TrackControl and other Control Manager routines to handle the pop-up menu.

The pop-up control definition function draws a box around the pop-up box, draws the
drop shadow, inserts the text into the pop-up box, draws the downward-pointing
triangle, and draws the pop-up title. When a dialog box contains a control that uses the
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pop-up control definition function and the user presses the mouse button while the
cursor is in the pop-up control, the pop-up control definition function highlights the
pop-up menu title, displays the pop-up menu, and handles all user interaction until the
user releases the mouse button. When the user releases the mouse button, the pop-up
control definition function closes the pop-up box, draws the user’s choice in the pop-up
box (or restores the previous item if the user did not make a new choice), stores the user’s
choice as the value of the control, and unhighlights the pop-up menu title. Your
application can use the Control Manager function GetControlValue to get the value of
the control and to determine the currently selected item in the pop-up menu.

To create a pop-up control, create a control and specify that the control uses the pop-up
control definition function by specifying the popupMenuProc constant:

CONST popupMenuProc = 1008; {pop-up menu control}

If you specify popupMenuProc (plus any appropriate variation code) as the procID
field of the resource description of a control, when your application creates the control
(by using the Dialog Manager or by using GetNewControl) the Control Manager creates
the pop-up control, which includes the pop-up title and the pop-up box with a one-pixel
drop shadow. The appearance of the pop-up title and the values in the menu are
controlled by other values stored in the resource (or other parameters passed to
NewControl). See the chapter “Control Manager” in this book for information on

the NewControl function.

If your application does not use the standard pop-up control definition function, you
can create your own control definition function to implement pop-up menus. In this
case you can use the PopUpMenuSelect function to draw the pop-up menu and track
the cursor within the menu. Your application is responsible for highlighting the title of
the pop-up menu before calling PopUpMenuSelect and unhighlighting the title
afterward (to duplicate the behavior of menu titles in the menu bar). Your application
must also set the mark of the items in the pop-up menu as appropriate if you use the
PopUpMenuSelect function.

For more information on creating controls, see the chapter “Control Manager” in this
book. For listings that define the dialog box shown in Figure 3-33, see the chapter “Dialog
Manager” in this book.

Changing the Appearance of ltems in a Menu

You can change the appearance of an item in a menu using Menu Manager routines. For
example, you can change the font style, text, or other characteristics of menu items. You
can also enable or disable a menu item.

Most of the Menu Manager routines that get or set characteristics of a particular menu
item require three parameters:

m a handle to the menu record of the menu containing the desired menu item
m the number of the menu item

m a variable that either specifies the data to set or identifies where to return information
about that item
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Enabling and Disabling Menu Items

Using the EnableItemand DisableItem procedures, you can enable and disable
specific menu items or an entire menu. You pass as parameters to these two procedures a
handle to the menu record that identifies the desired menu and either an item number
that identifies the particular menu item to enable or disable or a value of 0 to indicate that
the entire menu should be enabled or disabled.

Your application should always enable and disable any menu items as appropriate—
according to the user’s content—before calling MenuSelect or MenuKey. For example,
you should enable the Paste command when the scrap contains data that the user can
paste. (Listing 3-19 on page 3-74 shows code that adjusts an application’s menus.)

When you disable or enable an entire menu, call DrawMenuBar to update the menu bar.
The DrawMenuBar procedure draws the menus in the menu bar according to their
current enabled state and as they are defined in the current menu list.

If you disable an entire menu, the Menu Manager dims the menu title at your
application’s next call to DrawMenuBar and dims all items in the menu when it displays
the menu. If you enable an entire menu, the Menu Manager enables only the menu title
and any items that you did not previously disable individually; the Menu Manager does
not enable any item that your application previously disabled by calling DisableItem
with that menu item’s item number. For example, if all items in your application’s Edit
menu are enabled, you can disable the Cut and Copy commands individually using
DisableItem. If you choose to disable the entire menu by passing 0 as the menu item
parameter to DisableItem, the menu and all its items are disabled. If you then enable
the entire menu by passing 0 as the menu item parameter to EnableItem, the menu and
its items are enabled, except for the Cut and Copy commands, which remain disabled. In
this case, to enable the Cut and Copy commands, you must enable each one individually
using EnableItem.

You can use DisableItem to disable items that aren’t appropriate at a given time. For
example, you can disable the Cut and Copy commands when the user has not selected
anything to cut or copy and disable the Paste command when the scrap is empty.

This code enables the File menu, disables the Cut and Copy commands in the Edit menu,

and disables the application-defined menu Colors.

VAR
menu: MenuHandle;

menu := GetMenuHandle (mFile); {get a handle to the File menu}
EnableItem(menu, 0); {enable File menu and any items }
{ not individually disabled}
DrawMenuBar; {update menu bar's appearance}
menu := GetMenuHandle (mEdit); {get a handle to the Edit menu}
DisableItem(menu, iCut); {disable the Cut command}
DisableItem(menu, iCopy) ; {disable the Copy command}
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menu := GetMenuHandle (mColors); {get a handle to Colors menu}
DisableItem(menu, 0); {disable Colors menu & all }

{ items in it}
DrawMenuBar; {update menu bar's appearance}

If you disable or enable an entire menu, call DrawMenuBar when you need to update the
menu bar’s appearance. If you do not need to update the menu bar immediately, you can
use the InvalMenuBar procedure instead of DrawMenuBar, thus reducing flickering in
the menu bar. Rather than drawing the menu bar twice as in the previous example, you
can use InvalMenuBar instead of DrawMenuBar, causing the Event Manager to redraw
the menu bar the next time it scans for update events. The InvalMenuBar procedure is
available in System 7 and later. See page 3-114 for additional details on the
InvalMenuBar procedure.

Changing the Text of an ltem

You can get or set the text of a menu item using Menu Manager routines.

To get the text of a menu item, use the GetMenuItemText procedure. For example, you
can use the GetMenuItemText procedure to get the text of a menu item that you added
to a menu using InsertResMenu or AppendResMenu.

To set the text of a menu item, use the SetMenuItemText procedure. You can use

the SetMenuItemText procedure as a convenient way to change the text of a menu
command that allows the user to toggle between two states. For example, if your
application has a menu command that allows the user to either show or hide the
Clipboard window, depending on whether the window is currently showing, you can
change the text of the menu item at the appropriate time using the SetMenuItemText
procedure.

Listing 3-9 changes the text of a menu item from Hide Clipboard to Show Clipboard or
vice versa, based on the state of an application-defined global variable (gToggleState)
that holds the state information.

Listing 3-9 Changing the text of a menu item

PROCEDURE MyToggleHideShow;

VAR
myMenu : MenuHandle;
item: Integer;
itemString: Str255;
BEGIN
myMenu := GetMenuHandle (mEdit) ;
item := iToggleHideShow;
IF gToggleState = kShow THEN
BEGIN
GetIndString (itemString, kMyStrings, kShowClipboard) ;
gToggleState := kHide;
END
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ELSE
BEGIN
GetIndString (itemString, kMyStrings, kHideClipboard) ;
gToggleState := kShow;
END;
SetMenultemText (myMenu, item, itemString) ;
END;

Note that if you use the SetMenuItemText procedure, you should define the text of the
menu item in a string resource or string list resource (for example, using an 'STR ' or
'STR# ' resource). This makes your application easier to localize.

Changing the Font Style of Menu Items

You can change or get the font style of a menu item using the SetItemStyle or
GetItemStyle procedure. To set the style of a menu item, specify a handle to the menu
record of the menu containing the menu item whose style you want to set, specify the
number of the menu item to set, and specify the desired style.

You specify the style using values from the set defined by the Style data type:

TYPE
StyleItem = (bold, italic, underline, outline, shadow,
condense, extend) ;
Style = SET OF Styleltem;

You can set the style of a menu item to zero, one, or more than one of the styles defined
by the StyleItemdata type. You can set the style of a menu item to the empty set to
obtain the plain font style.

Listing 3-10 shows code that sets the style of menu items listed in an application’s
Style menu.

Listing 3-10 Setting the font style of menu items

3-60

VAR
menu: MenuHandle;
itemStyle: Style;

menu := GetMenuHandle (mStyle); {get a handle to the Style menu}
itemStyle := [italic];

SetItemStyle (menu, ilItalic, itemStyle);{set to italic style}
itemStyle := [bold];

SetItemStyle (menu, iBold, itemStyle);{set item to bold style}
itemStyle := [bold, Italic];

SetItemStyle (menu, iBoldItal, itemStyle);{bold & italic style}
itemStyle := [];

SetItemStyle (menu, iPlain, itemStyle);{set item to plain style}

To get the style of a menu item, you can use the Get ItemStyle procedure.
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Changing the Mark of Menu Iltems

You can change or get the mark of a menu item using the Set ItemMark or
GetItemMark procedure. To set the mark of a menu item to a checkmark, you
can use either the CheckItem or the SetItemMark procedure.

To set the mark of a menu item, specify a handle to the menu record of the menu
containing the item whose mark you want to set, specify the number of the menu
item to set, and specify the mark to use as the marking character of the menu item.

You typically use checkmarks and dashes in menus that contain commands that set
attributes and that you have grouped in accumulating groups. For example, you use a
combination of checkmarks and dashes in the Style menu to indicate whether the
selection contains more than one style. Figure 3-8 on page 3-15 shows an example of
using checkmarks and dashes in a menu. “Groups of Menu Items” beginning on

page 3-14 gives guidelines for determining how to group your menu items.

You specify the mark of the menu item by passing a character as one of the parameters to
the Set ItemMark procedure. You should use only the standard marking characters,
such as the checkmark, diamond, or dash, in your menu items; avoid using other marks
that might confuse the user. You can use the constants listed here to specify that the item
has no mark or to set the marking character to a checkmark or diamond:

CONST noMark = 0; {no marking character}
checkMark = $12; {checkmark}
diamondMark = $13; {diamond symbol}

As another example of the use of marks in menus, Listing 3-11 shows code that sets the
mark of items in an application-defined Directory menu. It sets the marking character of
the menu item of the last directory accessed to a checkmark, sets the marking character of
the second-last directory accessed to the diamond mark, and removes the mark from the
third-last directory accessed.

Listing 3-11 Adding marks to and removing marks from menu items

VAR
menu: MenuHandle;
itemMark: Char;
{get handle to Directory menu}
menu := GetMenuHandle (mDirectory) ;
itemMark := CHR (checkMark) ;
SetItemMark (menu, gLastDir, itemMark) ; {set mark to checkmark}
itemMark := CHR (diamondMark) ;

SetItemMark (menu, gOldLastDir, itemMark) ; {set mark to diamond}

itemMark := CHR (noMark) ;
SetItemMark (menu, gSecondLastDir, itemMark) ;{remove any mark}
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You can also set the mark of a menu item to a checkmark using the CheckItem
procedure:

VAR
menu: MenuHandle;
{get handle to Directory menu}
menu := GetMenuHandle (mDirectory) ;
CheckItem(menu, gLastDir, TRUE) ; {set to checkmark}
CheckItem(menu, gSecondLastDir, FALSE);{remove checkmark or }
{ any other mark}

Changing the Icon or Script Code of Menu Items

You can change or get the icon of a menu item using the SetItemIcon or GetItemIcon
procedure. You can also use these procedures to get or set the
script code of a menu item’s text.

To set the script code of a menu item using the Set ItemIcon procedure, you need to

m specify a handle to the menu record of the menu containing the item whose script code
you want to set

m specify the number of the menu item to set
m specify the script code

To set a menu item’s script code, you must also define the keyboard equivalent field of
the item to $1C. If an item contains $1C in its keyboard equivalent field and a script code
in its icon field, the Menu Manager draws the item in the script identified by the script
code value if the corresponding script system is installed.

To set the icon of a menu item using the Set ItemIcon procedure, you need to

m specify a handle to the menu record of the menu containing the item whose icon you
want to set

m specify the number of the menu item to set

m specify the icon number (the Menu Manager uses the icon number to generate the
resource ID of the icon)

The icon number that you specify to Set ItemIcon must be a value from 1 through 255
for color icons or icons, from 1 through 254 for small icons and reduced icons, or 0 to
specify that the item doesn’t have an icon. The Menu Manager adds 256 to the number
you specify and uses this calculated number as the icon’s resource ID. For example, if you
specify the icon number as 5, the Menu Manager uses the Resource Manager to find the
icon with resource ID 261. The Menu Manager first looks for an icon resource of type
'cicn';if it can’t find one with the calculated resource ID number (or if the computer
doesn’t have Color QuickDraw), it looks for a resource of type ' SICN' if the keyboard
equivalent field contains $1E; otherwise, it looks for an ' ICON' resource.

Use either an 'ICON' or 'SICN' resource if you want to provide only a black-and-white
icon. In addition, provide a 'cicn' resource if you want the Menu Manager to use a
color icon when Color QuickDraw is available. Figure 3-34 shows examples of icons in a
menu item generated from icon resources: an 'SICN' resource, an ' ICON' resource, an
'ICON' resource reduced to fit in a 16-by-16 bit rectangle, and a ' cicn' resource.
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Figure 3-34 Icons in menu items
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The Menu Manager automatically fits the icon in the menu item according to your
specifications. If the Menu Manager uses a ' cicn' resource, it automatically enlarges the
enclosing rectangle of the menu item according to the rectangle specified in the 'cicn'
resource. If the Menu Manager uses an ' ICON' resource and the item specifies the
nokey constant as the keyboard equivalent, the Menu Manager enlarges the rectangle of
the menu item to fit the 32-by-32 bit ' ICON' resource. You can request that the Menu
Manager reduce an ' ICON' resource to the size of a 16-by-16 bit small icon by specifying
a value of $1D as the item’s keyboard equivalent. To request that the Menu Manager use
an 'SICN' resource instead of an ' ICON' resource, specify a value of $1E as the item’s
keyboard equivalent.

This code sets the icon of a menu item to a specified icon.

VAR
menu: MenuHandle;
itemIcon: Byte;
itemIcon := 5;
menu := GetMenuHandle (mWeather) ;

{set the icon for this item in the Weather menu}
SetItemIcon (menu, iBeachWeather, itemIcon) ;

Listing 3-12 shows the Rez description of three menu items, each of which contains icons.
The first menu item has an icon with resource ID 261 (5 plus 256) and is defined by a
resource type of either 'cicn' or ' ICON'. The second menu item has an icon with
resource ID 262 (6 plus 256) and is identified by eithera 'cicn' resource or an ' ICON'
resource; however, in this case, the value of $1D requests the Menu Manager to reduce
the ' ICON' resource to a small icon. The third menu item has an icon with resource ID
263 (7 plus 256) and is defined by either a ' cicn' resource or an ' SICN' resource.

Listing 3-12 Specifying icons for menu items

#define mWeather 138

resource 'MENU' (mWeather, preload) {
mWeather,
textMenuProc,
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0b0000000000000000001011101100111,
enabled, “Weather",
{
"Beach Weather", /*item has icon or color icon */
/* with icon number 5%*/
5, nokey, nomark, plain;
"Ski Weather", /*item has reduced icon or color */
/* icon with icon number 6%/
6, $1D, nomark, plain;
"Kite-Flying Weather",/*item has small icon or */
/* color icon with icon number 7%/
7, $1E, nomark, plain

}i

See the chapter “Finder Interface” in this book for details on how to create icons.

Adding Items to a Menu

Usually you define a menu and all its items in a 'MENU' resource. Occasionally you
might need to add items to a menu after you've created it. After creating a menu (using
NewMenu, GetMenu, or GetNewMBar), you can add items to it using the AppendMenu,
InsertMenultem, AppendResMenu, or InsertResMenu procedure.

You can use AppendResMenu or InsertResMenu to add items that consist of resource
names to a menu. For example, you can use the AppendResMenu procedure to add fonts
to your application’s Font menu or to add all of the desktop items from the Apple Menu
Items folder to your application’s Apple menu. These are common instances when you'll
need to add items not already defined in a 'MENU' resource to a menu. See “Adding
Fonts to a Menu” on page 3-69 and “Adding Items to the Apple Menu” on page 3-68 for
information on adding names of resources to menus.

If you add items to your application’s Help menu, you'll need to use AppendMenu or
InsertMenuItem to add the additional items. This section discusses how to add items
using the AppendMenu and InsertMenultem procedures, and “Adding Items to the
Help Menu” on page 3-67 shows a specific example of adding items to the Help menu.

If you need to add items other than the names of resources to a previously created menu,
you can use the AppendMenu or InsertMenultem procedure. You can use
AppendMenu to add items to the end of a menu; note that you can add items to only the
end of the menu when using AppendMenu. Use InsertMenultem to add items after
any given item in a menu. When you add items to a menu using AppendMenu or
InsertMenuItem, you can specify the same characteristics for menu items that are
available to you when defining 'MENU' resources.
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You specify a handle to the menu record of the menu to which you want to add the item
or items, and you specify a string describing the items to add as parameters to the
AppendMenu or InsertMenultem procedure. The string you pass to these procedures
should consist of the text and any characteristics of the menu items. You can specify a
hyphen as the menu item text to create a divider line. You can also use various
metacharacters in the text string to separate menu items and to specify certain
characteristics of the menu items. The metacharacters aren’t displayed in the menu.

Here is a list of the metacharacters you can use in the text string that you specify to the
AppendMenu or InsertMenultem procedure:

Metacharacter Description
; or Return Separates menu items.

A

When followed by an icon number, defines the icon for the item. If the
keyboard equivalent field contains $1C, this number is interpreted as
a script code.

! When followed by a character, defines the mark for the item. If the
keyboard equivalent field contains $1B, this value is interpreted as
the menu ID of a submenu of this menu item.

< When followed by one or more of the characters B, I, U, O, and S,
defines the character style of the item to Bold, Italic, Underline,
Outline, or Shadow, respectively.

/ When followed by a character, defines the keyboard equivalent for the
item. When followed by $1B, specifies that this menu item has a
submenu. To specify that the menu item has a script code, small icon,
or reduced icon, use the Set ItemCmd procedure to set the keyboard
equivalent field to $1C, $1D, or $1E, respectively.

( Defines the menu item as disabled.

You can specify any, all, or none of these metacharacters in the text string to define the
characteristics of a menu item. Note that the metacharacters that you specify aren’t
displayed in the menu item. (To use any of these metacharacters in the text of a menu
item, first use AppendMenu or InsertMenultem, specifying at least one character as the
item’s text. Then use the SetMenuItemText procedure to set the item’s text to the
desired string.)

Note

If you add menu items using the AppendMenu or InsertMenuIltem
procedure, you should define the text and any marks or keyboard
equivalents in resources for easier localization. &

Listing 3-13 shows a string list (' STR# ') resource that stores the text of the menu items
used in the next examples.
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Listing 3-13 Rez input for text of menu items

3-66

resource 'STR#' (300, "Text for appended menu items")
{
/* 111/
"Just Text";
/*[21%/
"Pick a Color..";
/*[31%/
" (*21=Everything<B/E";
}

) i

Here’s code that uses the AppendMenu procedure to append a menu item with no
specific characteristics other than its text to the menu identified by the menu handle in
the myMenu variable. The text for the menu item is “Just Text” as stored in the ' STR# '
resource with resource ID 300.

VAR
myMenu : MenuHandle;
itemString: Str255;

myMenu := GetMenuHandle (mLibrary) ;
GetIndString(itemString, 300, 1);
AppendMenu (myMenu, itemString) ;

To insert an item after a given menu item, use the InsertMenulItem procedure. For
example, this code inserts the menu item Pick a Color after the menu item with the item
number specified by the iRed constant. The text for the new menu item consists of the
string “Pick a Color...” as stored in the ' STR# ' resource with resource ID 300.

VAR
myMenu : MenuHandle;
itemString: Str255;

myMenu := GetMenuHandle (mColors) ;
GetIndString(itemString, 300, 2);
InsertMenultem(myMenu, itemString, iRed) ;

If you do not explicitly specify a value for an item characteristic in the text string that you
pass to AppendMenu or InsertMenultem, the procedure assigns the default value for
that characteristic. The Menu Manager defines the default item characteristics as no icon,
no marking character, no keyboard equivalent, and plain text style. AppendMenu and
InsertMenuItem enable the added menu items unless you specify otherwise.

This code appends a menu item with the text “Everything” to the menu identified by the
menu handle in the myMenu variable. The text and other characteristics of this menu item
are stored in the ' STR# ' resource shown in Listing 3-13. It also specifies that this menu

Using the Menu Manager



CHAPTER 3

Menu Manager

item is disabled, has an icon with resource ID 258 (2 + 256), and has the “=" character as a
marking character; the style of the text is Bold; and the menu item has a keyboard
equivalent of Command-E.

VAR
myMenu : MenuHandle;
itemString: Str255;

myMenu := GetMenuHandle (mLibrary) ;
GetIndString(itemString, 300, 3);
AppendMenu (myMenu, itemString) ;

This code appends multiple items to the Edit menu using AppendMenu:

VAR
myMenu: MenuHandle;

myMenu := GetMenuHandle (mEdit) ;
AppendMenu (myMenu, 'Undo/Z;-;Cut/X;Copy/C;Paste/V');

The InsertMenulItem procedure differs from AppendMenu in how it handles the given
text string when the text string specifies multiple items. The InsertMenuItem
procedure inserts the items in the reverse of their order in the text string. For example,
this code inserts menu items into the Edit menu using InsertMenulItemand is
equivalent to the previous example:

VAR

myMenu : MenuHandle;

myMenu := GetMenuHandle (mEdit) ;
InsertMenultem (myMenu, 'Paste/V';Copy/C;Cut/X;-;Undo/Z',0);

Once you've added a menu item to a menu, you can change any of its characteristics

using Menu Manager routines, as described in “Changing the Appearance of Items in a
Menu” on page 3-57.

Adding ltems to the Help Menu

You add items to the Help menu by using the HMGetHelpMenuHandle function and
either the AppendMenu or InsertMenultem procedure.

The HMGetHelpMenuHandle function returns a copy of the handle to the menu record
of your application’s Help menu. Do not use the GetMenuHandle function to get a
handle to the Help menu, because GetMenuHandle returns a handle to the global Help
menu, not the Help menu that is specific to your application. Once you have a handle to
the Help menu that is specific to your application, you can add items to it using the
AppendMenu procedure or other Menu Manager routines. For example, Listing 3-14 adds
the menu item displayed in Figure 3-19 on page 3-30.
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Listing 3-14 Adding an item to the Help menu

3-68

PROCEDURE MyAddHelpItem;

VAR
myMenu : MenuHandle;
myErr: OSErr;
itemString: Str255;
BEGIN
myErr := HMGetHelpMenuHandle (myMenu) ;

IF myErr = noErr THEN

IF myMenu <> NIL THEN

BEGIN
{get the string (with index kSurfHelp) from the 'STR#' }
{ resource with resource ID kMyStrings}
GetIndString (itemString, kMyStrings, kSurfHelp) ;
AppendMenu (myMenu, itemString) ;

END;

END;

When you add items to the Help menu, the Help Manager automatically adds a divider
between the end of the standard Help menu items and your items.

Be sure to use an ' hmnu' resource and specify the kHMHe1pMenuID constant as the
resource 1D to provide help balloons for items you've added to the Help menu. (The Help
Manager automatically creates the help balloons for the Help menu title and the standard
Help menu items.) See the chapter “Help Manager” in Inside Macintosh: More Macintosh
Toolbox for specific information on the 'hmnu' resource.

The Help Manager automatically processes the event when a user chooses any of the
standard menu items in the Help menu. The Help Manager automatically enables and
disables help when the user chooses Show Balloons or Hide Balloons from the Help
menu. The setting of Balloon Help is global and affects all applications. See “Handling
the Help Menu” on page 3-81 for information on responding to the user when the user
chooses one of your appended items.

Adding Items to the Apple Menu

To insert the items contained in the Apple Menu Items folder into your application’s
Apple menu, use the AppendResMenu or InsertResMenu procedure and specify
'"DRVR' as the resource type. Doing so causes this procedure to automatically add all
items in the Apple Menu Items folder to the specified menu.

The user can place any desktop object in the Apple Menu Items folder. When the user
places an item in this folder, the system software automatically adds it to the list of items
in the Apple menu of all open applications.
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After inserting the Apple menu into your application’s menu bar (by using GetNewMBar
or GetMenu and InsertMenu), your application can add items to it. Listing 3-15 shows
code that uses GetMenuHandle to get a handle to the application’s Apple menu. The
code then uses the AppendResMenu procedure, specifying that AppendResMenu should
add all desktop items in the Apple Menu Items folder to the application’s Apple menu.

Listing 3-15 Adding menu items to the Apple menu

VAR
myMenu : MenuHandle;

myMenu := GetMenuHandle (mApple) ;
IF myMenu <> NIL THEN
AppendResMenu (myMenu, 'DRVR');{add desktop items in the }
{ Apple Menu Items folder }
{ to the Apple menu}

Listing 3-16 on page 3-70 shows a complete sample that sets up an application’s menu
bar, adds items to the Apple menu, adds items to the Font menu, and then updates the
appearance of the menu bar.

Adding Fonts to a Menu

If your application provides a Font menu, you typically include the description of the
menu in a 'MENU' resource, include a description of your menu bar in an 'MBAR'
resource, and use GetNewMBar to create your menu bar and all menus in the menu bar.
Once you've created the menu, you can use AppendResMenu to add the names of all font
resources in the Fonts folder of the System Folder (or in system software versions earlier
than 7.1, in the System file) as menu items in your application’s Font menu. (You can also
use InsertResMenu to insert the fonts into your menu.)

Listing 3-16 on the next page shows how to add names of font resources in the Fonts
folder to an application’s Font menu. The AppendResMenu procedure adds all resources
of the specified type to a given menu. If you specify the resource type ' FONT' or
'"FOND', the Menu Manager adds all resources of type ' FOND' and 'FONT' to the menu.
("NFNT' and 'sfnt' resources are specified through 'FOND' resources.)

The AppendResMenu and InsertResMenu procedures perform special processing for
any font resources they find that have font numbers greater than $4000. The Menu
Manager automatically sets the keyboard equivalent field of the menu item to $1C and
stores the script code in the icon field of the menu item for any such ' FOND' resource.
The Menu Manager displays a font name in its corresponding script if the script system
for that font is installed.
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Listing 3-16 Adding font names to a menu

3-70

PROCEDURE MyMakeAllMenus;

VAR
menu: MenuHandle;
menuBar: Handle;
BEGIN
{read menus in & create new menu list}
menuBar := GetNewMBar (rMenuBar) ;

IF menuBar = NIL THEN

EXIT (MyMakeAllMenus) ;
SetMenuBar (menuBar) ; {insert menus into the current menu list}
DisposHandle (menuBar) ;

myMenu := GetMenuHandle (mApple) ;
IF myMenu <> NIL THEN {add desktop items in }
AppendResMenu (myMenu, 'DRVR'); { npple Menu Items }
{ folder to Apple menu}
myMenu := GetMenuHandle (mFont) ;
IF myMenu <> NIL THEN
AppendResMenu (myMenu, 'FONT') ; {add font names to the }

{ Font menu--this adds all bitmapped and TrueType fonts }
{ in the Fonts folder to the Font menu}

MyAddHelpItem; {add app-specific item to Help menu}
MyAdjustMenus ; {adjust menu items}
DrawMenuBar ; {draw the menu bar}

END;

Your application should indicate the current font to the user by placing the appropriate
mark next to the text of the menu item that lists the font name. (“Changing the Mark of
Menu Items” on page 3-61 explains how to add marks to and remove marks from menu
items; Figure 3-13 on page 3-26 and Figure 3-14 on page 3-27 show examples of typical
Font menus.)

If your application allows the user to change the font style or font size of text, you should
provide separate Size and Style menus. See “Handling a Size Menu” beginning on
page 3-82 for information on providing a Size menu in your application.

Handling User Choice of a Menu Command

If the user presses the mouse button while the cursor is in the menu bar, your application
should first adjust its menus (enable or disable menu items and add marks to or remove
marks from any items as appropriate to the user’s context) and then call the
MenuSelect function to allow the user to choose a menu command. The MenuSelect
function handles all user interaction until the user releases the mouse button and returns
a value as its function result that indicates which (if any) menu item the user chose.
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For a command with a keyboard equivalent, your application should allow the user to
choose the command by pressing the keys that correspond to the keyboard equivalent
of that menu command. If the user presses the Command key and another key, your
application should adjust its menus and then call the MenuKey function to map this
combination to a keyboard equivalent. The MenuKey function returns as its function
result a value that indicates the corresponding menu and menu item of the keyboard
equivalent.

When the user chooses a menu command, your application should perform the action
associated with that command. The MenuSelect and MenuKey functions highlight the
menu title of the menu containing the chosen menu command. After your application
performs any operation associated with the menu command chosen by the user, your
application should unhighlight the menu title by using the HiliteMenu procedure.

However, if in response to a menu command your application displays a window that
contains editable text (such as a modal dialog box), you should unhighlight the menu
title immediately so that the user can access the Edit menu or other appropriate menus.
In other words, any time the user can use a menu, make sure that the menu title is

not highlighted.

When the user chooses a menu command that involves an operation that takes a long
time, display the animated wristwatch cursor or display a status dialog box to give the
user feedback that the operation is in progress.

If you want the users of your application to be able to record their actions (such as menu
commands, text input, or any sequence of actions) for later playback, your application
should send itself Apple events whenever a user performs a significant action. To do this
for menu commands, your application typically sends itself an Apple event to perform
the action associated with the chosen menu command. For example, when a user chooses
the New command from the File menu, your application can choose to send itself a
Create Element event. Your application then creates the new document in response to this
event. For information on sending Apple events in response to menu commands, see
Inside Macintosh: Interapplication Communication.

The next sections show how your application can
m determine if the user pressed the mouse button while the cursor was in the menu bar

m adjust its menus—enabling and disabling commands according to the current state of
the document—before displaying menus or before responding to the user’s choice of a
keyboard equivalent of a command

m determine if the user chose the keyboard equivalent of a menu command
m respond to the user when the user chooses a menu command

The next sections also show how your application should respond when the user chooses
an item from the Apple or Help menu.

Using the Menu Manager 3-71



CHAPTER 3

Menu Manager

Handling Mouse-Down Events in the Menu Bar

You can determine when the user has pressed the mouse button while the cursor is in the
menu bar by examining the event record for a mouse-down event. You can use the
Window Manager function FindWindow to map the mouse location at the time of the
mouse-down event to a corresponding area of the screen. If the cursor was in the menu
bar, your application should call the MenuSelect function, allowing the user to choose a
menu command.

Listing 3-17 shows an application-defined procedure, DoEvent, that determines whether
a mouse-down event occurred and, if so, calls another application-defined procedure to
handle the mouse-down event. (For a complete discussion of how to handle events, see
the “Event Manager” chapter in this book.)

Listing 3-17 Determining whether a mouse-down event occurred

PROCEDURE DoEvent (event: EventRecord) ;
BEGIN
CASE event.what OF
mouseDown : {handle mouse-down event}
DoMouseDown (event) ;
{handle other events appropriately}
END; {of CASE}
END;

Listing 3-18 shows an application-defined procedure, DoMouseDown, that handles
mouse-down events. The DoMouseDown procedure determines where the cursor was
when the mouse button was pressed and then responds appropriately.

Listing 3-18 Determining when the cursor is in the menu bar

PROCEDURE DoMouseDown (event: EventRecord) ;

VAR
part: Integer;
thisWindow: WindowPtr;
BEGIN
part := FindWindow(event.where, thisWindow) ;

CASE part OF
inMenuBar: {mouse down in menu bar, respond appropriately}

BEGIN
{adjust marks and enabled state of menu items}
MyAdjustMenus;
{let user choose a menu command if desired}
DoMenuCommand (MenuSelect (event .where)) ;

END;
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{handle other mouse-down events appropriately}
END; {of CASE}
END;

You can use the FindWindow function to map the mouse location at the time the

user pressed the mouse button to general areas of the screen. If the mouse location

is in the menu bar, the FindWindow function returns the constant inMenuBar. In Listing
3-18, if the mouse location associated with the mouse-down event is in the

menu bar, the DoMouseDown procedure first calls another application-defined procedure,
MyAdjustMenus, to adjust the menus. Listing 3-19 shows the MyAdjustMenus
procedure.

The DoMouseDown procedure then calls an application-defined procedure,
DoMenuCommand. The DoMouseDown procedure passes as a parameter to
the DoMenuCommand procedure the value returned from the MenuSelect function.

The MenuSelect function displays menus and handles all user interaction until the user
releases the mouse button. The MenuSelect function returns a long integer indicating
whether the user chose a menu command, and if so, it indicates which menu and which
command the user chose.

Listing 3-24 on page 3-79 shows the DoMenuCommand procedure.

Adjusting the Menus of an Application

Your application should always adjust its menus before calling MenuSelect or
MenuKey. For example, you should enable and disable any menu items as necessary
and add checkmarks or dashes to items that are attributes. When you adjust your
application’s menus, you should enable and disable menu items according to the type
of window that is in the front. For example, when a document window is the frontmost
window, you should enable items as appropriate for that document window. When

a modeless dialog box or modal dialog box is the frontmost window, enable those
items as appropriate to that particular dialog box. Listing 3-19 shows an application-
defined routine, MyAdjustMenus, that adjusts the menus of the SurfWriter
application appropriately.

The MyAdjustMenus procedure first determines what kind of window is in front
and then adjusts the application’s menus appropriately. The application-defined
MyGetWindowType procedure returns a value that indicates whether the window

is a document window, a dialog window, or a window belonging to a desk accessory.
It also returns the constant kNil if there isn’t a front window. (See the chapter
“Window Manager” in this book for a listing of the MyGetWindowType procedure.)
The MyAdjustMenus procedure calls other application-defined routines to adjust the
menus as appropriate for the given window type.
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Listing 3-19 Adjusting an application’s menus

PROCEDURE MyAdjustMenus;

VAR
window: WindowPtr;
windowType: Integer;
BEGIN
window := FrontWindow;
windowType := MyGetWindowType (window) ;

CASE windowType OF

kMyDocWindow:

BEGIN {document window is in front, adjust items appropriately}
MyAdjustFileMenuForDocWindow;
MyAdjustEditMenuForDocWindow;
{adjust other menus as needed}

END; {of adjusting menus for a document window}

kMyDialogWindow:
{adjust menus accordingly for any dialog box}
MyAdjustMenusForDialogs;

kDAWindow: {adjust menus accordingly for a DA window}
MyAdjustMenusForDA;
kNil:{adjust menus accordingly when there isn't a front window}
MyAdjustMenusNoWindows;
END; {of CASE}
DrawMenuBar;
END;

Listing 3-20 shows the application-defined procedure
MyAdjustFileMenuForDocWindow. This procedure enables and disables the File menu
for the application’s document window, according to the state of the document. For
example, this application always allows the user to create a new document or open

a file, so the code enables the New and Open menu items. The code also enables the
Close, Save As, Page Setup, Print, and Quit menu items. If the user has modified the

file since last saving it, the code enables the Save command; otherwise, it disables the
Save command.

Listing 3-20 Adjusting the File menu for a document window

3-74

PROCEDURE MyAdjustFileMenuForDocWindow;

VAR
window: WindowPtr;
menu: MenuHandle;
myData: MyDocRecHnd;
BEGIN
window := FrontWindow;
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menu := GetMenuHandle (mFile); {get a handle to the File menu}

IF

menu = NIL THEN {add your own error handling}

EXIT (MyAdjustFileMenuForDocWindow) ;

EnableItem(menu, iNew) ;

EnableItem(menu, iOpen) ;

EnableItem(menu, iClose) ;
myData := MyDocRecHnd (GetWRefCon (window) ) ;

IF

AA

myData” " .windowDirty THEN

EnableItem(menu, iSave)

ELSE

DisableItem(menu, iSave) ;

EnableItem (menu, iSaveAs) ;

EnableItem(menu, iPageSetup) ;

(
EnableItem (menu, iPrint) ;
(

EnableItem (menu, iQuit) ;

END;

Listing 3-21 shows the application-defined MyAdjustEditMenuForDocWindow
procedure.

Listing 3-21 Adjusting the Edit menu for a document window

PROCEDURE MyAdjustEditMenuForDocWindow;

VAR
window: WindowPtr;
menu: MenuHandle;
selection, undo: Boolean;
isSubscriber: Boolean;
undoText : Str255;
offset: LongInt;
BEGIN
window := FrontWindow;
menu := GetMenuHandle (mEdit) ; {get a handle
IF menu = NIL THEN {add your own
EXIT (MyAdjustEditMenuForDocWindow) ;
undo := MyIsLastActionUndoable (undoText) ;
IF undo THEN {if action can be undone}
BEGIN
SetMenultemText (menu, iUndo, undoText) ;
EnableItem(menu, iUndo) ;
END
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ELSE {if action can't be undone}

BEGIN
SetMenultemText (menu, iUndo, gCantUndo) ;
DisableItem(menu, iUndo) ;

END;

selection := MySelection (window) ;

IF selection THEN

BEGIN {enable editing items if there's a selection}
EnableItem (menu, iCut) ;
EnableItem(menu, iCopy) ;
EnableItem(menu, iCreatePublisher) ;

END

ELSE

BEGIN {disable editing items if there isn't a selection}
DisableItem(menu, iCut) ;
DisableItem(menu, iCopy) ;
DisableItem(menu, iCreatePublisher) ;

END;
IF GetScrap (NIL, 'TEXT', offset) > 0 THEN

EnableItem(menu, iPaste) {enable if something to paste}
ELSE

Disableltem(menu, iPaste); {disable if nothing to paste}

EnableItem(menu, iSelectAll) ;
EnableItem (menu, iSubscribeTo) ;
IF MySelectionContainsSubscriberOrPublisher (isSubcriber) THEN
BEGIN {selection contains a single subscriber or publisher}
IF isSubscriber THEN {selection contains a subscriber}
SetMenultemText (menu, iPubSubOptions, gSubOptText)
ELSE {selection contains a publisher}
SetMenultemText (menu, iPubSubOptions, gPubOptText) ;
EnableItem(menu, iPubSubOptions) ;
END
ELSE {selection contains either no subscribers or publishers }
{ or contains at least one subscriber and one publisher}
DisableItem(menu, iPubSubOptions) ;
IF (gPubCount > 0) OR (gSubCount > 0) THEN
EnableItem (menu, iShowHideBorders)
ELSE
DisableItem(menu, iShowHideBorders) ;
END;

The procedure in Listing 3-21 adjusts the items in the Edit menu as appropriate for a
document window of the application. The code enables the Undo command if the
application can undo the last command, enables the Cut and Copy commands if there’s a
selection that can be cut or copied, enables the Paste command if there’s text data in the
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scrap, and enables the menu items relating to publishers and subscribers appropriately,
according to whether the current selection contains a publisher or subscriber. The
application-defined MySelectionContainsSubscriberOrPublisher function
returns TRUE if the current selection contains a single subscriber or a single publisher and
returns FALSE otherwise. If the MySelectionContainsSubscriberOrPublisher
function returns TRUE, the code sets the text for the Publisher Options (or Subscriber
Options) command and enables the menu item. If the function returns FALSE, the code
disables the Publisher Options (or Subscriber Options) command.

Determining if the User Chose a Keyboard Equivalent

Keyboard equivalents of commands allow the user to invoke a menu command from the
keyboard. You can determine if the user chose the keyboard equivalent of a menu
command by examining the event record for a key-down event. If the user pressed the
Command key in combination with another 1-byte character, you can determine if this
combination maps to a Command-key equivalent by using the MenuKey function.

If your application supports keyboard equivalents that use other modifier keys in
addition to the Command key, your application should examine the modifiers
field and take any appropriate action; depending on the modifier keys you use,
your application may or may not be able to use MenuKey to map the key to the
menu command.

Listing 3-22 shows an application-defined procedure, DoEvent, that determines whether
a key-down event occurred and, if so, calls an application-defined routine to handle the
key-down event.

Listing 3-22 Determining when a key is pressed

PROCEDURE DoEvent (event: EventRecord) ;
BEGIN
CASE event.what OF
keyDown, autoKey: {handle keyboard events}
DoKeyDown (event) ;
{handle other events appropriately}
END; {of CASE}
END;

If your application determines that the user pressed a key, you need to determine whether
the user chose the keyboard equivalent of a menu command. You can do this by
examining the modifiers field of the event record describing the key-down event. If

the Command key was also pressed, then your application should call the MenuKey
function. The MenuKey function scans the current menu list for a menu item that has a
matching keyboard equivalent and returns the menu and menu item, if any. Although you
should not define the same keyboard equivalent for more than one command, the
MenuKey function scans the menus from right to left, scanning the items from top to
bottom, and returns the first matching keyboard equivalent that it finds.
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If your application uses other keyboard equivalents in addition to Command-key
equivalents, you can examine the state of the modifier keys and use the Event Manager
function KeyTranslate, if necessary, to help map the keyboard equivalent to a
particular menu item. See the discussion of 'KCHR' resources in Inside Macintosh: Text for
information on how various keyboard combinations map to specific character codes.

Listing 3-23 shows an application’s DoKeyDown procedure that handles key-down events
and determines if a keyboard equivalent was pressed.

Listing 3-23 Checking a key-down event for a keyboard equivalent

3-78

PROCEDURE DoKeyDown (event: EventRecord) ;

VAR
key: Char;
BEGIN
key := CHR(BAnd(event.message, charCodeMask)) ;
IF BAnd (event.modifiers, cmdKey) <> 0 THEN
BEGIN {Ccommand key down}
IF event.what = keyDown THEN
BEGIN {first enable/disable/check }
MyAdjustMenus; { menu items properly}
DoMenuCommand (MenuKey (key) ) ; {handle the menu command}
END;
END
ELSE
MyHandleKeyDown (event) ;
END;

Listing 3-23 extracts the pressed key from the message field of the event record and
then examines the modifiers field to determine if the Command key was also pressed.
If so, the application first adjusts its menus and then calls an application-defined
procedure, DoMenuCommand. The DoKeyDown procedure passes as a parameter to

the DoMenuCommand procedure the value returned from the MenuKey function.

Listing 3-24 shows the DoMenuCommand procedure.

Responding When the User Chooses a Menu ltem

Your application can use the MenuSelect function to determine when the user chooses a
menu command, and your application can use the MenuKey function to determine when
the user presses the keyboard equivalent for a menu command. Both MenuSelect and
MenuKey return a long integer value that indicates which menu and menu item the user
chose.

The MenuSelect and MenuKey functions return the menu ID of the menu in the high
word and the menu item number in the low word of their function result. If the user did
not choose a menu command or if the user pressed a keyboard combination that does
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not map to any keyboard equivalent in your application’s menus, the functions return 0
in the high word and the value of the low word is undefined. The MenuSelect function
also returns 0 in the high word when the user selects an item in the Application or
Keyboard menu. The MenuSelect function (and MenuKey function, if the command has
a keyboard equivalent) returns the kHMHelpMenuID constant in the high word and the
menu item in the low word when the user selects an item that your application appended
to the Help menu.

Listing 3-24 shows an application-defined procedure, DoMenuCommand. This procedure
takes the appropriate action based on which menu command the user chose.

The DoMenuCommand procedure is called by the application after the application
determines that either the user pressed the mouse button while the cursor was in the
menu bar (in which case the application calls MenuSelect to allow the user to choose
a command) or the user pressed the Command key and another key (in which case the
application calls the MenuKey function). In either case, the application passes the
function result returned by MenuSelect or MenuKey as a parameter to the
DoMenuCommand procedure.

Listing 3-24 Responding to the user’s choice of a menu command

PROCEDURE DoMenuCommand (menuResult: LongInt) ;

VAR
menulD, menultem: Integer;
BEGIN
menuID := HiWord (menuResult) ; {get menu ID of menu}
menultem := LoWord(menuResult); {get menu item number}
CASE menuID OF
mApple:
MyHandleAppleCommand (menultem) ;
mFile:

MyHandleFileCommand (menultem) ;
mEdit:
MyHandleEditCommand (menultem) ;
mFont :
MyHandleFontCommand (menultem) ;
mSize:
MyHandleSizeCommand (menultem) ;
kHMHelpMenulID:
MyHandleHelpCommand (menultem) ;
mOutline:
MyHandleOutlineCommand (menultem) ;
mSubMenu: {user chose item from submenu}
MyHandleSubLabelStyleCommand (menultem) ;
END; {end of CASE menulD}
HiliteMenu(0); {unhighlight what MenuSelect or MenuKey hilited}
END;
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The DoMenuCommand procedure calls other application-defined routines to perform the
requested action. After performing the action associated with the chosen menu item, your
application should use the HiliteMenu procedure to unhighlight the menu title to
indicate that the requested action is complete.

Handling the Apple Menu

When the user chooses an item from the Apple menu, the MenuSelect function returns
the menu ID of your application’s Apple menu in the high word and returns the chosen
menu item in the low word of its function result.

If your application provides an About command as the first menu item in the Apple
menu and the user chose this item, you should display your application’s About box.
Otherwise your application should use the GetMenuItemText procedure to get the
menu item text and then call the OpenDeskAcc function, passing the text of the chosen
menu item as a parameter.

Listing 3-25 shows an application-defined procedure, MyHandleAppleCommand, that
the application calls in response to the user’s choice of an item from the Apple menu.

Listing 3-25 Responding to the user’s choice of an item from the Apple menu

3-80

PROCEDURE MyHandleAppleCommand (menultem: Integer) ;
VAR

itemName: Str255;

daRefNum: Integer;

BEGIN
CASE menultem OF
iAbout: {bring up alert for About}
DisplayMyAboutBox;
OTHERWISE

BEGIN {all non-About items in this menu are desktop items, }
{ for example, DA's, other apps, documents, etc.}
GetMenuItemText (GetMenuHandle (mApple), menultem,
itemName) ;

daRefNum := OpenDeskAcc (itemName) ;

END;

END; {of CASE}
END;

When the user chooses an item other than your application’s About command from

the Apple menu, your application should call the OpenDeskAcc function. The
OpenDeskAcc function prepares to open the desktop object chosen by the user; for
example, if the user chose a document created by the TeachText application, the
OpenDeskAcc function schedules the TeachText application for execution (or prepares to
open it if it isn’t already open) and returns to your application. On your application’s
next call to WaitNextEvent, your application receives a suspend event, and then
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the Process Manager makes TeachText the foreground application and instructs TeachText
to open the chosen document.

Handling the Help Menu

Both the MenuSelect and MenuKey functions return the kHMHe 1pMenuID constant
(-16490) in the high word when the user chooses an appended item from the Help
menu. The item number of the appended menu item is returned in the low word of the
function result.

The DoMenuCommand procedure shown in Listing 3-24 determines which menu
command was chosen by the user. If the user chose a command from the Help menu,
the DoMenuCommand procedure calls the application-defined procedure
MyHandleHelpCommand. Listing 3-26 shows the application-defined procedure
MyHandleHelpCommand. This procedure illustrates how the SurfWriter application
responds to the user’s choice of an item from the application’s Help menu. Note that
you should use the HMGetHelpMenuHandle function, not the GetMenuHandle
function, to get a handle to your application’s Help menu.

Listing 3-26 Responding to the user’s choice of a command from the Help menu

PROCEDURE MyHandleHelpCommand (menultem: Integer) ;

VAR
myHelpMenuHdl : MenuHandle;
origHelpItems, numlItems: Integer;
myErr: OSErr;
BEGIN

{get handle to your application's Help menu}

myErr := HMGetHelpMenuHandle (myHelpMenuHdl) ;

IF myErr <> noErr THEN
EXIT (MyHandleHelpCommand) ;

{count the number of items in the Help menu}

numItems := CountMItems (myHelpMenuHdl) ;

origHelpItems := numItems - kNumMyHelpItems;

IF menultem > origHelpItems THEN

BEGIN {user chose an item added by this application}
{adjust this application's global variables that hold item }
{ numbers of the menu items that this application appended}
gMyHelpIteml := origHelpItems +1;

gMyHelpItem2 origHelpItems +2;
MyHelp (menultem) ;
END;

END;

Apple reserves the right to change the number of standard items in the Help menu. To
determine the number of items in the Help menu, call the CountMItems function.
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Handling a Size Menu

Your application can provide a Size menu to let the user choose various sizes of a font.
Your Size menu should also provide the user with a method for specifying a size that
isn’t currently listed in the menu. For example, you can choose to provide an Other
command that displays a dialog box allowing the user to choose a different font size. If
the user chooses a font size not already in the menu, add a checkmark to the Other menu
command and add the chosen size in parentheses to the text of the Other command.

Your application should outline font sizes to indicate which sizes are directly provided by
the current font. For bitmapped fonts, outline only those sizes that actually exist in the
Fonts folder. For TrueType fonts, outline all sizes that the TrueType font supports.

Your application should indicate the current font size to the user by placing a checkmark
next to the text of the menu item that lists the current font size. If the current selection
contains more than one font size, place a dash next to the name of each font size that the
selection contains. (“Changing the Mark of Menu Items” on page 3-61 explains how to
add marks to and remove marks from menu items.)

Figure 3-35 shows a Size menu as it appears after the user chooses a new font size of 31
by using the Other command. In Figure 3-35 the sizes 9, 10, 12, 18, 24, and 36 are the
standard sizes provided by the application. Your application should place a checkmark
next to the Other command to indicate that the current font size is a size other than a
standard size. If the selection contains only one nonstandard size, include the size of the
font in parentheses following the text Other. In Figure 3-35 the current selection contains
a nonstandard size of 31, so the application places the checkmark next to the Other
command and includes 31 in parentheses following the Other text. If the selection
contains multiple nonstandard sizes, include the text Mixed in parentheses following
the word Other. If the selection contains one or more standard sizes and only one
nonstandard size, place a dash next to each standard size that the selection contains

and place a dash next to the Other command with the nonstandard size included in
paretheses in the text of the Other command.

Figure 3-35 A Size menu with user-specified size added
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When the user chooses the Other command, you should display the current font size in a
dialog box and allow the user to choose a new size. Figure 3-16 on page 3-28 shows a
sample dialog box an application might display in response to the user’s choice of the
Other command.

You should always specify the text of the Other command in the plain font style (as
shown in Figure 3-35) and never outlined, regardless of whether the current font is a
TrueType font that supports that size or a bitmapped font that exists at that size in the
Fonts folder.

Listing 3-27 shows an application-defined procedure that handles the user’s choice of an
item in the Size menu shown in Figure 3-35.

Listing 3-27 Handling the Size menu

PROCEDURE MyHandleSizeCommand (menultem: Integer) ;

VAR
numItems: Integer;
addItem: Boolean;
itemString: Str255;
itemStyle: Style;
sizeChosen: LongInt;
BEGIN
numItems := CountMItems (GetMenuHandle (mSize)) ;

IF menultem = numItems THEN
BEGIN {user chose Other command}
{display a dialog box to allow the user to choose any }
{ size. If the user-specified size is not in the menu, }
{ add a checkmark to the Other command and add the }
{ new font size to the text of the Other command}
MyDisplayOtherBox (sizeChosen) ;

END
ELSE
BEGIN
IF (menultem = (numItems -2)) OR
(menulItem = (numItems -3)) THEN
DoMakeLargerOrSmaller (menultem, sizeChosen)
ELSE
BEGIN {user chose size displayed in the menu}
{remove checkmark or dashes from menu items showing }
{ previous size}
MyRemoveMarksFromSizeMenu;
{add checkmark to menu item of new current size}
CheckItem(GetMenuHandle (mSize), menultem, TRUE) ;
sizeChosen := MyItemToSize (menultem) ;
END;
END;
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{update the document's state or the user's selection as needed}
MyResizeSelection (sizeChosen) ;
END;

If the user chooses an item from the Size menu, the MyHandleSizeCommand procedure
first counts the current number of items in the menu. If the user chooses the last item in
the menu (the Other command), the procedure displays a dialog box like the one shown
in Figure 3-16 on page 3-28 to let the user choose a size other than the ones currently
shown in the menu. The application-defined function MyDisplayOtherBox also adds a
checkmark to the Other command if the user chose a new size, adds the new size to the
text of the Other command, and returns the chosen size in the sizeChosen variable.

If the user chose the Larger or Smaller command from the Size menu, the code calls an
application-defined routine, DoMakeLargerOrSmaller, to perform the requested
action. The DoMakeLargerOrSmaller procedure also adds a checkmark and adds the
new size to the text of the Other command if the new size does not match any size in
the menu. The procedure returns the chosen size in the sizeChosen variable.

If the user chose any size currently displayed in the menu, the MyHandleSizeCommand
procedure adjusts the marking character of the menu items appropriately. The code
removes the checkmark from the previous menu item and adds a checkmark to the menu
item representing the new size chosen by the user. The code uses an application-defined
function, MyItemToS1ize, to map the item number of the chosen menu item to a given
size and returns this size in the sizeChosen variable.

The code then uses the application-defined procedure MyResizeSelection to update
the document’s state and resize the user’s selection, if any, to the chosen size.

Accessing Menus From a Dialog Box

In System 7, the Menu Manager or your application can allow the user to access selected
menus in the menu bar while interacting with an alert box or a modal dialog box. This
allows users to make menu selections while your application is displaying an alert box or
a modal dialog box. For example, a user might want to turn on Balloon Help for
assistance in figuring out how to respond to an alert box. Similarly, if the modal dialog
box contains several editable text fields, the user might find it simpler to copy text

from one text field and paste it into another. Figure 3-36 shows a modal dialog box

with an editable text field. Note that only the Edit and Help menus are enabled and all
other menus are disabled. This gives the user access to editing commands and also to
Balloon Help.

Note

In System 6, user access to menus in the menu bar is prohibited from an
alert box or a modal dialog box unless your application specifically
allows it. For example, in System 6, your application must provide a
filter procedure to replace the standard filter procedure if you want to
support the keyboard equivalents of the standard Edit menu commands
in a modal dialog box. In System 7, you can let the Menu Manager enable
these commands for you.
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Figure 3-36 Menu access from a modal dialog box
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When your application displays a modeless or movable modal dialog box, your
application should adjust its menus as appropriate for that dialog box. For example,
when a movable modal dialog box is the frontmost window, your application should
enable the Apple menu, enable the Edit menu if your dialog box contains an editable text
item, enable or disable any other menus as needed, and disable any items it added to the
Help menu if the user can’t perform those actions while the dialog box is displayed.

When your application displays an alert box, system software automatically disables all
of your application’s menus except for the Help menu (in which all items are disabled
except for the Show Balloons/Hide Balloons command).

When your application displays a modal dialog box, your application should also enable
and disable its menus as appropriate. For example, you should enable the Edit menu if
your dialog box contains an editable text item and disable any items it added to the Help
menu if the user can’t perform those actions while the dialog box is displayed. If your
application handles access to the menu bar from a modal dialog box, it should disable the
Apple menu or the first item in the Apple menu.

If your application does not specifically handle access to the menu bar from an alert box
or a modal dialog box, in some cases the Menu Manager automatically disables the
appropriate menus for you, as described in the following paragraphs.

When your application displays an alert box or a modal dialog box (that is, a window of
type dBoxProc), the Menu Manager (in conjunction with the Dialog Manager) always
appropriately adjusts the system-handled menus and performs these actions:

1. Disables all menu items in the Help menu except the Show Balloons (or Hide Balloons)
command, which it enables.

2. Disables all menu items in the Application menu.

3. Enables the Keyboard menu if it appears in the menu bar, except for the About
Keyboards command, which it disables.

Using the Menu Manager 3-85



3-86

CHAPTER 3

Menu Manager

In addition, if your application then calls the ModalDialog procedure, the Menu
Manager (in conjunction with the Dialog Manager) performs two other actions:

4. Disables all of your application’s menus.

5. Enables commands with the standard keyboard equivalents Command-X,
Command-C, and Command-V if the modal dialog box contains a visible and active
editable text field. The user can then use either the menu commands or their keyboard
equivalents to cut, copy, and paste text. (The menu item having keyboard equivalent
Command-X must be one of the first five menu items.)

When the user dismisses the modal dialog box, the Menu Manager restores all menus to
the state they were in prior to the appearance of the modal dialog box.

In some cases actions 4 and 5 do not occur when you call ModalDialog. The enabling
and disabling described in steps 4 and 5 do not occur if any of these conditions is true:

m Your application does not have an Apple menu.

m Your application has an Apple menu, but the menu is disabled when the modal dialog
box is displayed.

m Your application has an Apple menu, but the first item in that menu is disabled when
the dialog box is displayed.

Note

If your application already handles access to the menu bar from a

modal dialog box and you do not want the automatic menu enabling and
disabling provided by System 7 to occur, you should ensure that one or
more of those conditions is true when you display a modal

dialog box.

When your application displays alert boxes or modal dialog boxes with no editable
text items, your application can allow system software to handle menu bar access. In
all other cases, your application should handle its own menu bar access.

System software always leaves the Help, Keyboard, and Application menus and their
commands available when you display movable modal dialog boxes and modeless
dialog boxes. For these types of dialog boxes, you must disable menus as appropriate and
handle menu bar access as appropriate given their contents.

When your application displays a movable modal dialog box (a window of type
movableDBoxProc), your application does not need to adjust the system-handled
menus but should disable all its other menus except the Apple menu and—if your
movable modal dialog box contains editable text items—the Edit menu. Leave the
Apple menu enabled so that the user can use it to open other applications, and leave the
Edit menu enabled so that the user can use the Cut, Copy, and Paste commands within
the editable text item. (You can also leave your Undo and Clear commands enabled;
otherwise, disable all other commands in the Edit menu.)

When your application removes a movable modal dialog box, modeless dialog box, or
modal dialog box with editable text items, your application must restore to their previous
states any menus that it disabled prior to displaying the dialog box. See the chapter
“Dialog Manager” in this book for additional information on dialog boxes.
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Writing Your Own Menu Definition Procedure

The Menu Manager uses the menu definition procedure and menu bar definition
function to display and perform basic operations on menus and the menu bar. The

menu definition procedure performs all the drawing of menu items within a menu

and performs all the actions that might differ between one type of menu and another. The
menu bar definition function draws the menu bar and performs most of the

drawing activities related to the display of menus when the user moves the cursor
between menus.

Apple provides a standard menu bar definition function, stored as a resource in the
System file. The standard menu bar definition procedure is the 'MBDF ' resource with
resource ID 0. When you create your menus and menu bar, by default the Menu Manager
uses the standard menu bar definition function to manage them. Although the Menu
Manager lets you provide your own menu bar definition function, Apple recommends
that you always use the standard menu bar definition function.

The Menu Manager uses the standard menu bar definition function to

m draw the menu bar

m clear the menu bar

m determine if the cursor is in the menu bar or any currently displayed menus

m calculate the left edges of menu titles

m highlight a menu title

m invert the entire menu bar

m erase the background color of a menu and draw the menu’s structure (shadow)
m save or restore the bits behind a menu

Apple provides a standard menu definition procedure, stored as a resource in the System
file. The standard menu definition procedure is the 'MDEF ' resource with resource ID 0.
The standard menu definition procedure handles three types of menus: pull-down,
pop-up, and hierarchical; it also implements scrolling in menus. When you define your
menus, you specify the menu definition procedure that the Menu Manager should use
when managing them. You'll usually want to use the standard definition procedure for
your application. However, if you need a feature not provided by the standard menu
definition procedure (for example, if you want to include more graphics in your menus),
you can write your own menu definition procedure.

The Menu Manager uses the standard menu definition procedure to

m calculate a menu’s dimensions

m draw the menu items in a menu

m highlight and unhighlight menu items as the user moves the cursor between them

m determine which item the user chose from a menu
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If you provide your own menu definition procedure, it should also perform these tasks.
Your menu definition procedure should also support scrolling in menus and color in
menus and provide support for Balloon Help.

If you provide your own menu definition procedure, store it in a resource of type 'MDEF"
and include its resource ID in the description of each menu that uses your own menu
definition procedure. If you create a menu using GetMenu (or GetNewMBar), the Menu
Manager reads the menu definition procedure into memory and stores a handle to it in
the menuProc field of the menu’s menu record.

When your application uses GetMenu (or GetNewMBar) to create a new menu that uses
your menu definition procedure, the Menu Manager creates a menu record for the menu
and fills in the menuID, menuProc, enableFlags, and menuData fields according to
the menu’s resource description. The Menu Manager also reads in the data for each menu
item and stores it as variable data at the end of the menu record. The menu definition
procedure is responsible for interpreting the contents of the data. For example, the
standard menu definition procedure interprets this data as described in “The Menu
Resource” beginning on page 3-151. After reading in a resource description of a menu,
the Menu Manager requests the menu definition procedure to calculate the size of

the menu and to store these values in the menuWwidth and menuHeight fields of the
menu’s menu record.

Note that when drawing a menu, the Menu Manager first requests your menu definition
procedure to calculate the dimensions (the menu rectangle) of the menu. Next the Menu
Manager requests the menu bar definition function to draw the structure (shadow) of the
menu and erase the contents of the menu to its background color. Then the Menu
Manager requests your menu definition procedure to draw the items in the menu. As the
user moves the cursor into and out of menu items, the Menu Manager requests your
menu definition procedure to highlight and unhighlight items appropriately. Your menu
definition procedure should also determine when to add scrolling indicators to a menu
and scroll the menu appropriately when the cursor is in a scrolling item. Your menu
definition is responsible for showing and removing any help balloons associated with a
menu item.

When the Menu Manager requests your menu definition procedure to perform an action
on a menu, it provides your procedure with a handle to its menu record. This allows your
procedure to access the data in the menu record and to use any data in the variable data
portion of the menu record to appropriately handle the menu items. However, your
menu definition procedure should not assume that the A5 register is properly set up, so
your procedure can’t refer to any of the QuickDraw global variables.

The Menu Manager passes a value to your menu definition procedure in the message
parameter that indicates the action your menu definition procedure should perform. The
Menu Manager always passes a handle to the menu record of the menu that the
operation should affect in the parameter theMenu. Depending on the requested action,
the Menu Manager passes additional information in other parameters.
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Listing 3-28 shows how you might declare a menu definition procedure.

Listing 3-28 A sample menu definition procedure

PROCEDURE MyMDEF (message: Integer; theMenu: MenuHandle;
VAR menuRect: Rect; hitPt: Point;
VAR whichItem: Integer) ;

{any support routines used by the main program of your MDEF }
{ go here}

BEGIN
CASE message OF
mDrawMsg:
MyDrawMenu (theMenu, menuRect) ;
mChooseMsg:
MyChooseItem (theMenu, menuRect, hitPt, whichItem) ;
mSizeMsg:
MySizeTheMenu (theMenu) ;
mPopUpMsg:
MyCalcMenuRectForOpenPopUpBox (theMenu, hitPt, menuRect) ;
END;
END;

The next sections describe in more detail how your menu definition procedure should
respond when it receives the mDrawMsg, mChooseMsg, or mSizeMsg constant in the
message parameter. For a complete description of the menu definition procedure and
the parameters passed to your procedure by the Menu Manager, see “The Menu
Definition Procedure” beginning on page 3-148.

Calculating the Dimensions of a Menu

Whenever the Menu Manager creates a menu or needs to calculate the size of a menu that
is managed by your menu definition procedure, the Menu Manager calls your procedure
and specifies the mSizeMsg constant in the message parameter, requesting that your
procedure calculate the size of the menu.

Listing 3-29 on page 3-90 shows an application-defined support routine,
MySizeTheMenu, used by the application’s menu definition procedure. After
calculating the height and width of the menu’s rectangle, the menu definition
procedure stores the values in the menuWidth and menuHeight fields of the
menu’s menu record.
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Listing 3-29 Calculating the size of a menu

PROCEDURE MySizeTheMenu (theMenu: MenuHandle) ;

VAR
itemDataPtr: Ptr;
numltems: Integer;
BEGIN

END;

3-90

HLock (Handle (theMenu) ) ;
WITH theMenu”” DO
BEGIN {menuData points to title of menu and additional item data}
itemDataPtr := @menuData;
{skip past the menu title}
itemDataPtr := POINTER (ORD4 (itemDataPtr)+ itemDataPtr” +1);
END;
numItems := CountMItems (theMenu) ;
{calculate the height of the menu--each item's height can vary }
{ according to whether the item has an icon or a script code defined. }
{ The height of the menu should not exceed the height of the }
{ screen minus the menu bar height. }
{ Store the height in the menu's menu record}
theMenu”™” .menuHeight := MyCalcMenuHeight (itemDataPtr, numItems) ;

{calculate the width of the menu (the width of the longest item): }
for each item calculate the width as }
width = iconWidth + markWidth + textWidth + subMenuWidth }
+ cmdKeyComboWidth }
If an item doesn't have a characteristic, use 0 as the width of }

{

{

{

{

{ that characteristic. }
{ To calculate the width of item's text, must consider script code and }
{ width of the font. }

{ The width of the menu should not exceed the right or left }

{ boundaries of the screen. }

{

Store the width in the menu's menu record}

theMenu” " .menuWidth := MyCalcMenuWidth (itemDataPtr, numlItems) ;
HUnLock (Handle (theMenu) ) ;

I

Drawing Menu ltems in a Menu

Whenever the user presses the mouse button while the cursor is in the menu title of a
menu managed by your menu definition procedure, the Menu Manager calls the menu
bar definition function to highlight the menu title, draw the structure of the menu, and
erase the contents of the menu to its background color. The Menu Manager then calls
your menu definition procedure and specifies the mDrawMsg constant in the message

Using the Menu Manager



CHAPTER 3

Menu Manager

parameter, requesting that your procedure draw the menu items. When your menu
definition procedure receives this constant, it should draw the menu items of the menu
specified by the parameter theMenu inside the rectangle specified by the menuRect
parameter. The Menu Manager sets the current graphics port to the Window Manager
port before calling your menu definition procedure. Your menu definition procedure can
determine how to draw the menu items by examining the data in the menu record.

If your menu definition procedure supports color menus, your procedure should

check the application’s menu color information table for the colors to use to draw

each item. If the application’s menu color information table contains a color entry for

an item, draw the item using that color. If the table does not contain an item entry for

a particular item, use the default item color defined in the menu title entry. If a menu title
entry doesn’t exist, use the default item color defined in the menu bar entry. If the menu
bar entry doesn’t exist, draw the item using black on white.

If your menu definition procedure supports scrolling menus, it should insert scrolling
indicators if necessary when drawing the menu items.

Listing 3-30 shows an application-defined support routine, MyDrawMenu, used by the
application’s menu definition procedure. The MyDrawMenu procedure draws each item
in the menu, according to the item’s defined characteristics. Disabled items should be
drawn using the colors returned by the GetGray function. Pass the RGB color of the
item’s background in the bkgnd parameter to the GetGray function; pass the RGB color
of the item’s enabled text in the f£gnd parameter. The GetGray function returns TRUE if
there’s an available color between the two specified colors and returns in the £gnd
parameter the color in which you should draw the item.

Listing 3-30 Drawing menu items

PRO
VAR

BEG

CEDURE MyDrawMenu (theMenu: MenuHandle; menuRect: Rect) ;
numltems: Integer;

itemRect: Rect;

item: Integer;

currentOffset: LonglInt;

nextOffset: LongInt;

IN

numItems := CountMItems (theMenu) ;
currentOffset := 0;

nextOffset := 0;

FOR item := 1 TO numItems DO
BEGIN

{calculate the enclosing rectangle for this item}

itemRect := MyCalcItemRect (item, menuRect, currentOffset, nextOffset);
{draw the item--index into the item-specific data from the menu record }
{ to get the characteristics of this menu item and draw the item }
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according to its defined characteristics. For example, draw the item's }
text in its defined style & font of its defined script, draw any icon, |}
mark, submenu indication, or keyboard equivalent, and draw each }
characteristic of the item according to its color entry in the menu's }
menu color information table. }

Draw disabled items in gray--use the GetGray function to return the }
appropriate color. Also draw dividers using the gray color }

returned by GetGray}

MyDrawTheItem(item, itemRect, menuRect, currentOffset);

END;

{if your menu supports scrolling, insert scrolling indicators if needed}

MyInsertScrollingArrows (menuRect) ;

7

Determining Whether the Cursor Is in an Enabled Menu ltem

Whenever the user drags the cursor into or out of a menu item of a displayed menu
managed by your menu definition procedure, the Menu Manager calls your procedure
and specifies the nChooseMsg constant in the message parameter, requesting that

your procedure determine whether the cursor is in a menu item and that your procedure
highlight or unhighlight the menu item as appropriate. When your menu definition
procedure receives this constant, it should use the menu rectangle specified in the
menuRect parameter, the mouse location specified in the hitPt parameter, and the item
number specified in the whichItem parameter to determine the proper action

to take.

To see whether the user chose an enabled item, your menu definition procedure should
determine whether the specified mouse location is inside the rectangle specified by the
menuRect parameter, and, if so, it should check whether the menu is enabled. If the
menu is enabled, your menu definition procedure should determine whether the mouse
location specified in the hitPt parameter is in an enabled menu item.

If the mouse location is in an enabled menu item, your menu definition procedure should
unhighlight the item specified by the whichItem parameter, highlight the new item, and
return the new item number in whichItem.

If the mouse location isn’t in an enabled menu item, your menu definition procedure
should unhighlight the item specified by the whichItem parameter and return 0 in
the whichItem parameter.

When your menu definition procedure draws a menu item in its highlighted state in a
color menu, it should reverse the background color and the item color and then draw the
menu item. When your menu definition procedure needs to return a menu item to its
normal (unhighlighted) state, it should reset the background color and item color of that
menu item and draw the menu item.

If your menu definition procedure supports scrolling menus, it should scroll the menu
when the user moves the cursor into the area of the indicator, or when the cursor is
directly above or below the menu. If the user can scroll the menu up (by dragging the
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cursor past the last item to view more items), place a downward-pointing triangular
indicator in place of the last item in the menu. If the user can scroll the menu down
(by dragging the cursor past the first item to view the items originally at the top of
the menu), place an upward-pointing triangular indicator in place of the first item
in the menu.

For all menus, your menu definition procedure should set the global variable
MenuDisable appropriately each time a new item is highlighted. Set MenuDisable to
the menu ID and item number of the last menu item chosen, whether or not it’s disabled.
The MenuChoice function uses the value in MenuDisable to determine if a chosen
menu item is disabled.

Listing 3-31 shows an application-defined support routine, MyChooseItem, used by the
application’s menu definition procedure. This routine determines which item, if any, the
point specified by the hit Pt parameter is in. If the item is in an enabled menu item that
is different from the previous item, the MyChooseItem procedure unhighlights the old
item and highlights the new item. However, the MyChooseItem procedure does not
highlight the new item if the item is in a divider or disabled item.

The procedure also removes any help balloons as appropriate and, if Balloon Help is
turned on, displays any help balloon of the new item (for any item other than a divider or
scrolling indicator). The MyChooseItem procedure returns the item number of the new
item in the whichItem parameter or returns 0 if no item is chosen. Although not shown
in the listing, if the item is a disabled item, the procedure returns 0 in the whichItem
parameter and sets the MenuDisable global variable to the menu ID and item number
of the disabled item.

Listing 3-31 Choosing menu items

PROCEDURE MyChooseItem (theMenu: MenuHandle; menuRect: Rect; hitPt: Point;

VAR whichItem: Integer) ;

VAR
oldWhichItem: Integer;
MenuChoicePtr: *LonglInt;
numlItems, item, max: Integer;
itemChosen: Integer;
inScroll: Integer;
currentOffset: LongInt;
nextOffset: LongInt;
BEGIN
oldWhichItem := whichItem;
whichItem := 0;
itemChosen := 0;
MenuChoicePtr := POINTER (kLowMemMenuDisable) ;

numltems

:= CountMItems (theMenu) ;

{find out whether the hitPt is in an item's rectangle, and if so, }

{ determine which item}
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item := 1;
max := numltems + 1;
currentOffset := 0;
nextOffset := 0;
REPEAT
itemRect := MyCalcItemRect (item, menuRect, currentOffset, nextOffset);
IF PtInRect (hitPt, itemRect) THEN {hitPt is in this item}
itemChosen := item;
item := item + 1;
UNTIL (item = MAX) OR (itemChosen <> 0);
IF itemChosen = 0 THEN
BEGIN {the mouse isn't in any item of this menu;unhighlight previous item}
MyNot InMenu (menuRect, oldWhichItem) ;
END
ELSE
BEGIN {the mouse is in this menu item. }
{ First see if a previous item was highlighted}
IF ((oldWhichItem <> 0) AND (oldWhichItem <> itemChosen)) THEN

BEGIN
{a previous item was highlighted--unhighlight it}
itemRect := MyCalcOldItemRect (oldWhichItem, menuRect) ;

IF HMGetBalloons THEN {if Balloon Help is on then }
HMRemoveBalloon;{ remove any balloon that might be showing}
MyHighlightItem(itemRect, oldWhichItem, FALSE) ;
END;
IF HMGetBalloons and MyIsItemDivider (itemChosen) THEN
{Balloon Help is on and item is divider}
HMRemoveBalloon; {remove any balloon that might be showing}
IF MyIsItemEnabled (itemChosen) THEN

BEGIN
{the item is enabled, so highlight the item the cursor is in}
itemRect := MyCalcNewlItemRect (itemChosen, menuRect, currentOffset);

{the highlighting routine must also support scrolling correctly }
{ (if the cursor is in a scrolling item, don't highlight the item) }
inScroll := MyIsScrollItem(itemChosen) ;
MyHighlightItem(itemRect, itemChosen, inScroll) ;
IF HMGetBalloons AND inScroll THEN
HMRemoveBalloon {remove any balloon that might be showing}
ELSE
BEGIN {display help balloon for this item, if any}
IF HMGetBalloons THEN
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BEGIN
IF StillDown THEN {mouse button is still down in this item}

{this routine sets up the needed parameters and then }
{ calls HMShowMenuBalloon}
MyShowMenuBalloon (itemChosen, itemRect) ;

END;

END;
END;
END;
END;

Menu Manager Reference

This section describes the data structures and routines of the Menu Manager. It also
describes various resources, including the resources you can use to create your menus
and menu bar, the 'MBAR' and 'MENU' resources.

Data Structures

This section describes the menu record, menu list, and menu color information table. The
Menu Manager maintains information about the menus in your application in menu
records. The Menu Manager maintains information about all the menus in a menu bar in
a data structure called the menu list.

The Menu Manager stores color information about your application’s menus in a menu
color information table. You can add entries to your application’s menu color information
table if you want to use colors other than the default colors for your menu bar or menus.
You can add entries to this table by using the SetMCEntries procedure or by providing
'mctb' resources.

The Menu Record

A menu record contains information about a single menu. Your application should never
manipulate or access the fields of a menu record; instead your application should use
Menu Manager routines to create and manage the menus in your application. To refer to
a menu, use a handle to the menu’s menu record.

The MenuInfo data type defines the menu record. The MenuHandle data type is a
handle to a menu record.

TYPE MenuPtr = “Menulnfo; {pointer to a menu record}

MenuHandle *MenuPtr; {handle to a menu record}
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Here is the structure of a menu record:

TYPE MenulInfo = {menu record}
RECORD
menulD: Integer; {number that identifies the menu}
menuWidth: Integer; {width (in pixels) of the menu}
menuHeight: Integer; {height (in pixels) of the menu}
menuProc: Handle; {menu definition procedure}
enableFlags: LonglInt; {indicates whether menu and }
{ menu items are enabled}
menuData: Str255; {title of menu}
{itemDefinitions} {variable-length data that }

{ defines the menu items}
END;

Field descriptions

menulID A number that identifies the menu. Each menu in your application
must have a unique menu ID. Your application specifies the menu
ID when you create the menu. Thereafter you can use the menu ID
and the GetMenuHandle function to get a handle to the menu’s
menu record.

When you define hierarchical menus, you must use a number from 1
through 235 for the menu ID of a submenu of an application; use a
number from 236 through 255 for the submenu of a desk accessory.

menuWidth The horizontal dimensions of the menu, in pixels.
menuHeight The vertical dimensions of the menu, in pixels.
menuProc A handle to the menu definition procedure of the menu. The Menu

Manager uses this menu definition procedure to draw the menu.

enableFlags A value that represents the enabled state of the menu title and
the first 31 items in the menu. All menu items greater than 31
are enabled by default and can be disabled only by disabling the
entire menu.

menuData A string that defines the title of the menu. Although the menuData
field is defined by the data type Str255 in the MenuInfo data
structure, the Menu Manager allocates only the storage necessary for
the title: the number of characters in the title of the string plus 1.

itemDefinitions
Variable-length data that defines the characteristics of each menu
item in the menu. If the menu uses the standard menu definition
procedure, this data can be conceptually defined in this manner:

itemData: ARRAY[1..X] OF
itemString: String; {text of menu item}
itemIcon: Byte; {icon number minus 256}
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itemCmd: Char; {keyboard equivalent or }
{ value ($1B) indicating }
{ item has a submenu, or }
{ ($1C) if item has }

{ a script code, or }

{ ($1D) if item's 'ICON' }
{ should be reduced, or }
{ ($1E) if item has an }
{ 'sIcN' icon}
{marking character or }
{ menu ID of submenu}
{style of menu text}
{contains 0 if no }
{ more menu items}

itemMark: Char;

itemStyle: Style;
endMarker: Byte;

The menu definition procedure maintains the information about the
menu items. You typically define your menu items in ' MENU'"
resources, and the Menu Manager stores information describing
your items in the menu’s menu record.

Your application should not directly change the values of any fields in a menu record.
Use Menu Manager routines to change the characteristics of menu items or to make other
changes to a menu.

The Menu List

The menu list contains information about the menus in a menu bar, about submenus, and
about pop-up menus. A menu list contains handles to the menu records of zero,

one, or more menus and contains other information that the Menu Manager uses to
manage menus.

The InitMenus procedure creates the current menu list of an application. The current
menu list contains handles to the menu records of all menus currently in the menu bar
and handles to the menu records of any submenus or pop-up menus inserted into the
menu list by your application. The menu bar shows the titles, in order, of all menus
(other than submenus or pop-up menus) in the menu list.

The initial menu list created by InitMenus does not contain handles to any menus. The
Menu Manager dynamically allocates storage in a menu list as menus are added to and
deleted from the menu list.

Your application should not directly change or access the information in a menu list. You
should use Menu Manager routines to create a menu list and to add menus to or remove
menus from the current menu list.

You typically define your application’s menu bar in an 'MBAR' resource and create a
menu list using the GetNewMBar function. The GetNewMBar function returns a handle
to a menu list. You can set the current menu list to the menu list returned by
GetNewMBar using the SetMenuBar procedure.
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The structure of the menu list is private to the Menu Manager. For conceptual purposes,
however, its general structure is defined here.

TYPE DynamicMenulList =

RECORD
lastMenu: Integer; {offset to last pull-down menu}
lastRight: Integer; {pixel location of right edge }
{ of rightmost menu in menu bar}
mbResID: Integer; {upper 13 bits are the resource ID of menu }
{ bar defn function, low 3 bits the variant}
menu: ARRAY[1..X] {variable array with one record for }
OF MenuRec; { each menu}
lastHMenu: Integer; {offset to last submenu or pop-up menu}
menuTitleSave: {handle to bits behind inverted menu title}
pixMapHandle;
hMenu: ARRAY[1..Y] {variable array with one record for }
OF HMenuRec;{ each submenu or pop-up menu}
END;

The Menu Manager dynamically allocates the records that contain handles to the menu
records of menus in the menu bar, submenus, and pop-up menus. These records can be
defined conceptually as the MenuRec and HMenuRec data types. The Menu Manager
uses a data structure similar to that of the MenuRec data type to store information about
pull-down menus in the menu list.

TYPE MenuRec =

RECORD
menuOH : MenuHandle; {handle to menu's menu record}
menuleft: Integer; {pixel location of left edge }
{ of this menu}
END;

The Menu Manager stores information about submenus and pop-up menus at the end of
a menu list in a data structure similar to that of the HMenuRec data type.

TYPE HMenuRec =

RECORD
menuHOH : MenuHandle; {handle to menu's menu record}
reserved: Integer; {reserved}

END;

The Menu Color Information Table Record

3-98

Your application’s menu color information table defines the standard color for the menu
bar, titles of menus, text and characteristics of menu items, and background color of a
displayed menu. If you do not add any entries to this table, the Menu Manager draws
your menus using the default colors, black on white. You can add colors to your menus
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by adding entries to your application’s menu color information table by using Menu
Manager routines or by defining these entries in an 'mctb' resource. Note that the menu
color information table uses a format that is different from the standard color table
format.

The Menu Manager maintains information about an application’s menu color
g pp

information table as an array of menu color entry records.

TYPE MCTable = ARRAY[0..0] OF MCEntry; {menu color table}
MCTablePtr = “MCTable; {pointer to a menu color table}
MCTableHandle = “MCTablePtr; {handle to a menu color table}

A menu color entry is defined by the MCEntry data type.

TYPE MCEntry = {menu color entry}
RECORD
mctID: Integer; {menu ID or 0 for menu bar}
mctItem: Integer; {menu item number or 0 for }
{ menu title}
mctRGB1 : RGBColor; {usage depends on mctID and }
{ mctItem}
mMCtRGB2 : RGBColor; {usage depends on mctID and }
{ mctitem}
mctRGB3 : RGBColor; {usage depends on mctID and }
{ mctIitem}
mctRGB4 : RGBColor; {usage depends on mctID and }
{ mctItem}
mctreserved: Integer; {reserved}
END;
MCEntryPtr = “MCEntry; {pointer to a menu color entry}

The first two fields of a menu color entry record, mct ID and mct Item, define whether
the entry is a menu bar entry, a menu title entry, or a menu item entry. The following four
fields specify color information for whatever type of entry the mct ID and mct Item fields
describe. The value of the mct ID field in the last entry in a menu color information table
is 99, and the rest of the fields of the last entry are reserved. The Menu Manager
automatically creates the last entry in a menu color information table; your application
should not use the value -99 as the menu ID of a menu if you wish to add a menu color
entry for it.

The Menu Manager creates your application’s menu color information table the first
time your application calls InitMenus or InitProcMenu. It creates the menu color
information table as initially empty except for the last entry, which indicates the end
of the table.
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Table 3-7 shows how the Menu Manager interprets the mct ID and mctItem fields for
each type of menu color entry in a menu color information table.

Table 3-7 Color information for menu entries

Menu bar

Menu title

Menu item

Last entry

3-100

ID Iltem RGB1 RGB2 RGB3 RGB4

0 0 Default Default back- Default Default bar
menu title ground color item color color
color of menus

N<>0 0 Menu title Bar color Default Background
color item color color of
menu

N<>0 M<>0 Mark color Item text Keyboard Background
color equivalent color of
color menu

-99 Reserved Reserved Reserved Reserved Reserved

A menu bar entry is defined by a menu color entry record that contains 0 in both the
mctID and mctItem fields. You can define only one menu bar entry in a menu color
information table. If you don’t provide a menu bar entry for your application’s menu
color information table, the Menu Manager uses the standard menu bar colors (black text
on a white background), and it uses the standard colors for the other menu elements. You
can provide a menu bar entry to specify default colors for the menu title, the background
of a displayed menu, the items in a menu, and the menu bar. The color information fields
for a menu bar entry are interpreted as follows:

m mctRGB1 specifies the default color for menu titles. If a menu doesn’t have a menu
title entry, the Menu Manager uses the value in this field as the color of the menu title.

m mctRGB2 specifies the default color for the background of a displayed menu. If a
menu doesn’t have a menu title entry, the Menu Manager uses the value in this field as
the color of the menu’s background when it is displayed.

m mctRGB3 specifies the default color for the items in a displayed menu. If a menu item
doesn’t have a menu item entry or a default color defined in a menu title entry, the
Menu Manager uses the value in this field as the color of the menu item.

m mctRGB4 specifies the default color for the menu bar. If a menu doesn’t have a menu
bar entry (and doesn’t have any menu title entries), the Menu Manager uses the
standard colors for the menu bar.

A menu title entry is defined by a menu color entry record that contains a menu ID in the
mct ID field and 0 in the mctItem field. You can define only one menu title entry for each
menu. If you don’t provide a menu title entry for a menu in your application’s menu
color information table, the Menu Manager uses the colors defined by the menu bar
entry. If a menu bar entry doesn’t exist, the Menu Manager uses the standard colors
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(black on white). You can provide a menu title entry to specify a color for the title and
background of a specific menu and a default color for its items. The color information
fields for a menu title entry are interpreted as follows:

B mctRGB1 specifies the color for the menu title of the specified menu. If a menu doesn’t
have a menu title entry, the Menu Manager uses the default value defined
in the menu bar entry.

m mctRGB2 specifies the default color for the menu bar. If a menu color information table
doesn’t have a menu bar entry, the Menu Manager uses the value in this field as the
color of the menu bar. If a menu bar entry already exists, the Menu Manager replaces
the value in the mctRGB2 field of the menu title entry with the value defined in the
mctRGB4 field of the menu bar entry.

m mctRGB3 specifies the default color for the items in the menu. If a menu item doesn’t
have a menu item entry or a default color defined in a menu bar entry, the Menu
Manager uses the value in this field as the color of the menu item.

m mctRGB4 specifies the color for the background of the menu.

A menu item entry is defined by a menu color entry record that contains a menu ID in
the mct ID field and an item number in the mctItem field. You can define only one menu
item entry for each menu item. If you don’t provide a menu item entry for an item in
your application’s menu color information table, the Menu Manager uses the colors
defined by the menu title entry (or by the menu bar entry if the menu containing the item
doesn’t have a menu title entry). If neither a menu title entry nor a menu bar entry exists,
the Menu Manager draws the mark, text, and keyboard equivalent in black. You can
provide a menu item entry to specify a color for the mark, text, and keyboard equivalent
of a specific menu item. The color information fields for a menu item entry are
interpreted as follows:

m mctRGB1 specifies the color for the mark of the menu item. If a menu item doesn’t
have a menu item entry, the Menu Manager uses the default value defined in the menu
title entry or the menu bar entry.

m mctRGB2 specifies the color for the text of the menu item. If a menu item doesn’t have
a menu item entry, the Menu Manager uses the default value defined in the menu title
entry or the menu bar entry. The Menu Manager also draws a black-and-white icon of
a menu item using the same color as defined by the mctRGB2 field. (Usea 'cicn'
resource to provide a menu item with a color icon.)

m mctRGB3 specifies the color for the keyboard equivalent of the menu item. If a menu
item doesn’t have a menu item entry, the Menu Manager uses the default value
defined in the menu title entry or the menu bar entry.

m mctRGB4 specifies the color for the background of the menu. If the menu color
information table doesn’t have a menu title entry for the menu this item is in, or
doesn’t have a menu bar entry, the Menu Manager uses the value in this field as the
background color of the menu. If a menu title entry already exists, the Menu Manager
replaces the value in the mctRGB4 field of the menu item entry with the value defined
in the mctRGB4 field of the menu title entry (or with the mctRGB2 field of the menu
bar entry).
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You can use the GetMCInfo function to get a copy of your application’s menu color
information table and the SetMCEntries procedure to set entries of your application’s
menu color information table, or you can provide 'mctb' resources that define the color
entries for your menus.

The GetMenu, GetNewMBar, and ClearMenuBar routines can also modify the entries in
the menu color information table. The GetMenu function looks for an 'mctb' resource
with a resource ID equal to the value in the menuID parameter. If it finds one, it adds the
entries to the application’s menu color information table.

The GetNewMBar function builds a new menu color information table when it creates the
new menu list. If you want to save the current menu color information table, call
GetMCInfo before calling GetNewMBar.

The ClearMenuBar procedure reinitializes both the current menu list and the menu
color information table.

Menu Manager Routines

3-102

The Menu Manager includes routines for creating menus, changing the characteristics of
menu items, and handling user choice of menu commands. The Menu Manager also
provides routines for adding items to and deleting items from menus, counting the
number of items in a menu, getting a handle to a menu’s menu record, disposing of
menus, calculating the dimensions of a menu, highlighting the menu bar, and managing
entries in your application’s menu color information table.

Some Menu Manager routines can be accessed using more than one spelling of the
routine’s name, depending on the interface files supported by your development
environment. For example, GetMenuHandle is also available as GetMHandle.
Table 3-8 provides a mapping between the previous name of a routine and its new
equivalent name.

Table 3-8 Mapping between new and previous names of Menu Manager routines
New name Previous name

AppendResMenu AddResMenu

DeleteMCEntries DelMCEntries

DeleteMenultem DelMenultem

DisposeMCInfo DispMCInfo

GetMenuHandle GetMHandle

GetMenulItemText GetItem

InsertMenultem InsMenulItem

SetMenultemText SetItem
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Initializing the Menu Manager

InitMenus

You can use the InitMenus procedure to initialize the Menu Manager.

You can use the InitProcMenu procedure to set the current menu list so that it uses a
custom menu bar definition function if necessary.

DESCRIPTION

The InitMenus procedure allocates space for your application’s current menu list in
your application’s heap. Your application needs to call InitMenus only once to initialize
the Menu Manager and the current menu list for your application.

PROCEDURE InitMenus;

The InitMenus procedure creates the current menu list with no menus, submenus, or
pop-up menus. InitMenus also creates your application’s menu color information table.
After allocating the menu color information table, InitMenus looks for an 'mctb'
resource with resource ID 0. You can provide an 'mctb' resource with a resource ID of 0
as one of your application’s resources if you want to use colors other than the default
colors for your application’s menu bar and menus. If InitMenus finds and successfully
loads an 'mctb' resource, it adds the information contained in that resource to the menu
color information table (using SetMCEntries).

The InitMenus procedure also draws an empty menu bar.

SPECIAL CONSIDERATIONS

SEE ALSO

Your application must initalize QuickDraw, the Font Manager, and the Window Manager
(using the InitGraf, InitFonts, and InitWindows procedures) before initializing
the Menu Manager.

To set up the menus for your application’s menu bar, use GetNewMBar and
SetMenuBar, described on page 3-111 and page 3-112, respectively. You can also add
menus to the current menu list using the InsertMenu procedure, described on
page 3-108.

To remove all menus from the current menu list, use the ClearMenuBar procedure,
described on page 3-110.

If your application uses its own menu bar definition function, use the InitProcMenu
procedure to set the mbResID field of the current menu list to the resource ID of your
custom 'MBDF' resource.

Menu Manager Reference 3-103



CHAPTER 3

Menu Manager

See “The Menu Color Information Table Resource” on page 3-155 for a description of the
'mctb' resource.

See the chapter “Window Manager” in this book for a description of the InitWindows
procedure. See Inside Macintosh: Imaging and Inside Macintosh: Text for descriptions of the
InitGraf and InitFonts procedures.

InitProcMenu

DESCRIPTION

Apple recommends that you use the standard menu bar definition function. However, if
your application provides its own menu bar definition function, use the InitProcMenu
procedure to set the mbResID field of the current menu list to the resource ID of your
custom 'MBDF' resource.

PROCEDURE InitProcMenu (resID: Integer) ;

resID The resource ID of your application’s menu bar definition function in the
upper 13 bits of this parameter; the variant in the lower 3 bits. You must
use a resource ID greater than $100.

For resources of type 'MBDF ', Apple reserves resource IDs $000 through
$100 for its own use.

The InitProcMenu procedure creates the current menu list if it hasn’t already been
created by a previous call to InitMenus. The InitProcMenu procedure stores the
resource ID that you specify in the mbResID field of the current menu list. The Menu
Manager uses the menu bar definition function referred to in this field to draw the menu
bar and to perform basic operations on menus.

SPECIAL CONSIDERATIONS

SEE ALSO

3-104

The resource ID of your application’s menu bar definition function is maintained in the
current menu list until your application next calls InitMenus; InitMenus initializes the
mbResID field with the resource ID of the standard menu bar definition function. This
can affect applications such as development environments that control other applications
that may call InitMenus.

See the description of the InitMenus procedure on page 3-103; you should use
InitMenus if your application uses the standard menu bar definition function.
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Creating Menus

NewMenu

You can use the NewMenu or GetMenu function to create a pull-down menu, although
you usually create all the menus in your menu bar at once by providing an 'MBAR'
resource and using the GetNewMBar function. See “Getting and Setting the Menu Bar”
on page 3-112 for information on creating a menu bar. You typically use the NewMenu or
GetMenu function to create submenus or pop-up menus.

The NewMenu function creates a menu with the specified title, assigns it the specified
menu ID, and creates a menu record for the menu. Use AppendMenu, InsertMenultem,
AppendResMenu, or InsertResMenu to add items to menus you create with NewMenu.

The GetMenu function creates a menu with the title, items, and characteristics defined in
a specified 'MENU' resource.

Both NewMenu and GetMenu allocate space in your application’s heap for the menu
record and return a handle to the menu’s newly created menu record.

To add menus created by NewMenu or GetMenu to the current menu list, use the
InsertMenu procedure. To update the menu bar with any new menu titles, use
DrawMenuBar.

You can use the NewMenu function to create an empty menu with a specified title and
menu ID. In most cases you should store information about your menus (such as their
titles, items, and characteristics) in resources; use the GetMenu or GetNewMBar function
to create menus from resource definitions.

FUNCTION NewMenu (menulID: Integer; menuTitle: Str255): MenuHandle;

menulID The menu ID of the menu. (Note that this is not the resource ID of a
'"MENU' resource.) The menu ID is a number that identifies the menu. Use
positive menu IDs for menus belonging to your application. Use negative
menu IDs for desk accessories (except for submenus of a desk accessory).
Submenus must have menu IDs from 1 through 255. For submenus of an
application, use menu IDs from 1 through 235; for submenus of a desk
accessory, use menu IDs from 236 through 255. Apple reserves the menu
ID of 0.

menuTitle The title of the new menu. Note that in most cases you should store
the titles of menus in resources, so that your menu titles can be more
easily localized.
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The NewMenu function creates a menu with the specified title, assigns it the specified
menu ID, creates a menu record for the menu, and returns a handle to the menu record. It
sets up the menu record to use the standard menu definition procedure (and it reads the
standard menu definition procedure into memory if it isn’t already there). The NewMenu
function does not insert the newly created menu into the current menu list.

After creating a menu with NewMenu, use AppendMenu, InsertMenultem,
AppendResMenu, or InsertResMenu to add menu items to the menu. To add a menu
created by NewMenu to the current menu list, use the InsertMenu procedure. To update
the menu bar with any new menu titles, use the DrawMenuBar procedure.

SPECIAL CONSIDERATIONS

SEE ALSO

GetMenu

To release the memory associated with a menu that you created using NewMenu, first
call DeleteMenu to remove the menu from the current menu list and to remove any
entries for this menu in your application’s menu color information table; then call
DisposeMenu to dispose of the menu’s menu record. After disposing of a menu, use
DrawMenuBar to update the menu bar.

If the NewMenu function is unable to create the menu record, it returns NIL as its function
result.

For information on how to add items to a menu, see the description of AppendMenu on
page 3-124, InsertMenultem on page 3-126, AppendResMenu on page 3-128, and
InsertResMenu on page 3-129. For information on InsertMenu, see page 3-108. To
dispose of a menu, see the description of DeleteMenu on page 3-109 and DisposeMenu
on page 3-140.

3-106

Use the GetMenu function to create a menu with the title, items, and other characteristics
defined in a 'MENU' resource with the specified resource ID. You typically use this
function only when you create submenus; you can create all your pull-down menus at
once using the GetNewMBar function, and you can create pop-up menus using the
standard pop-up control definition function.

FUNCTION GetMenu (resourceID: Integer): MenuHandle;
resourceID The resource ID of the 'MENU' resource that defines the characteristics of

the menu. (You usually use the same number for a menu’s resource ID as
the number that you specify for the menu ID in the menu resource.)
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The GetMenu function creates a menu according to the specified menu resource, and it
also creates a menu record for the menu. It reads the menu definition procedure
(specified in the menu resource) into memory if it isn’t already in memory, and it stores
a handle to the menu definition procedure in the menu record. The GetMenu function
does not insert the newly created menu into the current menu list.

After reading the 'MENU' resource, the GetMenu function searches for an 'mctb’
resource with the same resource ID as the 'MENU' resource. If GetMenu finds this
'mctb' resource, it uses the information in the 'mctb' resource to add entries for this
menu to the application’s menu color information table. The GetMenu function uses
SetMCEntries to add the entries defined by the 'mctb' resource to the application’s
menu color information table. If GetMenu doesn’t find this 'mctb' resource, it uses the
default colors specified in the menu bar entry of the application’s menu color
information, or, if the menu bar entry doesn’t exist, it uses the standard colors for

the menu.

The GetMenu function returns a handle to the menu record of the menu. You can use the
returned menu handle to refer to this menu in most Menu Manager routines. If GetMenu
is unable to read the menu or menu definition procedure from the resource file, GetMenu
returns NIL.

After creating a menu with GetMenu, you can use AppendMenu, InsertMenultemn,
AppendResMenu, or InsertResMenu to add more menu items to the menu if necessary.

To add a menu created by GetMenu to a menu list, use the InsertMenu procedure. To
update the menu bar with any new menu titles, use the DrawMenuBar procedure.

Storing the definitions of your menus in resources (especially menu titles and menu

items) makes your application easier to localize.

WARNING
Menus in a resource must not be purgeable. A

SPECIAL CONSIDERATIONS

To release the memory associated with a menu that you read from a resource file using
GetMenu, first call DeleteMenu to remove the menu from the menu list and to remove
any menu title entry or menu item entries for this menu in the application’s menu color
information table, then call the Resource Manager procedure ReleaseResource to
dispose of the menu’s menu record. Use DrawMenuBar to update the menu bar.

WARNING

Call GetMenu only once for a particular menu. If you need the handle of
a menu currently in the menu list, use GetMenuHandle or the Resource
Manager function GetResource. A
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For a description of the 'MENU' resource, see “The Menu Resource” on page 3-151; for a
sample 'MENU' resource in Rez format, see Listing 3-2 on page 3-48. For information on
the 'mctb' resource, see “The Menu Color Information Table Resource” on page 3-155.

For details on how to add items to a menu, see the description of AppendMenu on

page 3-124, InsertMenultem on page 3-126, AppendResMenu on page 3-128, and
InsertResMenu on page 3-129. To remove a menu, see the description of DeleteMenu
on page 3-109. To update the menu bar, use the DrawMenuBar procedure, described on
page 3-113.

Adding Menus to and Removing Menus From the Current Menu List

InsertMenu

After creating a menu with NewMenu or GetMenu, use the InsertMenu procedure to
insert the menu into the current menu list. Use the DeleteMenu procedure to delete
a menu from the current menu list; use the ClearMenuBar procedure to remove all
menus from the current menu list.
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Use the InsertMenu procedure to insert an existing menu into the current menu list.
PROCEDURE InsertMenu (theMenu: MenuHandle; beforeID: Integer) ;

theMenu Ahandle to the menu record of the menu. The NewMenu and GetMenu
functions return a handle to a menu record that you can use in this
parameter.

beforeID  Anumber thatindicates where in the current menu list the menu should
be inserted. InsertMenu inserts the menu into the current menu list
before the menu whose menu ID equals the number specified in the
beforelID parameter. If the number in the beforeID parameter is 0 (or it
isn’t the ID of any menu in the menu list), InsertMenu adds the new
menu after all others (except before the Help, Keyboard, and Application
menus). If the menu is already in the current menu list or the menu list is
already full, InsertMenu does nothing.

You can specify -1 for the beforeID parameter to insert a submenu into
the current menu list. The submenus in the submenu portion of the menu
list do not have to be currently associated with a hierarchical menu item;
you can store submenus in the menu list and later specify that a menu
item has a submenu if needed. However, note that the MenuKey function
scans all menus in the menu list for keyboard equivalents, including
submenus that are not associated with any menu item. You should not
define keyboard equivalents for submenus that are in the current menu
list but not associated with a menu item.
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You can also specify —1 for the beforeID parameter to insert a pop-up
menu into the current menu list. However, if you use the standard
pop-up control definition function, the pop-up control automatically
inserts the menu into the current menu list according to the needs of the
pop-up control.

The InsertMenu procedure inserts into the current menu list the menu identified by the
specified handle to a menu record. To update the menu bar to reflect the new menu, use
DrawMenuBar.

SEE ALSO
For details on how to update your application’s menu bar, see the description of
DrawMenuBar on page 3-113.
DeleteMenu
Use the DeleteMenu procedure to delete an existing menu from the current menu list.
PROCEDURE DeleteMenu (menulID: Integer) ;
menulID The menu ID of the menu to delete from the current menu list. If the menu
list does not contain a menu with the specified menu ID, DeleteMenu
does nothing.
DESCRIPTION

The DeleteMenu procedure deletes the menu identified by the specified menu ID

from the current menu list, and it removes all color entries for that menu from the
application’s menu color information table. DeleteMenu does not release the memory
occupied by the menu’s menu record. To release the memory occupied by the menu'’s
associated data structures, use DisposeMenu if you created the menu using NewMenu;
use the Resource Manager procedure ReleaseResource if you created the menu using
GetMenu or you read the resource in using GetNewMBar.

The DeleteMenu procedure first checks the submenu portion of the current menu list for
a menu ID with the specified ID. If it finds such a menu, it deletes that menu and returns.
If DeleteMenu doesn’t find the menu in the submenu portion, it checks the regular
portion of the current menu list. This allows a desk accessory to delete a submenu
without deleting an application’s menu whose menu ID might conflict with the menu ID
defined by a desk accessory.

After deleting a menu, use DrawMenuBar to update the menu bar to reflect the changes
to the current menu list.
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For details on how to dispose of a menu’s associated data structures using
DisposeMenu, see “Disposing of Menus” on page 3-140. For information on the
ReleaseResource procedure, see the chapter “Resource Manager” in Inside
Macintosh: More Macintosh Toolbox.

ClearMenuBar

DESCRIPTION

SEE ALSO

Use the ClearMenuBar procedure to delete all menus from the current menu list.

PROCEDURE ClearMenuBar;

The ClearMenuBar procedure deletes all menus from the current menu list and deletes
all color entries from the application’s menu color information table. ClearMenuBar
does not release the memory occupied by any of the menus” menu records or the menu
color information table. To release the memory occupied by the data structures associated
with the menus, use DisposeMenu for each menu you created using NewMenu; use
ReleaseResource for each menu you created using GetMenu or if you read the
resource in using GetNewMBar.

After deleting all menus from the current menu list, use DrawMenuBar to update the
appearance of the menu bar.

To update your application’s menu bar, see the description of DrawMenuBar on
page 3-113. For information on the ReleaseResource procedure, see the chapter
“Resource Manager” in Inside Macintosh: More Macintosh Toolbox.

Getting a Menu Bar Description From an 'MBAR' Resource
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You usually create your application’s menu bar by doing the following:

defining the order and resource ID of your menus in an 'MBAR' resource
m defining the menus in 'MENU' resources

m reading in these descriptions using the GetNewMBar function

m setting the current menu list to the menu list returned by GetNewMBar

m updating the menu bar using DrawMenuBar
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GetNewMBar

DESCRIPTION

Use the GetNewMBar function to read in the definition of a menu bar from an 'MBAR'
resource.

FUNCTION GetNewMBar (menuBarID: Integer): Handle;

menuBarID The resource ID of an 'MBAR' resource that specifies the menus for a
menu bar.

The GetNewMBar function reads in the definition of a menu bar and its associated menus
from an 'MBAR' resource. The 'MBAR' resource identifies the order of menus contained
in its menu bar. For each menu, it also specifies the menu’s resource ID. The
GetNewMBar function reads in each menu from the 'MENU' resource with the resource
ID specified in the 'MBAR' resource.

The GetNewMBar function creates a menu list for the menu bar defined by the 'MBAR'
resource and returns a handle to the menu list. (If the resource isn’t already in memory,
GetNewMBar reads it into memory.) If GetNewMBar can’t read the resource,
GetNewMBar returns NIL. GetNewMBar uses GetMenu to read in each individual menu.

After reading in menus from an 'MBAR' resource, use SetMenuBar to make the menu
list created by GetNewMBar the current menu list. Then use DrawMenuBar to update the
menu bar.

To release the memory occupied by the data structures associated with the menus in a
menu list, use DisposeMenu for each menu you created using NewMenu; use the
Resource Manager procedure ReleaseResource for each menu you created using
GetMenu or if you read the resource in using GetNewMBar. To release the memory
occupied by a menu list, use the Memory Manager procedure DisposeHandle.

SPECIAL CONSIDERATIONS

The GetNewMBar function first saves the current menu list and then clears the current
menu list and your application’s menu color information table. It then creates a

new menu list. Before returning a handle to the new menu list, the GetNewMBar function
restores the current menu list to the previously saved menu list, but Get NewMBar does
not restore the previous menu color information table. To save

and then restore your application’s current menu color information table, call the
GetMCInfo function before GetNewMBar and call the SetMCInfo procedure afterward.

While you supply only the resource ID of an 'MBAR' resource to the GetNewMBar
function, your application often needs to use the menu IDs defined in each of your
menus’ 'MENU' resources. Most Menu Manager routines require either a menu ID
or a handle to a menu record to perform operations on a specific menu. For menus in
the current menu list, you can use the GetMenuHandle function to get the handle to
a menu record of a menu with a given menu ID.
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For a description of the 'MENU' resource, see “The Menu Resource” on page 3-151; for a
sample 'MENU' resource in Rez format, see Listing 3-2 on page 3-48. For a description of
the 'MBAR ' resource, see “The Menu Bar Resource” on page 3-155; for a sample 'MBAR'
resource in Rez format, see Listing 3-4 on page 3-49. For information on the 'mctb'
resource, see “The Menu Color Information Table Resource” on page 3-155. For
information about the Resource Manager, see Inside Macintosh: More Macintosh Toolbox.

Getting and Setting the Menu Bar

You can use the GetMenuBar function to get a handle to a copy of the current menu list.
Use the SetMenuBar procedure to set the current menu bar to a menu list previously
returned by GetMenuBar or GetNewMBar. You can get the height of the menu bar using
the GetMBarHeight function.

GetMenuBar

DESCRIPTION

Use the GetMenuBar function to get a handle to a copy of the current menu list.

FUNCTION GetMenuBar: Handle;

The GetMenuBar function creates a copy of the current menu list and returns a handle to
the copy. You can save the returned menu list and then add menus to or remove menus
from the current menu list (using InsertMenu, DeleteMenu, or ClearMenuBar). You
can later restore the saved menu list using SetMenuBar.

To release the memory occupied by a saved menu list, use the Memory Manager’s
DisposeHandle procedure.

WARNING

GetMenuBar doesn’t copy the menu records, just the menu list (which
contains handles to the menu records). Do not dispose of any menus in a
saved menu list if you wish to restore the menu list later. A

SetMenuBar

3-112

Use the SetMenuBar procedure to set the current menu list to a specified menu list.
PROCEDURE SetMenuBar (menulList: Handle) ;
menuList  Ahandle to a menu list that specifies the menus for a menu bar. You

should specify a handle returned by GetMenuBar or GetNewMBar.
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The SetMenuBar procedure copies the given menu list to the current menu list. As with
GetMenuBar, SetMenuBar doesn’t copy the menu records, just the menu list (which
contains handles to the menu records).

You can use SetMenuBar to restore a menu list that you previously saved using
GetMenuBar or to set the current menu list to a menu list created by GetNewMBar.

The SetMenuBar procedure sets only the current menu list; to update the menu bar
according to the new menu list, use the DrawMenuBar procedure.

GetMBarHeight

DESCRIPTION

Use the GetMBarHeight function if you need to determine the current height of the
menu bar. When the Roman script system is the current system script, the menu bar is
20 pixels high. If a non-Roman script is the current system script, the menu bar may be
greater than 20 pixels high to accommodate the current system font.

FUNCTION GetMBarHeight: Integer;

The GetMBarHeight function returns the current height, in pixels, of the menu bar.

Drawing the Menu Bar

Whenever your application adds menus to or removes menus from the current menu list,
you should update the titles of the menus in the menu bar using the DrawMenuBar
procedure. If you change the enabled state of a menu, you should call DrawMenuBar to
update the menu title accordingly. Alternatively, you can use the InvalMenuBar
procedure instead of DrawMenuBar to invalidate the menu bar; this causes the Event
Manager to redraw the menu bar as part of its normal processing of update events.

DrawMenuBar

DESCRIPTION

Use the DrawMenuBar procedure to draw the menu bar based on the current menu list.

PROCEDURE DrawMenuBar;

The DrawMenuBar procedure draws (or redraws) the menu bar according to the current
menu list. You must call DrawMenuBar to update the menu bar after adding menus to or
deleting menus from the current menu list using InsertMenu or DeleteMenu, after
setting the current menu list using SetMenuBar, after changing the enabled state of a
menu, or after any other routine that changes the current menu list.
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InvalMenuBar

DESCRIPTION

Use the InvalMenuBar procedure to invalidate the menu bar.

PROCEDURE InvalMenuBar;

The InvalMenuBar procedure marks the menu bar as changed and in need

of updating. When the Event Manager scans update regions for regions that require
updating, the Event Manager also checks to determine whether the menu bar

requires updating (because of a call to InvalMenuBar). If the menu bar needs updating,
the Event Manager calls the DrawMenuBar procedure to draw the menu bar.

You can use InvalMenuBar instead of DrawMenuBar to minimize blinking in the menu
bar. For example, if you have several application-defined routines that can change the
enabled state of a menu and each calls DrawMenuBar, you can replace the calls to
DrawMenuBar with calls to InvalMenuBar. In this way the menu bar is redrawn only
once instead of multiple times in quick succession. If you need to make immediate
changes to the menu bar, use DrawMenuBar. If you want to redraw the menu bar at most
once each time through your event loop, use InvalMenuBar. The InvalMenuBar
procedure is available only in System 7.

Responding to the User’s Choice of a Menu Command

3-114

When the user presses the mouse button while the cursor is in the menu bar, your
application should call the MenuSelect function to allow the user to choose a command
from the menu bar. If the user presses the mouse button while the cursor is over a pop-up
menu that does not use the standard pop-up control definition function, your application
should call the PopUpMenuSelect function to allow the user to make a choice from the
pop-up menu.

You should also allow the user to choose a menu command by typing a keyboard
equivalent. When the user presses a key on the keyboard, your application should
determine if the Command key was pressed at the same time, and, if so, your application
should call the MenuKey function to map this keyboard combination to any
corresponding Command-key equivalent.

If the user chooses an item, both the MenuSelect and MenuKey functions highlight the
title of the menu containing the chosen item and report the user’s choice to your
application. Your application should perform the corresponding command and, when
finished, should unhighlight the menu title using the HiliteMenu procedure to indicate
to the user that the command is completed.

If the user releases the mouse button while the cursor is over a disabled item or types the
keyboard equivalent of a disabled item, MenuSelect and MenuKey do not report the
menu ID or menu item of the item. To determine if the user chose a disabled item (for
example, so that your application can provide assistance to the user or explain to the user
why the command is disabled), you can use the MenuChoice function to return the
menu ID and menu item of the disabled menu command.
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Your application should adjust its menus before calling MenuSelect or MenuKey. For
example, you should enable or disable menu items as appropriate and add any
applicable checkmarks or dashes to items that show attributes.

MenuSelect

DESCRIPTION

Use the MenuSelect function to allow the user to choose a menu item from the menus
in your application’s menu bar.

FUNCTION MenuSelect (startPt: Point): LonglInt;

startPt The point (in global coordinates) representing the location of the cursor at
the time the mouse button was pressed.

When the user presses the mouse button while the cursor is in the menu bar, your
application receives a mouse-down event. To handle mouse-down events in the menu
bar, pass the location of the cursor at the time of the mouse-down event as the startpPt
parameter to MenuSelect. The MenuSelect function displays and removes menus as
the user moves the cursor over menu titles in the menu bar, and it handles all user
interaction until the user releases the mouse button.

As the user drags the cursor through the menu bar, the MenuSelect function highlights
the title of the menu the cursor is currently over and displays all items in that menu. If
the user moves the cursor so that it is over a different menu, the MenuSelect function
removes the previous menu and unhighlights its menu title.

The MenuSelect function highlights and unhighlights menu items as the user drags the
cursor over the items in a menu. The MenuSelect function highlights a menu item if the
item is enabled and the cursor is currently over it; it removes such highlighting when the
user moves the cursor to another menu item. The MenuSelect function does not
highlight disabled menu items.

If the user chooses an enabled menu item (including any item from a submenu), the
MenuSelect function returns a value as its function result that indicates which menu
and menu item the user chose. The high-order word of the function result contains the
menu ID of the menu, and the low-order word contains the item number of the menu
item chosen by the user. The MenuSelect function leaves the menu title highlighted;
after performing the chosen task your application should unhighlight the menu title
using the HiliteMenu procedure.

If the user chooses an item from a submenu, MenuSelect returns the menu ID of the
submenu in the high-order word and the item chosen by the user in the low-order word
of its function result. The MenuSelect function also highlights the title of the menu in
the menu bar that the user originally displayed in order to begin traversing to the
submenu. After performing the chosen task, your application should unhighlight the
menu title.
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If the user releases the mouse button while the cursor is over a disabled item, in the menu
bar, or outside of any menu, the MenuSelect function returns 0 in the high-order word
of its function result and the low-order word is undefined. If it is necessary for your
application to find the item number of the disabled item, your application can call
MenuChoice to return the menu ID and menu item.

If the user chooses an enabled item in a menu that a desk accessory has inserted into your
application’s menu list, MenuSelect uses the SystemMenu procedure to process this
occurrence and returns 0 to your application in the high-order word.

SPECIAL CONSIDERATIONS

When the MenuSelect function pulls down a menu, it stores the bits behind the menu
as a relocatable object in the application heap of your application.

ASSEMBLY-LANGUAGE INFORMATION

SEE ALSO
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The InitMenus and InitProcMenu procedures initialize the MenuHook and
MBarHook global variables to 0. If you choose, you can store the addresses of routines
that MenuSelect calls in these global variables. The MenuHook global variable contains
the address (if any) of a routine that MenuSelect calls repeatedly while the mouse
button is down. MenuSelect does not pass any parameters to this routine.

The MBarHook global variable contains the address (if any) of a routine that
MenuSelect calls after a menu title is highlighted and the menu rectangle is calculated
but before the menu is drawn. The menu rectangle is the rectangle (in global coordinates)
in which the menu will be drawn. MenuSelect passes a pointer to the menu rectangle
on the stack. If you provide the address of a routine in the MBarHook global variable, it
should normally return 0 in the DO register, indicating that MenuSelect should
continue; returning 1 causes MenuSelect to cancel its operation and return immediately
to the application.

The MenuSelect function uses the global variable MBarEnable to determine if all
menus in the current menu bar belong to a desk accessory or an application. If the
MBarEnable global variable is nonzero, then all menus in the current menu bar belong
to a desk accessory. If the MBarEnable global variable is 0, then all menus in the current
menu bar belong to an application. If you're writing a desk accessory, you may need to
set the MBarEnable global variable to a nonzero value; if you're writing an application,
you should not change the value of the MBarEnable global variable.

The global variable TheMenu contains the ID of the currently highlighted menu in the
menu bar. If the user chooses an item from a submenu, TheMenu contains the menu ID of
the submenu, not the menu to which the submenu is attached.

For information on adjusting your application’s menus before calling MenuSelect, see
“Adjusting the Menus of an Application” beginning on page 3-73.
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See the description of the HiliteMenu procedure on page 3-119 for details on how to
unhighlight a menu. For information on how to determine if the user chose a disabled
item, see the description of the MenuChoice function on page 3-118.

DESCRIPTION

If the user presses another key while holding down the Command key, call the MenuKey
function to determine if the keyboard combination maps to the keyboard equivalent of a
menu item in a menu in the current menu list.

FUNCTION MenuKey (ch: Char): LongInt;

ch The 1-byte character representing the key pressed by the user in
combination with the Command key.

The MenuKey function maps the given character to the menu and menu item with that
keyboard equivalent. The MenuKey function returns as its function result a value that
indicates the menu ID and menu item that has the keyboard equivalent corresponding to
the given character.

The MenuKey function does not distinguish between uppercase and lowercase letters. It
takes the 1-byte character passed to it and calls the UpperText procedure (which
provides localizable uppercase conversion of the character). Thus, MenuKey translates
any lowercase character to uppercase when comparing a keyboard event to keyboard
equivalents. This allows a user to invoke a keyboard equivalent command, such as the
Copy command, by pressing the Command key and “c” or “C”. For consistency between
applications, you should define the keyboard equivalents of your commands so that they

appear in uppercase in your menus.

If the given character maps to an enabled menu item in the current menu list, MenuKey
highlights the menu title of the chosen menu, returns the menu ID in the high-order word
of its function result, and returns the chosen menu item in the low-order word of its
function result. After performing the chosen task, your application should unhighlight
the menu title using the HiliteMenu procedure.

If the given character does not map to an enabled menu item in the current menu list,
MenuKey returns 0 in its high-order word and the low-order word is undefined.

If the given character maps to a menu item in a menu that a desk accessory has inserted
into your application’s menu list, MenuSelect uses the SystemMenu procedure to
process this occurrence and returns 0 to your application in the high-order word.

You should not define menu items with identical keyboard equivalents. The MenuKey
function scans the menus from right to left and the items from top to bottom. If you have
defined more than one menu item with identical keyboard equivalents, MenuKey returns
the first one it finds.
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The MenuKey function first searches the regular portion of the current menu list for a
menu item with a keyboard equivalent matching the given key. If it doesn’t find one
there, it searches the submenu portion of the current menu list. If the given key maps to a
menu item in a submenu, MenuKey highlights the menu title in the menu bar that the
user would normally pull down to begin traversing to the submenu. Your application
should perform the desired command and then unhighlight the menu title.

You shouldn’t assign a Command-Shift-number key sequence to a menu item as its
keyboard equivalent; Command-Shift-number key sequences are reserved for use as
'"FKEY ' resources. Command-Shift-number key sequences are not returned to your
application, but instead are processed by the Event Manager. The Event Manager invokes
the ' FKEY' resource with a resource ID that corresponds to the number that activates it.

Apple reserves the Command-key codes $1B (Control-[ ) through $1F (Control-_ ) to
indicate meanings other than keyboard equivalents. MenuKey ignores these character
codes and returns a function result of 0 if you specify any of these values in the ch
parameter. Your application should not use these character codes for its own use.

The global variable TheMenu contains the ID of the currently highlighted menu in the
menu bar. If the user chooses an item from a submenu, TheMenu contains the menu ID of
the submenu, not the menu to which the submenu is attached.

WARNING

Do not define a “circular” hierarchical menu—that is, a hierarchical
menu in which a submenu has a submenu whose submenu is

a hierarchical menu higher in the chain. If MenuKey detects a circular
hierarchical menu, it creates a system error with error number 86. A

To unhighlight a menu, use the HiliteMenu procedure, described on page 3-119. To
provide support for keyboard equivalents other than Command-key equivalents, see the
discussion of 'KCHR' resources in Inside Macintosh: Text.

MenuChoice

DESCRIPTION

3-118

If your application needs to find the item number of a disabled menu item that the
user attempted to choose, you can use the MenuChoice function to return the chosen
menu item.

FUNCTION MenuChoice: LongInt;

If the user chooses a disabled menu item, the MenuChoice function returns a value that
indicates which menu and menu item the user chose. The high-order word of the
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function result contains the menu ID of the menu, and the low-order word contains the
item number of the menu item chosen by the user.

The MenuChoice function returns 0 as the low-order word of its function result if the
mouse button was released while the cursor was in the menu bar or outside the menu.

SPECIAL CONSIDERATIONS

HiliteMenu

The Menu Manager updates the global variable MenuDisable whenever a menu is
displayed. As the user moves the cursor over each item, the Menu Manager calls the
menu definition procedure of the menu to update the MenuDisable global variable to
reflect the current menu ID and menu item. The standard menu definition procedure
updates the global variable MenuDisable appropriately. If your application uses its own
menu definition procedure, your menu definition procedure should support this feature;
if you use a menu definition procedure that does not update the global variable
MenuDisable appropriately, the result returned by MenuChoice is undefined.

DESCRIPTION

You can use the HiliteMenu procedure to highlight or unhighlight menu titles. For
example, after performing a menu command chosen by the user, use the HiliteMenu
procedure to unhighlight the menu title.

PROCEDURE HiliteMenu (menulID: Integer) ;

menulID The menu ID of the menu whose title should be highlighted. If the menu
title of the specified menu is already highlighted, HiliteMenu does
nothing. If the menu ID is 0 or the specified menu ID isn’t in the current
menu list, HiliteMenu unhighlights whichever menu title is currently
highlighted (if any).

The MenuSelect and MenuKey functions highlight the title of the menu containing
the item chosen by the user. After performing the chosen task, your application
should unhighlight the menu title by calling HiliteMenu and passing 0 in the
menulID parameter.

The HiliteMenu procedure highlights a menu title by first saving the bits behind the
title rectangle and then drawing the highlighted title. Hi11iteMenu unhighlights a menu
title by restoring the bits behind the menu title.

The global variable TheMenu contains the ID of the currently highlighted menu in the
menu bar. If the user chooses an item from a submenu, TheMenu contains the menu ID of
the submenu, not the menu to which the submenu is attached.
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To highlight the entire menu bar, use the FlashMenuBar procedure, described on
page 3-141.

PopUpMenuSelect

DESCRIPTION

3-120

To display a pop-up menu without using the standard pop-up control definition
function, use the PopUpMenuSelect function to display the pop-up menu anywhere
on the screen. If your application uses the standard pop-up control definition function,
your application does not need to use PopUpMenuSelect.

FUNCTION PopUpMenuSelect (menu: MenuHandle;
Top: Integer; Left: Integer;
PopUpIltem: Integer)
LongInt;

menu A handle to the menu record of the menu. The NewMenu, GetMenu, and
GetMenuHandle functions return a handle to a specified menu’s menu
record.

Top The top coordinate of the pop-up box when it is closed. This value should
be in global coordinates.

Left The left coordinate of the pop-up box when it is closed. This value should
be in global coordinates.

PopUpItem The item number of the current item minus 1. This value should
correspond to the user’s previous choice from this menu. If the user has
not previously made a choice, this value should be set to the default value.

The PopUpMenuSelect function uses the location specified by the Top and Left
parameters to determine where to display the specified item of the pop-up menu. The
PopUpMenuSelect function displays the pop-up menu so that the menu item specified
in the PopUpItem parameter appears highlighted at the specified location. Figure 3-24 on
page 3-34 shows the pop-up title and pop-up box of a pop-up menu.

The PopUpMenuSelect function highlights and unhighlights menu items and handles
all user interaction until the user releases the mouse button. The PopUpMenuSelect
function returns the menu ID of the chosen menu in the high-order word of its function
result and the chosen menu item in the low-order word.

Your application is responsible for highlighting the pop-up title, setting the mark of the
current menu item appropriately, and drawing the text and downward-pointing
indicator in the pop-up box before calling PopUpMenuSelect. Your application should
also make sure the pop-up menu is in the submenu portion of the current menu list
before calling PopUpMenuSelect. (You can use the InsertMenu procedure and specify
-1 in the beforeID parameter to insert the pop-up menu into the current menu list.)
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After calling PopUpMenuSelect, your application can delete the pop-up menu from the
current menu list or leave it in the current menu list.

Your application is also responsible for storing the current value of the menu item,
drawing the text and downward-pointing indicator in the pop-up box, and
unhighlighting the pop-up title after calling PopUpMenuSelect. If you use the standard
pop-up control definition function, these actions are performed for you by the pop-up
control and your application does not need to call PopUpMenuSelect.

When implementing pop-up menus, you should follow the guidelines for pop-up menus
described in Macintosh Human Interface Guidelines. For example, you should define the
pop-up box of your pop-up menu as a rectangle that is the same height as a menu item,
with a one-pixel drop shadow, and should make the pop-up box wide enough to show
the currently selected item and a downward-pointing indicator.

SystemMenu

DESCRIPTION

The MenuSelect and MenuKey functions call the SystemMenu procedure when the
user chooses an item in a menu that belongs to a desk accessory launched in your
application’s partition. Your application should not need to call the SystemMenu
procedure.

PROCEDURE SystemMenu (menuResult: LongInt) ;

menuResult The value that indicates the menu and menu item chosen by the user. The
menu ID is in the high-order word, and the menu item is in the low-order
word. The menu ID for a menu belonging to a desk accessory is a negative
number.

The SystemMenu procedure directs the desk accessory to perform the appropriate action
for the given menu item by calling the desk accessory’s control routine and passing the
accMenu constant in the csCode parameter. The desk accessory should perform the
desired action and return. See Inside Macintosh: Devices for more information on desk
accessories.

ASSEMBLY-LANGUAGE INFORMATION

If you're writing a desk accessory, you may need to set the MBarEnable global variable
to appropriate values. If the MBarEnable global variable is nonzero, then all menus in
the current menu bar belong to a desk accessory. If the MBarEnable global variable is 0,
then all menus in the current menu bar belong to an application. If you're writing an
application, you should not change the value of the MBarEnable global variable.
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When the user chooses one of the standard editing commands in the Edit menu (Undo,
Cut, Copy, Paste, and Clear), call the SystemEdit function to determine whether the
active window belongs to a desk accessory that is launched in your application’s
partition. If so, the SystemEdit function directs the desk accessory to perform the
editing command and returns TRUE. If the active window does not belong to a desk
accessory launched in your application’s partition, SystemEdit returns FALSE and your
application should process the command.

FUNCTION SystemEdit (editCmd: Integer): Boolean;

editCmd The item number of the standard editing command chosen by the user.

Getting a Handle to a Menu Record

Most Menu Manager routines that manage menus require that you specify a handle to
the menu record of the menu on which you want to perform an operation. You can use
the HMGetHelpMenuHandle function to get a handle to your application’s Help menu.
Use the GetMenuHandle function to get a handle to the menu record of any of your
application’s other pull-down menus or submenus in the current menu list. For pop-up
menus that use the standard control definition function, you can access the control record
to get the menu’s handle.

GetMenuHandle

DESCRIPTION

3-122

You can use the GetMenuHandle function to get a handle to the menu record of any of
your application’s menus other than its Help menu. (Use the HMGetHelpMenuHandle
function to get a handle to the menu record of your application’s Help menu.) The
GetMenuHandle function is also available as the GetMHandle function.

FUNCTION GetMenuHandle (menuID: Integer): MenuHandle;

menulID The menu ID of the menu. (Note that this is not the resource ID,
although you often assign the menu ID so that it matches the resource ID.)
You assign a menu ID in the 'MENU' resource of a menu. If you
do not define your menus in 'MENU' resources, you can assign a menu
ID using NewMenu.

The GetMenuHandle function returns a handle to the menu record of the menu having
the specified menu ID. If the menu is in the current menu list, GetMenuHandle returns a
handle to the menu record of the menu as its function result. Otherwise,
GetMenuHandle returns NIL as its function result.
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SPECIAL CONSIDERATIONS

To get a handle to a menu record of a pop-up menu that you create using the pop-up
control definition function, dereference the cntr1Data field of the pop-up menu’s
control record instead of using GetMenuHandle.

HMGetHelpMenuHandle

DESCRIPTION

Use the HMGetHelpMenuHandle function to get a handle to the menu record of your
application’s Help menu.

FUNCTION HMGetHelpMenuHandle (VAR mh: MenuHandle): OSErr;

mh The HMGetHelpMenuHandle function returns a copy of a handle to your
application’s Help menu in this parameter.

The HMGetHelpMenuHandle function returns in the mh parameter a copy of a handle to
the menu record of your application’s Help menu. With this handle, you can append
items to your application’s Help menu by using the AppendMenu procedure or other
related Menu Manager routines. The Help Manager automatically adds the divider that
separates your items from the rest of the Help menu items.

Be sure to define help balloons for your items in the Help menu by creating an ' hmnu'
resource and specifying the kHMHe 1pMenuID constant as its resource ID.

The Menu Manager functions MenuSelect and MenuKey return a result with the menu
ID in the high-order word and the menu item in the low-order word. The MenuSelect
function (and the MenuKey function, if the user chooses an item with a keyboard
equivalent) returns the kHMHe1pMenuID constant in the high-order word when the user
chooses an appended item from the Help menu. The menu item number of the appended
menu item is returned in the low-order word of the function result. Apple reserves the
right to change the number of standard items in the Help menu. To determine the
number of items in the Help menu, call the CountMItems function.

SPECIAL CONSIDERATIONS

RESULT CODES

Do not use the GetMenuHandle function to get a handle to the menu record of the Help
menu. GetMenuHandle returns a handle to the menu record of the global Help menu,
not the menu record of the Help menu that is specific to your application.

noErr 0 No error

paramErr -50 Error in parameter list
memFullErr -108 Not enough room in heap zone
resNotFound -192 Unable to read resource
hmHelpManagerNotInited -855 Help menu not set up
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For examples of how to add items to your application’s Help menu and how to handle
the user’s choice of an item in the Help menu, see Listing 3-14 on page 3-68 and
Listing 3-26 on page 3-81. See the chapter “Help Manager” in Inside Macintosh: More
Macintosh Toolbox for information on creating help balloons for the menus of

your application.

Adding and Deleting Menu Items

You can add the names of all resources of a specified type to a menu using the
InsertResMenu or AppendResMenu procedure. You can add menu items that you
define to a menu using the AppendMenu or InsertMenultem procedure. You can also
delete menu items using the DeleteMenuItem procedure. In most cases you should

not insert or delete individual menu items from an already existing menu unless the user
expects a menu (such as a list of currently open documents) to change.

If you add menu items using the AppendMenu or InsertMenultem procedure, you
should define in resources the text and other characteristics of the menu items that you
add. This makes your application easier to localize for other regions.

AppendMenu

DESCRIPTION
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Use the AppendMenu procedure to append one or more items to a menu previously
created using NewMenu, GetMenu, or GetNewMBar.

PROCEDURE AppendMenu (menu: MenuHandle; data: Str255);

menu A handle to the menu record of the menu to which you wish to append
the menu item or items.

data A string that defines the characteristics of the new menu item or items.
Note that in most cases you should store the text of a menu item in a
resource, so that your menu items can be more easily localized. The
AppendMenu procedure appends the menu items in the order in which
they are listed in the data parameter.

The AppendMenu procedure appends any defined menu items to the specified menu. The
menu items are added to the end of the menu. You specify the text of any menu items
and their characteristics in the data parameter. You can embed metacharacters in the
string to define various characteristics of a menu item.
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Here are the metacharacters that you can specify in the data parameter:

Metacharacter Description
; or Return Separates menu items.

A

When followed by an icon number, defines the icon for the item. If the
keyboard equivalent field contains $1C, this number is interpreted as
a script code.

! When followed by a character, defines the mark for the item. If the
keyboard equivalent field contains $1B, this value is interpreted as
the menu ID of a submenu of this menu item.

< When followed by one or more of the characters B, I, U, O, and S,
defines the character style of the item to Bold, Italic, Underline,
Outline, or Shadow, respectively.

/ When followed by a character, defines the keyboard equivalent for the
item. When followed by $1B, specifies that this menu item has a
submenu. To specify that the menu item has a script code, small icon,
or reduced icon, use the Set ItemCmd procedure to set the keyboard
equivalent field to $1C, $1D, or $1E, respectively.

( Defines the menu item as disabled.

You can specify any, all, or none of these metacharacters in the text string. The
metacharacters that you specify aren’t displayed in the menu item. (To use any of these
metacharacters in the text of a menu item, first use AppendMenu, specifying at least one
character as the item’s text, and then use the SetMenuItemText procedure to set the
item’s text to the desired string.)

Note

If you add menu items using the AppendMenu procedure, you should
define the text and any marks or keyboard equivalents in resources for
easier localization. &

You can specify the first character that defines the text of a menu item as a hyphen to
create a divider line. The string in the data parameter can be blank (containing one or
more spaces), but it should not be an empty string.

If you do not define a specific characteristic of a menu item, the AppendMenu procedure
assigns the default characteristic to the menu item. If you do not define any characteristic
other than the text for a menu item, the AppendMenu procedure inserts the menu item so
that it appears in the menu as an enabled item, without an icon or a mark, in the plain
character style, and without a keyboard equivalent.

You can use AppendMenu to append items to a menu regardless of whether the menu is
in the current menu list.

See “Adding Items to a Menu” on page 3-64 for examples of appending items to a menu.
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InsertMenultem

DESCRIPTION
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Use the InsertMenuItem procedure to insert one or more items to a menu previously
created using NewMenu, GetMenu, or GetNewMBar.

The InsertMenuItem procedure is also available as the InsMenuItem procedure.

PROCEDURE InsertMenultem (theMenu: MenuHandle; itemString: Str255;
afterItem: Integer) ;

theMenu A handle to the menu record of the menu to which you wish to add the
menu item or items.

itemString
A string that defines the characteristics of the new menu items. Note that
in most cases you should store the text of a menu item in a resource, so
that your menu items can be more easily localized. You can specify the
contents of the itemString parameter using metacharacters; the
InsertMenultem procedure accepts the same metacharacters as the
AppendMenu procedure. However, if you specify multiple items, the
InsertMenultem procedure inserts the items in the reverse of their order
in the itemString parameter.

afterItem The item number of the menu item after which the new menu items are to
be added. Specify 0 in the afterItem parameter to insert the new items
before the first menu item; specify the item number of a current menu
item to insert the new menu items after it; specify a number greater than
or equal to the last item in the menu to append the new items to the end of
the menu.

The InsertMenuItem procedure inserts any defined menu items to the specified menu.
The menu items are inserted according to the location specified by the afterItem
parameter. You specify the text of any menu items and their characteristics in the
itemString parameter. You can embed metacharacters in the string you specify to
define various characteristics of a menu item. The metacharacters aren’t displayed in

the menu.

Here are the metacharacters you can specify in the itemString parameter:

Metacharacter Description
; or Return Separates menu items.

A

When followed by an icon number, defines the icon for the item. If the
keyboard equivalent field contains $1C, this number is interpreted as
a script code.

! When followed by a character, defines the mark for the item. If the
keyboard equivalent field contains $1B, this value is interpreted as
the menu ID of a submenu of this menu item.
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Metacharacter Description

< When followed by one or more of the characters B, I, U, O, and S,
defines the character style of the item to Bold, Italic, Underline,
Outline, or Shadow, respectively.

/ When followed by a character, defines the keyboard equivalent for the
item. When followed by $1B, specifies that this menu item has a
submenu. To specify that the menu item has a script code, small icon,
or reduced icon, use the Set ITtemCmd procedure to set the keyboard
equivalent field to $1C, $1D, or $1E, respectively.

( Defines the menu item as disabled.

You can specify any, all, or none of these metacharacters in the text string. The
metacharacters that you specify aren’t displayed in the menu item. To use any of these
metacharacters in the text of a menu item, first use InsertMenuItem, specifying at least
one character as the item’s text, and then use the SetMenuItemText procedure to set
the item’s text to the desired string.

Note

If you add menu items using the InsertMenuItem procedure, you
should define the text and any marks or keyboard equivalents in
resources for easier localization. &

You can specify the first character that defines the text of a menu item as a hyphen to
create a divider line. The string in the i temString parameter can be blank (containing
one or more spaces), but it should not be an empty string.

If you do not define a specific characteristic of a menu item, the InsertMenuItem
procedure assigns the default characteristic to the menu item. If you do not define any
characteristic other than the text for a menu item, the InsertMenuItem procedure
inserts the menu item so that it appears in the menu as an enabled item, without an icon
or a mark, in the plain character style, and without a keyboard equivalent.

You can use InsertMenultem to insert items into a menu regardless of whether the
menu is in the current menu list.

See “Adding Items to a Menu” beginning on page 3-64 for examples.

DeleteMenultem

Use the DeleteMenuItem procedure to delete an item from a menu. The
DeleteMenuItem procedure is also available as the DelMenuItem procedure.

PROCEDURE DeleteMenultem (theMenu: MenuHandle; item: Integer) ;
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theMenu A handle to the menu record of the menu from which you want to delete
the menu item.

item The item number of the menu item to delete. If you specify 0 or a number
greater than the last item in the menu, DeleteMenuItem does not delete
any item from the menu.

The DeleteMenulItem procedure deletes a specified menu item from a menu. The
DeleteMenuItem procedure also deletes the item’s menu item entry from your
application’s menu color information table (if an entry exists). You should not delete
items from an existing menu unless the user expects the menu (such as a menu that lists
open documents) to change.

AppendResMenu

DESCRIPTION
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Use the AppendResMenu procedure to search all resource files open to your application
for a given resource type and to append the names of any resources it finds to a specified
menu. The specified menu must have been previously created using NewMenu, GetMenu,
or GetNewMBar.

The AppendResMenu procedure is also available as the AddResMenu procedure.
PROCEDURE AppendResMenu (theMenu: MenuHandle; theType: ResType) ;

theMenu Ahandle to the menu record of the menu to which to append the names
of any resources of a given type that AppendResMenu finds.

theType A four-character code that identifies the resource type for which to search.

The AppendResMenu procedure searches all resource files open to your application for
resources of the type defined by the parameter theType. It appends the names of any
resources it finds of the given type to the end of the specified menu. AppendResMenu
appends the names of found resources in alphabetical order; it does not alphabetize items
already in the menu. The AppendResMenu procedure does not add resources with
names that begin with a period (.) or a percent sign (%) to the menu.

The AppendResMenu procedure assigns default characteristics to each menu item. Each
appended menu item appears in the menu as an enabled item, without an icon or a mark,
in the plain character style, and without a keyboard equivalent. To get the name or to
change other characteristics of an item appended by AppendResMenu, use the Menu
Manager routines described in “Getting and Setting the Appearance of Menu Items”
beginning on page 3-130.
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If you specify that AppendResMenu add resources of type 'DRVR' to your Apple menu,
AppendResMenu adds the name (and icon) of each item in the Apple Menu Items folder
to the menu.

If you specify that AppendResMenu append resources of type ' FONT' or ' FOND', the
Menu Manager performs special processing for any resources it finds that have font
numbers greater than $4000. If the script system associated with the font name is installed
in the system, AppendResMenu stores information in the itemDefinitions array (in
the itemIcon and itemCmd fields for that item) in the menu’s menu record. This allows
the Menu Manager to display the font name in the correct script.

SPECIAL CONSIDERATIONS

The AppendResMenu procedure calls the Resource Manager procedure SetResLoad
(specifying TRUE in the 1oad parameter) before returning. The AppendResMenu
procedure reads the resource data of the resources it finds into memory. If your
application does not want the Resource Manager to read resource data into memory
when your application calls other routines that read resources, you need to call
SetResLoad and specify FALSE in the 1oad parameter after AppendResMenu returns.

SEE ALSO
Listing 3-15 on page 3-69 shows a sample that adds items from the Apple Menu Items
folder to the Apple menu, and Listing 3-16 on page 3-70 shows a sample that adds font
names to a menu. See Inside Macintosh: More Macintosh Toolbox for information on the
Resource Manager.

InsertResMenu

Use the InsertResMenu procedure to search all resource files open to your application
for a given resource type and to insert the names of any resources it finds to a specified
menu. The items are inserted after the specified menu item. The specified menu must
have been previously created using NewMenu, GetMenu, or GetNewMBar.

PROCEDURE InsertResMenu (theMenu: MenuHandle; theType: ResType;
afterItem: Integer);

theMenu A handle to the menu record of the menu to which to add the names of
any resources of a given type that InsertResMenu finds.

theType A four-character code that identifies the resource type for which to search.

afterItem A number that indicates where in the menu to insert the names of any
resources of the given type that InsertResMenu finds. Specify 0 in the
afterItem parameter to insert the items before the first menu item;
specify the item number of a menu item already in the menu to insert the
items after the specified item number. If you specify a number greater than
or equal to the last item in the menu, the items are inserted at the end of
the menu.
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The InsertResMenu procedure searches all resource files open to your application for
resources of the type defined by the parameter theType. It inserts the names of any
resources it finds of the given type at the specified location in the specified menu.
InsertResMenu adds the names of found resources in alphabetical order; it does not
alphabetize items already in the menu.

The InsertResMenu procedure does not add resources with names that begin with a
period (.) or a percent sign (%) to the menu.

The InsertResMenu procedure assigns default characteristics to each menu item. Each
appended menu item appears in the menu as an enabled item, without an icon or a mark,
in the plain character style, and without a keyboard equivalent. To get the name or to
change other characteristics of an item appended by InsertResMenu, use the Menu
Manager routines described in the next section, “Getting and Setting the Appearance of
Menu Items.”

If you specify that InsertResMenu add resources of type 'DRVR' to your Apple menu,
InsertResMenu adds the name (and icon) of each item in the Apple Menu Items folder
to the menu.

If you specify that InsertResMenu add resources of type ' FONT' or ' FOND', the Menu
Manager performs special processing for any resources it finds that have font numbers
greater than $4000. If the script associated with the font name is currently active,
InsertResMenu stores information in the itemDefinitions array (in the itemIcon
and itemCmd fields for that item) in the menu’s menu record that allows the Menu
Manager to display the font name in the correct script.

SPECIAL CONSIDERATIONS

The InsertResMenu procedure calls the Resource Manager procedure SetResLoad
(specifying TRUE in the 1oad parameter) before returning. The InsertResMenu
procedure reads the resource data of the resources it finds into memory. If your
application does not want the Resource Manager to read resource data into memory
when your application calls other routines that read resources, you need to call
SetResLoad and specify FALSE in the 1oad parameter after InsertResMenu returns.

Getting and Setting the Appearance of Menu Items

3-130

You can get information about the characteristics of a menu item using Menu Manager
routines. For example, you can get an item’s text, style, mark, keyboard equivalent, script
code, and associated icons. You can also determine if a menu item has a submenu
associated with it and the menu ID of the submenu.

You can set the characteristics of a menu item, including associating a submenu with a
menu item, using Menu Manager routines. Whenever possible, however, you should
define your application’s menu items in 'MENU' resources. This makes your application
easier to localize for other regions.

You can also enable and disable menu items or entire menus using Menu Manager
routines.
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DESCRIPTION

Use the EnableItem procedure to enable a menu item or a menu.

PROCEDURE EnableItem (theMenu: MenuHandle; item: Integer) ;

theMenu Ahandle to the menu record of the menu containing the menu item
to enable.

item The item number of the menu item to enable, or 0 to enable the entire
menu. You cannot individually enable a menu item with an item number
greater than 31.

If you specify 0 in the item parameter, the EnableItem procedure
enables the menu title and all items in the menu that were not previously
individually disabled.

The EnableItem procedure enables a specified menu item so that it no longer appears
dim and so that the user can choose the menu item.

Note that, if you enable a menu, the EnableItem procedure enables the menu title but
only enables those menu items that are not currently disabled as a result of your
application previously calling DisableItem and specifying each item’s item number.
For example, if all items in your application’s Edit menu are enabled, you can disable the
Cut and Copy commands individually using DisableItem. If you choose to disable the
entire menu by passing 0 as the item parameter to DisableItem, the menu and all its
items are disabled. If you then enable the entire menu by passing 0 as the item
parameter to EnableItem, the menu and its items are enabled, except for the Cut and
Copy commands, which remain disabled. In this case, to enable the Cut and Copy
commands you must enable each one individually using EnableItem.

If your application enables a menu using EnableItemn, it should call DrawMenuBar to
update the menu bar’s appearance.

SEE ALSO
See “Enabling and Disabling Menu Items” on page 3-58 for examples of enabling items in
a menu.

Disableltem

Use the DisableItem procedure to disable a menu item or an entire menu.

PROCEDURE DisableItem (theMenu: MenuHandle; item: Integer) ;
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theMenu A handle to the menu record of the menu containing the menu item
to disable.

item The item number of the menu item to disable, or 0 to disable the entire
menu. You cannot individually disable a menu item with an item number
greater than 31.

If you specify 0 in the item parameter, the DisableItem procedure
disables the menu title and all items in the menu, including menu items
with item numbers greater than 31.

The DisableItem procedure disables a specified menu item so that it appears dim and
cannot be chosen by the user.

If your application disables a menu using DisableItem, your application should call
DrawMenuBar to update the menu bar’s appearance.

See “Enabling and Disabling Menu Items” on page 3-58 for examples of disabling items
in a menu.

GetMenultemText

DESCRIPTION
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Use the GetMenuItemText procedure to get the text of a specific menu item. The
GetMenuItemText procedure is also available as the Get Item procedure.

PROCEDURE GetMenultemText (theMenu: MenuHandle; item: Integer;
VAR itemString: Str255);

theMenu Ahandle to the menu record of the menu containing the menu item whose
text you wish to get.

item The item number of the menu item. The GetMenuItemText procedure
returns the text of this item.

itemString The GetMenulItemText procedure returns the text of the menu item in
this parameter.

The GetMenuItemText procedure returns the text of the specified menu item in the
itemString parameter. Use other Menu Manager routines to get information about
the other characteristics of a menu item.
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SetMenultemText

DESCRIPTION

SEE ALSO

Use the SetMenuItemText procedure to set the text of a specific menu item to a given
string. The SetMenuItemText procedure is also available as the Set Item procedure.

PROCEDURE SetMenultemText (theMenu: MenuHandle; item: Integer;
itemString: Str255) ;

theMenu Ahandle to the menu record of the menu containing the menu item whose
text you wish you to set.

item The item number of the menu item. The SetMenuItemText procedure
sets the text of this item.

itemString The SetMenuItemText procedure sets the text of the menu item
according to the string specified in the itemString parameter. The
SetMenuItemText procedure does not recognize metacharacters or set
any other characteristics of the menu item. The itemString parameter
can be blank, but it should not be an empty string.

The SetMenuItemText procedure sets the text of the specified menu item to the text
specified in the itemString parameter. The SetMenuItemText procedure does not
recognize any metacharacters used by the AppendMenu and InsertMenuItem
procedures. Use other Menu Manager routines to set other characteristics of a menu item.

If you set the text of a menu item using the SetMenuItemText procedure, you should
store the text in a string resource so that your application can be more easily localized.

See Listing 3-9 on page 3-59 for an example of setting the text of a menu item.

GetltemStyle

Use the GetItemStyle procedure to get the style of the text in a specific menu item.

PROCEDURE GetItemStyle (theMenu: MenuHandle; item: Integer;
VAR chStyle: Style) ;

theMenu Ahandle to the menu record of the menu containing the menu item whose
style you wish to get.
item The item number of the menu item. The Get ItemStyle procedure

returns the style of the text for this item.
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chStyle

The Get ItemStyle procedure returns the style of the text for this item in
the chStyle parameter. The chStyle parameter is a set defined by the
Style data type.

TYPE

StyleItem = (bold, italic, underline, outline,
shadow, condense, extend) ;

Style = SET OF Styleltem;

DESCRIPTION
The Get ItemStyle procedure returns the style of the text of the specified menu item in
the chsStyle parameter. The returned style can be one or more of the styles defined by
the Style data type, or it is the empty set if the style of the text is Plain.
SetltemStyle
Use the SetItemStyle procedure to set the style of the text in a specific menu item.
PROCEDURE SetItemStyle (theMenu: MenuHandle; item: Integer;
chStyle: Style);
theMenu Ahandle to the menu record of the menu containing the menu item whose
style you wish to set.
item The item number of the menu item. The Set ItemStyle procedure sets
the style of the text for this item.
chsStyle The SetItemStyle procedure sets the style of the text for this item
according to the style described by the chStyle parameter. The chStyle
parameter is a set defined by the Style data type.
TYPE
StyleItem = (bold, italic, underline, outline,
shadow, condense, extend) ;
Style = SET OF Styleltem;
You can set the style to one or more of the styles defined by the Style
data type, or you can set it to Plain by specifying an empty set in the
chStyle parameter.
DESCRIPTION
The SetItemStyle procedure sets the style of the text of the specified menu item to the
style or styles defined by the chStyle parameter.
SEE ALSO
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See Listing 3-10 on page 3-60 for examples of setting the style of a menu item.
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GetltemMark

Use the Get ItemMark procedure to get the mark of a specific menu item or the menu ID
of the submenu associated with the menu item.

PROCEDURE GetItemMark (theMenu: MenuHandle; item: Integer;
VAR markChar: Char) ;

theMenu Ahandle to the menu record of the menu containing the menu item whose
mark or submenu you wish to get.

item The item number of the menu item. The Get ItemMark procedure returns
the mark of this item or, if this item has a submenu associated with it,
returns the menu ID of the submenu in the markChar parameter.

markChar  The GetItemMark procedure returns the mark or the submenu of this
item in the markChar parameter. A menu item can have a mark or a
submenu attached to it, but not both. If this menu item has a marking
character, the Get ItemMark procedure returns the mark. If this menu
item has a submenu associated with it, the Get ItemMark procedure
returns the menu ID of the submenu. If the item doesn’t have a mark or
a submenu, Get ItemMark returns 0 in this parameter.

DESCRIPTION

If the item has a mark or submenu, the Get ItemMark procedure returns the mark or the
menu ID of the submenu of the specified menu item in the markChar parameter (or 0 if
the item doesn’t have a mark or a submenu).

SetItemMark

Use the SetItemMark procedure to set the mark of a specific menu item or to change or
set the submenu associated with a menu item.

PROCEDURE SetItemMark (theMenu: MenuHandle; item: Integer;
markChar: Char) ;

theMenu Ahandle to the menu record of the menu containing the menu item whose
mark or submenu you wish to set.

item The item number of the menu item. The Set ItemMark procedure sets the
mark or the submenu of this item.

markChar  The SetItemMark procedure sets the mark or submenu of this item
according to the information in the markChar parameter.
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To set the mark of a menu item, specify the marking character in the
markChar parameter. You can also use one of these constants to specify
that the item has no mark, has a checkmark as the marking character, or
has the diamond symbol as the marking character:

CONST

noMark = 0; {no marking character}
checkMark = $12; {checkmark}
diamondMark = $13; {diamond symbol}

To set the submenu associated with this menu item, specify the menu ID
of the submenu in the markChar parameter.

The SetItemMark procedure sets the mark or the submenu of the specified menu item.

See Listing 3-11 on page 3-61 for examples of setting the mark of a menu item.

DESCRIPTION

SEE ALSO
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Use the CheckItem procedure to set the mark of a specific menu item to a checkmark or
to remove a mark from a menu item.

PROCEDURE CheckItem (theMenu: MenuHandle; item: Integer;
checked: Boolean) ;

theMenu Ahandle to the menu record of the menu containing the menu item whose
mark you wish to set to a checkmark or whose mark you wish to remove.

item The item number of the menu item.

checked The CheckItem procedure sets or removes the mark of the item according

to the information in the checked parameter.

To set the mark of a menu item to a checkmark, specify TRUE in the
checked parameter. To remove a checkmark or any other mark from a
menu item, specify FALSE in the checked parameter.

The CheckItem procedure sets the mark of the specified menu item to a checkmark or
removes any mark from the menu item.

See Listing 3-11 on page 3-61 for examples of setting the mark of a menu item.

Menu Manager Reference



CHAPTER 3

Menu Manager

Getltemlcon

Use the Get ItemIcon procedure to get the icon or script code of a specific menu item. If
the menu item’s keyboard equivalent field contains $1C, the returned number represents
the script code of the menu item. Otherwise, the returned number represents the item’s
icon number.

PROCEDURE GetItemIcon (theMenu: MenuHandle; item: Integer;
VAR iconIndex: Byte);

theMenu A handle to the menu record of the menu containing the menu item whose
icon or script code you wish to get.

item The item number of the menu item. The Get ItemIcon procedure returns
the icon number or script code of this item.

iconIndex For menu items that do not specify $1C in the keyboard equivalent field,
the Get ItemIcon procedure returns the icon number of the item’s icon in
this parameter. The icon number returned in this parameter is a value
from 1 through 255 if the menu item has an icon associated with it and is 0
otherwise. You can add 256 to the icon number to generate the resource ID
of the 'cicn', 'ICON', or 'SICN' resource that describes the icon of the
menu item. For example, if the Get ItemIcon procedure returns 5 in this
parameter, then the icon of the menu item is described by an icon resource
with resource ID 261.

For menu items that contain $1C in the keyboard equivalent field, the
GetItemIcon procedure returns the script code of the menu item. The
Menu Manager displays the menu item using this script code if the
corresponding script system is installed.

DESCRIPTION

The Get ItemIcon procedure returns the icon number or script code of the specified
menu item in the iconIndex parameter (or 0 if the item doesn’t have an icon or a
script code).

Setltemlcon

Use the SetItemIcon procedure to set the icon number or script code of a specific menu
item. Usually you display menu items in the current system script; however, if needed,
you can use the Set ItemIcon procedure to set the script code of a menu item. For an
item’s script code to be set, the keyboard equivalent field of the item must contain $1C. If
the keyboard equivalent field contains any other value, the Set ItemIcon procedure
interprets the specified number as the item’s icon number.

PROCEDURE SetItemIcon (theMenu: MenuHandle; item: Integer;
iconIndex: Byte);

Menu Manager Reference 3-137



DESCRIPTION

CHAPTER 3

Menu Manager

theMenu Ahandle to the menu record of the menu containing the menu item whose
icon (or script code) you wish to set.

item The item number of the menu item. The Set ItemIcon procedure sets the
icon (or script code) of this item.

iconIndex If the menu item’s keyboard equivalent field does not contain $1C, the
SetItemIcon procedure sets the icon number of the item’s icon to the
number defined in this parameter. The icon number you specify should be
a value from 1 through 255 (or from 1 through 254 if the item has a small
or reduced icon) or 0 if the item does not have an icon.

The Menu Manager adds 256 to the icon number to generate the resource
ID of the 'cicn!' or 'ICON' resource that describes the icon of the menu
item. For example, if you specify 5 as the value of the iconIndex
parameter, when the Menu Manager needs to draw the item, it looks for
an icon resource with resource ID 261.

If the menu item’s keyboard equivalent field contains $1C, the
SetItemIcon procedure sets the script code of the menu item to the
number defined in the iconIndex parameter. The Menu Manager
displays the menu item using the specified script code if the
corresponding script system is installed.

You can specify 0 in the iconIndex parameter to indicate that the item
uses the current system script and does not have an icon number.

The Set ItemIcon procedure sets the icon number or script code of the specified menu
item to the value in the iconIndex parameter.

SEE ALSO
See “Changing the Icon or Script Code of Menu Items” beginning on page 3-62 for
examples of setting the icon of a menu item.
GetltemCmd
Use the Get ItemCmd procedure to get the value of the keyboard equivalent field of a
menu item.
PROCEDURE GetItemCmd (theMenu: MenuHandle; item: Integer;
VAR cmdChar: Char) ;
theMenu Ahandle to the menu record of the menu containing the menu item whose
keyboard equivalent field you wish to get.
item The item number of the menu item. The Get ItemCmd procedure returns
the keyboard equivalent field of this item.
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cmdChar The value of the item’s keyboard equivalent field. The Menu Manager
uses this value to map keyboard equivalents to menu commands or to
indicate special characteristics of the menu item.

If the cmdChar parameter contains $1B, the menu item has a submenu; a
value of $1C indicates that the item has a script code; a value of $1D
indicates that the Menu Manager reduces the item’s ' ICON' resource; and
a value of $1E indicates that the item has an ' SICN' resource.

The Get ItemCmd procedure returns the value in the keyboard equivalent field of the
specified menu item in the cmdChar parameter (or 0 if the item doesn’t have a keyboard
equivalent, submenu, script code, reduced icon, or small icon).

SetltemCmd

DESCRIPTION

Use the Set ItemCmd procedure to set the value of the keyboard equivalent field of a
menu item. You usually define the keyboard equivalents and other characteristics of your
menu items in 'MENU' resources rather than using the Set ItemCmd procedure.

PROCEDURE SetItemCmd (theMenu: MenuHandle; item: Integer;
cmdChar: Char) ;

theMenu Ahandle to the menu record of the menu containing the menu item whose
keyboard equivalent field you wish to set.

item The item number of the menu item. The Set ItemCmd procedure sets the
keyboard equivalent field of this item to the value specified in the
cmdChar parameter.

cmdChar The value of the item’s keyboard equivalent field. The Menu Manager
uses this value to map keyboard equivalents to menu commands or to
define special characteristics of the menu item.

To indicate that the menu item has a submenu, specify $1B in the
cmdChar parameter; specify a value of $1C to indicate that the item has a
script code; specify a value of $1D to indicate that the Menu Manager
should reduce the item’s ' ICON' resource to the size of a small icon; and
specify a value of $1E to indicate that the item has an ' SICN' resource.

The values $01 through $1A, as well as $1F and $20, are reserved for use
by Apple. You should not use any of these reserved values in the cmdChar
parameter.

The Set ItemCmd procedure sets the value in the keyboard equivalent field of the
specified menu item in the cmdChar parameter (you can specify 0 if the item doesn’t
have a keyboard equivalent, submenu, script code, reduced icon, or small icon). If you
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specify that the item has a submenu, you should provide the menu ID of the submenu as
the item’s marking character. If you specify that the item has a script code, provide the
script code in the icon field of the menu item. If you specify that the item has an ' SICN"
or areduced ' ICON' resource, provide the icon number in the icon field of the item.

Disposing of Menus

If you no longer need a menu in the menu list, you can delete the menu using
DeleteMenu. You should then release the memory associated with that menu using
the DisposeMenu procedure if you created the menu using NewMenu, otherwise,
use the Resource Manager procedure ReleaseResource. See the chapter “Resource
Manager” in Inside Macintosh: More Macintosh Toolbox for information on the
ReleaseResource routine.

DisposeMenu

DESCRIPTION

SEE ALSO

To release the memory occupied by a menu’s associated data structures, use either the
DisposeMenu procedure or the Resource Manager procedure ReleaseResource.
Use DisposeMenu if you created the menu using NewMenu; use ReleaseResource if
you created the menu using GetMenu or read the resource in using GetNewMBar.

You should delete the menu from the current menu list using DeleteMenu or
ClearMenuBar before calling the DisposeMenu procedure.

PROCEDURE DisposeMenu (theMenu: MenuHandle) ;

theMenu Ahandle to the menu record of the menu you wish to dispose of.

The DisposeMenu procedure releases the memory occupied by the specified menu’s
menu record. The handle that you pass in the parameter theMenu is not valid after
DisposeMenu returns.

To delete a menu from the current menu list, see the description of the DeleteMenu
procedure on page 3-109.

Counting the Items in a Menu
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If your application needs to count the number of items in a menu—for example, in a
menu that can contain a variable number of menu items such as the Font menu or Help
menu—use the CountMItems function.
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CountMlItems

DESCRIPTION

You can count the number of items in a menu using the CountMItems function.
FUNCTION CountMItems (theMenu: MenuHandle): Integer;

theMenu Ahandle to the menu record of the menu whose items your application
needs to count.

The CountMItems function counts the number of items in the specified menu and
returns as its function result the number of items in the menu.

Highlighting the Menu Bar

You can highlight (invert) a menu title or the entire menu bar using the FlashMenuBar
procedure. (The HiliteMenu procedure highlights only menu titles.) In most cases
your application should not highlight the menu bar; use HiliteMenu to highlight a
menu title.

The user sets the number of times an enabled menu item flashes using the General
Controls panel. The SetMenuFlash procedure can be used to control the number of
times that menu items blink when the user chooses an enabled menu item; usually you
should not change the setting chosen by the user.

FlashMenuBar

DESCRIPTION

Use the FlashMenuBar procedure to highlight (invert) a menu title or the entire menu
bar. You can call FlashMenuBar twice in a row to make the menu bar blink.

PROCEDURE FlashMenuBar (menulD: Integer) ;

menulID The menu ID of the menu whose title you want to invert. Use 0 in this
parameter to invert the entire menu bar. If the specified menu ID does not
exist in the current menu list, the FlashMenuBar procedure inverts the
entire menu bar.

The FlashMenuBar procedure inverts the title of the specified menu or inverts the menu
bar. To prevent unexpected colors from appearing in the menu bar, you should
not call FlashMenuBar to invert a menu title while the entire menu bar is inverted.
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Only one menu title can be inverted at a time. If no menus are currently highlighted,
calling FlashMenuBar with a specific menu ID inverts the title of that menu. If you call
FlashMenuBar again specifying another menu ID that is different from that of the
previously inverted menu title, FlashMenuBar restores the previously highlighted
menu to normal and then inverts the title of the specified menu.

You can also highlight a menu using the HiliteMenu procedure, described on
page 3-119.

SetMenuFlash

DESCRIPTION

Use the SetMenuF1lash procedure to set the number of times a menu item blinks when
the user chooses an enabled menu item. The user sets this value using the General
Controls panel, and in most cases your application should not change the value set by the
user.

PROCEDURE SetMenuFlash (count: Integer) ;

count The number of times an enabled menu item should blink when the user
chooses it. This value is initially set to 3 by the General Controls panel. A
count of 0 disables the blinking. Values greater than 3 can be slow and
distracting to the user.

The SetMenuFlash procedure sets the number of times that the Menu Manager causes a
menu item to blink when the user chooses an enabled menu item.

The appearance of blinking in a menu item is determined by the menu’s menu definition
procedure.

ASSEMBLY-LANGUAGE INFORMATION

The global variable MenuFlash contains the current count (number of times) a menu
item blinks when chosen by the user.

Recalculating Menu Dimensions
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The Menu Manager uses the CalcMenuSize procedure to recalculate the dimensions of
a menu whenever its contents have changed. In most cases your application does not
need to use the CalcMenuSize procedure.
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CalcMenuSize

DESCRIPTION

The CalcMenuSize procedure recalculates the horizontal and vertical dimensions of
a menu and stores the new values in the menuWidth and menuHeight fields of the
menu record.

PROCEDURE CalcMenuSize (theMenu: MenuHandle) ;

theMenu A handle to the menu record of the menu whose dimensions need
recalculating.

The CalcMenuSize procedure uses the menu definition procedure of the specified menu
to calculate the dimensions of the menu.

Managing Entries in the Menu Color Information Table

GetMClInfo

The Menu Manager maintains color information about an application’s menus in a menu
color information table. The standard menu definition procedure defines the standard
color for the menu bar, titles of menus, text and characteristics of a menu item, and
background color of a displayed menu. You can change any of these colors by adding
entries to your application’s menu color information table. However, note that in most
cases your application should use the default colors for its menus.

You can provide an 'mctb' resource with resource ID 0 as one of your application’s
resources if you want to use colors other than the default colors for your application’s
menu bar and menus. (Or you can provide an 'mctb' resource with the same resource
ID as a 'MENU' resource to define the color entries for a single menu.) You can also add
entries to or delete entries from your application’s menu color information table using
the SetMCEntries and DeleteMCEntries procedures. You can get information about
an entry using the GetMCEntry function. To get or set your application’s menu color
information table, use the GetMCInfo function or SetMCInfo procedure. To dispose of
your application’s menu color information table, use the DisposeMCInfo procedure.

Note that the menu color information table uses a format that is different from the
standard color table format. “The Menu Color Information Table Record” beginning on
page 3-98 describes the format of the menu color information table in detail.

Use the GetMCInfo function to get a handle to a copy of your application’s menu color
information table.

FUNCTION GetMCInfo: MCTableHandle;
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The GetMCInfo function creates a copy of your application’s menu color information
table and returns a handle to the copy. If the copy fails, GetMCInfo returns NIL.

See “The Menu Color Information Table Record” beginning on page 3-98 for a
description of the format of the menu color information table.

DESCRIPTION

SEE ALSO

3-144

Use the SetMCInfo procedure to set your application’s menu color information table.
PROCEDURE SetMCInfo (menuCTbl: MCTableHandle) ;

menuCTbl A handle to a menu color information table.

The SetMCInfo procedure copies the table specified by the menuCTbl parameter
to your application’s menu color information table. If successful, the SetMCInfo
procedure is responsible for disposing of your application’s current menu color
information table, so your application does not need to explicitly dispose of the
current table.

Your application should call the Memory Manager function MemError to determine
whether the SetMCInfo procedure successfully copied the table. If the SetMCInfo
procedure cannot successfully copy the table, it does not dispose of the current menu
color information table and the MemError function returns a nonzero result code. If the
SetMCInfo procedure is able to successfully copy the table, it disposes of the current
menu color information table and the MemError function returns the noErr result code.

If the menu color information table specifies a new menu bar color or new menu title
colors, your application should call DrawMenuBar after calling SetMCInfo.

Note that GetNewMBar does not save your application’s current menu color information
table. If your application changes menu bars, you can save and restore your application’s
current menu color information table by calling GetMCInfo before GetNewMBar and
calling SetMCInfo afterward.

See “The Menu Color Information Table Record” beginning on page 3-98 for a
description of the format of the menu color information table. For an example of using
the GetMCInfo and SetMCInfo routines to save and restore menu color information,
see Listing 3-6 on page 3-52. See Inside Macintosh: Memory for information on the
MemError function
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DisposeMClInfo

DESCRIPTION

Use the DisposeMCInfo procedure to dispose of a menu color information table. The
DisposeMCInfo procedure is also available as the DispMCInfo procedure.

PROCEDURE DisposeMCInfo (menuCTbl: MCTableHandle) ;

menuCTbl A handle to a menu color information table.

The DisposeMCInfo procedure disposes of the menu color information table referred to
by the menuCTb1 parameter.

GetMCEntry

DESCRIPTION

Use the GetMCEntry function to return information about an entry in your application’s
menu color information table. You can get information about the menu bar entry, a menu
title entry, or a menu item entry.

FUNCTION GetMCEntry (menulID: Integer; menultem: Integer)
MCEntryPtr;

menulD The menu ID that the GetMCEnt ry function should use to return
information about the menu color information table. Specify 0 in the
menulID parameter (and the menuItem parameter) to get the menu bar
entry. Specify the menu ID of a menu in the current menu list in the
menulID parameter and 0 in the menuItem parameter to get a specific
menu title entry. Specify the menu ID of a menu in the current menu list in
the menuID parameter and an item number in the menuItem parameter
to get a specific menu item entry.

menultem  The menu item that the GetMCEntry function should use to return
information about the menu color information table. If you specify 0 in
this parameter, GetMCEntry returns either the menu bar entry or the
menu title entry, depending on the value of the menuID parameter. If you
specify the item number of a menu item in this parameter and the menu
ID of a menu in the current menu list in the menuID parameter,
GetMCEntry returns a specific menu item entry.

The GetMCEntry function returns a menu bar entry, a menu title entry, or a menu item
entry according to the values specified in the menuID and menuItem parameters. If
the GetMCEntry function finds the specified entry in your application’s menu color
information table, it returns a pointer to a record of data type MCEntry. If the specified
entry is not found, GetMCEntry returns NIL.
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WARNING
The menu color information table is relocatable, so the pointer returned

by the GetMCEntry function may not be valid across routines that may

move or purge memory. Your application should make a copy of the
menu color entry record if necessary. A

“The Menu Color Information Table Record” beginning on page 3-98 describes the entries
in a menu color information table.

SetMCEntries

DESCRIPTION

Use the SetMCEntries procedure to set entries in your application’s menu color
information table. You can set any or all of your application’s menu item entries and
menu title entries or the menu bar entry.

PROCEDURE SetMCEntries (numEntries: Integer;
menuCEntries: MCTablePtr) ;

numEntries The number of entries contained in the array of menu color entry records.

menuCEntries
A pointer to an array of menu color entry records. Specify the number of
records in the array in the numEntries parameter.

The SetMCEntries procedure sets any specified menu bar entry, menu title entry, or
menu item entry according to the values specified in the menu color entry records. If

an entry already exists for a specified menu color entry, the SetMCEntries procedure
updates the entry in your application’s menu color information table with the new
values. If the entry doesn't exist, it is added to your application’s menu color information
table.

If any of the added entries specify a new menu bar color or new menu title colors, your
application should call DrawMenuBar to update the menu bar with the new colors.

SPECIAL CONSIDERATIONS

3-146

The SetMCEntries procedure may move or purge memory. Your application should
make sure that the array specified by the menuCEntries parameter is nonrelocatable

before calling SetMCEntries.
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“The Menu Color Information Table Record” beginning on page 3-98 describes the entries
in a menu color information table.

DeleteMCEntries

DESCRIPTION

Use the DeleteMCEntries procedure to delete one or all entries for a specific menu
from your application’s menu color information table. You can delete a menu item entry,
a menu title entry, the menu bar entry, or all menu item entries of a specific menu. The
DeleteMCEntries procedure is also available as the DelMCEntries procedure.

PROCEDURE DeleteMCEntries (menulD: Integer; menultem: Integer) ;

menulID The menu ID that the DeleteMCEntries procedure should use to
determine which entry to delete from the menu color information table.
Specify 0 in the menuID parameter (and the menuItem parameter) to
delete the menu bar entry. Specify the menu ID of a menu in the current
menu list in the menuID parameter and 0 in the menuItem parameter to
delete a specific menu title entry. Specify the menu ID of a menu in the
current menu list in the menuID parameter and an item number in the
menultem parameter to delete a specific menu item entry.

menultem  The menu item that the DeleteMCEntries procedure should use to
determine which entry to delete from the menu color information table. If
you specify 0 in this parameter, DeleteMCEntries deletes either the
menu bar entry or menu title entry, depending on the value of the menuID
parameter. If you specify the item number of a menu item in this
parameter and the menu ID of a menu in the current menu list in the
menulD parameter, DeleteMCEntries deletes a specific menu item
entry. You can also delete all menu item entries for a specific menu from
your application’s menu color information table using this constant:

CONST
mctAllItems = -98; {delete all menu item entries }
{ for the specified menu}

The DeleteMCEntries procedure deletes a menu bar entry, a menu title entry, a menu
item entry, or all menu item entries of a given menu, according to the values specified in
the menuID and menultem parameters. If the GetMCEntry function does not find the
specified entry in your application’s menu color information table, it does not delete the
entry. Your application should not delete the last entry in your application’s menu color
information table.

If any of the deleted entries changes the menu bar color or a menu title color, your
application should call DrawMenuBar to update the menu bar.
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Application-Defined Routine

Apple provides a standard menu definition procedure and standard menu bar definition
function. The Menu Manager uses the menu definition procedure and menu bar
definition function to display and perform basic operations on menus and the menu bar.
Although the Menu Manager allows you to provide your own menu bar definition
function, Apple recommends that you use the standard menu bar definition function.
Similarly, in most cases the standard menu definition procedure should meet the needs of
most applications. However, if your application has special needs, you can choose to
provide your own menu definition procedure. If you do so, define your menu definition
procedure so that it emulates the standard behavior of menus as much as possible. If you
define your own menus, they should follow the guidelines described in this chapter and
in Macintosh Human Interface Guidelines.

The Menu Definition Procedure

The Menu Manager uses the menu definition procedure of a menu to draw the menu
items in the menu, to determine which item the user chose from the menu, and to
calculate the menu’s dimensions. If you provide your own menu definition procedure,
it should also perform these tasks.

Apple provides a standard menu definition procedure, stored as a resource in the System
file. The standard menu definition procedure is the 'MDEF ' resource with resource ID 0.
When you define your menus, you specify the menu definition procedure the Menu
Manager should use when managing them. You'll usually want to use the standard menu
definition procedure for your application. However, if you need a feature not provided
by the standard menu definition procedure (for example, if you want to include more
graphics in your menus), you can choose to write your own menu definition procedure.

MyMenuDef

3-148

You can provide your own menu definition procedure if you need special features in a
menu other than those provided by the standard menu definition procedure. This section
describes how to define your own menu definition procedure, defines the parameters
passed to your procedure by the Menu Manager, and describes the general actions your
procedure should perform.

PROCEDURE MyMenuDef (message: Integer; theMenu: MenuHandle;
VAR menuRect: Rect; hitPt: Point;
VAR whichItem: Integer) ;

message A number that identifies the operation that the menu definition proce-

dure should perform. The message parameter can contain any one of
these values:
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theMenu

menuRect

hitPt

whichItem

CONST
mDrawMsg = 0; {draw the menu}
mChooseMsg = 1; {tell which item was chosen }
{ and highlight it}
mSizeMsg = 2; {calculate menu dimensions}
mPopUpMsg = 3; {calculate rectangle of }

{ the pop-up box}

Your menu definition procedure should not respond to any value other
than the four constants listed above.

A handle to the menu record of the menu that the operation should affect.

The rectangle (in global coordinates) in which the menu is located; the
Menu Manager provides this information to the menu definition
procedure only when the value in the message parameter is the
mDrawMsg or mChooseMsg constant.

When the value in the message parameter is the mPopUpMsg constant,
the menu definition procedure should calculate and then return the
dimensions of the pop-up box in this parameter. When the value in the
message parameter is the mSizeMsg constant, the menu definition
procedure should calculate the horizontal and vertical dimensions of the
menu rectangle and store these values in the menuWidth and
menuHeight fields of the menu record.

A mouse location (in global coordinates). The Menu Manager provides
information in this parameter to the menu definition procedure when the
value in the message parameter is the mChooseMsg or mPopUpMsg
constant. When the menu definition procedure receives the mChooseMsg
constant in the message parameter, it should determine whether the
mouse location specified in the hit Pt parameter is in an enabled menu
item and highlight or unhighlight the item specified in the whichItem
parameter appropriately. When the menu definition procedure receives
the mPopUpMsg constant in the message parameter, the hit Pt parameter
contains the top-left coordinates of the closed pop-up box, which your
procedure can use to calculate the rectangle of the open pop-up box.

The item number of the last item chosen from this menu (or 0 if an item
hasn’t been chosen). The Menu Manager provides information in this
parameter to the menu definition procedure when the value in the
message parameter is the nChooseMsg constant. When the menu
definition procedure receives the nChooseMsg constant in the
message parameter, it should determine whether the mouse location
specified in the hitPt parameter is in an enabled menu item. If so, the
menu definition procedure should unhighlight the item specified by
the whichItem parameter, highlight the new item, and return the new
item number in whichItem. If the mouse location isn’t in an enabled
menu item, the menu definition procedure should unhighlight the
item specified by the whichItem parameter and return 0 in the
whichItem parameter.
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The Menu Manager calls your menu definition procedure whenever it needs your
definition procedure to perform a certain action on a specific menu. The action
your menu definition procedure should perform depends on the value of the
message parameter.

If you provide your own menu definition procedure, store it in a resource of type 'MDEF '
and include its resource ID in the description of each menu that uses your own definition
procedure. If you create a menu using GetMenu (or GetNewMBar), the Menu Manager
reads the menu definition procedure into memory and stores a handle to it in the
menuProc field of the menu’s menu record.

If you create a menu using NewMenu, the Menu Manager stores a handle to the standard
menu definition procedure in the menuProc field of the menu’s menu record. In this case
you must replace the value in the menuProc field with a handle to your own procedure
and then call the CalcMenuSize procedure. If your menu definition procedure is in a
resource file, you can get its handle by using the Resource Manager to read it from the
resource file into memory. However, note that you should usually store your menus in
resources (rather than using NewMenu) to make your application easier to localize. See
the “Resource Manager” chapter in Inside Macintosh: More Macintosh Toolbox for
information on the Resource Manager.

The menu definition procedure is responsible for drawing the contents of the menu and
its menu items, determining whether the cursor is in a displayed menu, highlighting and
unhighlighting menu items, and calculating a menu’s dimensions.

When the Menu Manager requests your menu definition procedure to perform an action
on a menu, it provides your procedure with a handle to its menu record. This allows your
procedure to access the data in the menu record and to use any data in the variable data
portion of the menu record to appropriately handle the menu items.

When the Menu Manager creates a menu as a result of an application calling GetMenu or
GetNewMBar, it fills out the menuID, menuProc, enableFlags, menuTitle, and
itemDefinitions fields of the menu record according to its resource definition. If the
menu is managed by your menu definition procedure, the Menu Manager calls your
procedure (specifying mSizeMsg) to calculate and fill in the menuHeight and
menuWidth fields of the menu record. The menu items are described by a variable length
field (itemDefinitions) in the menu record. Your menu definition procedure can
define and use this variable-length data in any manner it chooses.

For pop-up menus that are not implemented as controls, the Menu Manager uses the
menu definition procedure to support pop-up menus. If your menu definition procedure
supports pop-up menus, it should respond appropriately to the mPopUpMsg constant.

The Menu Manager specifies the mPopUpMsg constant in the message parameter and
calls your menu definition procedure whenever it needs to calculate the rectangle
bounded by the pop-up box for a pop-up menu that is managed by your menu definition
procedure. The parameter theMenu contains a handle to the menu record

of the pop-up menu, the hitPt parameter contains the top-left coordinates of the pop-
up box, and whichItem contains the previously chosen item. Your menu definition
procedure should calculate the rectangle in which the pop-up menu is to appear
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and return this rectangle in the menuRect parameter. If the menu is so large that it
scrolls, return the actual top of the menu in the whichItem parameter. For pop-up
menus, your menu definition procedure also must place the pop-up menu’s scrolling
information in the global variables TopMenuItem and AtMenuBottom. Place in
TopMenulItem the pixel value of the top of the scrollable menu, and place in
AtMenuBot tom the pixel value of the bottom of the scrollable menu.

Note

Your menu definition procedure should not assume that the A5
register is properly set up, so your procedure can’t refer to any of
the QuickDraw global variables. &

For additional information on how your menu definition procedure should respond
when it receives the mDrawMsg, mChooseMsg, or mSizeMsg constant in the message
parameter, see “Writing Your Own Menu Definition Procedure” beginning on page 3-87.

This section describes the menu (' MENU ') resource, menu bar (' MBAR ') resource, and
menu color information table ('mctb ') resource. Usually you should define your menus
using 'MENU' resources, define the menus in your menu bar in an 'MBAR' resource, and
use the GetNewMBar function to read in the descriptions of your menus and menu bar.

If you want to use colors other than the default colors in a menu, you can provide an
'mctb ' resource with the same resource ID as its corresponding 'MENU' resource, or
you can provide an 'mctb' resource with resource ID 0 to define colors for all your
menus and your menu bar.

If you choose to provide your own menu definition procedure, you should store your
routine in an 'MDEF ' resource.

To create a 'MENU', an 'MBAR', or an 'mctb' resource, either you can specify the
resource description in an input file and compile the resource using a resoure compiler,
such as Rez, or you can directly create your resources in a resource file using a tool such
as ResEdit. This section describes the structures of these resources after they are compiled
by the Rez resource compiler. If you are interested in creating the Rez input files for these
resources, see “Using the Menu Manager,” beginning on page 3-41, for detailed
information.

The Menu Resource

You can provide descriptions of your menus in 'MENU' resources and use the GetMenu
function or GetNewMBar function (if you also provide an 'MBAR' resource) to read in the
descriptions of your menus. After reading in the resource description, the Menu Manager
stores the information about specific menus in menu records.
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WARNING
Menus in a resource must not be purgeable. A

Figure 3-37 shows the format of a compiled 'MENU' resource. See Listing 3-1 on
page 3-43 for a description of a 'MENU' resource in Rez input format.

Figure 3-37 Structure of a compiled menu (' MENU') resource
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'"MENU' resource type Bytes
Menu ID 2
Placeholder for menu width 2
Placeholder for menu height 2

Resource ID of menu definition procedure | 2

Placeholder 2
Initial enabled state of the menu 4
and menu items
Length (n) of title 1
Characters of menu title n
Z Variable-length data that / variable

defines the menu items

Placeholder 1

A compiled version of a 'MENU' resource contains the following elements:

Menu ID. Each menu in your application should have a unique menu ID. Note that the
menu ID does not have to match the resource ID, although by convention most
applications assign the same number for a menu’s resource ID and menu ID. A
negative menu ID indicates a menu belonging to a desk accessory (except for
submenus of a desk accessory). A menu ID from 1 through 235 indicates a menu (or
submenu) of an application; a menu ID from 236 through 255 indicates a submenu of
a desk accessory. Apple reserves the menu ID of 0.

Placeholder (two integers containing 0) for the menu’s width and height. After reading
in the resource data, the Menu Manager requests the menu’s menu definition
procedure to calculate the width and height of the menu and to store these values in
the menuWidth and menuHeight fields of the menu record.

Resource ID of the menu’s menu definition procedure. If the integer 0 appears here (as
specified by the textMenuProc constant in the Rez input file), the Menu Manager
uses the standard menu definition procedure to manage the menu. If you provide your
own menu definition procedure, its resource ID should appear in these bytes. After
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reading in the menu’s resource data, the Menu Manager reads in the menu definition
procedure, if necessary. The Menu Manager stores a handle to the menu’s menu
definition procedure in the menuProc field of the menu record.

m Placeholder (an integer containing 0).

m The initial enabled state of the menu and first 31 menu items. This is a 32-bit value,
where bits 1-31 indicate if the corresponding menu item is disabled or enabled, and bit
0 indicates whether the menu is enabled or disabled. The Menu Manager
automatically enables menu items greater than 31 when a menu is created.

m The length (in bytes) of the menu title.
m The title of the menu.

m Variable-length data that describes the menu items. If you provide your own menu
definition procedure, you can define and provide this variable-length data according
to the needs of your procedure. The Menu Manager simply reads in the data for each
menu item and stores it as variable data at the end of the menu record. The menu
definition procedure is responsible for interpreting the contents of the data. For
example, the standard menu definition procedure interprets this data according to the
description given in the following paragraphs.

m Placeholder (a byte containing 0) to indicate the end of the menu item definitions.

If you use the standard menu definition procedure, your 'MENU' resource should
describe the menu items in this manner. For each menu item, you need to provide its text,
the icon number, the keyboard equivalent or other value ($1B to indicate the menu item
has a submenu, $1C to indicate a script code other than the system script for the item’s
text, $1D to indicate the item’s icon should be reduced, or $1E to indicate that an ' SICN'
icon should be used), the marking character of the menu item or menu ID of the menu
item’s submenu, and the font style of the menu item’s text. If an item doesn’t have a
particular characteristic, specify O for that characteristic. Figure 3-38 shows the
variable-length data portion of a compiled 'MENU' resource that uses the standard menu
definition procedure.

Figure 3-38 The variable-length data that describes menu items as defined by the standard

menu definition procedure

Variable-length data in ' MENU' resource Bytes
(For each menu item)
Length (m) of menu item text 1
} Text of menu item / m

Icon number, script code, or 0
Keyboard equivalent, $1B, $1C, $1D, $1E, or 0
Marking character or menu ID of submenu, or 0

Style of the menu item

—_
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The variable-length data portion of a compiled version of a 'MENU' resource that uses
the standard menu definition procedure contains the following elements:

m Length (in bytes) of the menu item’s text.
m Text of the menu item.

m Icon number, script code, or 0 (as specified by the noicon constant in a Rez input file)
if the menu item doesn’t contain an icon and uses the system script. The icon number
is a number from 1 through 255 (or from 1 through 254 for small or reduced icons). The
Menu Manager adds 256 to the icon number to generate the resource ID of the menu
item’s icon. If a menu item has an icon, you should also provide a 'cicn' or an
"ICON' resource with the resource ID equal to the icon number plus 256. If you want
the Menu Manager to reduce an ' ICON' resource to the size of a small icon, also
provide the value $1D in the keyboard equivalent field. If you provide an ' SICN'
resource, provide $1E in the keyboard equivalent field. Otherwise, the Menu Manager
looks first for a ' cicn' resource with the calculated resource ID and uses that icon. If
you want the Menu Manager to draw the item’s text in a script other than the system
script, specify the script code here and also provide $1C in the keyboard equivalent
field. If the script system for the specified script is installed, the Menu Manager draws
the item’s text using that script. An item that is drawn in a script other than the system
script cannot also have an icon.

m Keyboard equivalent (specified as a 1-byte character), the value $1B (as specified by
the constant hierarchicalMenu in a Rez input file) if the item has a submenu, the
value $1C if the item uses a script other than the system script, or 0 (as specified by the
nokey constant in a Rez input file) if the item has neither a keyboard equivalent nor a
submenu and uses the system script. A menu item can have a keyboard equivalent, a
submenu, a small icon, a reduced icon, or a script code, but not more than one of these
characteristics. For items containing icons, you can provide $1D in this field if you
want the Menu Manager to reduce an ' ICON' resource to the size
of a small icon. Provide $1E if you want the Menu Manager to use an ' SICN' resource
for the item’s icon. The values $01 through $1A as well as $1F and $20 are reserved for
use by Apple; your application should not use any of these reserved values in this
field.

m Marking character, the menu ID of the item’s submenu, or 0 (as specified by the
nomark constant in a Rez input file) if the item has neither a mark nor a submenu. A
menu item can have a mark or a submenu, but not both. Submenus of an application
should have menu IDs from 1 through 235; submenus of a desk accessory should have
menu IDs from 236 through 255.

m Font style of the menu item. The constants bold, italic, plain, outline, and
shadow can be used in a Rez input file to define their corresponding styles.

If you provide your own menu definition procedure, you should use the same format
for your resource descriptions of menus as shown in Figure 3-37. You can use the same
format or a format of your choosing to describe menu items. You can also use bits 1-31
of the enableFlags field of the menu record as you choose; however, bit 0 must still
indicate whether the menu is enabled or disabled.
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The Menu Bar Resource

You can describe the order and number of menus in your menu bar in an 'MBAR'
resource, and you can describe your menus in 'MENU' resources. If you do so, you can
use the GetNewMBar function to read in the descriptions of your menus and create a new
menu list. The Menu Manager stores information about your application’s menu bar in a
menu list. Figure 3-39 shows the format of a compiled 'MBAR' resource. (See Listing 3-4
on page 3-49 for a description of an 'MBAR' resource in Rez input format.)

Figure 3-39 Structure of a compiled menu bar (' MBAR ') resource

'"MBAR' resource type Bytes
Number of menus 2
Resource ID of first menu 2
Resource ID of second menu 2
Resource ID of next menu 2
7 /
Resource ID of last menu 2

A compiled version of an 'MBAR' resource contains the following elements:
m Number of menus described by this menu bar.

m A variable number (the amount should match the number declared in the first 2 bytes)
of resource IDs; each resource ID should identify a 'MENU' resource.

If you use the GetNewMBar function, the Menu Manager places the menus in the menu
bar according to the order that they appear in the 'MBAR' resource.

The Menu Color Information Table Resource

To use colors other than the default colors in a menu, provide a menu color information
table (' mctb') resource with the same resource ID as its corresponding ' MENU
resource. You can also choose to provide an 'mctb' resource with resource ID 0 to define
colors for all your menus and your menu bar. Note that you should usually use the
default colors provided by the Menu Manager.

The Menu Manager stores color information about your application’s menus and menu
bar in a menu color information table. If you provide an 'mctb' resource with resource
ID 0, the Menu Manager reads the resource in when your application calls InitMenus
and stores the information in your application’s menu color information table. If you
provide an 'mctb' resource with the same resource ID as a 'MENU' resource, when you
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use GetMenu to read in the resource description of the menu (or GetNewMBar to read
in all menus in the menu bar), the Menu Manager also reads in any associated 'mctb'
resource (if it exists). “The Menu Color Information Table Record” beginning on

page 3-98 describes the format of the menu color information table.

Figure 3-40 shows the format of a compiled 'mctb' resource.

Figure 3-40 Structure of a compiled menu color information table ('mctb') resource
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'mctb' resource type Bytes
Number of entries 2
Z First color entry / 28

4 /

{ Last color entry { 28

A compiled version of an 'mctb' resource contains the following elements:
m a count of the number of menu color entry descriptions
m a variable number of menu color entries

A color entry defines colors for various parts of the menu and menu bar. Figure 3-41 on
the next page shows the format of a compiled menu color entry in an 'mctb' resource.

Each menu color entry in an 'mctb' resource contains the following:

m A menu ID to indicate that this entry is either a menu item entry or menu title entry, 0
to indicate that this entry is a menu bar entry, or 99 to indicate that this is the last
entry in this resource.

m Anitem number to indicate that this entry is a menu item entry, or 0 to indicate that
this is either a menu title or menu bar entry. Together, the menu ID and menu item
determine how the type of menu color entry is described. See Table 3-7 on page 3-100
for a complete description of how the menu ID and menu item specifications define
the type of menu color entry.

m RGBL: for a menu bar entry, the default color for menu titles; for a menu title entry, the
title color of a specific menu; for a menu item entry, the mark color for a specific item.

m RGB2: for a menu bar entry, the default background color of a displayed menu; for a
menu title entry, the default color for the menu bar; for a menu item entry, the color for
the text of a specific item.
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Figure 3-41 Structure of a menu color entry in an 'mctb' resource

Menu color entry Bytes
ID 2
ltem 2
/ RGB1 /6
/ RGB2 /6
/ RGB3 /6
{ RGB4 { 6

m RGB3: for a menu bar entry, the default color of items in a displayed menu; for a menu
title entry, the default color for items in a specific menu; for a menu item entry, the
color for the keyboard equivalent of a specific item.

m RGB4: for a menu bar entry, the default color of the menu bar; for a menu title entry,
the background color of a specific menu; for a menu item entry, the background color
of a specific menu.

The Menu Definition Procedure Resource

If you provide your own menu definition procedure, you should store it in a resource of
type 'MDEF'. Provide as the resource data the compiled or assembled code of your menu

definition procedure. The entry point of your procedure must be at the beginning of the
resource data.

If you define your menus in 'MENU' resources (and use the GetMenu or GetNewMBar
function), you specify the menu definition procedure that the Menu Manager should

use to manage the menu in the 'MENU' resource. If you use the NewMenu function
(instead of 'MENU' resources), your application must explicitly replace the handle to

the standard menu definition procedure in the menuProc field of the menu record with a
handle to the desired menu definition procedure.
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Summary of the Menu Manager

Pascal Summary

Constants

CONST
noMark = 0; {menu item doesn't have a marking character}

{values for the message parameter to the menu definition procedure}

mDrawMsg = 0; {draw the menu items of a menu}
mChooseMsg = 1; {highlight or unhighlight a menu item as }

{ appropriate if the cursor is in a menu item}
mSizeMsg = 2; {calculate the dimensions of a menu}
mPopUpMsg = 3; {calculate the open pop-up box rectangle}
textMenuProc = 0; {resource ID of standard menu definition }

{ procedure}

hMenuCmd = 27; {constant ($1B) specified as keyboard equivalent }
{ to indicate a menu item has a submenu}
hierMenu = -1; {constant used with InsertMenu routine to insert }
{ a submenu or pop-up menu into the submenu }
{ portion of the current menu list}
mctAllItems = —98;{search for all items with the given ID}
mctLastIDIndic = -99;{last menu color table entry has this value }
{ in the ID field of the entry}
Data Types
TYPE
MenulInfo = {menu record}
RECORD
menulD: Integer; {number that identifies the menu}
menuWidth: Integer; {width (in pixels) of the menu}
menuHeight: Integer; {height (in pixels) of the menu}
menuProc: Handle; {menu definition procedure}
enableFlags:LongInt; {indicates whether menu and }

{ menu items are enabled}
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menuData: Str255; {title of menu}
{itembDefinitions} {variable-length data that }
{ defines the menu items}
END;
MenuPtr = “MenulInfo; {pointer to a menu record}
MenuHandle = “MenuPtr; {handle to a menu record}
MCEntry = {menu color entry record}
RECORD
mctID: Integer; {menu ID or 0 for menu bar}
mctItem: Integer; {menu item number or 0 for }
{ menu title}
mctRGB1 : RGBColor; {usage depends on mctID and }
{ mctIitem}
mctRGB2 : RGBColor; {usage depends on mctID and }
{ mctItem}
mctRGB3 : RGBColor; {usage depends on mctID and }
{ mctItem}
mctRGB4 : RGBColor; {usage depends on mctID and }
{ mctIitem}
mctReserved: Integer; {reserved}
END;
MCEntryPtr = “MCEntry; {pointer to a menu color entry record}
MCTable = ARRAY[0..0] OF MCEntry; {menu color table}
MCTablePtr = "MCTable; {pointer to a menu color table}

MCTableHandle = “MCTablePtr; {(handle to a menu color table}

Menu Manager Routines

Initializing the Menu Manager

PROCEDURE InitMenus;
PROCEDURE InitProcMenu (resID: Integer) ;

Creating Menus

FUNCTION NewMenu (menulID: Integer; menuTitle: Str255)
MenuHandle;
FUNCTION GetMenu (resourcelID: Integer): MenuHandle;
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Adding Menus to and Removing Menus From the Current Menu List

PROCEDURE InsertMenu (theMenu: MenuHandle; beforeID: Integer) ;
PROCEDURE DeleteMenu (menuID: Integer) ;
PROCEDURE ClearMenuBar;

Getting a Menu Bar Description From an 'MBAR' Resource

FUNCTION GetNewMBar (menuBarID: Integer): Handle;

Getting and Setting the Menu Bar

FUNCTION GetMenuBar: Handle;
PROCEDURE SetMenuBar (menulList: Handle) ;
FUNCTION GetMBarHeight: Integer;

Drawing the Menu Bar

PROCEDURE DrawMenuBar;
PROCEDURE InvalMenuBar;

Responding to the User’s Choice of a Menu Command

FUNCTION MenuSelect (startPt: Point): LonglInt;
FUNCTION MenuKey (ch: Char): LongInt;
FUNCTION MenuChoice: LongInt;

PROCEDURE HiliteMenu (menuID: Integer) ;

FUNCTION PopUpMenuSelect (menu: MenuHandle;
Top: Integer; Left: Integer;
PopUpItem: Integer): LongInt;

PROCEDURE SystemMenu (menuResult: LongInt) ;
FUNCTION SystemEdit (editCmd: Integer): Boolean;

Getting a Handle to a Menu Record

{some routines have two spellings, see Table 3-8 for the alternate spelling}
FUNCTION GetMenuHandle (menuID: Integer): MenuHandle;

FUNCTION HMGetHelpMenuHandle
(VAR mh: MenuHandle): OSErr;

Adding and Deleting Menu Items

{some routines have two spellings, see Table 3-8 for the alternate spelling}
PROCEDURE AppendMenu (menu: MenuHandle; data: Str255);

PROCEDURE InsertMenultem (theMenu: MenuHandle; itemString: Str255;
afterItem: Integer);
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DeleteMenultem
AppendResMenu

InsertResMenu

(theMenu: MenuHandle;
(theMenu: MenuHandle;
(theMenu: MenuHandle;
afterItem: Integer) ;

Getting and Setting the Appearance of Menu Items

item: Integer);
theType: ResType) ;
theType: ResType;

{some routines have two spellings, see Table 3-8 for the alternate spelling}

PROCEDURE
PROCEDURE
PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

EnableItem
DisableItem
GetMenultemText

SetMenultemText

GetItemStyle

SetItemStyle

GetItemMark

SetItemMark

CheckItem

GetItemIcon

SetItemIcon

GetItemCmd

SetItemCmd

(theMenu: MenuHandle;
(theMenu: MenuHandle;

(theMenu: MenuHandle;

VAR itemString: Str255);

(theMenu: MenuHandle;
itemString: Str255);

(theMenu: MenuHandle;
VAR chStyle: Style);
(theMenu: MenuHandle;
chStyle: Style);

(theMenu: MenuHandle;
VAR markChar: Char) ;
(theMenu: MenuHandle;
markChar: Char) ;

(theMenu: MenuHandle;
checked: Boolean) ;

(theMenu: MenuHandle;
VAR iconIndex:
(theMenu: MenuHandle;
iconIndex: Byte);

Byte) ;

Disposing of Menus

PROCEDURE DisposeMenu

Counting the Items in a Menu

FUNCTION CountMItems

Highlighting the Menu Bar

PROCEDURE FlashMenuBar
PROCEDURE SetMenuFlash

(theMenu: MenuHandle;
VAR cmdChar: CHAR) ;
(theMenu: MenuHandle;
cmdChar: CHAR) ;
(theMenu: MenuHandle) ;
(theMenu: MenuHandle) :
(menuID: Integer) ;
(count: Integer) ;

Summary of the Menu Manager

item: Integer) ;
item: Integer) ;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
item: Integer;
Integer;
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Recalculating Menu Dimensions

PROCEDURE CalcMenuSize (theMenu: MenuHandle) ;

Managing Entries in the Menu Color Information Table

{some routines have two spellings, see Table 3-8 for the alternate spelling}

FUNCTION GetMCInfo: MCTableHandle;

PROCEDURE SetMCInfo (menuCTbl: MCTableHandle) ;

PROCEDURE DisposeMCInfo (menuCTbl: MCTableHandle) ;

FUNCTION GetMCEntry (menuID: Integer; menultem: Integer)
MCEntryPtr;

PROCEDURE SetMCEntries (numEntries: Integer;

menuCEntries: MCTablePtr) ;
PROCEDURE DeleteMCEntries (menuID: Integer; menultem: Integer) ;

Application-Defined Routine

PROCEDURE MyMenuDef (message: Integer; theMenu: MenuHandle;
VAR menuRect: Rect; hitPt: Point;
VAR whichItem: Integer);

C Summary

Constants

enum {
#define noMark '\0' /*menu item doesn't have a marking character*/

/*values for the message parameter to the menu definition procedure*/

mDrawMsg = 0, /*draw the menu items of a menu*/
mChooseMsg = 1, /*highlight or unhighlight a menu item as */

/* appropriate if the cursor is in a menu item*/
mSizeMsg = 2, /*calculate the dimensions of a menu*/
mPopUpMsg = 3, /*calculate the open pop-up box rectangle*/
textMenuProc = 0, /*resource ID of standard menu definition */

/* procedure*/
hMenuCmd = 27, /*constant ($1B) specified as keyboard */
/* equivalent to indicate an item has a submenu¥*/
hierMenu = -1, /*constant used with InsertMenu to insert */
/* a submenu or pop-up menu into the submenu */
/* portion of the current menu list*/
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mctAllItems = -98,/*search for all items with the given ID*/
mctLastIDIndic = -99 /*last menu color table entry has this value */
/* in the ID field of the entry*/

}i

Data Types
struct MenuInfo /*menu record*/
short menulD; /*number that identifies the menu*/
short menuWidth; /*width (in pixels) of the menu*/
short menuHeight; /*height (in pixels) of the menu*/
Handle menuProc; /*menu definition procedure*/
long enableFlags; /*indicates whether menu and */
/* menu items are enabled*/
Str255 menuData; /*title of menu*/
/*itemDefinitions*/ /*variable-length data that */
/* defines the menu items*/
Vi
typedef struct MenuInfo MenulInfo; /*pointer to a menu record*/
typedef MenuInfo *MenuPtr, **MenuHandle; /*handle to a menu record*/
struct MCEntry { /*menu color entry record*/
short mctID; /*menu ID or 0 for menu bar*/
short mctItem; /*menu item number or 0 for */
/* menu titlex/
RGBColor mctRGB1; /*usage depends on mctID and */
/* mctItem*/
RGBColor mctRGB2; /*usage depends on mctID and */
/* mctItem*/
RGBColor mctRGB3; /*usage depends on mctID and */
/* mctItem*/
RGBColor mctRGB4 ; /*usage depends on mctID and */
/* mctItem*/
short mctReserved; /*reserved*/
}i
typedef struct MCEntry MCEntry;
typedef MCEntry *MCEntryPtr; /*pointer to a menu color entry recordx*/

/*menu color tablex*/
typedef MCEntry MCTable[l], *MCTablePtr, **MCTableHandle;
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Menu Manager Routines

Initializing the Menu Manager

pascal void InitMenus (void) ;

pascal void InitProcMenu (short resID) ;

Creating Menus

pascal

pascal

MenuHandle NewMenu (short menuID, const Str255 menuTitle) ;

MenuHandle GetMenu (short resourcelD) ;

Adding Menus to and Removing Menus From the Current Menu List

pascal
pascal

pascal

void InsertMenu (MenuHandle theMenu,
void DeleteMenu (short menulID) ;
void ClearMenuBar (void) ;

Getting a Menu Bar Description From an '"MBAR' Resource

pascal

Handle GetNewMBar (short menuBarID) ;

Getting and Setting the Menu Bar

pascal Handle GetMenuBar (void) ;
pascal void SetMenuBar (Handle menulList) ;
#define GetMBarHeight () (* (short*) 0xO0BAA)

Drawing the Menu Bar

pascal

pascal

void DrawMenuBar (void) ;

void InvalMenuBar (void) ;

Responding to the User’s Choice of a Menu Command

pascal
pascal
pascal
pascal

pascal

pascal

pascal

3-164

long MenuSelect Point startPt);

long MenuKey short ch);

short menulD) ;

(

(
long MenuChoice (void) ;
void HiliteMenu (

(

MenuHandle menu,
short popUplItem) ;

long PopUpMenuSelect

void SystemMenu (long menuResult) ;

Boolean SystemEdit (short editCmd) ;
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Getting a Handle to a Menu Record

{some routines have two spellings, see Table 3-8 for the alternate spelling}

pascal MenuHandle GetMenuHandle

(short menulID) ;

pascal OSErr HMGetHelpMenuHandle

Adding and Deleting Menu Items

(MenuHandle *mh) ;

{some routines have two spellings, see Table 3-8 for the alternate spelling}

pascal void AppendMenu

pascal

pascal
pascal

pascal

void

void
void

void

InsertMenultem

DeleteMenultem
AppendResMenu

InsertResMenu

(MenuHandle menu, ConstStr255Param data) ;

(MenuHandle theMenu,

ConstStr255Param itemString,

short afterItem) ;
(MenuHandle theMenu,
(MenuHandle theMenu,

(MenuHandle theMenu,
short afterItem) ;

Getting and Setting the Appearance of Menu Items

{some routines have two spellings, see Table 3-8

pascal

pascal

pascal

pascal

pascal

pascal

pascal

pascal

pascal

pascal

pascal

void
void

void

void

void

void

void

void

void

void

void

EnablelItem

DisablelItem
GetMenultemText

SetMenultemText

GetItemStyle

SetItemStyle
GetItemMark

SetItemMark

CheckItem

GetItemIcon

SetItemIcon

(MenuHandle theMenu,

(MenuHandle theMenu,

(MenuHandle theMenu,
Str255 itemString) ;

(MenuHandle theMenu,

short item) ;

ResType theType) ;

ResType theType,

for the alternate spelling}

short item) ;

short item) ;

short

short

item,

item,

ConstStr255Param itemString) ;

(MenuHandle theMenu,
Style *chStyle) ;

(MenuHandle theMenu,

(MenuHandle theMenu,
short *markChar) ;
(MenuHandle theMenu,
short markChar) ;

(MenuHandle theMenu,
Boolean checked) ;

(MenuHandle theMenu,
short *iconIndex) ;
(MenuHandle theMenu,
short iconIndex) ;
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pascal void GetItemCmd (MenuHandle theMenu, short item, short
*cmdChar) ;
pascal void SetItemCmd (MenuHandle theMenu, short item, short cmdChar) ;

Disposing of Menus

pascal void DisposeMenu (MenuHandle theMenu) ;

Counting the Items in a Menu

pascal short CountMItems (MenuHandle theMenu) ;

Highlighting the Menu Bar

pascal void FlashMenuBar (short menulID) ;

pascal void SetMenuFlash (short count) ;

Recalculating Menu Dimensions

pascal void CalcMenuSize (MenuHandle theMenu) ;

Managing Entries in the Menu Color Information Table

{some routines have two spellings, see Table 3-8 for the alternate spelling}
pascal MCTableHandle GetMCInfo (void) ;

MCTableHandle menuCTbl) ;

MCTableHandle menuCTbl) ;

pascal void SetMCInfo

pascal void DisposeMCInfo

short numEntries, MCTablePtr menuCEntries) ;

(

(
pascal MCEntryPtr GetMCEntry (short menuID, short menultem) ;

pascal void SetMCEntries (

(

pascal void DeleteMCEntries (short menulID, short menultem) ;

Application-Defined Routine

pascal void MyMenuDef (short message, MenuHandle theMenu,
Rect *menuRect, Point hitPt,
short *whichItem) ;
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Assembly-Language Summary

Data Structures

The Menu Information Data Structure

0 menulID word number that identifies the menu
2 menuWidth word width (in pixels) of the menu
4 menuHeight word height (in pixels) of the menu
6 menuDefHandle long menu definition procedure
10 menuEnable long enable flags
14 menuData 256 bytes menu title followed by menu item information

Global Variables

AtMenuBottom
MBarEnable

MBarHeight
MBarHook

MenuCInfo
MenuDisable

MenuFlash
MenuHook

TheMenu
TopMenuItem

Result Codes

The pixel value at the bottom of the scrollable menu.

Contains 0 if all menus in the current menu bar belong to an application; contains
a nonzero value if all menus belong to a desk accessory.

Contains current height of the menu bar, in pixels.

Address of routine that MenuSelect calls repeatedly while the mouse button
is down.

Contains a handle to application’s menu color information table.

Contains the menu ID and item number of the last item chosen, regardless of
whether the item was disabled or enabled.

Contains the current count (number of times) a menu item blinks when chosen by
the user.

Address of routine that MenuSelect calls after a menu title is highlighted and
the menu rectangle is calculated but before the menu is drawn.

Contains the menu ID of the highlighted menu in the menu bar.
The pixel value at the top of the scrollable menu.

noErr 0 No error

paramErr -50 Error in parameter list
memFullErr -108 Not enough room in heap zone
resNotFound -192 Unable to read resource
hmHelpManagerNotInited -855 Help menu not set up
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This chapter describes how your application can use the Window Manager to create and
manage windows.

A Macintosh application uses windows for most communication with the user, from
discrete interactions like presenting and acknowledging alert boxes to open-ended
interactions like creating and editing documents. Users generally type words and
formulas, draw pictures, or otherwise enter data in a window on the screen. Your
application typically lets the user save this data in a file, open saved files, and view
the saved data in a window. See the chapter “Introduction to File Management” in
Inside Macintosh: Files for more information about handling files.

A window can be any size or shape, and the user can display any number of windows,
within the limits of available memory, on the screen at once.

The Window Manager defines a set of standard windows and provides a set of routines
for managing them. The Window Manager helps your application display windows that
are consistent with the Macintosh user interface. See Macintosh Human Interface Guidelines
for a detailed description of windows and their behavior.

You typically store information about your windows in resources. This chapter describes
the standard window resources. For general information on resources, see the chapter
“Introduction to the Macintosh Toolbox” in this book. For information on Resource
Manager routines, see the chapter “Resource Manager” in Inside Macintosh: More
Macintosh Toolbox.

The Window Manager itself depends on QuickDraw, the part of the Macintosh system
software that handles quick manipulation of graphics. QuickDraw supports drawing into
graphics ports, which are individual and complete drawing environments with
independent coordinate systems. Each window represents a graphics port, which is
described in Inside Macintosh: Imaging.

To maintain its windows, your application needs to know what actions the user is taking
on the desktop. It receives this information through events, which are messages that
describe user actions and report on the processing status of your application. This
chapter describes the events that affect window display and considers mouse-down and
keyboard events as they relate to windows. For a complete description of events and how
your application handles them, see the chapter “Event Manager” in this book.

Most document windows contain controls, which are screen images the user manipulates
to control the display or the behavior of the application. This chapter illustrates the
controls most commonly used in windows. For more information on creating and
responding to controls, see the chapter “Control Manager” in this book.

You use the Window Manager to create and display a new window when the user creates
a new document or opens an existing document. When the user clicks or holds down the
mouse button while the cursor is in a window created by your application, you use the
Window Manager to determine the location of the mouse action and to

alter the window display as appropriate. When the user closes a window, you use the
Window Manager to remove the window from the screen.
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This chapter describes how the Window Manager supports windows and then explains
how you can use the Window Manager to

m create and display windows

m handle events in windows

m change the display when the user moves or resizes windows

m remove windows

Introduction to Windows

A window is a user interface element, an area on the screen in which the user can enter
or view information.

The user can have multiple windows on the desktop at once, from a number of different
applications. The user can change the size and location of most windows and can place

windows entirely or partially in front of other windows. Figure 4-1 shows a few windows
on the desktop.

Figure 4-1 Multiple windows
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Your application typically creates document windows that allow the user to enter and
display text, graphics, or other information. For an illustration of a document window in
full color, see Plate 1 at the beginning of this book.
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A document window is a view into the document—if the document is larger than the
window, the window is a view of a portion of the document. Your application can put
one or more windows on the screen, each window showing a view of a document or of
auxiliary information used to process the document.

The Window Manager defines and supports a set of standard window elements through
which the user can manipulate windows. It’s important that your application follow the
standard conventions for drawing, moving, resizing, and closing windows. By presenting
the standard interface, you make experienced users instantly familiar with many aspects
of your application, allowing them to focus on learning its unique features.

Figure 4-2 illustrates a standard document window and its elements.

Figure 4-2 A document window
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The title bar displays the name of the window and indicates whether it’s active or not.
The Window Manager displays the title of the window in the center of the title bar, in the
system font and system font size. If the system font is in the Roman script system, the
title bar is 20 pixels high.

When the user creates a new document, you ordinarily display a new document window
with the title “untitled”, spelled in lowercase letters. If the user creates a second new
document window without saving the first, you title the second window “untitled 2”,
with a space between the word and the number. Continue to add 1 to the number in the
title as long as the user continues to create new windows without saving previously
numbered, untitled windows.

When the user opens a saved document, you assign the document’s filename to the
window in which it is displayed.

The user expects to move a window by dragging it by its title bar. You can support
moving the window by calling the Window Manager’s DragWindow procedure, as
described in “Moving a Window” on page 4-53.
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The close box offers the user a quick way to close a window. You can use the
TrackGoAway function to track mouse activity in the close box and the CloseWindow
and DisposeWindow procedures to close windows. Closing windows is described in
“Closing a Window” beginning on page 4-60.

The zoom box offers the user a quick way to switch between two different window sizes.
You use the TrackBox function to track mouse activity in the zoom box and the
ZoomWindow procedure to zoom windows. Zooming windows is described in “Zooming
a Window” beginning on page 4-53.

The size box lets the user change the size and dimensions of the window. You use the
GrowWindow function to track mouse activity in the size box and the SizeWindow
procedure to resize windows. Sizing windows is described in “Resizing a Window”
beginning on page 4-57.

The scroll bars let the user see different parts of a document that contains more
information than can be displayed at once in the window. Although the Macintosh user
interface guidelines specify that you place scroll bars on the right and lower edges of a
window that needs them, scroll bars are not part of the window structure. You create and
control the scroll bars through the Control Manager, described in the chapter “Control
Manager” in this book.

The content region is the part of the window in which your application displays the
contents of a document, the size box, and the window controls.

The window frame is the part of the window drawn automatically by the Window
Manager—the title bar, including the close box and zoom box, and the window’s outline.

The structure region is the entire screen area occupied by a window, including the frame
and content region. (See Figure 4-10 on page 4-12.)

Active and Inactive Windows

The window in which the user is currently working is the active window. The active
window is the frontmost window on the desktop. It is identified visually by the “racing
stripes” in its title bar.

The active window is the target of keyboard activity. It often contains a blinking insertion
point (also called the caret) marking the place where new text or graphics will appear.
When the user selects text in an active window, your application should highlight the
text with inverse video; if the window becomes inactive, you remove the highlighting.
You can use a secondary selection technique, such as an outline, to mark a selection in an
inactive window. You display scroll bars only in the active window. Figure 4-3 illustrates
a sample document window in active and inactive states.

Except for the active window, all document windows on the desktop, whether they
belong to your application or another, are inactive. Your application can process
documents in inactive windows, but only the active window interacts with the user.
For example, if the user chooses Save from the File menu, your application saves
only the document in the active window.

Introduction to Windows



CHAPTER 4

Window Manager

Figure 4-3
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To make a window active, the user clicks anywhere in its contents or frame. When
the user activates one of your windows, you call the Window Manager to highlight
the window frame and title bar; you activate the controls and window contents.

As a window becomes active, it appears to the user to move forward, in front of all
other windows.

When the user clicks in an inactive document window, you should make the window
active but not make any selections in the window in response to the click. To make a
selection in the window, the user must click again. This behavior protects the user from
losing an existing selection unintentionally when activating a window.

Note

The Finder makes selections in response to the first click in an inactive
window, because this action is more natural for the way Finder windows
are used. You might find that users expect the first click to cause a
selection in some other special-purpose windows created by your
application. This behavior is seldom appropriate in document

windows. &

When a window that belongs to your application becomes inactive, the Window
Manager redraws the frame, removing the highlighting from the title bar and hiding
the close and zoom boxes. Your application hides the controls and the size box and
removes highlighting from application-controlled elements.

When the user reactivates a window, reinstate the window as it was before it was
deactivated. Draw the scroll box in the same position and restore the insertion point or
highlight the previous selection.
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Types of Windows

Because windows have so many uses, their appearances vary. The Window Manager
defines a number of window types that meet the basic needs of most applications. A
window type is the general description of how a window looks and behaves. Some
windows have title bars and others don’t, for example, and windows can have almost
any combination of the window-manipulation elements: close box, zoom box, and
size box.

This section describes the nine basic window types supported by the Window Manager
and their uses. You can create windows of these types by specifying one of the window
type constants: zoomDocProc, dBoxProc, altDBoxProc, plainDBoxProc,
movableDBoxProc, noGrowDocProc, documentProc, zoomNoGrow, and rDocProc.
For instructions for creating windows, see “Creating a Window” beginning on page 4-25.

To give the user maximum flexibility and control, you can use the zoomDocProc
window type for your document windows. A zoomDocProc window supports all of the
window-manipulation elements shown in Figure 4-2 on page 4-5: title bar, close box,
zoom box, and size box. The Window Manager does not necessarily draw the close box
and size box, however. You must call the Window Manager’s DrawGrowIcon procedure
to draw the size box, and you can optionally suppress the close box when you create the
window. For more information on defining a window’s characteristics, see “Creating a
Window” beginning on page 4-25.

Figure 4-4 illustrates a window of type zoomDocProc with a close box, as drawn by the
Window Manager before you add the size box and scroll bars.

4-8

Figure 4-4 A window of type zoomDocProc
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In most cases, a window of type zoomDocProc should contain both a close box and a
size box. When the related document contains more data than fits in the window, you
activate the scroll bars and adjust them to show where in the document the user is
working. Figure 4-5 illustrates a window of type zoomDocProc with a size box and scroll
bars.
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Figure 4-5 A window of type zoomDocProc, with size box and inactive scroll bars
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You also use windows to display alert boxes and dialog boxes. This section describes the
window types used for alert boxes and dialog boxes. For more thorough descriptions of
the different kinds of alert boxes and dialog boxes, see the chapter “Dialog Manager” in
this book.

Alert boxes and fixed-position modal dialog boxes contain no window-manipulation
elements. The user cannot move, resize, zoom, or close them manually. An alert box or a
modal dialog box remains on the screen as the active window until the Dialog Manager
or your application removes it—usually when the user completes the interaction by
clicking one of the buttons. Figure 4-6 illustrates the three window types available for
alert boxes and fixed-position modal dialog boxes.

Figure 4-6 Window types for alert boxes and fixed-position modal dialog boxes

dBoxProc

altDBoxProc plainDBoxProc

When you want to let the user move a modal dialog box window—in order, for example,
to see text that might be obscured by the window—you can implement a movable modal
dialog box. A movable modal dialog box cannot be resized, closed, or zoomed, but it can
be moved. Figure 4-7 on the next page illustrates the movableDBoxProc window type.
Like a fixed-position modal dialog box, the movable modal dialog box remains active
until the user completes the dialog.
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Figure 4-7 A window of type movableDBoxProc
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Whenever possible, avoid modal dialog boxes and instead use modeless dialog boxes,
which allow the user to perform other tasks without dismissing the dialog box. Windows
of type noGrowDocProc, used for displaying modeless dialog boxes, can be moved or
closed but not resized or zoomed. You can implement modeless dialog boxes with other
window types if necessary, but it’s easier to conform to the user interface guidelines if
you keep your dialog box windows as simple as possible. Figure 4-8 illustrates the
modeless dialog box window.

Figure 4-8 A window of type noGrowDocProc

4-10

=0

untitied

noGrowbDocProc

The Window Manager also supports a few window types that are seldom used. The
document Proc window type, for example, has a title bar and supports a close box and
size box but no zoom box. The zoomNoGrow window type is virtually never appropriate:
zoomNoGrow supports a close box and a zoom box, but not a size box. The rDocProc
window type is a rounded-corner window with a title bar and a close box; it is used by
desk accessories. Figure 4-9 illustrates these three seldom-used window types.

The window definition function defines the general appearance and behavior of a
window. The system software and various Window Manager routines call a window’s
window definition function when they need to perform certain window-dependent
actions, such as drawing or resizing a window’s frame.
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Figure 4-9 Seldom-used window types
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The Window Manager supplies two standard window definition functions that handle
the nine standard window types. A window definition function draws the window’s
frame, draws the close box and window title (if any), determines which region the cursor
is in within the window, calculates the window’s structure and content regions, draws
the window’s zoom box (if any), draws the window’s size box (if any), and performs any
special initialization or disposal tasks.

A single window definition function can support up to 16 different window types. The
window definition function defines a variation code, an integer from 0 through 15, for
each window type it supports.

A window definition ID is a single value incorporating both the window’s definition
function and its variation code. (The resource ID of the window definition function

is stored in the upper 12 bits of the integer, and the variation code is stored in the
lower 4 bits.) The window-type constants described in this section are in fact window

definition IDs.

Window
Constant definition ID Description
documentProc 0 movable, sizable window, no zoom box
dBoxProc 1 alert box or modal dialog box
plainDBox 2 plain box
altDBoxProc 3 plain box with shadow
noGrowDocProc 4 movable window, no size box or zoom box
movableDBoxProc 5 movable modal dialog box
zoomDocProc 8 standard document window
zoomNoGrow 12 zoomable, nonresizable window
rDocProc 16 rounded-corner window

You can provide your own window definition function if you need a window with
unusual characteristics, as described in “The Window Definition Function” beginning
on page 4-120. Always be careful to conform window behavior to the guidelines in
Macintosh Human Interface Guidelines.
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Window Regions

The Window Manager recognizes a number of different special-purpose window
regions, which are defined by either the Window Manager or the window definition
functions.

The most obvious window regions are the parts of the visible window that the user
manipulates to control the display. These window regions correspond to the standard
window parts. The drag region is the area occupied by the title bar, except for the close
box and zoom box. (The user moves the window by dragging it by its title bar.) The size
region, close region, and zoom region are the areas occupied by the size box, close box,
and zoom box, respectively.

When the user presses the mouse button while the cursor is in one of your windows, you
use the Window Manager function FindWindow to determine the region in which the
mouse-down event occurred. (The FindWindow function calls the window’s window
definition function, which defines and interprets the window-manipulation regions.)
Depending on the result, you then call the appropriate Window Manager routine or your
own routine for handling the event. For more information about determining where the
cursor is when the user presses the mouse button, see “Handling Mouse Events in
Windows” on page 4-42. For discussions of how to use the Window Manager routines for
moving, sizing, closing, and zooming windows, see “Moving a Window” beginning on
page 4-53 and the sections that follow it.

The Window Manager also makes a broad distinction between the parts of the window
it draws automatically and the parts drawn by your application. The Window Manager
draws the window frame—the title bar, including the close box and zoom box, and

the window’s outline. (The Window Manager also draws the size box, but only when
your application calls the DrawGrowIcon procedure.) Your application is responsible for
drawing the content region—that is, the part of the window in which the contents

of a document, the size box, and the window controls (including the scroll bars)

are displayed.

The entire screen area occupied by a window, including the window outline, title bar, and
content region, is the structure region. Figure 4-10 illustrates the frame, content region,
and structure region of a window.

Figure 4-10 Window frame, content region, and structure region
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The drawing region of a graphics port associated with a window encompasses only the
window’s content region.

As the user creates, moves, resizes, and closes windows on the desktop, portions of
windows may be obscured and uncovered. The Window Manager keeps track of these
changes, accumulating a dynamic region known as the update region for each window.
The update region contains all areas of a window’s content region that need updating.
The Event Manager periodically scans the update regions of all windows on the desktop,
generating update events for windows whose update regions are not empty. When your
application receives an update event, it redraws the update region. Both your application
and the Window Manager can manipulate a window’s update region. The sections
“Updating the Content Region” on page 4-40 and “Maintaining the Update Region” on
page 4-41 describe how the Window Manager and your application track and use the
update region.

Dialog Boxes and Alert Boxes

Macintosh applications use alert boxes and dialog boxes to give the user messages and
to solicit information. A text-processing application, for example, might display an
alert box telling the user that a newly inserted graphic does not fit within the page
boundaries. It might display a dialog box in which the user can specify margins, tabs,
and other formatting information. (The chapter “Dialog Manager” in this book explains
how to use the various kinds of alert boxes and dialog boxes.)

Alert boxes and dialog boxes are merely special-purpose windows. You can handle all
alert boxes and most modal dialog boxes through the Dialog Manager, which itself calls
the Window Manager. You supply the Dialog Manager with lists of the items in your alert
boxes and dialog boxes, and the Dialog Manager displays the windows, tells you which
items the user is manipulating, and disposes of the windows when the user is done. Your
application provides the code that responds to the user’s selections in the alert and dialog
boxes.

Although you can specify any window type for your alert boxes and modal dialog boxes,
the Dialog Manager functions that handle alert boxes and modal dialog boxes do not
support window manipulation. You should therefore use one of the window types
without a title bar or size box, most typically the dBoxProc window type, for alert boxes
and modal dialog boxes. (When the user is responding to a modal dialog box,
mouse-down events outside the menu bar or the content region of the dialog box result
only in the sounding of the system alert. Note that the Process Manager does not perform
major switching while the ModalDialog procedure is handling events.)

You use the movableDBox window type for movable modal dialog boxes. As described
in the chapter “Dialog Manager” in this book, your application can use the Dialog
Manager to help handle events in a movable modal dialog box. Your application,
however, must handle window-manipulation events—ordinarily only the moving of the
movable modal dialog box window.
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Use the noGrowDocProc window type for modeless dialog boxes. You typically use
the Dialog Manager to handle events in a modeless dialog box, much like events in

a movable modal dialog box. Your application handles window-manipulation events in
modeless dialog boxes just as it handles them in document windows.

If you use complex dialog boxes, you might find it’s more efficient to use the Window
Manager and other parts of the Toolbox, instead of the Dialog Manager, to create and
manage your own dialog box windows. Again, see the chapter “Dialog Manager” in this
book for a list of characteristics to consider when evaluating the complexity of a dialog
box and for examples of customized dialog boxes.

Controls

Most windows contain controls, which are screen images that the user manipulates to
control the display or the behavior of the application. The most common control in a
document window is the scroll bar, illustrated in Figure 4-11.

Figure 4-11 Scroll bars
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You use scroll bars to show the relative position, within the entire document, of the
portion of the document displayed in the window. You should allow the user to drag the
scroll box or click in the gray areas or the scroll arrows to move parts of the document
into and out of the window. You activate scroll bars in a window any time there is more
data than can be shown at one time in the space available.

You use the Control Manager to create, display, and manipulate the scroll bars and any
other controls in your windows. Each control “belongs” to a window and is displayed
within the graphics port that represents that window. For each window your application
creates, the Window Manager maintains a control list, a series of entries pointing to the
descriptions of the controls associated with the window.
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Most alert boxes and dialog boxes contain buttons, rounded rectangles that cause

an immediate or continuous action when clicked, and most dialog boxes contain
additional screen images, like radio buttons, that display and retain settings. Figure 4-12
illustrates a dialog box with buttons, radio buttons, and a number of other controls and
dialog items.

Figure 4-12 Controls in a dialog box
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Buttons ordinarily appear only in alert boxes and dialog boxes. Most of the other
elements illustrated in Figure 4-12 appear only in dialog boxes. If you use the Dialog
Manager to create your alert boxes and dialog boxes, it draws your controls for you and
lets you know when the user has clicked one of them. You can, however, call the Control
Manager yourself to display and track buttons and other controls in any windows your
application creates. You can also write your own control definition functions to create and
control other kinds of controls. For a complete description of how to create and support
controls, see the chapter “Control Manager” in this book.

Windows on the Desktop

Multiple windows, from different applications, can appear simultaneously on the
desktop. The Window Manager tracks all windows, using its own private data structure
called the window list. Entries appear in the window list in their order on the desktop,
beginning with the frontmost, active window. When the user changes the ordering of
windows on the desktop, the Window Manager generates events telling your application
to activate, deactivate, and redraw windows as necessary. The Window Manager
prevents you from drawing accidentally in the windows of other applications.
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The user can interact with only one application at a time. The application with which the
user is interacting (that is, the application that owns the window in which the user is
working) is the active application, or foreground process, and the others are inactive
applications, or background processes. One way the user can switch applications is by
clicking in a window that belongs to a background 